## Contents

**Introduction** ........................................... xv

**Chapter 1. IBM Cognos Incentive Compensation Management Client overview** ............................................. 1

- Login window ........................................... 1
- Options menu ........................................... 1
- Creating a new model ...................................... 2
  - Creating models with multilingual support ............... 3
- Navigation in the Client ................................... 4
  - Tabs ................................................... 4
  - Keyboard shortcuts .................................... 5

**Chapter 2. Home page and process lists** ...................... 7

- Welcome message ......................................... 7
- Show or hide text in toolbars ............................... 7
- Access help files .......................................... 7
- Navigator tab ............................................. 7
  - Recently Opened Items and Most Commonly Opened Items windows ........................................ 8
  - The Quick Navigation window ............................ 8
  - Online window .......................................... 9
- Process lists ............................................... 9
  - Creating a process list .................................. 9
  - Adding tasks to a process list ............................ 9
  - Viewing and filtering process lists ....................... 10
  - Modifying a process list ................................ 10
  - Marking tasks as complete ................................ 10
  - Rearranging the order of tabs on the Home page ........ 11
  - Defining process list security ............................ 11

**Chapter 3. Composer** ..................................... 13

- Build a model ........................................... 13
- Toolbar ................................................... 13
  - Multi-edit or Single-edit mode .......................... 13
  - Link .................................................... 14
  - Arrange .................................................. 14
  - Visibility ............................................... 15
  - All ....................................................... 15
  - Uses and Used By ...................................... 15
  - Go To .................................................... 15
  - View Connection ........................................ 15
  - Purging table history ................................... 15
  - Sidebar .................................................. 16
  - Viewer ................................................... 17
  - Change font ............................................. 17
  - Using Format Painter ................................... 17
  - Setting component color ................................ 17
  - Expand Links and Collapse Links ........................ 18
  - Exporting the Composer diagram ......................... 18
  - Composer navigation .................................... 18
  - Selecting objects and zooming in Composer .............. 18
  - Finding elements in Composer ........................... 19
  - Viewing the title and description of Composer objects . 19
- Components ............................................... 19
  - Component organization .................................. 19
  - Navigation between components .......................... 20
  - Data flow between components ............................ 20

© Copyright IBM Corp. 2005, 2014
# Chapter 3. Connections

Working with components ........................................ 21  
Wrap and unwrap component feature ......................... 23  
Component security ............................................. 24  
Setting component security .................................. 24  
Connections .......................................................... 25  
Outbound and inbound connections ............................ 25  
Creating connections ............................................ 25  
Viewing current values in a connection ....................... 26  
Using an inbound connection as a calculation source ......... 26  
Change connections .............................................. 26  
Connection names .................................................. 28  
Connection wizard .................................................. 28  
Defining connections .............................................. 28  
When to use the Connection Wizard ............................ 29  
Creating outbound and inbound connections with the Connection Wizard ............................................. 30  
Linking tables and calculations to outbound connections 31

# Chapter 4. Table configuration

Connect table data between components ....................... 33  
Use table columns between components ....................... 33  
Tables ................................................................. 33  
System tables ....................................................... 34  
Hierarchy table ..................................................... 34  
Data table ............................................................ 36  
Structural table ...................................................... 36  
Custom table .......................................................... 36  
View ................................................................. 36  
Working with tables .................................................. 37  
Table column types ................................................. 37  
Primary keys .......................................................... 38  
Adding a table ....................................................... 38  
Adding a Data table ............................................... 39  
Adding a View .......................................................... 40  
Viewing the Payee table and Account table as a hierarchy . 40  
Viewing the Time table as a hierarchy ......................... 41  
View and edit table data ........................................... 41  
Viewing and editing table structure ............................ 42  
Deleting a table ...................................................... 43  
Adding and editing table descriptions ......................... 43  
Deleting multiple rows in a table ............................... 43  
Copying tables ....................................................... 44  
Publishing tables .................................................... 44  
Viewing table dependencies ..................................... 47  
Creating a global table ............................................. 47  
Globalizing and replacing connections ....................... 47  
Navigating between tables ....................................... 48  
Clearing tables ....................................................... 48  
Finding and replacing data in a table .......................... 48  
Table history .......................................................... 49  
Disabling table history collection ............................. 49  
Purging table history ............................................... 49  
Web data edit .......................................................... 50  
Uses for the web data edit feature .............................. 50  
Defining accessible information ................................ 50  
Restricting visible rows in tables .............................. 50  
Enabling direct editing ............................................. 51  
Edit data through the web client ............................... 51  
Approving web data edits ........................................ 52
Chapter 9. Working with calculations ................................. 93

Previewing a calculation ........................................ 93
Viewing current calculation values ................................ 93
Filtering calculation data ........................................ 93
Viewing calculation history ....................................... 94
Viewing sources that use the calculation ....................... 94
Viewing sources the calculation uses ............................ 94
Viewing a calculation description ................................. 95
Editing calculations ............................................. 95
Editing locked calculations ..................................... 95
Copying calculations ............................................ 96
Publishing calculations .......................................... 96
  Publishing calculations to a Microsoft Excel file ............. 96
  Publishing calculations to a Microsoft Dynamics CRM database ........................................ 97
  Publishing calculations to PDF file .......................... 97
  Publishing calculations to Salesforce.com ........................ 97
  Publishing calculations to a text file ........................ 98

Chapter 10. Draws .................................................. 99

Creating a draw ................................................ 99
  Adding a draw in Composer .................................. 100
  Adding a draw template .................................... 101
  Editing the draw name and earnings period .................. 102
  Copying and pasting a draw ................................ 102
  Deleting draw connections .................................. 103
  Editing draw templates ..................................... 103
  Draw web tab settings ....................................... 104
  Creating web tabs for draw assignment and draw reports .... 105
  Defining web access for draw report and assignment tabs ... 105
Assigning payees to draws in the web client .................... 106
  Assigning payees to draw templates ........................ 106
  Viewing and editing draw assignments for payees on fixed term draws ...................... 106
  Viewing or editing draw assignments for payees on ongoing draws ........................ 107
  Unassign payees and hide inactive payees .................... 107
Viewing draw reports in the web client .......................... 107
  Overview report ........................................... 108
  Draw assignments report .................................. 108
  YTD payouts report ....................................... 108
  By period payout report ................................... 109
  Exporting report results to Microsoft Excel .................. 109

Chapter 11. Data stores ........................................... 111

Data store creation ............................................ 111
  Adding a data store object .................................. 111
  Selecting the sources for the data store ..................... 112
  Selecting columns for a data store .......................... 113
  Selecting restrictions ..................................... 113
  Naming columns in data stores ............................... 114
Data store security ............................................ 114
  Setting permission for a role to view a data store ....... 114
  Setting permission for a role to view and edit a data store ........................................ 114
  Setting permission for a role to view and delete a data store ..................................... 115
Chapter 12. Plans and tailored reports. .......................................................... 117
  Compensation plans .................................................................................. 117
  Associating plans with payee groups ......................................................... 117
  Compensation plan creation ...................................................................... 118
    Step 1. Naming the plan and defining the calendar .................................. 118
    Step 2. Adding calculations .................................................................. 118
    Step 3. Selecting a payee group and defining holds, caps, and guarantees .. 120
  Locked compensation plans ...................................................................... 120
  Copying compensation plans .................................................................... 121
  Tailored reports ....................................................................................... 121
    Step 1. Naming the report, adding calculations, and selecting reporting settings 121
    Step 2. Selecting a payee group .............................................................. 122
    Step 3. Enabling alert generation through Task Manager ......................... 122
    Editing locked tailored reports ............................................................. 122
    Copying tailored reports ....................................................................... 123
  Report results in Payee Ledger .................................................................. 123

Chapter 13. Adjustments ........................................................................... 125
  When to use an adjustment ........................................................................ 125
  Creating adjustment categories ............................................................... 125
  Adjustments and calculation speed ........................................................... 125
  Manual adjustments ................................................................................. 126
  Creating a manual adjustment .................................................................. 126
  When not to use an adjustment ................................................................ 126
    Start and end dates in adjustments ........................................................ 127
  Payee Ledger reports ............................................................................... 127
  Viewing adjustment details on the web ..................................................... 127

Chapter 14. Scenarios. ............................................................................. 129
  Step 1. Creating a workspace .................................................................... 130
    Editing workspace properties .............................................................. 131
    Searching for and viewing workspaces .................................................. 131
  Step 2. Creating scenarios ...................................................................... 131
  Step 3. Adding items ............................................................................... 131
  Step 4. Change sets ................................................................................ 132
    Adding overwrite change sets .............................................................. 132
    Adding transform change sets ............................................................. 133
    Editing transform change set and overwrite change set properties ........ 133
  Previewing scenario results ..................................................................... 134
  Modifying the order of change sets ........................................................... 134
  Step 5. Generating reports ...................................................................... 134
  Step 6. Promoting a scenario ................................................................... 135

Chapter 15. Web forms ............................................................................ 137
  Adding a web form .................................................................................. 137
  Defining web form filters ......................................................................... 137
    Defining a simple filter ........................................................................ 138
    Defining Portal Access filters ............................................................... 138
    Defining a custom filter ....................................................................... 138
  Adding sources to web forms ................................................................... 139
    Adding validation rules to editable web form columns ......................... 139
    Adding saved web form filters ............................................................. 139
  Adding a row form .................................................................................. 140
    Adding a required flag to a row form .................................................... 140
    Setting a field width ............................................................................ 140
  Adding web resources ............................................................................. 140
  Adding an admin form ............................................................................ 141
Introduction

This document is intended for the use with IBM® Cognos® Incentive Compensation Management Version 8.0.4.

IBM Cognos Incentive Compensation Management enables organizations to automate the process of administering, calculating, reporting, and analyzing variable-based pay programs. The solution simplifies incentive compensation management for organizations by increasing accuracy, reducing costs, and improving visibility into sales performance and compensation plans.

Audience

This guide is intended for administrators who will be working in the IBM Cognos Incentive Compensation Management client.

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access the IBM Cognos Incentive Compensation Management Information Center (http://pic.dhe.ibm.com/infocenter/cicm/v8r0m4/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technotes and APARs.

You can also read PDF versions of the product release notes and installation guides directly on the IBM Cognos product discs.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no accessibility features.
Chapter 1. IBM Cognos Incentive Compensation Management
Client overview

Use Cognos Incentive Compensation Management to manage payment for individuals who receive variable compensation, including the sales force, management, or distribution channels.

Cognos Incentive Compensation Management enables organizations to design, manage, and automate the calculation of variable payment for dozens of plans and thousand of employees simultaneously. From the Cognos Incentive Compensation Management Client, administrators can create models, customize tables, import data, create calculations, and report on results.

Login window

You can gain access to the IBM Cognos Incentive Compensation Management Client and select a specific environment and language for the Client from the login window.

To log in to the Cognos Incentive Compensation Management Client, you need to know the model name, your user ID, and your password. You can browse for models on different servers in the Model Name drop-down menu.

Users have the ability to access multiple database servers with a single service. You can configure access to multiple databases in the Cognos Incentive Compensation Management Windows Service configuration. Each model on each database server is accessible from the login window. Users are able to access both Unicode and non-Unicode SQL models with a single service.

All models on each database server in the service configuration file are accessible from the login window.

For more information on configuration files, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Options menu

Use the Options menu on the login window to choose the environment and language that is used in the IBM Cognos Incentive Compensation Management Client.

Environments that you define during the installation and configuration process are visible in the Environment drop-down menu. After you select an environment, you can access any models that are contained within it. If you have models on different servers, you can set up multiple environments in the Cognos Incentive Compensation Management Client configuration file. You must give the environments a name and provide the address and security mode.

Important: The security mode in the Cognos Incentive Compensation Management Client configuration file has to be an identical match to the security mode in the Cognos Incentive Compensation Management Windows Service configuration file (it is case sensitive).
There are multiple languages that you can select from the **Language** drop-down menu. If you select English with a regional setting (that is, United States or United Kingdom) you set the language as well as the date format. English (United States) sets the language to English and the date format to mm/dd/yyyy. English (United Kingdom) sets the language to English and the date format to dd/mm/yyyy.

**Selecting the model environment**
If you have multiple environments set up in IBM Cognos Incentive Compensation Management, you can choose which one to log in to.

**Procedure**
1. On the login window, click **Options**.
2. Select the environment you want to log in to from the **Environment** drop-down menu.
3. Click **OK**.

**Setting the Client language and date format**
You can specify the language used in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. On the login window, click **Options**.
2. Select the language you want to use in the Cognos Incentive Compensation Management Client from the **Language** drop-down menu.
   
   - To set the language to English and the date format to mm/dd/yyyy in the Client, select **English (United States)**.
   
   - To set the language to English and the date format to dd/mm/yyyy in the Client, select **English (United Kingdom)**.

**Creating a new model**
When you create an IBM Cognos Incentive Compensation Management model, you must set up the calendar, the currencies, and the hierarchy tables that are generated.

**Procedure**
1. On the login window, click **New Model**.
   
   Use the New Model wizard to quickly create and customize a new model.
2. Name the new model.
   
   All spaces and punctuation are removed from your model name and used as the database name on your database server. The model name can be changed at any time from within the Cognos Incentive Compensation Management Client, but the database name that is set initially will remain for the life of the database.
3. Select the beginning fiscal year.
   
   Cognos Incentive Compensation Management uses this date and the number of payroll periods to construct a default calendar for the new model. The default calendar can be modified and refined from within the Cognos Incentive Compensation Management Client, or replaced entirely if a mistake is made.
4. Select the number of payroll periods.
Choose whether your organization pays employees weekly (52), biweekly (26), semimonthly (24), or monthly (12). The number of pay periods is used to create the default calendar, which is used to set payment schedules for calculated earnings. The default calendar can be modified or replaced entirely after the new model has been created.

5. Click Next.
6. Select the currencies.
   A currency should be added if it is used for either collection or payment. More than one currency can be selected.
7. Optionally, you can add another currency.
   a. To add another currency, select the Other Currencies check box.
   b. Select Add.
   c. Type in the Currency ID and the Currency Name.
   d. Click OK.

   **Important:** Currencies can be added without using the New Model wizard, so the list can be expanded at a later time.

8. Click Next.
9. Select the hierarchy tables.
   Tables for payees, accounts, time, and data are automatically generated. If you require more hierarchy tables such as, products, or customers, you can add those items to the list of hierarchies by selecting the appropriate check box.
10. Optionally, you can add additional hierarchy tables such as, territories or promotion codes.
    a. Type the name of the hierarchy table you want to add in the Add an item field.
    b. Click Add.

    **Important:** It does not matter whether the data for these tables exists in a single data file, or if you are loading multiple data files.

11. Click Finish.

**Creating models with multilingual support**

You can create Unicode IBM Cognos Incentive Compensation Management models in structured query language (SQL) to support double-byte characters.

This enables the internationalization of the software because Unicode supports all of the major languages in East Asia.

**Procedure**

1. In the IBM Cognos ICM Windows Service.exe.config file, add Unicode to the DBType value.
   For example, type the following information in the value field:
   
   <add key="DBType" value="SqlServer2005Unicode"/>

2. In the jdbc.properties file, type the following information as the jdbc.productName value:
   
   jdbc.productName=sqlserverunicode.
Important: To prevent any possible damage to models, Cognos Incentive Compensation Management prevents users from opening Unicode models in non-Unicode mode and vice versa.

Navigation in the Client

IBM Cognos Incentive Compensation Management Client functionality is accessed by opening tabs. Multiple tabs can be open at the same time.

When you close a tab, the previously selected tab opens. If the previously selected tab is removed, the tab next to the closed tab opens. To change the order of opened modules, drag the tabs.

Tabs

The IBM Cognos Incentive Compensation Management Client is divided into multiple tabs for ease of navigation.

The following tabs are available:
- Home Page
- Composer
- Workflow Manager
- Portal Access
- Scheduler
- Task Manager
- Audit
- Activity
- Payee Ledger
- Calculate
- Scenarios

Opening a tab

There are several ways to open a tab in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. To open a tab, perform one of the following steps:
   - Go to the View menu.
   - Click the + tab.
   - Right-click the tab bar.
2. Select the module you want to open.

Closing a tab

There are multiple ways to close tabs in the IBM Cognos Incentive Compensation Management Client.

Procedure

Select the tab you want to close and perform one of the following steps:
- Right-click the tab and select Close.
- Click the middle mouse button.
- Press Ctrl + w.
Rearranging open tabs
Open tabs can be rearranged in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Select the tab you want to move.
2. Drag it to the location you want.

Keyboard shortcuts
There are several keyboard shortcuts you can use to facilitate navigating through the IBM Cognos Incentive Compensation Management Client.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + w</td>
<td>Close the module you are in.</td>
</tr>
<tr>
<td>Middle mouse click</td>
<td>Close the tab your cursor is hovering over.</td>
</tr>
<tr>
<td>Ctrl + tab</td>
<td>Open the next tab.</td>
</tr>
<tr>
<td>Ctrl + shift + tab</td>
<td>Open the previous tab.</td>
</tr>
<tr>
<td>Middle mouse click + drag (in Composer module only)</td>
<td>Move the Composer diagram around the screen.</td>
</tr>
</tbody>
</table>
Chapter 2. Home page and process lists

The Home page is the entry point for navigating the IBM Cognos Incentive Compensation Management model and provides a dashboard that facilitates model management.

The Home page is intended to help users perform the following actions:

- Navigate directly to tables and reports without having to drill through components.
- Access process lists.
- Identify if a global action has been started by another user.
- Manage the model maintenance process with the help of process lists.
- Access help with links to documentation and external resources.

Welcome message

When you log in to your IBM Cognos Incentive Compensation Management model, you see the name of the environment and model you are logged into, and your user ID is also displayed.

If a global action icon is displayed next to your user name, a global action is being run at that time by another user. A tooltip with the user name of the person who is running the global action and amount of time it has been running for is displayed when you hover your cursor over the global action icon.

Show or hide text in toolbars

On the IBM Cognos Incentive Compensation Management toolbar, use the chevron icon to display or hide the text under the toolbar buttons.

This icon is visible in each module.

By default, the show or hide text icon is enabled, and the text in the toolbar is displayed. Your selection is remembered as you navigate between different modules; however, whenever you log back in to the Client, the toolbar will return to the default setting.

Access help files

On the toolbar, use the question mark icon to view the help contents for the IBM Cognos Incentive Compensation Management Client. This icon is visible in each module so you can easily access information.

Navigator tab

The Navigator tab in the IBM Cognos Incentive Compensation Management Client lists links to various modules, objects, and help resources.

It can be used to quickly open an item or to search for a link to an item.
Recently Opened Items and Most Commonly Opened Items

windows

The window on the left of the IBM Cognos Incentive Compensation Management Home page provides the user with links to the top ten most commonly used and recently used items.

These lists are specific to each individual login ID and are populated with tables, input forms, Presenter reports, and web forms that have been accessed by the user.

The items that are listed in the Recently Opened Items window include the last ten items opened by the current user. The items listed in the Most Commonly Used Items list include the items that have been opened the most times by the current user.

Navigating to a recently opened item

Items that were recently opened in the IBM Cognos Incentive Compensation Management Client are listed together and easily located.

Procedure
1. On the Home page, open the Navigator tab.
2. Under Recently Opened Items, select a link.
   A new tab opens and displays the selected item.

Navigating to a most commonly opened item

Items that you open frequently in the IBM Cognos Incentive Compensation Management Client are listed together.

Procedure
1. On the Home page, open the Navigator tab.
2. Under Most Commonly Opened Items, select a link.
   A new tab opens and displays the selected item.

The Quick Navigation window

Use the center pane of the IBM Cognos Incentive Compensation Management Home page to quickly navigate to any component, table, Presenter report, or web form that they have access to in the model.

All items are grouped by type and listed alphabetically. Select the item you want to navigate to and the link will take you directly there.

Searching for items

A filter can be used on the IBM Cognos Incentive Compensation Management Home page to search for components, tables, and reports in large models.

Procedure
1. On the Home page, open the Navigator tab.
2. In the Filter field, type the name or partial name of the item you are looking for.
   The filter will return any table, Presenter report, web form, or component that contains the text you typed.
Online window
The link under the Online heading on the IBM Cognos Incentive Compensation Management Home page takes you to the Assist Support portal.

On the Assist portal, you can log tickets, access the knowledge base, or download documents. A user name and password are required for this portal.

Process lists
Process lists are created in IBM Cognos Incentive Compensation Management to help users complete model maintenance tasks.

When users are presented with the dilemma of needing to remember what tasks must be completed at any given time and the order in which those tasks need to be completed, process lists are the answer.

Creating a process list
You can create lists that outline the tasks users must perform to complete different procedures in IBM Cognos Incentive Compensation Management.

Procedure
1. To create a new process list, from the toolbar, click Add Process List.
2. To define and add items to the list, from the toolbar, click Edit.
   The process list opens in a new tab.
3. Type a Process Name for your list and select the type of process you are creating from the Process Type drop-down list.
   • To create a process list that requires the items be checked off in order, select Ordered as the process type.
   • To create a process list that can be completed in any order, select Perpetual as the process type.

Resizing a process list window
You can change the size of the panes on the process list tab in IBM Cognos Incentive Compensation Management.

Procedure
1. Open a process list.
2. Drag the empty space between any two windows on the process list tab to change their sizes.

Adding tasks to a process list
A process list in IBM Cognos Incentive Compensation Management can contain any number of tasks and sub-tasks.

Each task can have a description to provide users with information about the task and can be linked to an appropriate item in the model.

Procedure
1. In the process list, in Edit mode, click the Add Task icon in the Task pane to add an item to the list.
2. Select the new task.
3. In the **Process Overview** pane, type a description of the task to help users understand its purpose.
4. To link the selected task to a component, table, input form, web form, Presenter report, Scheduler process, or module, click **Add Link**. Process list users can navigate to the item by clicking the task.

   **Important:** Linking to Presenter reports listed in the View Presenter Report section will open the Presenter report in a new tab and display the report as it appears on the web client when the task is selected.

5. To show the row count of an input form beside the task name, select the input form then select the **Show Details** check box.

   **Important:** If the input form has more than 1000 rows, the row count displays as (1000+).

6. Type a task name and description and select a task icon from the **Task Icon** drop-down list.
7. Click **Save**.

### Viewing and filtering process lists

You can open a panel on the IBM Cognos Incentive Compensation Management **Home** page that lists all saved process lists. You can then search for a specific list using the **Filter** field.

**Procedure**

1. To view and access saved process lists, click the **Sidebar** button in the toolbar. You can only see lists that you have been granted access to in the **Manage Roles** window.
2. Select a process list to open it.
3. To search for a process list, type the name (or partial name) of the process list in the **Filter** field. The filter returns all process lists that contain the text that you entered.

### Modifying a process list

You can edit and add tasks to existing process lists in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Select the process list that you want to modify and click **Edit**.
2. To delete a task, select the task and click **Delete Task**.
3. To modify the order of any tasks in the list, click the blue arrows in the **Task** pane.
4. To delete a link, select the task and click the **Delete Link** icon.
5. Click **Save** when you have finished making your changes.

### Marking tasks as complete

Completed tasks can be tracked and flagged as complete in IBM Cognos Incentive Compensation Management process lists.
**Procedure**

1. On the **Home** page, open the process list.
2. To mark a task as complete, select the check box next to the task.
   The user name of the administrator who selected the check box and the date and time that the task was completed is populated automatically.

   **Important**: The date and time of task completion are recorded as the time on the database server, regardless of the local time on the user’s computer. This ensures that the completed time is consistent and accurate for all users in all locations.

**Rearranging the order of tabs on the Home page**

The order of the process list tabs displayed on the IBM Cognos Incentive Compensation Management **Home** page can be changed.

**Procedure**

1. On the **Home** page, select the tab you want to move.
2. Drag the tab to the new location.

**Defining process list security**

After process lists are created, they can only be viewed or edited by users who have been granted appropriate access in IBM Cognos Incentive Compensation Management.

**Procedure**

1. To define access for process lists, go to **Admin > Manage Roles**.
2. Select a role from the left pane, or click the **Add Role** icon to create a new role.
3. Expand **Home Page** and then expand **Process List**.
4. To allow the selected role to create new process lists, right-click **Add** and select **Grant**.
5. To allow the selected role to edit, view, and delete a process list, right-click the process list and select **Grant**.
6. To allow the selected role to only view a process list, expand the process list, right-click **View** and select **Grant**.
7. To allow the selected role to only view and edit a process list, perform the following tasks:
   a. Expand the process list.
   b. Right-click **View** and select **Grant**.
   c. Right-click **Edit** and select **Grant**.
8. When you are done assigning security, click **Close**.
9. To assign the role to a user, go to **Admin > Manage Users**.
10. Select a user and click **Edit**, or click **Add** to create a new user.
11. Type in the user’s information, and select the role from the **Role** drop-down menu.
12. Click **OK**.
13. Click **Save**.
Chapter 3. Composer

Use the IBM Cognos Incentive Compensation Management Composer module to view, manage, and build a model.

From this interface, you can build and edit calculations, tables, compensation plans, tailored and Presenter reports, and web forms. Composer is also used to manage hierarchies, such as the payee structure, and import data into the model.

Composer provides a visualization of the entire model, which can assist in design, troubleshooting, and refinement. This visual representation is completely configurable and can show either a very high-level representation of the model or a detailed picture of table and calculation streams.

Build a model

Composer provides the interface for building an IBM Cognos Incentive Compensation Management model.

At a high level, the following steps will help you build a model:
1. Create components to organize model elements.
2. Set security for each component.
3. Add any necessary or relevant documents to a component. These documents may include a description of the contents of the component.
4. Build tables to contain data.
5. Import data into the tables from external source systems.
6. Manipulate the data using calculations.
7. Present calculation results in a compensation plan, tailored or Presenter report, or in a web form.

Important: If any of your calculations require a data source that is contained in another component, you must create an inbound connection from that data source to use it in your calculation. If any of your table data or calculation results need to be used as sources for a calculation contained in another component, you must create an outbound connection so that your data can be used outside the component.

Toolbar

The Composer toolbar has many tools that help you work quickly and easily when you create and maintain your IBM Cognos Incentive Compensation Management model.

Multi-edit or Single-edit mode

When using single-edit mode in the IBM Cognos Incentive Compensation Management Composer module, every change is immediately saved. In multi-edit mode, changes are not saved (validation is suspended) until you leave the Multi-edit mode or save your model.

You can make many temporary changes in multi-edit mode.
For example, imagine that you want to change the source of a calculation that is used by another calculation. You will need to edit each calculation in the chain, but until you have changed all of them, some calculations may be invalid. These temporary changes can only occur in the multi-edit mode because only valid calculations can be saved in single-edit mode. If you try to make a change or connection in single-edit mode that is invalid, you will get an error message.

Users will notice more options are available when you right-click a component in single-edit mode.

In single-edit mode, users can perform the following actions:
- Open components and elements
- Auto arrange
- Add or delete components
- Add or delete tables, calculations, compensation plans, tailored and Presenter reports, and web forms
- Import data into tables
- Add inbound or outbound connections
- Set component color
- Export Composer diagram
- Select visibility icons
- Cut, copy, and paste
- Preview calculations

In multi-edit mode, users can perform the following actions:
- Open components and elements
- Add, edit, or delete calculations
- Edit a calculation’s partitions and the port it is connected to so it matches the new calculation
- Add inbound or outbound connections
- View and edit data in tables
- Select visibility icons
- Export Composer diagram

**Link**

In order to link components together, you have to select the **Link** icon in the IBM Cognos Incentive Compensation Management Composer module.

When you select **Link**, you will notice a black box inside a component and on the edge of an element. You can then link one component to another. To turn off Link mode, click the **Link** icon again.

**Arrange**

The **Arrange** icon automatically arranges the components and elements into a logical pattern in the IBM Cognos Incentive Compensation Management Composer module.

It also smooths out connection lines. Users can undo the auto arrange by clicking the **Refresh** icon if they do not like the layout, or if they clicked it accidentally.
Visibility
You can choose to show or hide components and objects on the Composer window in IBM Cognos Incentive Compensation Management.

For example, if you unselect Table from the Visibility drop-down menu, tables will no longer be visible.

All
When you are only viewing a select number of elements in the Composer window in IBM Cognos Incentive Compensation Management (for example, you are in Uses mode), you can use All to view all the elements in the window again.

Uses and Used By
The Uses and Used By buttons in the IBM Cognos Incentive Compensation Management Composer toolbar are used to show what objects the selected object uses as data sources or what objects use the selected object as a data source.

When you select an object in Composer and click the Uses icon, only the objects and elements that are used by the object selected and exist in the same component as the object selected are displayed. When you select an object and click the Used By icon, only the object and the elements that use the object and exist in the same component as the object are displayed.

Go To
When viewing objects in Uses or Used By mode in the IBM Cognos Incentive Compensation Management Composer module, the Go To icon takes you to the Top level of Composer or the last component you were viewing.

View Connection
The View Connection button in the IBM Cognos Incentive Compensation Management Composer module displays information that shows where a selected connection was created and where the connection is currently being used.

Use the information displayed in the View Connection window to analyze the flow of data through your model.

Purging table history
In IBM Cognos Incentive Compensation Management, use the Purge History icon in the toolbar of the Composer module to clear the history collected for specified tables.

Procedure
1. In Composer, from the toolbar, click Purge History.
2. Select the table or tables for which you want to remove history.
3. If you selected a data type table, you must select a date range for which to purge history.
4. Click OK.
Sidebar

The sidebar in the IBM Cognos Incentive Compensation Management Composer module is composed of the **Palette** tab, the **Navigation** tab, and the **Overview** window.

You can opt to show or hide the Sidebar by toggling the **Sidebar** icon on or off.

**Palette tab**

The **Palette** tab of the IBM Cognos Incentive Compensation Management Composer Sidebar stores empty components and elements.

Users can select the objects and drag them onto the main Composer window. Prebuilt libraries can be accessed by clicking and dragging the **Library** object onto the Composer window.

**Navigation tab**

The **Navigation** tab in the IBM Cognos Incentive Compensation Management Composer toolbar is made up of two different sections: Favorites and Search.

Any object in the Composer window (except connections) can be added to the Favorites list. When objects are added to the **Favorites** section, links to those objects in Composer are created. When a user clicks the link in the **Favorites** section, the object will be highlighted and centered on the Composer window. The object links can be arranged by users into folders and sub-folders to make finding and navigating to the objects quick and easy. Users can also use the **Filter** field to search for objects within the **Favorites** section.

The **Search** section lists all the objects in Composer and groups them by element such as components, tables, calculations, plans, tailored reports, Presenter reports, and web forms. Users can type the name of the object they are looking for in the **Filter** box. After a pause in typing has been detected, Cognos Incentive Compensation Management searches for any objects that contain the text string the user typed. The results return the top 50 matches for all objects; however, the search results will not limit the number of components shown. To view all the results, users can click the **Show All** link. To search all the components for an object, leave the **Search All Components** icon selected. If you only want to search for an object within the component you are currently viewing, unselect the **Search All Components** icon.

All the folders in the **Search** section or **Favorites** section can be expanded or collapsed by clicking the **Expand All or Collapse All** icon.

Users can right-click any component, calculation, table, plan, report, or form listed in the **Favorites** or **Search** section to bring up a context menu associated with the object.

**Adding an object to the Favorites list**

You can add a link to any frequently used object (except ports) in the IBM Cognos Incentive Compensation Management Composer module to the **Favorites** section.

**Procedure**

1. Right-click the object in the Composer window and select **Add to Favorites**.
2. On the sidebar, open the Navigation tab and click the yellow star to view the Favorites list.

   **Tip:** Folders and sub-folders can be added to the Favorites section to organize your favorites list.

**Overview window**
The Overview window shows a scaled-down version of the IBM Cognos Incentive Compensation Management Composer diagram.

The whole Composer diagram is displayed in the window; however, dependency view selection and component visibility selection in Composer is reflected in the Overview window. The section of the Composer diagram the user is currently viewing in Composer is outlined in gray. Users can resize and move the gray box around the Overview window to navigate to different areas in the Composer. Users can also use the middle mouse wheel to zoom in and out around the location of their cursor. The Overview window can be resized by clicking and dragging the window. It can be closed or opened by clicking the Overview header.

**Viewer**
When the Viewer icon is selected, a window at the bottom of the IBM Cognos Incentive Compensation Management Composer module is displayed.

When you select a table or a calculation, you can see the data and results in the Viewer window.

**Change font**
You can choose the style, type, and size of text as well as effects and script types in the IBM Cognos Incentive Compensation Management Composer module.

When you make changes to the font, the text of every component changes.

**Using Format Painter**
The Format Painter icon copies the format options of a component and applies them to another component in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. Select a component and click the Format Painter icon.
2. Click the component you want to copy the format to.
3. To copy the format to multiple components, press Ctrl and click the components.
   The selected components must be on the same level in Composer.

**Setting component color**
You can change the color of any component in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. Select a component, or press Ctrl and select multiple components.
2. Click the arrow next to the Color icon and select a color.
3. To define a custom color, perform the following steps:
a. Click the **Define Custom Color** button.
b. Select a basic color or click the **Define Custom Colors** button.
c. Create the color you want, and then click **Add to Custom Colors** to save it.
d. Click **OK**.

**Important:** Custom colors defined in Composer are unique to each login.

**Expand Links and Collapse Links**

The **Expand Links** icon shows all the connection lines in the IBM Cognos Incentive Compensation Management Composer window. The **Collapse Links** icon hides connection lines in the Composer window.

A formula is used to decide if connection lines should be hidden or not. The formula is based on the length of the line, the number of bends in the line, and the number of sibling connections each connection in the model has. Only the connection lines that receive a high enough value based on the formula are hidden.

**Exporting the Composer diagram**

The IBM Cognos Incentive Compensation Management Composer diagram can be exported to an image file.

**Procedure**

1. Click the **Export** icon.
2. Select the server location for the image file to be saved and select the image file type.
3. Select the scaling options.
   The saved image can optionally be scaled down or up in size by increasing or decreasing either the height and width of the pixels or the zoom percentage.
4. Click **Finish**.

**Composer navigation**

There are many features in the IBM Cognos Incentive Compensation Management Composer module that make moving around the Composer window and locating objects easy.

**Selecting objects and zooming in Composer**

You can use your mouse to select multiple items in the IBM Cognos Incentive Compensation Management Composer module and zoom in and out of the Composer window.

**Procedure**

1. To select multiple items, drag a selection box around the items or use Ctrl + click.
2. To select another group of items, hold down Ctrl and drag a selection box around the items.
3. To zoom in and out, scroll up and down with the mouse wheel.
   The Composer window centers on your cursor when zooming in and out.
Finding elements in Composer

You can search for objects in the current IBM Cognos Incentive Compensation Management Composer module view by using the Select feature.

In the Select window, you can type the name of the object or objects you want to find and any object with that name is selected.

Procedure

1. Right-click a blank area.
2. Click Select.
   
   **Important**: Connections cannot be selected using this feature.

3. Type a name in the Select window.
   
   The Select feature is not case-sensitive.

   **Tip**: You can select multiple objects by placing a semicolon between names. For example, you can type account;title;payee to select the Account, Title, and Payee tables.

4. Click OK.
   
   The matching element or elements are selected and centered in the Composer window.

Viewing the title and description of Composer objects

When you hover your cursor over any object in the IBM Cognos Incentive Compensation Management Composer module, the name of the object is displayed.

For objects that contain descriptions such as, tables, calculations, and compensation plans, you can see both the description and title.

Components

A component is a container that is used to organize your IBM Cognos Incentive Compensation Management model.

When creating a new model, components should be created first in order to give your model a framework and ensure that your model is easy to navigate. After components have been created, model elements, such as tables, calculations, and plans, can be built.

An element is any one of the following items used to build a model; table: calculation, compensation plan, tailored report, Presenter report, and web form.

Component organization

The IBM Cognos Incentive Compensation Management module gives you flexibility when deciding how to organize your model.

You can build your model wide by placing components side-by-side (sibling model), or you can build your model deep by placing components inside other components (parent-child model).

For example, a typical model might have all of its compensation plans represented by high-level components and all of the plan elements (tables, calculations, and
reports) contained in child components. Complex plans might have multiple levels of components that are used to separate and organize different calculation pieces.

When deciding how to organize your model, you must consider the following things:

**Security**
While very granular access permissions can be defined, typically security is defined at a component level. If you grant access to particular compensation pieces, but deny access to other pieces, you can put the compensation pieces in separate components. Then by turning access on or off for a particular component, you can deny or allow access to everything in the entire component.

**Data accessibility between components**
While data can flow between components by creating connections, certain restrictions do exist. For example, any calculations that need to be added to a reporting element (compensation plan and tailored reports) need to reside in the same component as the reporting element.

**Navigation between components**
Moving in, out, and between components is easy in the IBM Cognos Incentive Compensation Management Composer module with the use of breadcrumbs and the drill-through feature.

**Drill-through**
After the model structure has been built, users can double-click components in the IBM Cognos Incentive Compensation Management Composer module to drill into their contents.

There is no limit to the depth of the model. The number of levels will be determined by model size, complexity, and security requirements.

**Breadcrumbs**
The IBM Cognos Incentive Compensation Management Composer module displays breadcrumbs at the top of the page to promote easy navigation.

Breadcrumbs are displayed horizontally across the top of the window and provide links back to each parent component that the user drilled into in order to arrive at the current component. The Top breadcrumb represents the top level, or main window, in Composer.

**Data flow between components**
When working with components in the IBM Cognos Incentive Compensation Management Composer module, you may have data in one component that is needed as a source in another component.

In order to share data between components, a connection has to be made between the two components. Connections can be made from parent to child components or from one sibling component to another.

**Data accessibility in components**
In order to use data inside a component in another component in the IBM Cognos Incentive Compensation Management Composer module, outbound and inbound connections must be created.
Inbound and outbound connections can be created to do the following things:

- Use table data as a source for a calculation in another component
- Use calculation results as sources for a calculation or report in another component

**Data accessibility between sibling components:**

To use data from tables or calculation results that are in a sibling component in the IBM Cognos Incentive Compensation Management Composer module, connections have to be made.

Sibling components are components that are on the same level in the Composer window.

**Data accessibility from parent to child components:**

To use data from tables or calculation results that are in a parent component (one level up in the IBM Cognos Incentive Compensation Management Composer module), connections have to be made.

An outbound connection from the object containing the data in the parent component must be linked to the child component. This creates an inbound connection in the child component so the data stored in the parent component can be available in the child component.

**Working with components**

Users can create components to contain tables, calculations, compensation plans, web forms, and reports in the IBM Cognos Incentive Compensation Management Composer module.

You can rename and change the color of components to make specific components easily identifiable. Documents can be attached to components to show users the data available inside the component. Components can also be moved around the Composer diagram and organized by cutting, pasting, and wrapping them into parent components.

**Adding a component**

Empty components can be added to contain and organize objects in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**

1. To create an empty component, do one of the following steps:
   - Right-click in Composer, and select **Add Component**.
   - Drag the **Component** element from the Sidebar onto the Composer window.
2. Type a **Name** for the component.
3. Click **OK**.

**Changing the color of a component**

To distinguish one component from another, the color of each component can be modified in the IBM Cognos Incentive Compensation Management Composer module.
Procedure
1. In Composer, select the component or press Ctrl and select multiple components.
2. Click the drop-down arrow next to the **Color** icon and select a color.

Renaming a component
The name of a component can be changed after it has been added to the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. Right-click the component and select **Edit**.
2. Type in the new name and click **OK**.

Adding documents to components
Files that contain data or information about the component can be attached to the component in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In Composer, right-click a component and select **Manage Documents**.
   The Document Manager window opens.
2. Click **Add**.
3. Select the document you want to attach.
4. Click **Open**.
   The document will be added to the Document Manager window.
5. Click **Close**.
   After the document is attached, you will see a document icon on the component.

Opening a component
You can open a component in the IBM Cognos Incentive Compensation Management Composer module to view and manage the elements that you have placed inside it.

Procedure
1. To open a component, do one of the following steps:
   • Double-click the component.
   • Right-click the component and select **View Component**.
2. From inside a component, you can right-click to do one of the following actions:
   • View its parent component.
   • Add a component, table, calculation, plan, tailored and Presenter report, draw, data store, and web form.
   • Create an inbound and outbound connection.

Copying components
The copy feature will simultaneously copy a selected component along with the calculations and tables that it uses or depends upon in the IBM Cognos Incentive Compensation Management Composer module.
Procedure
1. To copy a component, do one of the following steps:
   • Right-click the component to be copied and select Copy.
   • Select the component to be copied and click the Copy button.
2. To paste the component, do one of the following steps:
   • Right-click the place where you want to copy the component and select Paste.
   • Navigate to the place where you want to copy the component and click the Paste button.
3. In the Paste Form window, specify the Paste suffix.
   The suffix ensures that you do not have two components with the same name, and ensures that you can distinguish the copied component from the original.
4. If the copied component contained any ports, specify the new sources for the ports by either clicking Automatch or by dragging the sources.
   You must map the old sources to the new sources.
5. Click OK.
   All connections (if any) stay intact.

Deleting components
Components can be deleted as long as they do not contain any objects that are used as sources for objects in other components in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. To delete a component, do one of the following steps:
   • Right-click the component and select Delete.
   • Select the component and click the Delete icon in the toolbar.
   
   Tip: Delete all of the component’s dependencies before deleting the component. If you try to delete a component, and there are other components still connected to it, the Dependency Viewer opens showing the component’s dependencies.
2. Click Yes in the Question window.

Wrap and unwrap component feature
In the IBM Cognos Incentive Compensation Management Composer module, you can create a component out of selected elements (wrap) and remove a component by moving its contents into its parent’s component (unwrap).

The wrap feature takes the selected elements and puts a component around them; adding connections and linking them as needed. The unwrap feature takes the selected components and moves their contents into the current component; removing connections and re-linking parent elements as needed.

The following list outlines restrictions for wrapping:
• If the set of selected elements would create a cycle, they cannot be wrapped. For example, A -> B -> C and you try to wrap A and C.
• Web forms that contain sources with editable fields, row forms, multi select, and/or admin forms that reference non-global tables must exist in the same component as the referenced table.
- Compensation plans and tailored reports must exist in the same component as their calculations.
- Calculations used as sources in detail ledgers must exist in the same component as their compensation plan or tailored report.
- Tables with a single key column should not be made into connections that are used by calculations.

The following list outlines restrictions for unwrapping:
- If the parent component has an inbound connection with the same name as something in the target component, it cannot be unwrapped. This is to prevent having two items with the same name in the same component.
- If any connections are not linked, the component cannot be unwrapped.
- Components that are empty cannot be unwrapped. A message will tell you to delete the component instead.

**Wrapping an element or component**
Any number of elements in the IBM Cognos Incentive Compensation Management Composer module can be wrapped into a component as long as they follow the restrictions for wrapping.

**Procedure**
1. In Composer, select an object or press Ctrl and select multiple objects to wrap.
2. Right-click the selection and select Wrap.

**Unwrapping an element or component**
A component in the IBM Cognos Incentive Compensation Management Composer module can be deleted and the elements inside the component placed in its parent component by unwrapping the component, as long as you follow the restrictions for unwrapping.

**Procedure**
In Composer, right-click the component and select Unwrap.

**Component security**
Security can be set for each component in the IBM Cognos Incentive Compensation Management Composer module.

In the Manage Roles window, administrators are able to grant or restrict access to components.

Any component the user has view permission for can be navigated to from the Home page. In order to access components from the Composer module, the user must also be granted view permission to the Composer module. The user must be granted Edit permission in Composer as well as the component to modify and add elements to the component. For example, a Lead Consultant role can be created that has permission to view all of the components in the Composer module, but is only granted edit permission for the Managers Bonus, Reporting, Sales Plan, and YTD Product Commission components.

**Setting component security**
You can give users the ability to view, edit, and delete specific components in the IBM Cognos Incentive Compensation Management Composer module.
Procedure
1. Go to Admin > Manage Roles.
2. In the left pane, select a role or click the Add Role icon to create a new role.
3. In the right pane, expand Composer.
4. To allow the user to view, edit, and delete all components in Composer, right-click Component and select Grant.
5. To allow the user to view, edit, and delete specific components, expand Component, right-click a specific component and select Grant.
6. To allow the user to view, edit, or delete a specific component, expand the component, right-click Delete, Edit, or View and select Grant.

Important: Users must have view permission for the component to be able to edit and delete it. Users must have edit permission for the Composer module to be able to add or modify elements in components. Users must also have view permission for the Composer module to open the Composer tab.

Connections
Connections link components together in the IBM Cognos Incentive Compensation Management Composer module. There are inbound and outbound connections.

In Link mode, you can see the ports represented by small black square boxes. When Link mode is turned off, connections from one element to another are represented by arrows.

From inside the components, the connections are represented by blue boxes; these blue boxes are called ports. Inbound connections are at the bottom of the component and outbound connections are at the top.

Use connections to send data from tables, calculations, and other sources to related components that require the information. For example, if a component contains a data table with transactional data, it can be connected to another component containing a calculation that needs to calculate results using the transactional data.

Outbound and inbound connections
An outbound connection is a resource used to export calculation results or table data from a component in the IBM Cognos Incentive Compensation Management Composer module. An inbound connection is a resource used to import data from selected outbound connections into a component.

Outbound connections can be created from tables, calculations, and other outbound connections. By creating an outbound connection, you are telling Cognos Incentive Compensation Management that the data in the selected table or calculation is available for use in child or sibling components. In order to use the outbound connection in a second component, a corresponding inbound connection needs to be made to the second component. Inbound connections are created to specify which component the selected outbound connection should connect to.

Creating connections
Use inbound and outbound connections in components in the IBM Cognos Incentive Compensation Management Composer module to send data from one component to another.
Inbound connections can be used as sources in components.

**Procedure**
1. Select the **Link** icon in the toolbar.
2. Drill into the component with the object that is your outbound connection source.
3. From inside the component, select the object that is your outbound connection source and drag an arrow from that object to the top of the window.
   
   An outbound connection is created.
4. From outside the component, drag the arrow from the port on the component containing the outbound source to the component that will use that source.
5. In the Link Form wizard, drag the connection from the **Source Connections** column to the **Map to** column.
   
   This creates the inbound connection from the object.

**Viewing current values in a connection**
You can view the data from the table or calculation that is the original source of a connection in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. In Composer, double-click the component that contains the connection.
2. Right-click a blue connection port and select **View Current Values**.

**Using an inbound connection as a calculation source**
When a component has an inbound connection, you can use that inbound connection as a data source for a calculation inside the component in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. In Composer, double-click the component containing the inbound connection.
2. Inside the component, right-click and select **Add Calculation**.
3. Type a name for the calculation and select the calculation **Type**.
4. Select the inbound connection as a source.
5. Finish the calculation wizard.

**Change connections**
Inbound and outbound connections in components can be modified, deleted, or removed and replaced with global tables in the IBM Cognos Incentive Compensation Management Composer module.

**Editing a connection**
A connection can be renamed and the connection columns can be modified in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. Right-click a component and select **Edit Connections**.
2. Select the connection that you want to view or change and click **Edit**.
3. You can rename the connection and change the source of the connection, and then click **Finish**.
4. If you are editing a user-defined connection, you can add columns, remove columns, or change the name of columns; then click **Next**.
5. You can remap the source columns to the connections columns, and then click **Finish**.

**Editing connection mapping**
You can change the source columns that the connection columns are matched to in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. Right-click the connection and select **Edit Connection Mapping**.
2. Drag source columns to match them to connection columns or use the **Automatch** button.
3. Click **Finish**.

**Deleting a connection**
Inbound and outbound connections can be removed from components after they have been created in the IBM Cognos Incentive Compensation Management Composer module.

In order to delete a connection, it cannot be in use by another object.

**Procedure**
1. In Composer, right-click the component and select **Edit Connections**.
2. Select the connection to be removed and click **Delete**.
3. Click **Close**.

**Replacing a connection with a global table**
In the IBM Cognos Incentive Compensation Management Composer module, you can replace connections with global tables.

If the global table has more columns than the connection, it can still replace the connection as long as identical column connections exist in the table and connection.

**Procedure**
1. In Composer, right-click the component and click **Edit Connections**.
2. Right-click the connection you want to replace and select **Replace Connection**.
3. Select the **Global** table from the drop-down list and click **OK**.

**Editing a connection from inside a component**
Connections can also be modified while you are working inside a component in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
Inside the component, right-click the port and select **Edit** or double-click the port. The connection wizard is displayed so that you can edit the details of the connection. For more information, see “Connection wizard” on page 28.
Connection names

When creating outbound connections, IBM Cognos Incentive Compensation Management automatically gives the outbound connection the same name as the source.

For example, if an outbound connection is created from a table named ERP, the connection is named ERP.

You can rename the connection in the connection wizard. When renaming connections, make sure that you have a method of distinguishing connections from other model elements like tables and calculations. Using an Out suffix is one choice, but you can choose another suffix, such as Feed. You can also change inbound connection names and the Out suffix to a prefix, or add an IN prefix.

The following list gives you a few examples of naming options:
- Out ERP
- ERP Feed
- In ERP
- Connect ERP

Connection wizard

In the Connection Wizard, users can define or edit the schema of the connection in the IBM Cognos Incentive Compensation Management Composer module.

When using the Connection Wizard, remember that connection columns must have the same data types as the columns they are connected to, but the order and name of the connection columns does not matter, and the connection can have less than or an equal number of columns as the source. After the schema of the connection has been created, you can link the table or calculation to another component.

Defining connections

Users can create or edit an outbound or inbound connection with any structure in the IBM Cognos Incentive Compensation Management Composer module.

To define the schema of a connection, users can select columns from the References, Columns, Tables, and Structural tabs.

References

This tab provides a list of available references that can be used when defining a connection in the IBM Cognos Incentive Compensation Management Composer module.

References include the tables that are created when the model was created and the calendar.

For example, if you are creating a connection that contains columns from any of your hierarchies, such as payee ID or product ID, you can easily locate those columns in the References tab.

Columns

This tab provides options for users to create generic calculation and table columns in the IBM Cognos Incentive Compensation Management Composer module.
For example, if you need to make a placeholder connection but do not know the names of the required columns, you can simply select the column types.

You can choose from the following column types:
- Text
- Numeric
- Date
- Int (placeholder for a rank column from a Sort calculation)
- Comment or URL

**Tables**
This tab lists all tables, calculations, and connections available to the connection that you are defining in the IBM Cognos Incentive Compensation Management Composer module.

Selecting a table, calculation, or connection from the drop-down menu displays the columns of that table, calculation, or connection. You can then drag specific columns to the Connections Columns window. For example, if you are creating a connection and you know the names and structure of the columns in the connection, you can select the required columns from a table, calculation, or connection in the **Tables** tab.

**Structural**
This tab lists all the hierarchy tables in the IBM Cognos Incentive Compensation Management model.

Selecting a table from the drop-down menu lists all the columns from that table in the Connection Columns window.

For example, if you are creating a connection and you want all the names and structure of columns from a specific hierarchy table, you can select the table from the **Structural** tab.

**When to use the Connection Wizard**
The simplest way to create connections is by dragging the connection in the IBM Cognos Incentive Compensation Management Composer module.

For more information on creating connections, see "Creating connections" on page 25. Typically, the connection wizard is only used in the following situations:
- Viewing and editing existing connections
- Creating a placeholder connection for a source that has not been created yet

**Viewing and editing existing connections**
After a connection has been created in the IBM Cognos Incentive Compensation Management Composer module, the connection wizard can be used to view and modify the details of those connections.

If a connection was initially made using generic column types, you can use the wizard to edit the connection columns to use the correct table or calculation. You may also use the wizard to reduce the number of columns included in the connection.
**Placeholder connections**

The connection wizard in the IBM Cognos Incentive Compensation Management Composer module can be used to create an outbound connection from a source that has not been created yet.

A corresponding inbound connection can then be created and the two components can be linked.

For example, imagine you want to work on a compensation component that requires the Quota table as a source. If the Quota table has not been created yet, you can use the Connection Wizard to create a placeholder connection. Creating a placeholder connection means you can build your calculation prior to having the Quota table created. After the Quota table has been created, the connection can be edited in the Connection Wizard to reference the appropriate columns.

**Creating a placeholder connection:**

You can create connections for sources that have not been created yet in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**

1. In Composer, right-click the component that you want to create the outbound connection from.
2. Select **Add Outbound Connection** and name the connection.
3. Select **User-Defined** from the **Source** drop-down menu and click **Next**.
4. Using the **References**, **Columns**, **Tables**, or **Structural** tabs, define the schema of the source as accurately as possible by selecting required columns and dragging them to the right pane.
5. To edit the connection column name or make it a key column, right-click the column and select **Edit**.
6. Rename the column and select the **Key Column** check box.
7. Click **OK**.
8. Click **Finish**.
9. In Link mode, drag the outbound connection to a second component that requires it as a source.
   
   This creates an inbound connection in that component, and you can use the placeholder outbound connection as a source in the second component.

**Creating outbound and inbound connections with the Connection Wizard**

In the IBM Cognos Incentive Compensation Management Composer module, the Connection Wizard can be used to view, edit, and create inbound and outbound connections.

**About this task**

When creating connections, it is easier to create the outbound connection first. However, placeholder inbound connections can be made and connected to the corresponding outbound connection when it has been created.

When selecting tables or calculations from the **Tables** or **References** tabs, all columns listed in bold are required for the connection; any other columns can be omitted from the connection. For tables, this means that all primary key columns...
are to be included in the connection. For calculations, all partitions and the value column are to be included in the connection.

Procedure
1. Right-click a component and select Add Outbound or Add Inbound Connection.
2. Type a Name for the connection.
3. From the Source drop-down list, select the table or calculation that is the source of the connection and click Finish.

Linking tables and calculations to outbound connections
In order to finalize the connected columns in the IBM Cognos Incentive Compensation Management Composer module, you have to link the table or calculation to the connection.

This is done by using Link mode in Composer and drawing a line from the table or calculation to the port you are linking to.

Procedure
1. In Composer, double-click the component containing an outbound placeholder connection.
2. Select the Link icon.
3. Click the black box in the table or calculation and drag to the outbound placeholder connection.

Tip: Tables and calculations can link to more than one outbound or inbound connection.

Mapping incompatible connections
If you have incompatible connections in the IBM Cognos Incentive Compensation Management Composer module, the Connection Wizard opens and you can map connection columns to source columns.

Procedure
1. In the Connection Wizard, drag the Source columns on the right to the Matched cells of their matching connections on the left.
2. Click Finish.
Chapter 4. Table configuration

Organizations use the IBM Cognos Incentive Compensation Management Composer module to easily modify the database structure, either by adding fields or entire tables, to store the metrics needed for compensation calculations.

For example, you may need to include commission rates or quotas by customer, product, or payee. Use Composer to add that information to an existing table, such as the Payee table, or you can choose to create an entirely new table for lookup purposes. The rate and quota information may be retrieved later for calculations.

When you create a new model, the Hierarchy tables, that is the Payee, Accounts, Time, Product, and Customer tables, will be displayed in the Top level of Composer. The Hierarchy tables and any other tables you create can be moved by cutting and pasting, provided that the table is not being used by a calculation.

Connect table data between components

In the IBM Cognos Incentive Compensation Management Composer module, the data in tables can be available as sources for calculations in other components by creating inbound and outbound connections.

Data in tables can be connected from a parent component to a child component or between sibling components.

Use table columns between components

The table schema for all tables is globally available throughout the IBM Cognos Incentive Compensation Management model, regardless of the component that the table resides in.

This is useful if you create a table in a component that requires a column from another component.

For example, your Payee table is in one component and you create a custom table in another component. Your custom table contains a payee ID column that pick lists from the Payee table. Because the table schema is universally accessible, tables can pick from other tables that are in different components.

Tables

In every model, IBM Cognos Incentive Compensation Management creates System tables and tables for each of the hierarchies that were defined when the model was initially created.

Users can also create Data, Structural, Custom, and View tables.

After a table is created, new fields can be added and existing fields can be deleted; however, the primary key structure of the table cannot change and adding or deleting primary key fields is not permitted after the table is created.
System tables

System tables are automatically created in IBM Cognos Incentive Compensation Management and include Title, Salutation, Currency and Group Member tables.

These tables are created to contain common attributes for fields in the Payee table. The Title, Salutation, and Payee Currency fields in the Payee table are populated with information from their respective System tables. Therefore, all possible titles, salutations, and currencies that are needed by the Payee table should be listed in the System tables. Additional fields can be added to System tables as needed.

Title table
The Title table in the IBM Cognos Incentive Compensation Management Composer module contains a TitleID field and a Title field.

The Title column in the Payee table picks from the TitleID field in the Title System table, so all job titles attributed to any payee in the Payee table should be loaded into the Title table. Additional fields can be added to this table if needed.

Salutation table
The Salutation table in IBM Cognos Incentive Compensation Management contains a Salutation column and is pre-populated with common salutations.

The Salutation field in the Payee table picks from the Salutation table, so any salutations attributed to any payee in the Payee table should be loaded into the Salutation table. Additional fields can be added to this table if needed.

Currency table
The Currency table in the IBM Cognos Incentive Compensation Management Composer module is populated with currencies selected in the New Model wizard, but additional currencies can be added.

It contains a CurrencyID field and a Name field. The Payee Currency field in the Payee table picks from the Currency table, so any currencies needed to pay any payee should be contained in the Currency table. Additional fields can be added to this table if needed.

Group Member table
The Group Member table in IBM Cognos Incentive Compensation Management contains the PayeeID, Name, Start Date and End Date for each payee that has been added to a payee group via the Payee Groups window.

This table is created automatically and its structure cannot be modified. The primary key field for this table is the GroupID which is automatically generated. To view or edit group members, open the Payee Groups window from the Tools Menu. This table can be used as a calculation source; however, you cannot view the structure or contents of this table in the Composer window.

Hierarchy table
By default, tables are created for the hierarchies defined during IBM Cognos Incentive Compensation Management model creation.

After a model is created, a hierarchy cannot be added or deleted.

Use hierarchy tables to create the relationships necessary to analyze and manage payee, account, customer, product, and other organizational data.
Each model will contain Payee, Account, and Time hierarchies as well as any additional hierarchies defined during model creation. Common hierarchy examples include product, customer, and territory hierarchies.

Hierarchies use parent-child relationships to organize structural information. In a parent-child hierarchy, two table columns define the hierarchical relationships among the dimension members. The primary key column uniquely identifies each dimension member and a parent column identifies the parent of each dimension member. Each parent can have many children, but each child can only have one parent. The parent column in hierarchies has a self-referencing relationship, or self-join, within the table.

For example, if the Parent column in the Payee table contains each payee's manager, your table might look like the table below. The Parent column contains the ID for each payee's manager and references the PayeeID column.

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>Parent</th>
</tr>
</thead>
<tbody>
<tr>
<td>E010 - HUDDLE</td>
<td>Dan Huddle</td>
<td>E030 - CLARKSON</td>
</tr>
<tr>
<td>E020 - HUMPHREY</td>
<td>Darnell Humphrey</td>
<td>E030 - CLARKSON</td>
</tr>
<tr>
<td>E030 - CLARKSON</td>
<td>Debbie Clarkson</td>
<td>E040 - YOUNG</td>
</tr>
<tr>
<td>E040 - YOUNG</td>
<td>Diana Young</td>
<td>E210 - KAREY</td>
</tr>
<tr>
<td>E210 - KAREY</td>
<td>Doug Karey</td>
<td></td>
</tr>
</tbody>
</table>

**Payee table**
The payee structure is used to store individuals who are being compensated, or approving variable compensation payments in IBM Cognos Incentive Compensation Management.

The Payee table contains many of the fields that are typically needed to organize payee information. You can opt to not use any columns that do not suit your organization or add additional columns to the table as required.

In the Payee table, the primary key column is the payee ID column. The Parent column identifies the groups that your payees are organized into. For example, because payees are often grouped into territories, the Parent column is often used to store payee territories.

**Accounts table**
The accounts structure is used to store both loaded values from your source system and output values in IBM Cognos Incentive Compensation Management.

The accounts in the Accounts table are typically a subset of the general ledger chart of accounts and are associated with commissions and other variable compensation payments. The Accounts table contains AccountID, Name, Parent, and DrCr fields by default. You can opt to not use some columns or add additional columns to the table as required.

In the Accounts table, the account ID column is the primary key field. The parent column is used to organize your account IDs into groups. For example, GL Accounts are typically grouped by account type, so the account type would be stored in the parent column.
**Time table**
The time structure is used to store the payroll periods calendar as defined during IBM Cognos Incentive Compensation Management model creation.

The Time table is the only hierarchy that is not displayed as a table in the Composer module.

**Data table**
A Data table contains a date field, but other fields may be added as needed and key columns are defined at IBM Cognos Incentive Compensation Management model creation.

This table is best suited for transactional data, such as lists of sales or orders.

When periods are locked, all Data tables associated with the locked calendar are locked by the date field in the table (other table types are not locked). If more than one date field exists in the data table, the system will prompt you to choose a Lock by Date when the table is created. This lets the system know what field to look at when locking the table.

**Structural table**
Structural tables are completely customizable, and they help to define the structure of your IBM Cognos Incentive Compensation Management model.

Because you can create only one primary key column in a Structural table, pick lists can pick from Structural tables.

**Custom table**
Custom tables are completely customizable and they are used to help define the structure of your IBM Cognos Incentive Compensation Management model.

Because you can add multiple primary key columns to a Custom table, pick lists cannot pick from Custom tables.

Custom tables can be created for multiple purposes. One common use of a Custom table is to contain data for reference values that either vary by one or more key members, or exist in the form of a lookup. As a reference for compensation calculations, you can create a Custom table to hold compensation rates that vary by product and by quarter, or multipliers that define benefits based on a percent of quota attainment. The following data format would be well suited to a Custom table.

<table>
<thead>
<tr>
<th>Product</th>
<th>Quarter</th>
<th>Compensation Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Quarter 1</td>
<td>8.00%</td>
</tr>
<tr>
<td>100</td>
<td>Quarter 2</td>
<td>7.95%</td>
</tr>
<tr>
<td>100</td>
<td>Quarter 3</td>
<td>7.75%</td>
</tr>
</tbody>
</table>

**View**
Views are a good way to display results that are contained in two different sources in the IBM Cognos Incentive Compensation Management Composer module.
Views do not contain their own unique data sets. Use a view to join tables together to create a view of two tables.

With Views, joins can contain tables and the results of calculations. When creating calculations, Views cannot be used as data sources. Instead, add columns to the original data source during the calculation creation process. Because Views cannot be used as data sources, they also cannot be made into global tables. Views are also not accessible from the web client.

When you create a View, you join two or more tables based on a point of commonality. For example, consider a situation where you join a Product table to a Payee table in order to display the products that were sold by each payee. If you restrict (link) your results based on the payee ID, you will get the following results:

**Table 4. Payee table**

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>

**Table 5. Product table**

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
<tr>
<td>345</td>
<td>Monitor</td>
<td>003</td>
</tr>
</tbody>
</table>

**Table 6. Payee table and Product table joined in View table**

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

**Important:** No data is displayed for Sue Jacob or Mary Scott because there are no corresponding product sales for those payees.

**Working with tables**

You can add Data, Structural, Custom, and View tables in the IBM Cognos Incentive Compensation Management Composer module.

When you add a table you must create columns in the table for the data.

**Table column types**

IBM Cognos Incentive Compensation Management tables use several different column types.
Table 7. Table column types

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Can contain any numeric, alpha, or symbol, but cannot be used in a formula. Text fields have a limit of 100 characters.</td>
</tr>
<tr>
<td>Date</td>
<td>Can contain any data in a date format (mm/dd/yyyy, dd/mm/yyyy, Jan. 1, 2011).</td>
</tr>
<tr>
<td>Numeric</td>
<td>Can contain only figures and can be used in formulas. A numeric column can contain up to 28 integers and 14 decimal places.</td>
</tr>
<tr>
<td>Pick List</td>
<td>A link to another table. Values loaded into this field must be contained in the linked table or they will be rejected during an import. Pick lists are ideal for situations where the data you need already exists. For example, you can create a pick list for the payee ID. If you want to create a Data table containing accounts, dates, payees, values, and customers, you could define pick lists for accounts and payees. <strong>Important:</strong> Pick lists can only pick from Hierarchy and Structural tables.</td>
</tr>
<tr>
<td>Email</td>
<td>A column similar to Text but with extra validation to restrict the input to email addresses.</td>
</tr>
<tr>
<td>Comment</td>
<td>A column designed for longer text input. Comment fields have a limit of 1000 characters.</td>
</tr>
<tr>
<td>URL</td>
<td>This column restricts input to valid URLs.</td>
</tr>
</tbody>
</table>

**Primary keys**

A primary key uniquely identifies each row in a table in IBM Cognos Incentive Compensation Management.

If your primary key is the payee ID, no two rows of data in your table can contain the same payee ID. You can identity more than one primary key in some tables. If you create a custom table that identifies both the payee ID column and the date column as primary keys, no two rows of data can contain the same combination of date and payee ID.

**Adding a table**

Tables can be added in the IBM Cognos Incentive Compensation Management Composer module to contain the data required for the model.

**Procedure**

1. Open the component that you want to add the new table to.
2. To add a table, perform one of the following steps:
   • Drag the **Table** element from the **Palette** tab onto the Composer window.
   • Right-click an empty space and select **Add Table**.
3. Select the appropriate **Table Type** from the drop-down menu and click **OK**.
4. Type a name for the table.
   The table name cannot contain spaces.
5. Type a name for the primary key field and select the column type from the **Type** drop-down list.
   Each field in the table needs to be given a unique name. Field names can contain spaces. Field names cannot be changed after the table has been created.
6. Use the **Add a Field** link to add columns to the table.
7. If the field is a primary key field, select the **ID** check box.
8. Type a name for the new field and select the type of data that will be added to the field.
9. When you have added all the table columns, click **Save**.

### Defining pick list field types

If you have selected pick list as a field type in an IBM Cognos Incentive Compensation Management table, you must define the source that will populate the pick list.

**Procedure**

1. In the Add Table wizard, click the gray question mark to open the Define Pick List window.
2. Select the table that will populate the pick list.
3. You can select the **Description** check box and a column from the drop-down menu.
   - For example, if you link to the Payee table, you might want the description to be the Name column.
4. To restrict the rows available for the pick list, select the **Filter** check box and click **Add Filter**.
   a. Add any data sources needed to filter your data.
   b. Click **Next**.
   c. Define any restrictions, and then click **OK**.
      - For example, you can create a table with a payee column that contains transaction information for Regional Sales Managers. After this filter has been added, only payees with the job title Regional Sales Manager can be added to the new table.
   d. Click **Finish**.
5. Click **OK**.
6. To review the links that already exist in default tables, click the gray **L** next to a pick list column.
   - All linked fields are attached to a source table. You should review the structure of all source tables before exiting.

### Adding a Data table

You can create a Data table in IBM Cognos Incentive Compensation Management that is used to hold transactional data.

**Procedure**

1. To create a table, perform one of the following steps:
   - Right-click a blank area in Composer and select **Add Table**.
   - Drag the **Table** element onto the main window.
2. Select **Data** from the **Table Type** drop-down menu and click **OK**.
3. Type a name for the Data table.
4. To define the primary key, select the **ID** check box next to the field.

**Important:** although data tables can contain multiple primary key columns, to simplify the partitioning process during calculation creation, use only one, such as a transaction ID column.
5. To add more fields, click the blue **Add a Field** link.
6. Type a name for the field and select a field type from the **Type** drop-down list.
   a. Define any pick list columns.
7. If your data table contains more than one date field, select the **Lock by Date** link to indicate which date field to lock by when a period is locked.
8. Click **Save**.

### Adding a View

You can create a View table to display results from two different sources in IBM Cognos Incentive Compensation Management.

**Procedure**

1. To create a table, perform one of the following steps:
   - Drag the **Table** element onto the main window.
   - Right-click a blank area in Composer and select **Add Table**.
2. Select **View** from the **Table Type** drop-down menu and click **OK**.
3. Type a name for the View and click **Next**.
   The name cannot be modified after it is created.
4. Click the **Source** drop-down menu to add a table.
5. Click **Add** to join another table.
   a. Select the second **Source** from the drop-down menu and click **Next**.
   b. Define any restrictions for the join, and click **OK**.
   c. Click **Finish**.
6. Click **Next**.
7. Drag columns on the left to the right to select the **Detail Columns**.
   Each column must be unique.
8. Click **Next**.
9. Define any restrictions and click **Next**.
10. Double-click a column to rename it.
    Each name must be less than 100 characters, must be unique, must start with a letter, and must only contain letters, numbers, spaces, periods, and underscores.
11. Click **Finish**.

### Viewing the Payee table and Account table as a hierarchy

You can view the Hierarchy tables in a tree-based interface in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**

1. In Composer, right-click the Hierarchy table.
2. Select **View As Hierarchy**.
   The table is opened in a new tab in a tree-based structure.
3. To add a new row to the table, click the **Add Item** icon, type in the appropriate information in the fields, and click **OK**.
4. To search for an item in the table, click the **Find** icon.
5. To modify an item in the table, select the item and click the **Edit Item** icon.
6. To delete an item in the table, select the item and click the **Delete** icon.
Viewing the Time table as a hierarchy

You can view and edit the Time structure in IBM Cognos Incentive Compensation Management.

Procedure
1. Go to Tools > Calendars.
2. Select the calendar and click Edit.

View and edit table data

The IBM Cognos Incentive Compensation Management Composer module can be used to modify an existing table.

For example, if an organization wants to add a commission rate for each payee, the model administrator may simply add a commission rate field to the Payee table. Then, each payee in the system would have a commission rate attribute that can be imported (or manually entered) and then used in calculations.

When you open a table for viewing or editing, any columns containing a key icon in the header are the primary key columns. Columns that users do not have access to edit will be unavailable.

The options in the following table are available when you open a table for editing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Row</td>
<td>Add a row of data to the table in an unlocked period.</td>
</tr>
<tr>
<td>Edit Row</td>
<td>Make changes to the row data if the row is in an unlocked period. Primary key fields cannot be changed.</td>
</tr>
<tr>
<td>History</td>
<td>View details of every change made to that row. History includes edits made in both locked and unlocked periods.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Delete a row in an unlocked period.</td>
</tr>
<tr>
<td>To Excel</td>
<td>Send the contents of the selected rows to a Microsoft Excel spreadsheet.</td>
</tr>
<tr>
<td>Publish</td>
<td>Send the contents of the selected rows to Microsoft Excel, Microsoft Dynamics CRM, PDF, Salesforce.com, or text file.</td>
</tr>
</tbody>
</table>

Adding table data

In the IBM Cognos Incentive Compensation Management Composer module, you can add data to a table manually.

Procedure
1. To open a table, perform one of the following steps:
   • Double-click the table.
   • Right-click the table and select View/Edit Data.
2. Click the Show Row Editor icon.

Tip: By default, the Row Editor is not displayed. However, if you choose to display the Row Editor, it will remain displayed even after the tab has been closed and reopened. To hide the Row Editor, click the Row Editor icon again.
3. Click the **Add Row** icon or the **Add** button.
4. In the top panel, enter the data in the appropriate fields and click **Submit**.
   Clicking **Add** will also submit the row of data.
   Alternatively, you can open the table, enter the data in the columns of the first empty row, and press Enter when you have finished entering all the data into the row.

**Editing table data**

In the IBM Cognos Incentive Compensation Management Composer module, you can modify existing data in a table.

**Procedure**

1. To open a table, perform one of the following steps:
   - Double-click the table.
   - Right-click the table and select **View/Edit Data**.
2. In the table, select the row containing the data you want to modify.
3. Click the **Show Row Editor** icon.
4. In the Row Editor panel, enter the new data in the appropriate fields and click **Submit**. Clicking **Add** also submits the row of data.
5. To edit the row before the selected row, click the **Previous Row** icon or click the **Edit Prev** button.
6. To edit the row after the selected row, click the **Next Row** icon or click the **Edit Next** button.

**Filtering table data**

When viewing table data in IBM Cognos Incentive Compensation Management, you can optionally filter the results.

**Procedure**

1. When viewing table data, click the filter icon in the column header.
2. Set filter parameters.
   You can filter results based on a range of values or by a specific value.
3. Click **Filter**.
   You can choose multiple columns to filter data by.

**Viewing and editing table structure**

You can view, add, and remove columns in a table after it has been created in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**

1. In Composer, right-click a table and select **Edit**.
2. To delete a column, click the **Remove** link next to the column you want to delete.
3. To add a column, click the **Add a Field** link.
4. Type a field name and select a field type from the **Type** drop-down menu.
5. Click **Save**.

**Important:** The Edit Table window for Account tables and tables used by inbound or outbound connections is displayed in Read-only mode and cannot be edited.
Editing a View table
If you have view and edit permission for the structure of a View table, you can make modifications to the sources, detail columns, restrictions and column names of the View in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In Composer, right-click the View table that you want to modify and select Edit Table.
2. Modify the source, joins, columns, restrictions, or column names.
   You cannot modify the name of the View table.

   Important: If changes are made to the View table, an entry is made to the Audit Log indicating that the View table has been edited.

Deleting a table
Tables can be removed from the IBM Cognos Incentive Compensation Management Composer module if they do not have any dependencies.

Procedure
1. Right-click a table element.
2. Select Delete.

Adding and editing table descriptions
You can add a description to a table in the IBM Cognos Incentive Compensation Management Composer module.

The description is then visible in Composer as a tooltip.

Procedure
1. Right-click the table and select Edit Table Description.
2. Type a description for the table.
3. Click OK.
4. Hover your cursor over the table to see the description tooltip.

Deleting multiple rows in a table
IBM Cognos Incentive Compensation Management provides an option to filter and delete multiple rows from a table at one time if the rows are not locked and the table is not a View.

About this task
In order to maintain data integrity, when deleting rows from a table or clearing an entire table, all child table records that have pick listed columns linked to the table being cleared are also deleted.

When rows are being deleted that are pick listed by other tables, a warning message is displayed that states which tables will have records deleted. You can click the Details button to view the dependent tables that are affected by table clearing.
The Audit log records the start and finish time of the row deletion operation. While many factors determine the exact amount of time it takes to delete multiple rows, testing has indicated that 500,000 rows can be deleted in approximately 1 minute.

**Procedure**

1. Right-click the table and select **Data > Delete Rows**.
2. Define the restrictions to filter the rows you want to delete. Drag the column that you want to filter on into the pane on the right, then select an operator and filter based on a selected field or a specific value.
   - For example, to delete all rows prior to January 1, 2011, drag over the date field and select < 01/01/2011.
   - Most columns can use these operators: =, < >, is not empty, is empty.
   - Date and value columns can use these operators: <, < =, =, >, > =, <>, is not empty, is empty.
   - If no restrictions are defined, the entire table will be cleared.
3. Click **OK**.

**Important:** This operation will delete the selected rows in the table as well as all referencing rows from other tables. This action cannot be undone.

**Copying tables**

Use the copy table feature to duplicate tables in the IBM Cognos Incentive Compensation Management Composer module and rename them by adding a suffix.

**Procedure**

1. To copy a table, perform one of the following steps:
   - Select the table and click the **Copy** icon.
   - Right-click a table element and select **Copy**.
   - **Important:** You cannot copy System or Hierarchy tables.
2. In the component you want to copy the table to, perform one of the following steps:
   - Click the **Paste** icon.
   - Right-click and select **Paste**.
3. Type a suffix that will be appended to the new table name.
4. Click **OK**.

**Publishing tables**

Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Microsoft Excel file, Microsoft Dynamics CRM database, PDF file, Salesforce.com table, or a text file.

**Procedure**

1. Right-click a table and select **Data > Publish**.
2. Select either **Publish to my computer** or **Publish to the server**.
   - If you select **Publish from the server** and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the **Save this publication as** field.
3. Click Next.
4. Select the output format for the published table or calculation.

**Publishing tables to Microsoft Excel**
Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Microsoft Excel file.

**Procedure**
1. Right-click a table and select Data > Publish.
2. Select either Publish to my computer or Publish to the server.
   a. If you select Publish to the server and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the Save this publication as field.
3. Click Next.
4. Select Microsoft Excel as the destination for the published table or calculation.
5. Format the headers and cells then click Next.
6. Click Browse to select where you want to save the file.
7. Click Finish.

**Publishing tables to Microsoft Dynamics CRM**
Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Microsoft Dynamics CRM database.

**Procedure**
1. Right-click a table and select Data > Publish.
2. Select either Publish to my computer or Publish to the server.
   a. If you select Publish to the server and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the Save this publication as field.
3. Click Next.
4. Select Microsoft Dynamics CRM as the destination for the published table or calculation.
5. Type your login credentials.

**Publishing tables to a PDF file**
Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a PDF file.

**Procedure**
1. Right-click a table and select Data > Publish.
2. Select either Publish to my computer or Publish to the server.
   a. If you select Publish to the server and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the Save this publication as field.
3. Click Next.
4. Select Portable Document Format as the destination for the published table or calculation.
5. Select the Orientation and Scaling.
6. Select the Use header image check box if you want an image displayed as the header on each PDF file.
7. You can select the **Include page numbers** check box to show page numbers in the footer.
8. You can select the **Show total page number** check box to show the total number of pages in the document along with the current page number.
9. You can type a **Footer** to be included on each page.
10. Click **Next**.
11. Format the headers and cells then click **Next**.
12. Click **Browse** to select where you want to save the PDF file.
13. Click **Finish**.

**Publishing tables to Salesforce.com**

Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Salesforce.com table.

**Procedure**

1. Right-click a table and select **Data > Publish**.
2. Select either **Publish to my computer** or **Publish to the server**.
   a. If you select **Publish to the server** and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the **Save this publication as** field.
3. Click **Next**.
4. Select **Salesforce.com** as the destination for the published table or calculation.
5. Log in to Salesforce.com with a user ID that has administrative rights.
6. Select the **Setup** link.
7. From the left pane, select **Create > Objects** from the **App Setup** section.
8. Select **New Custom Object**, and create the object according to your specifications.
9. In the IBM Cognos Incentive Compensation Management Client, right-click the table and select **Publish Table**.
10. In step 2 of the Publisher wizard, select **Salesforce.com** and click **Next**.
11. Type your user name, password, and security token, then click **Next**.
12. Select the table to export data to from the drop-down menu and click **Next**.
13. Continue with the Publisher wizard and click **Finish**.

**Publishing tables to a text file**

Use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a text file.

**Procedure**

1. Right-click a table and select **Data > Publish**.
2. Select either **Publish to my computer** or **Publish to the server**.
   a. If you select **Publish to the server** and want to save the publication to run at a later date using the Scheduler module, type a name for the publication in the **Save this publication as** field.
3. Click **Next**.
4. Select **Text File** as the destination for the published table or calculation.
5. Select a delimiter and click **Next**.
6. Click **Browse** to select where you want to save the file.
7. Click **Finish**.
Viewing table dependencies

The dependency viewer will display a list of all calculations, web forms, input forms, or other tables that use the selected table as a source in the IBM Cognos Incentive Compensation Management model.

Procedure

To open the Dependency Viewer, perform one of the following steps:

- Right-click the table and select Used By.
- Select the table and click the Used By icon in the Composer toolbar.

Copying text from the Dependency Viewer

You can copy the information in the Dependency Viewer in the IBM Cognos Incentive Compensation Management Composer module and paste it into another file.

Procedure

1. In the Dependency Viewer window, press Ctrl and select the text that you want to copy, or press Shift and select a range of text.
2. Right-click the selection and select Copy.

The text from the dependency viewer can then be pasted into a spreadsheet or other document.

Creating a global table

In the IBM Cognos Incentive Compensation Management Composer module, tables can be made global to make them visible to all users no matter what component they are in.

A table cannot be made global if it has the same name as a connection or is a View table.

Procedure

1. Right-click the table.
2. Select Global.
   An image of a globe is displayed on the table element.
3. Unselect Global to make the table local again.

Globalizing and replacing connections

In the IBM Cognos Incentive Compensation Management Composer module, you can make tables that are already being used in connections global.

This will remove the connections and change the sources of any objects (calculations, web forms, presenter reports, and so on) to use the global table.

Procedure

1. Right-click the table.
2. Select Globalize and Replace Connections.
Navigating between tables

From within any table in the IBM Cognos Incentive Compensation Management Composer module, users can easily navigate to any related table by using the Jump To feature.

The Jump To feature is not available in View tables

Procedure

1. To open the table in a new tab, perform one of the following steps:
   • Double-click the table.
   • Right-click the table and select View/Edit.
2. Right-click a value in a pick list column and select Jump To.
   You will have the option to navigate directly to the tables that the selected column picks from.
3. Select the table to Jump To.
   The table will open in the current tab and the table results will be filtered by the value that you selected in step 2.

   Important: Tables must be saved for the Jump To feature to be possible.

Clearing tables

You can delete the entire contents of a table, but not the table itself in the IBM Cognos Incentive Compensation Management Composer module.

About this task

You will receive a warning message when clearing a table containing a key column that is pick listed by other tables. You can choose to continue with the deletion or cancel the action. You can click the Details button to view the dependent tables that will be affected by the table clearing.

Important: The warning message can be turned off in the User Preferences window.

Procedure

1. Right-click the table.
2. Select Clear Table.
   This deletes all the rows in the table. Table clearing can also be scheduled using the Scheduler module.

   Important: Table clearing cannot be undone.

Finding and replacing data in a table

Use the data transformation feature to perform a find and replace operation for data in any table in the IBM Cognos Incentive Compensation Management Composer module.

This is useful when there is an error in source data that affects multiple rows of data in a table. Rather than manually adjusting each row, you can simultaneously make the change across multiple rows.
**Procedure**

1. Right-click the table and select **Transform Data**.
2. Type the original value that you want to be replaced in the **Find what** field.
   
   **Important:** In the **Find what** field, asterisks (*) act as wild cards and underscores (_) act as placeholders. If the **Find what** field is left blank, the engine will search for empty cells in the specified column.
3. Select the table where the data transformation will occur in the **Look in** field.
4. Select the column containing the value that will be replaced in the **Make change in** field.
   
   **Important:** The search engine will only perform the find and replace operation in the specified column.
5. In the **Change to** field, type the new value that will replace the original value.
6. If you want to save the transformation, select the **Save Transformation** check box and name the transformation.
   
   Once a data transformation has been saved, it can be accessed for editing or deletion through the Manage Saved Transformations window. Saved data transformations can also be scheduled to run at predefined times through the Scheduler module.
7. Click **OK**.
   
   For each row where the **Look in** column cell value equals the **Find what** value, the corresponding cell in the **Make change in** column will contain the **Change to** value.

---

**Table history**

You can chose to enable or disable the recording of history for tables in the IBM Cognos Incentive Compensation Management Composer module. You can clear the history collected for tables.

Administrators can grant users permission to purge the history of tables and can also enable or disable the recording of history for tables in Cognos Incentive Compensation Management. If tables are recording history in Cognos Incentive Compensation Management, and you have the appropriate permission, you can clear the history for tables from the Composer module or schedule the clearing of history for tables in the Scheduler module.

**Disabling table history collection**

By default, changes to tables are logged in IBM Cognos Incentive Compensation Management. You can choose to disable the collection of history for specific tables in the Composer module.

**Procedure**

1. In Composer, right-click the table for which you want to disable history recording.
2. Select **Data > History > Track History**.

**Purging table history**

You can delete the recorded history of a table in IBM Cognos Incentive Compensation Management.
About this task

If you want to purge the history of a data table, you must specify a date range; only items that fall in the data range selected are removed. Administrators must grant users permission to purge history.

Procedure

1. In Composer, right-click a table, and select **Data > History > Purge History**.
2. If you have selected a data table, you must select a date range for which to purge history.

Web data edit

Use the web data edit feature to enable specified tables for review and edit through the IBM Cognos Incentive Compensation Management web client.

Uses for the web data edit feature

In IBM Cognos Incentive Compensation Management, there may be instances where data imported from a source system is incomplete, or contains errors.

In order to correct this, tables can be enabled for web review and certain columns can be made editable. Specified users can then log in to the web client and edit the erroneous table data.

A compensation plan might require managers to supply weekly performance ratings for their subordinates. These metrics could be easily submitted by the managers through the **Data Edit** tab on the web client.

Defining accessible information

You can define the information that should be accessible to specified users through the IBM Cognos Incentive Compensation Management web client.

Procedure

1. In the Composer module, right-click the table to be enabled for web editing.
2. Select **Web Data Edit > Edit Column Permissions**.
   You can then select the fields that can be modified by the web user.
3. Check the field boxes next to the payee you want to be given editing permission.

   **Important:** After a table has been enabled for web review, you can not restrict which columns are available for review because all columns are displayed.
4. To enable an entire group of payees to be able to edit a particular column, click **Enable Group**.
   For example, you may want all payees with the job title "Sales Manager" to be able to edit the Quota column of the selected table.
   a. Select a **Source** that will be used to define the payee group and click **Next**.
   b. Define your restrictions based on that source and click **Next**.
      For example, if you want only account executives to be able to edit certain columns, then drag 'Title' to the pane on the right and make it equal to 'Account Executive'.
   c. Define the columns that the restriction applies to, and click **Finish**.
After setting your restrictions, every payee in your defined group will be enabled to edit the specified columns.

5. Click Close.

Restricting visible rows in tables

You have the option to restrict the rows that are displayed on the IBM Cognos Incentive Compensation Management web client.

For example, you may want to make sure that payees can only view and edit their own information. In this case, you can restrict results to a subset of all data in a given table.

Procedure
1. In Composer, right-click the table.
2. Select Web Data Edit > View Restrictions.
3. Define the parameters of your restrictions.
4. Click OK.

Enabling direct editing

If you enable direct editing, changes can be made to tables through the IBM Cognos Incentive Compensation Management web client without administrator approval.

Direct editing should be enabled with caution. If it is not enabled, administrators have the option of either approving each edit individually, or approving all edits at once.

Procedure
1. In the Cognos Incentive Compensation Management Client, right-click the table.
2. Select Web Data Edit > Direct Edit.
   All users with web access to the selected table can edit column information without requiring approval. Typically, all edits made in the web client need to be approved by an administrator prior to the change being permanently made in the database.

Edit data through the web client

After tables have been enabled for review, web users can go to the Data Edit tab in the IBM Cognos Incentive Compensation Management web client to edit data in the columns that they have been enabled for.

Any tables that have been authorized for editing can be selected from the Available Tables drop-down menu. Any data that appears in a white box can be changed by the user and if direct editing has not been enabled, the updated results will be submitted to the compensation plan administrator. At this point, the administrator can choose to accept or decline the change.

Use the submit button to communicate changes.

Important: After users click Submit, they are no longer able to make any changes.
Approving web data edits

After web users have submitted changes, administrators can either approve or reject those changes through the IBM Cognos Incentive Compensation Management Composer module.

If the table name is in bold letters, edits (either web form or web data edit) need to be reviewed by an administrator.

Procedure
1. In Composer, right-click the table.
2. Select Web Data Edit > Approve /Reject Edits to see a list of changes that have been made.
3. Click Approve to commit those changes to the table.

Important: Period locking will not be permitted if there are pending edits that affect the period. This prevents any changes from being made to data in locked periods. If you need to lock Month 1, all pending data edits for Month 1 must first be approved.
Chapter 5. Import data

Use the Import Data wizard in IBM Cognos Incentive Compensation Management to import data into any Hierarchy, System, Data, Custom, or Structural table.

You can import data from text files, Microsoft Excel files, any ODBC compliant database, Salesforce.com, Microsoft Dynamics CRM, XML files, and Extended Binary Coded Decimal Interchange Code (EBCDIC) text files. Cognos Incentive Compensation Management is capable of extracting the EBCDIC data and importing it directly into the model, unpacking any packed decimal files in the process. Text or Microsoft Excel files are the easiest sources to use when building your model, and a direct link to existing databases saves time once the layout of your model has been defined.

Step 1. Selecting the table and import type

You can select the table and import type when importing data into IBM Cognos Incentive Compensation Management.

Procedure
1. Right-click a table in Composer and select Data > Import.
2. Select either Import from my computer or Import from the server.

   Important: If you are importing from a server, an import directory needs to be specified in the Cognos Incentive Compensation Management Windows Service configuration file.

   a. Select the Save this Import as check box if you want to save the current import for processing at a later time through the Scheduler model.

   If you save an import, it will be saved in the file location defined in the Service configuration file. For more information on configuration files, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide. After they have been saved, all imports are accessible from the Manage Saved Imports window. Users can delete saved imports or edit details of the import, such as the data source or the destination table.

3. Click Next.

Step 2. Selecting a data source

You can select your data source for the import into IBM Cognos Incentive Compensation Management.

Procedure
1. In step 2 of the Import Data Wizard, select the type of data source that you are importing from.

   Important: While Cognos Incentive Compensation Management offers the flexibility of supporting data imports from multiple sources, you might want to consider using only one source system for all imports. The more source systems you use, the more time you will have to spend ensuring that the source system information is accurate, up-to-date, and accessible.

2. Click Next.
Step 3. Checking required columns

The third Import Data step presents the columns that the selected table requires for the import of data into IBM Cognos Incentive Compensation Management.

Each required field is needed in the data source for the import to run successfully.

Procedure

1. In step 3 of the Import Data Wizard, verify that the data file has the columns required to complete the import.
2. Click Next.

Step 4. File selection

You must choose the file that contains the data that you want to import into the IBM Cognos Incentive Compensation Management table.

The steps that you must follow to select the data file depends on the type of data source that you selected in step 2 of the Data Import Wizard.

Selecting a text file as a data source

You can choose a text file as your data source for an IBM Cognos Incentive Compensation Management table.

Procedure

1. In step 4 of the Import Data Wizard, click Browse to select a text file to import.
2. Check the First record is a header check box if the first row of your text file contains labels for each column.
   This indicates that the first row should not be processed as data, as it is a label for each column.
3. Select the delimiter from the Fields delimited by check box.
   When importing from a text file, you can choose a special character to import fields that contain a delimiter. You can choose from the following five delimiters: comma, tab, vertical pipe (|), semicolon, and period. This is useful if you have data that contains a comma but is importing from a comma delimited file. Without some sort of special character, there would be no way to import a field containing a comma from that kind of file.
4. Click Preview to make sure the data you have selected is correct.

Selecting a Microsoft Excel file as a data source

You can choose a Microsoft Excel file as your data source for the IBM Cognos Incentive Compensation Management table.

Procedure

1. In step 4 of the Import Data Wizard, click Browse to select the file to import.
2. If the first row of your Microsoft Excel file contains labels for each column, select the First record is a header check box.
3. Select the worksheet you want to import.
4. Click Select to choose the range of cells to import.
   The Microsoft Excel file opens.
5. Highlight the cell range containing your data in the Microsoft Excel file.
6. In the Import Data Wizard, click **Preview** to ensure the data you have selected is correct.
7. Click **Confirm**.
   The Microsoft Excel file closes.

**Important**: Microsoft Excel must be closed when you are importing data into a table.

### Selecting ODBC Compliant Database file option 1 as a data source

If you choose ODBC Compliant Database as your data source, you can choose this option to complete step 4 of the Import Data Wizard in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In step 4 of the Import Data Wizard, select a **Driver**.
2. Click **Browse** to select your file.
3. Select **The first record as header** check box.
4. Type in your user ID and password or select the **Use Advanced Settings** check box to enter a custom connection string.
5. Click **Next**.
6. Type an SQL statement.
7. Click **Preview** to display the first 1000 rows of your selected data.

### Selecting ODBC Compliant Database file option 2 as a data source

If you choose ODBC Compliant Database as your data source, you can use this option to complete step 4 of the Import Data Wizard in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In step 4 of the Import Data Wizard, select a **Driver**.
2. Select the Server name or select the **Use Advanced Settings** check box to type a custom connection string.
3. Type the **Database** name.
   For example, type **ForODBCExport**.
4. Type your user ID and password.
5. Click **Next**.
6. Type a SQL statement.
7. Click **Preview** to display the first 1000 rows of your selected data.

### Selecting Salesforce.com as a data source

You can choose Salesforce.com as your data source for IBM Cognos Incentive Compensation Management tables.

**Procedure**
1. In step 4 of the Import Data Wizard, type your Salesforce.com user name, password, and security token.
Important: You must be set up with an administrator profile in Salesforce.com in order to import data.

2. Select the table and columns that you want to import.
   The drop-down menu lists all of the Salesforce.com tables that you have access to. The tables include all the default Salesforce.com columns, as well as any custom fields you have created.

3. To add custom columns to import from the selected table, perform the following steps:
   a. Select the **Enable Custom Columns** check box.
   b. Click **Add**.
   c. Type the name of the column from the table you want to import and click **OK**.

4. Click **Preview** to view the contents of the Salesforce.com table prior to running the import.
   Use the preview feature to see exactly what your Salesforce.com data looks like before you import. Previewing data also eliminates guesswork if you are unsure of the name of the Salesforce.com table that contains the import data you need.

Selecting a Microsoft Dynamics CRM file as a data source
You can choose Microsoft Dynamics CRM as your data source for your IBM Cognos Incentive Compensation Management tables.

**Procedure**
1. In step 4 of the Import Data Wizard, type your user name and password.
2. Type the domain, organization, and host.
3. Click **Next**.
4. Select the table that you want to import.
5. Click **Preview** to view the contents of the table prior to running the import.

Selecting an EBCDIC file as a data source
You can choose an EBCDIC text file as your data source for your IBM Cognos Incentive Compensation Management tables.

**Procedure**
1. In step 4 of the Import Data Wizard, click **Browse** to select the EBCDIC text file to import.
2. Select the **Encoding**.
3. You can select the **Ignore first record** and **Ignore last record** check boxes.
4. Click **Next**.
5. Increase or decrease the record length.
6. Add more fields.

   **Important**: The record length must match the number of fields.
7. Click **Preview** to make sure the data that you selected is correct.
Selecting a Microsoft Excel file from TerrAlign as a data source

You can choose a Microsoft Excel file from TerrAlign as your data source for your IBM Cognos Incentive Compensation Management tables.

Procedure
1. In step 4 of the Import Data Wizard, click Browse to select the file to import.
2. If the first row of your Microsoft Excel file contains labels for each column, select the First record is a header check box.
3. Select the worksheet you want to import.
4. Click Select to select the range of cells to import and highlight the cell range containing your data.
5. Click Preview to make sure the data you selected is correct.
6. Click Confirm.

Important: You must have Microsoft Excel closed when you are importing data into a table.

Selecting an XML file as a data source

Data stored in XML format can be imported into an IBM Cognos Incentive Compensation Management Composer table.

The XML file should contain nodes that represent rows. These nodes should be nested at the same level for each row. The columns of the row are expected to be the children of the row node. If a row does not have a child that another row has, the value for it will be empty.

Procedure
1. In step 4 of the Import Data Wizard, click Browse to select the file to import.
2. Select the row node to import data from.
3. Click Preview to make sure the data you have selected is correct.
4. Click Next.

Step 5. Mapping columns

You must match your IBM Cognos Incentive Compensation Management table columns to the columns in your data source.

Procedure
1. Navigate to step 5 of the Import Data Wizard.
2. Click Automatch or drag each field from your data source onto the mapping column next to its corresponding field.

Creating sub-items

On the map columns window in the IBM Cognos Incentive Compensation Management Import Data Wizard, you can create a new field.

These sub-items are a segment of the data in an existing column.
**Procedure**

1. In step 5 of the Import Data Wizard, right-click any data source column to create a sub-item of that field.

2. Click **Create New Field**.

3. Type a new field name.

4. To create a sub-item, perform one of the following steps:
   - Select **Create a sub-item by selecting characters to include** and type the selection. For example, type 1-5 if you want to include the first five characters of the field.
   - Select **Use the following delimiter to create a sub-item for this field**, type a delimiter and select the **Index**. For example, if you have a Name field that contains first and last names separated by a space (for example, Dan Huddle) and you want to create a First Name field, you would type a space as the delimiter and select an Index of 1 since the first name is the first item before the delimiter.

   **Important**: You can confirm if your selection is correct by looking at the example in the Create New Field window.

5. Click **OK**.
   
   You can see your sub-item in the data fields column on the map columns window.

**Merging fields**

In the IBM Cognos Incentive Compensation Management Import Data Wizard, you can combine two columns in your data source into one column.

For example, if you have a month and a year field, you can merge the two and create one date field.

**Procedure**

1. In step 5 of the Import Data Wizard, right-click any data source column.

2. Select **Merge Fields**.

3. Type a merge fields name.

4. Select at least two data fields to merge by dragging a field from the left to the right column.

5. Type in a delimiter.
   
   The delimiter is placed between the merged fields.

   **Important**: You can confirm if your selection is correct by looking at the example in the Create New Field window.

6. Click **OK**.
   
   You can see your merged field in the data fields column on the map columns window.

---

**Step 6. Selecting save and run options**

In the last step of the Import Data Wizard in IBM Cognos Incentive Compensation Management, you can choose how you want the import to run.
**Procedure**

1. Navigate to step 6 of the Import Data Wizard.
2. Select any or all of the following options:
   - **Add new members as needed** - indicates that new members should be added.
   - **Update existing rows** - indicates that existing rows of data should be updated with data contained in the rows being imported.
   - **Run this import now** - indicates that the Cognos Incentive Compensation Management Client should run the current import immediately. Unselect this check box if you want to simply save the current import and process it at a later date.
   - **Use Incremental Import** - indicates that the Cognos Incentive Compensation Management Client should import rows to the database in smaller batches instead of committing the entire import in one batch. Use this option to process database calls, such as report generation in the web client, during a large data import.
3. Click Finish.

**Step 7. Track import progress in the Activity module**

After you have finished the Import Data Wizard, the Activity module opens in IBM Cognos Incentive Compensation Management and tracks the progress of the data import into the table.

While the import is progressing, you can open a new module or continue working in a previously opened module. If the import ran successfully, you will see a message indicating the data import was successful in the Activity module. You can then review the imported data in the Composer module by double-clicking the table. After a successful import, the selected table will contain records that correspond to the source file. If the import was unsuccessful, an error message will be shown in the Activity module as well as the Audit log.

**Viewing import exceptions reports**

If the import is unsuccessful, an exception report detailing the problems with the import will be automatically generated in the IBM Cognos Incentive Compensation Management Import log.

**Procedure**

1. In the Audit module, click the **Import** tab.
2. From within the Import log, you can perform the following actions:
   - clear all error reports
   - copy the report text
   - view all reports within a specified date range

**Using a remote directory for saved imports**

In order to use a remote directory for saved imports, you have to first change the login credentials for the administrator that runs the IBM Cognos Incentive Compensation Management Scheduler and Service to match an account with access to the directory with the saved import.

The Service user credentials can be modified from the Service Properties window.
Procedure

1. In the Cognos Incentive Compensation Management Windows Service configuration file, indicate the location of the import file directory:

```
<add key="ImportFileDirectory" value="\Network\Directory Name\"/>
```

**Important:** The user needs to have full rights to the specified directory.

2. To access the Service Properties window, go to Control Panel > Administrative Tools > Services.

3. Right-click the Cognos Incentive Compensation Management Windows Service and select **Properties**.

4. On the Log On tab, select **This account** and type in the account information.

5. Click **OK**.

6. In the Cognos Incentive Compensation Management Client, save imports using the Import Data Wizard.

7. Click **Browse** on the Import Data Wizard Step 4 window to access the files available in the specified import file directory.

---

**Import data from IBM Cognos Sales Performance Management on Cloud**

Assignment detail reports created in Cognos Sales Performance Management on Cloud can be imported and used as sources in calculations and reports in IBM Cognos Incentive Compensation Management.

After the Cognos Sales Performance Management on Cloud object has been created in the Cognos Incentive Compensation Management Client, data can be synced manually through a right-click option or at predetermined intervals using the Scheduler module.

---

**IBM Cognos Incentive Compensation Management connection configuration**

In order for the Cognos Incentive Compensation Management Client to import data from IBM Cognos Sales Performance Management on Cloud, the Cognos Incentive Compensation Management Windows Service configuration file needs to be updated to point to the Cognos Sales Performance Management on Cloud instance.

The Cognos Incentive Compensation Management Windows Service configuration file contains a section called `SPMOnCloudServiceAddress`. The Value field of this section must contain the URL that you use to login to Cognos Sales Performance Management on Cloud. You will need to omit HTTPS:// and append :8443 to the URL.

For example, type the following text in the Cognos Incentive Compensation Management Windows Service configuration file:

```
<!-- SPMOnCloudServiceAddress -->
<add key="SPMOnCloudServiceAddress" value="spm.ibm.com:8443"/>
```
Creating an IBM Sales Performance Management on Cloud object in Composer

Details of credit assignments from Cognos Sales Performance Management on Cloud are pulled into an IBM Cognos Sales Performance Management on Cloud object in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. In Composer, drag the IBM Cognos Sales Performance Management on Cloud object from the Palette tab onto the Composer window.
2. In the Sync with IBM Cognos Sales Performance Management on Cloud window, type valid Cognos Sales Performance Management on Cloud login credentials and click Login.
3. Select the Cognos Sales Performance Management on Cloud detail report that you want to link to Cognos Incentive Compensation Management and type a name.

The Cognos Incentive Compensation Management application creates a table with columns that are identical to the assignment report.

Name This is the display name for the IBM Cognos Sales Performance Management on Cloud object in Cognos Incentive Compensation Management. The name cannot contain any spaces.

Choose a report This is the assignment detail report from IBM Cognos Sales Performance Management on Cloud that you are importing.

IBM Cognos Sales Performance Management on Cloud data synchronization

After an IBM Cognos Sales Performance Management on Cloud object has been added to your model, data from Cognos Sales Performance Management on Cloud can be synchronized with the data in the Cognos Incentive Compensation Management Client at any time.

When data is synced, all the data in the IBM Cognos Sales Performance Management on Cloud object is deleted and replaced with the current data in the Cognos Sales Performance Management on Cloud assignment report.

Load data into an IBM Cognos Sales Performance Management on Cloud object manually

Data can be loaded into the IBM Cognos Sales Performance Management on Cloud object in the Cognos Incentive Compensation Management Composer module.

Procedure
1. In Composer, right-click the IBM Cognos Sales Performance Management on Cloud object you want to load data into.
2. Click Synchronize.

An Activity tab opens to display the progress of the synchronization.

Scheduling an import from IBM Cognos Sales Performance Management on Cloud

Data can be loaded into the IBM Cognos Sales Performance Management on Cloud object using the Scheduler module.
Procedure
1. In Scheduler, add or select a process folder to add the table synchronization to.
2. Select the **IBM Cognos Sales Performance Management on Cloud Table Synchronization** task from the **Add Task** drop-down list in the toolbar.
3. Select the IBM Cognos Sales Performance Management on Cloud object to import into and click **OK**.
4. Right-click the task and set the schedule.

**Switching report associated with IBM Cognos Sales Performance Management on Cloud object**

Users can now change the report associated with an IBM Cognos Sales Performance Management on Cloud object.

The original report and target report should have matching schemas.

**Procedure**
1. In Composer, right-click the IBM Cognos Sales Performance Management on Cloud object, and select **Edit IBM Cognos Sales Performance Management on Cloud Source**.
2. Select the report you want to switch to.
3. Click **Import**.
Chapter 6. Activity tab

The Activity tracking tab in IBM Cognos Incentive Compensation Management opens automatically when a user runs an activity such as an import, model optimization, migration, calendar lock or unlock, calculation, library import, task generation, and task run.

When a user begins one of these processes, the Activity tab opens and tracks the progress of the process. Users can then navigate to other modules while the process is running. The Activity tab records up to 100 activity logs per user; however, running activities are only shown in the session in which they were started. Users can delete records of individual activities or all activities from the tab. If an activity results in an error, users are able to view the error message in the Activity tab.

**Important:** Users are only able to see their own activities, not all activities performed in the model.

Viewing the Activity tab

You can use activity tracking in IBM Cognos Incentive Compensation Management to delete activities or view the details of an activity.

**Procedure**
1. To open the Activity module, right-click a tab and select *Activity*.
2. From within the Activity tab, you can perform the following tasks:
   - To delete an activity, click the *X* next to the activity you want to delete.
   - To delete all the activities listed, click the *Clear All* button.
   - To view details of an activity that resulted in an error, click *Details*.

Viewing error details on the Activity tab

When an activity does not complete in IBM Cognos Incentive Compensation Management, details of the error are displayed.

The error details remain until the activity entry is deleted by the user.

**Procedure**
1. On the Activity tab, to view details of an activity that resulted in an error, click *Details*.
2. To copy the text of the error message, highlight the text, right-click, and select *Copy*.
   - The text can then be pasted into an email for troubleshooting.
Chapter 7. Input forms

Use input forms in IBM Cognos Incentive Compensation Management to control the tables and table fields that are viewable and editable by particular administrators.

Often there are situations when someone needs to be able to edit specific information in a certain table, but it would not be prudent to grant that person complete access to every table. To ensure data integrity, it is important that data changes can only be made by authorized users. By creating an input form, you can not only define what table is editable, you can also select which table fields to display and what type of data can be entered in editable fields.

**Important:** After changes are made through an input form, they are applied directly and immediately to the table.

Creating an input form

In IBM Cognos Incentive Compensation Management, you can define what tables and table fields are viewable and editable to users by adding an input form to the table in Composer.

**Procedure**
1. In Composer, select the table to be made available for editing or review.
2. Right-click the table and select **Input Forms > Add Input Form**.
3. Type a **Name** for the input form and click **Next**.
   
   **Important:** The primary key columns are automatically displayed as selected columns.
4. Drag the columns you want to be viewable and editable to users from **All Columns** to **Selected Columns**, then click **Next**.
   
   **Tip:** The primary key field needs to be selected.
5. To set default values for a column, click the **Default Values** link.
   a. Select the **Enable Default Value** check box.
   b. Select the default value you want to use from the **Default Value** drop-down menu.
   c. Click **OK**.
6. To mark individual columns as read-only, select the **Read Only** check box.
7. To configure reference column options for an input form column, click the **Options** link.
   a. To create a tab in the input form based on a reference column in the input form, select the **Tab** check box and type a **Tab Name**.
      A tab cannot have an empty name.
   b. Leave the **Jump To** check box selected to enable the Jump To feature for reference columns.
   c. Click **OK**.
8. Click **Next**.
9. Define any restrictions and click **Next**.
Important: Restrictions can be used as static filters.

10. To change the display name of a column, perform one of the following steps:
    - Double-click the column to change the display name.
    - Right-click the column and select Edit Column Name.

11. Click Finish.

Assigning security to input forms

After creating the input form in IBM Cognos Incentive Compensation Management, you must grant users the ability to view, edit, and delete the form.

Procedure

1. Go to Admin > Manage Roles.
2. Select the role or add a new role.
3. Highlight the role.
   - All the flags are red by default, which indicates that this role has no access to the items in the Cognos Incentive Compensation Management Client.
4. Drill down to find your input form by expanding Composer > Table > Table where you created your input form > Input Forms.
   - Notice that default input forms are created for each table.
5. Right-click your input form and select Grant or expand the input form and right-click Add, Delete, Edit, History, or View and select Grant.
   - The flag becomes green, indicating the role has access to the input form. Users must have view permission for input forms to perform any of these actions.
6. To allow the user to view the Composer module, collapse Table, right-click View, and select Grant.
7. To allow the user to add, edit, and delete input forms, right-click Input Forms and select Grant.
   - The user must also have edit permission for Composer. If the table the input form belongs to is in a component, the user must also have view and edit permission for the component.
8. To allow the user to add, edit, or delete input forms, expand Input Forms, right-click Add, Edit, or Delete and select Grant.
   - Users must have View permission for the input form to be able to edit or delete it.

Assigning users to the input form role

After the role has been created in IBM Cognos Incentive Compensation Management, you must assign specific users to that role so they can have input form permissions.

Procedure

1. Go to Admin > Manage Users.
2. Click Add, or highlight a user ID and click Edit.
   a. If you clicked Add, type a user ID, user name, email, and password for the user.
3. Select the input form role in the Role drop-down menu.
4. Click OK.
Adding input form validation rules

After an input form is created in IBM Cognos Incentive Compensation Management, validation rules can be defined to make sure data entered into a particular field is valid.

These rules are applied to specified columns and can be number or text-based.

Procedure

1. In Composer, right-click the table element that contains the input form.
2. Select Input Forms > Edit Validation Rules.
3. In the Validation Rules window, click Add.
4. Select either Numeric or Text for the validation rule type and click Next.

   **Important:** Additional sources cannot be joined to the table to create a validation rule.

5. Type a rule name.
6. Type an invalid input message that will be displayed to the user when the rule is violated.
   
   For example, if you selected a numeric rule type, then the rule could be called Greater than or equal to zero and the invalid input message would be Value must be greater than or equal to zero.

7. If you selected Numeric, perform the following steps:
   a. Drag the column into the formula box.
   b. Create your formula.
      
      For example, drag the Product Quota column into the formula box, click \( > \) and type 0.

8. If you selected Text, perform the following steps:
   a. Select the column from the column drop-down menu that you want to create a regular expression for.
   b. Type in a regular expression.
   c. Type in sample text.
   d. Click Test to test your regular expression.
      
      A message that states: The sample is a match to your regular expression indicates that you have used the correct expression.

   **Important:** Regular expressions are used for text based rule validation in order to make sure that data entered into a particular text field is valid.

9. Click Finish and click Close.

Viewing an input form

After an input form is created in IBM Cognos Incentive Compensation Management, the administrators with appropriate access can view the input form.

**Procedure**

1. Double-click the table that contains the input form.
2. In the Input Form Selector window, select the input form you want to view and click OK.
   
   The input form opens in a new tab.
Submit changes through an input form

IBM Cognos Incentive Compensation Management administrators with appropriate access can add data or make changes to the specified table fields.

When a change is made through the input form, it is applied directly to the table.

Adding a new row to an input form

In IBM Cognos Incentive Compensation Management, you can add a new row to an input form by entering the data directly in the columns of the first blank row in the table and pressing Enter to submit the row.

You can also add a new row using the row editor.

Procedure
1. Open the input form.
2. Open the row editor by clicking the Show Row Editor icon.
3. In the top panel, click the Add Row icon or the Add button, and enter the data in the blank fields.
4. Click Submit.
   Clicking Add also submits the row to the table.

Modifying a row in an input form

In IBM Cognos Incentive Compensation Management, you can edit a row in an input form by selecting the cell containing the data to be modified and making the changes directly in the table, or you can also use the Row Editor.

Procedure
1. In the table, select the row you want to modify.
2. Open the Row Editor by clicking the Show Row Editor icon.
3. In the top panel, modify the data in the fields and click Submit.
   Clicking Add also submits any changes to the table.
4. To move to a row before the selected row in the table, click the Previous Row icon, or click the Edit Prev button.
5. To move to a row after the selected row in the table, click the Next Row icon, or click the Edit Next button.
Chapter 8. Calculation creation

In IBM Cognos Incentive Compensation Management, the process of transforming your company’s data into compensation results begins with calculations.

Calculations enable the model administrator to select records from the source data, perform operations on the data, segment the results, and begin another calculation based on those results.

When the Calculation wizard is first launched, you are prompted to select a calculation type. Cognos Incentive Compensation Management offers a selection of many different types of calculations, but user-defined calculations are the most common because they offer complete flexibility when selecting data sources, defining mathematical formulas, and partitioning results.

The calculation engine is capable of highly complex, multi-step calculations that can accommodate any compensation plan or analytical calculation requirements. Calculation templates have been added to make it easier to set up certain common calculations. Beneath the surface however, every calculation is created using the Calculation Wizard, which uses five steps for calculation creation.

<table>
<thead>
<tr>
<th>Calculation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-Defined</td>
<td>If the standard templates do not address the complexity of your compensation calculations in a single step, select this item to define a user-defined calculation. Administrators can use multiple data sources and custom formulas in user-defined calculations.</td>
</tr>
<tr>
<td>Sort</td>
<td>A custom defined sort calculation. This is a more flexible and powerful interface used to select top performers or identify areas for improvement.</td>
</tr>
<tr>
<td>Time Shift</td>
<td>A calculation type used to shift results across time periods. This calculation type is useful for examining results from prior periods.</td>
</tr>
<tr>
<td>Category</td>
<td>A calculation type used to evaluate each row of a source against an unlimited series of restrictions. Category values are added to the rows depending on the restriction that applies to it. This calculation type can be used to organize records in tables or calculations into different categories.</td>
</tr>
</tbody>
</table>

In the first step of the Calculation Wizard, you must name the calculation and choose a type of calculation. Additionally, you can type a description for the calculation. The description can be viewed as a header in Payee Ledger if the calculation is added to a compensation plan.
Define a data source

Each calculation in IBM Cognos Incentive Compensation Management begins with data.

Initially, any non-system table is available as a calculation source.

After one or more calculations have been created, any prior calculation result can be selected as a source for a new calculation. Draw results can also be used as data sources.

After a source has been selected, the fields of the table (or calculation result) are displayed in the Add Data Source pane of the Calculation Wizard.

Changing the size of Calculation Wizard icons

You can increase or decrease the size of the icons in the Calculation Wizard in IBM Cognos Incentive Compensation Management to minimize the amount of scrolling required to view table columns.

Procedure

1. In step 2 of the Calculation Wizard, in the Add Data Source pane, click the drop-down arrow next to the Preview button.
2. Select Large Icons, Medium Icons, or Small Icons.

Calculation Wizard column icons

To aid you in evaluating the type of data in the IBM Cognos Incentive Compensation Management data source, different types of columns, such as date and numeric columns, have different icons.

Table 10. Column icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder icon" /></td>
<td>Any links that connect the selected source to other tables are denoted with a folder icon. You can access the contents of the linked tables by double-clicking the folder icon.</td>
</tr>
<tr>
<td><img src="image" alt="Page icon" /></td>
<td>Any text fields or email fields are denoted with a page icon.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar icon" /></td>
<td>Any date fields are denoted with a blue calendar icon.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar icon" /></td>
<td>A field that links to a calendar is denoted by a red calendar icon. You can drill into a period to access the Time ID, Level, Parent, and Starting and Ending dates.</td>
</tr>
<tr>
<td><img src="image" alt="Value icon" /></td>
<td>Any numeric fields are denoted with a value icon.</td>
</tr>
<tr>
<td><img src="image" alt="Dialog icon" /></td>
<td>Any comment or URL fields are denoted with a dialog icon.</td>
</tr>
</tbody>
</table>
Calculation wizard shortcut keys

There are several shortcut keys that can be used to make finding and adding sources easier in the IBM Cognos Incentive Compensation Management Calculation Wizard.

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Keys</td>
<td>You can move up, down, left, and right through the sources in the Available Sources pane using the arrow keys.</td>
</tr>
<tr>
<td>Enter</td>
<td>You can add a selected source to the Add Data Source pane by pressing Enter.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>This opens the Available Sources pane and focuses the Search field.</td>
</tr>
</tbody>
</table>

Add multiple sources

Frequently, more than one IBM Cognos Incentive Compensation Management data source needs to be referenced in a single calculation.

For example, one table may contain all of the sales data required to calculate total sales, and another may contain quotas and compensation rates to be applied. Multiple sources will be required for this calculation.

The Cognos Incentive Compensation Management model administrator can add multiple additional sources to the current source. Depending on your calculation and the data in your tables, you can either add rows or columns to your source table.

Important: Adding columns produces the same result as creating a View in Composer; however, Views cannot be used as sources in calculations.

Adding columns

In IBM Cognos Incentive Compensation Management, you can join two or more tables or calculations together to define the data sources for your calculation by adding columns.

Normally, you join data sources together based on a point of commonality; this is done by defining restrictions for the join.

For example, consider a situation where you join a product table to a payee table in order to display the products that were sold by each payee. If you restrict, or join, your results based on the payee ID, you will get the results shown in the following tables.

<table>
<thead>
<tr>
<th>Payee ID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacobs</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>
Table 13. Product table

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
<tr>
<td>345</td>
<td>Monitor</td>
<td>003</td>
</tr>
</tbody>
</table>

Table 14. Result of joining the Payee table and Product table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

Important: No data is displayed for Sue Jacob (002) or Mary Scott (004) since there are no corresponding rows in the Product table for those payees.

You can join each new source to an existing source based on a point of commonality using restrictions. For example, if the initial source contains transactional data for each payee, and the second source contains compensation rates to be applied to sales, Cognos Incentive Compensation Management needs to know how to associate the two types of payee data. If the compensation rates vary based on job title, and Title ID is contained in both tables, they can be joined together on that basis. For example, ERP.TitleID = Rates.TitleID.

Adding restrictions is a very important part of adding a new data source. If you do not create restrictions, each row in the new source will be added to each row in the existing source. This creates many more rows than either source would have individually.

For example, if the first source had 100 rows and the second had 50 rows, the result of a join with no matches would be $100 \times 50 = 5000$ rows, or a row for each possible combination of rows in the two sources.

While restrictions are normally necessary, there may occasionally be instances where you want to display all the possible row combinations when joining two tables. Imagine you have a product table and a payee table and you want a table that shows each product that could potentially be sold by each payee.

Table 15. Payee table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>

Table 16. Product table

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
</tbody>
</table>
If you perform the following steps:
1. Define the payee table as your first source.
2. Add columns to the payee table from the product table.
3. Decline to add restrictions.

Your join will produce the results in the following table.

### Table 17. Imposing restrictions example

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

**Important**: This example represents an unrestricted join, where every row on the first table is matched to every row on the second table. Carefully defining joins is very important to make sure that your information is returned as intended.

### Adding additional sources by columns

In IBM Cognos Incentive Compensation Management, you can join two or more data sources together in a calculation to compare the data sources or use the data in a formula.

**Procedure**

1. In the Define Data Sources step of the Calculation Wizard, drag the first source from the **Available Sources** pane to the **Add Data Source** pane.
2. To add a joined source, perform one of the following steps:
   - Drag the second source from the **Available Sources** pane and place it after the first source in the **Add Data Source** pane.
   - Right-click in the **Add Data Source** pane and select **Add New Source**, and then select the source you want to add from the list.
3. To rename the additional source, double-click the source name in the **Add Data Source** pane.
4. If you do not want to define restrictions, simply click **Next** without joining any columns.
5. If you want to define restrictions, select the second source in the Add Data Source pane.
   The source will be outlined in blue.

6. To have the calculation wizard automatically create restrictions between the sources, click the Auto Join button.
   Any text, date, email, or pick list columns that have the same name and column type in the two sources will be joined.

7. If you have added more than one source, you can use the Join With drop-down list to select the source you want to automatically join to the selected source.

8. To manually define the restrictions for the join, perform the following steps:
   a. In the Define Restrictions pane, right-click and select Add New Restriction or drag a column from the source to the Define Restrictions pane.
   b. To create the restriction, drag a column from a data source in the Add Data Source pane and place it in the first restriction field.
   c. Select an operator for the restriction from the Operator drop-down menu.
   d. Select a value from the drop-down menu in the second restriction field, or drag another column to the second restriction field to define the restriction.

9. If you want to remove all the restrictions for the selected source, click Clear.

10. When are finished joining sources, click Next.

**Anchor feature**
You can use the Anchor feature in the IBM Cognos Incentive Compensation Management Calculation wizard to join sources using a left outer join.

This join type displays rows for all records for the first data source even if the join does not find matching records in the second data source. Only matched records from the second data source are returned. If the second data source returns one row and the first data source returns more than one matching row for it, the values in the second source are repeated for each distinct row in the first data source.

Consider a situation where you have the following two data sources:

**Table 18. Source 1**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
</tr>
<tr>
<td>Brain Acton</td>
<td>001</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
</tr>
</tbody>
</table>

**Table 19. Source 2**

<table>
<thead>
<tr>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>005</td>
<td>Training</td>
</tr>
</tbody>
</table>
When the Anchor feature is used, records from the first data source are returned even when there is no matching record in the second source.

**Table 20. Results from joining the sources and using the anchor feature**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>Brain Acton</td>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Creating a left outer join in a calculation**

When joining sources by columns in IBM Cognos Incentive Compensation Management, you can use a left outer join to display rows for all records for the first data source even if the join does not find matching records in the second data source.

**Procedure**
1. In the Define Data Sources step of the Calculation Wizard, add an initial source.
2. Add a second source and apply a join restriction.
   
   **Important:** If you have many joined sources, at least one join restriction is required to create a left join.
3. Right-click the first source and select **Anchor Base Source** to enable left join functionality.
   
   A blue anchor icon is displayed on the first source.

**Renaming a joined source**

Sources that have been joined by columns can be given an alias in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In the Add Data Source pane, select the joined source.
2. Double-click the name of the source and type in the new name.

   **Important:** If you are using Large or Medium Icon mode, then the original name of the source is displayed in brackets after the alias name. If you are using Small Icon mode, you can view the original name of the source by hovering your mouse over the alias name.

**Switching a joined source**

A joined source can be switched in the Add Data Source pane of the IBM Cognos Incentive Compensation Management Calculation Wizard.

When a source is switched, it retains its original name and join restrictions.

**Procedure**
1. To switch a joined source, right-click the source in the Add Data Source pane of the Calculation Wizard and select **Switch Source**.
2. Type the name of the source in the search field, or select the source you want to switch to from the list.

**Joining sources automatically**
You can use the Auto Join button to join a source to any additional source in the IBM Cognos Incentive Compensation Management Calculation Wizard.

When the Auto Join button is clicked any matching columns between the two sources will be joined. The columns must have the same column type (date, text, email, or pick list) and name to be automatically joined.

**Procedure**
1. In step 2 of the Calculation Wizard, select the first source in the Add Data source pane.
2. In the Define Restrictions pane, from the **Join With** drop-down list, select the source to which you want to join the first source.
3. Click **Auto Join**.
4. To remove the restrictions for the selected source, click **Clear**.

**Adding rows**
In the IBM Cognos Incentive Compensation Management Calculation Wizard, you can create a union between data sources.

You might find that joining sources (adding columns) does not organize your data in a way that creates the results you want. If this is the case, you have the option to append sources by adding rows. This feature is similar to adding columns in that both options are used to relate information from multiple sources.

Consider a plan that pays compensation to employees based on their total sales minus any returns made by month. Look at the information for employee 001.

*Table 21. Sales data table*

<table>
<thead>
<tr>
<th>Employee</th>
<th>Total Sales</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>1500</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>250</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>700</td>
<td>Month 2</td>
</tr>
<tr>
<td>001</td>
<td>500</td>
<td>Month 3</td>
</tr>
</tbody>
</table>

*Table 22. Return data table*

<table>
<thead>
<tr>
<th>Employee</th>
<th>Returns</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>-100</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>-50</td>
<td>Month 2</td>
</tr>
</tbody>
</table>

If we follow these steps to add rows from the return data table to the sales data table, the results match the *Results of adding rows* table.
1. Add rows from the return data table to the sales data table.
2. Look for a sum of the total sales.
3. Partition the results by months.
Table 23. Results of adding rows

<table>
<thead>
<tr>
<th>Total Sales</th>
<th>Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>1650</td>
<td>Month 1</td>
</tr>
<tr>
<td>650</td>
<td>Month 2</td>
</tr>
<tr>
<td>500</td>
<td>Month 3</td>
</tr>
</tbody>
</table>

There is a result shown for Month 3, even though there is no record for that month in the return data table. If you were to link these tables by adding columns, the row containing March would not be displayed.

All columns in the source table must be mapped to a column in the union table. For this reason, the columns in the source table should be similar to the columns in the union table. For example, both the Sales data table and Return data table had employee ID, amount, and date columns.

Adding additional data sources by rows

You can join two or more data sources together by rows when creating a calculation in IBM Cognos Incentive Compensation Management.

Procedure

1. In the Define Data Sources step of the Calculation Wizard, drag the first source from the Available Sources pane to the Add Data Source pane.
2. Drag the second source from the Available Sources pane and place it before the first source in the Add Data Source pane.
   The second source is highlighted in gray.
3. To define the join, click the orange icon next to the second source.
4. To make changes, click the Clear button to remove the column mapping.
5. When you are finished defining the column mapping for the unions, click Next.

Preview

After you have selected your data sources, you can use the Preview button to display the rows of data to be used in your calculation in IBM Cognos Incentive Compensation Management.

You can examine the results generated by adding columns or rows to your data source prior to running a calculation.

Important: Only the top 100 rows are displayed.

Define a formula

In the Define Formula step of the IBM Cognos Incentive Compensation Management Calculation Wizard, you can create the multiplier (or a more complex formula) for the calculation.

Any numeric value can be pulled directly from the sources tree into the formula window.

Various formulas (SUM, MIN, MAX, IF, AND, OR, NOT, and so on) are available to aid in setting up the calculation you want.
In addition, the Preview button provides the option of examining the results of each formula prior to proceeding.

**Important:** Each formula only needs to satisfy a portion of the requirements of the entire compensation calculation. For example, consider a compensation plan that requires the following calculations: totaling product sales for the month, determining the appropriate compensation rate based on the sales amount, then calculating the compensation payout. This plan could be conceptually understood more easily in three calculations than in a single step. You could create three separate calculations that build on each other to obtain the final result.

**Formula operators**

Several formula operators are available to aid in setting up the calculation you want to create in IBM Cognos Incentive Compensation Management.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUM()</td>
<td>This will take the aggregate of whatever is within the brackets and give you a total.</td>
<td>To calculate 5% of the value of each sale as commission: Sum(SourceTable.ValueColumn) *0.05</td>
<td>Sum(Value)</td>
<td>The use of SUM is recommended for most calculations as it will not only provide you with the proper summed amount for your calculation, but will also enable clear reporting in Payee Ledger. If you are showing negative values in Payee Ledger, make sure your formula is using the SUM operator.</td>
</tr>
<tr>
<td>COUNT()</td>
<td>This will give a value of 1+ for each record that has a value. This means that each record will be one more than the previous amount.</td>
<td>To calculate the total number of deals in a period: COUNT(SourceTable.ValueColumn)</td>
<td>Count(Value)</td>
<td>If the data is partitioned by PayeeID and Month, the count will reset back to zero after each month and start again.</td>
</tr>
<tr>
<td>MAX()</td>
<td>This will take the maximum value of a set of results.</td>
<td>If, for each deal, you will receive a 5% commission but there is a minimum of $5 per deal you will earn, you can use the following formula to determine if the 5% commission is higher than the $5 minimum: MAX(Data.Value*0.05, $5)</td>
<td>MAX(Value1, Value2, Value3, etc.)</td>
<td>If you have an if statement similar to the following example: IF(A&gt;B,A,B), you may want to use the MAX operator.</td>
</tr>
</tbody>
</table>

Table 24. Formula operators
Table 24. Formula operators  (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIN()</td>
<td>This will take the minimum value of a set of results.</td>
<td>If 5% commission is paid on each deal to a maximum of $100, the following formula will pay either 5% commission or $100, whichever is less:</td>
<td>MIN(Data.Value*0.05 , 100)</td>
<td>MIN(Value1, Value2, Value3, etc.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MIN can also be used on a single value to be used as an aggregate function (like SUM, AVG, COUNT):</td>
<td>MIN(Data.Value)</td>
<td></td>
</tr>
<tr>
<td>AVG()</td>
<td>This will take the average of the value within the brackets.</td>
<td>If a product has a set price, but sales reps can sell above or below this price, the following formula will compare their average monthly sale value to the set price and pay commission based on their gross margin:</td>
<td>(AVG Sale - Set Price)/ Set Price</td>
<td>AVG(Value)</td>
</tr>
<tr>
<td>IF()</td>
<td>You can use this operator to perform a logical test and provide a true and false result.</td>
<td>If the sale amount is greater than $100, you will receive a 5% commission, otherwise you will receive a 2% commission.</td>
<td>IF(Data.Value &gt; 100, Data.Value * 0.05, Data.Value * 0.02)</td>
<td>IF(Logical Test, True Result, False Result)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Nested IF() Example</td>
<td>IF(Data.Value &gt; 100, Data.Value * 0.05, IF(Data.Value &gt; 50, Data.Value * 0.03, Data.Value * 0.02))</td>
<td></td>
</tr>
<tr>
<td>ISEMPTY()</td>
<td>This will take a Date or Numeric field and provide a true result if the field does not have a value (i.e. the equivalent of NULL in the database).</td>
<td>If(IsEmpty(Payee.DateOfHire), DefaultDate, Payee.DateOfHire)</td>
<td>ISEMPTY (Value)</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>AND()</td>
<td>This will return results if all conditions are true. If you use the AND operator to return results for Logical Test 1 AND Logical Test 2, results that include both Value 1 and Value 2 will be returned.</td>
<td>If you only want to show results for transactions that are bigger than $1,000 and less than $10,000, use a formula similar to the following example: AND(SourceTable.ValueColumn &gt; 1000, SourceTable.ValueColumn &lt; 10000)</td>
<td>AND(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td>OR()</td>
<td>This will return results if one or more conditions are true. If you use the OR operator to return results for Logical Test 1 OR Logical Test 2, any records with either value will be returned.</td>
<td>If you want to show a result of 1 for values that fall between 10,000 and 20,000 and a result of zero for all other values, use a formula similar to the following example: IF(OR(SourceTable.ValueColumn &lt; 10000, SourceTable.ValueColumn &gt; 20000),0,1)</td>
<td>OR(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td>NOT()</td>
<td>This will return results when a condition is not met. You can use this function to exclude records from your results.</td>
<td>If you want to apply a 5% commission to all transactions, except when the transaction value is less than $1,000, use a formula similar to the following example: SUM((SourceTable.ValueColumn) *0.05, NOT(SourceTable.ValueColumn &lt; 1000))</td>
<td>NOT(Logical Test)</td>
<td></td>
</tr>
<tr>
<td>ABS()</td>
<td>You can use this operator to take the value within the brackets and show the number as a positive, regardless of whether or not the value within the brackets is positive or negative.</td>
<td>If you want to show the difference between this month's sales and last month's sales as a percentage, but you do not want the percent change to be a negative value, use a formula similar to the following example: ABS(Current - Prior)/Prior</td>
<td>ABS(Value)</td>
<td></td>
</tr>
</tbody>
</table>
Table 24. Formula operators (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND()</td>
<td>This will use Banker’s Rounding to round the results in the brackets. For example: 0.5 will round to 0, but 0.51 will round to 1.</td>
<td>If you want to round your results to the nearest cent, use a formula similar to the following example: ROUND(Result, 2)</td>
<td>ROUND (Value, Decimal Places)</td>
<td>You must specify the value you want to round, then the amount of decimal places you want to round to. Type 0 for a whole number, 1 for one decimal place, 2 for two decimal places, etc.</td>
</tr>
<tr>
<td>ROUND DOWN()</td>
<td>This will round any number down towards zero by the number of decimal places you define in the formula.</td>
<td>If you want to round your results down to two decimal places, use a formula similar to the following example: ROUNDDOWN(Result, 2)</td>
<td>ROUNDDOWN (Source Table.ValueColumn, num_digits)</td>
<td>num_digits in the number of digits to which you want to round the number. If num_digits &gt; 0, then the number is rounded down to the specified number of decimal places. If num_digits = 0, then the number is rounded down to the nearest integer. If num_digits &lt; 0, then the number is rounded down after the decimal point.</td>
</tr>
<tr>
<td>MULT()</td>
<td>This is used to multiply numerous numbers together.</td>
<td>If you wanted to multiply all the values in your data table together, use a formula similar to the following example: MULT(Data.Value)</td>
<td>MULT(Value)</td>
<td></td>
</tr>
</tbody>
</table>
### Table 24. Formula operators (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PREV()</td>
<td>The Prev() operator references to the previous value of the calculation you are modifying along its accumulating partition. This is important any time you have a situation where you need to have explicit access to the previous iteration of the calculation you are modifying in order to come up with the required current period results.</td>
<td>If a minimum of $500 is to be paid each month to each rep but if commissions fall short, they have to be clawed back in subsequent months, use a formula similar to the following example: MAX(0,PREV() + Monthly Minimum.Value - Monthly Sales.Value)</td>
<td>PREV()</td>
<td>PREV does not have any values inserted in the brackets. This function will only work properly if your data only has one row per partition in the calculation table.</td>
</tr>
</tbody>
</table>

| POW()    | This is used to create an exponent. Instead of using A^B for A to the power of B, Cognos Incentive Compensation Management will use the formula POW(A,B). | If you want to calculate the value of a deal which is sold today but paid upon completion in 5 years, use a formula similar to the following example: Present Value = Future Value / (1+Interest Rate)^Term If you will be paid 20,000 in 5 years where the interest rate is 5% the formula would look like this: 20,000 / POW((1+.05),5) | POW(Value, Exponent) | |

#### Define partitions

Partitions define how the results of the calculation are displayed in IBM Cognos Incentive Compensation Management by offering the option of dividing a single calculated result into sub-results.

All column types, except comment columns, can be used to partition calculation results.

For example, your formula might be: Sum(Data.Value) * 0.01 (or 1% of the sum of the amounts in the value column of the data table). If the result of the above formula is 1,000,000 and no partitions are defined, the following data is displayed:

| Amount | 1,000,000 |

---

82 IBM Cognos Incentive Compensation Management Version 8.0.4: Client User Guide
If you partition the calculation by PayeeID, you have results similar to the following table:

*Table 26. Partitioned by PayeeID*

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>150,000</td>
</tr>
<tr>
<td>10002</td>
<td>275,000</td>
</tr>
<tr>
<td>10003</td>
<td>312,000</td>
</tr>
<tr>
<td>10004</td>
<td>363,000</td>
</tr>
</tbody>
</table>

A partition simply replaces a single calculated result with multiple results, equal in total to the original single number. Multiple partitions are also possible, and are frequently required. In the example, imagine partitioning by PayeeID and Date, instead of simply by PayeeID. The result might look something like the following table.

*Table 27. Multiple Partitions*

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2013</td>
<td>90,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2013</td>
<td>50,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2013</td>
<td>10,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 1, 2013</td>
<td>85,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 2, 2013</td>
<td>95,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 3, 2013</td>
<td>60,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 4, 2013</td>
<td>35,000</td>
</tr>
</tbody>
</table>

**Important:** Each compensation plan requires results to be partitioned by payee and by period. If a calculation result does not include a payee and date, Cognos Incentive Compensation Management is unable to calculate compensation. As a result, partitioning is required for calculations within compensation plans.

**Including empty partitions**

You can choose to have the IBM Cognos Incentive Compensation Management Calculation Wizard display a result of zero in all empty partitions.

Sometimes a calculated result partition will be empty. For example, payee 10001 might only have generated sales results for periods one, two, and three in 2007. Under this circumstance, no result will be generated for periods four and up, and typically this is fine.

There are, however, situations when you want to insist a result is calculated for each payee and period within a given plan, even if that result is zero. For example, consider a situation where you want to calculate compensation for each payee by:

- Totaling their sales for a period
- Subtracting their discounts
- Paying 5% commission on the net value

Imagine that you calculated the following results for payee 10001:
Table 28. Sales by period

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2009</td>
<td>90,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2009</td>
<td>50,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2009</td>
<td>10,000</td>
</tr>
</tbody>
</table>

Table 29. Discounts by period

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2009</td>
<td>7,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2009</td>
<td>2,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2009</td>
<td>1,500</td>
</tr>
<tr>
<td>10001</td>
<td>Period 4, 2009</td>
<td>1,950</td>
</tr>
</tbody>
</table>

In order to complete this calculation, Cognos Incentive Compensation Management requires results for each period. The net results for period four cannot be calculated since there are no values in the first calculation that correspond to this period.

You can opt to Include Empty Partitions on the partitions step. This adds an additional prompt and indicates that zeros should be added to any empty results. In the example shown, payees and periods would then be extended to include zeros in partitions that would otherwise be empty.

**Accumulating partitioning**

You can use the accumulating partitioning option to display an accumulated total of results in IBM Cognos Incentive Compensation Management, for example, the year-to-date value of transactions for each payee rather than the individual value of each transaction.

With regular partitioning, the results reset at every partition. If you want each result to show an accumulated value, select the Accumulating Partitioning option on the define partitions step.

Table 30. Results with accumulating value

<table>
<thead>
<tr>
<th>Time</th>
<th>PayeeID</th>
<th>ProductID</th>
<th>Partition Value</th>
<th>Accumulating Partitioning Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month 1</td>
<td>A250</td>
<td>Product A</td>
<td>175</td>
<td>175</td>
</tr>
<tr>
<td>Month 2</td>
<td>A250</td>
<td>Product D</td>
<td>150</td>
<td>325</td>
</tr>
<tr>
<td>Month 3</td>
<td>A250</td>
<td>Product C</td>
<td>125</td>
<td>450</td>
</tr>
<tr>
<td>Month 4</td>
<td>A250</td>
<td>Product F</td>
<td>175</td>
<td>625</td>
</tr>
<tr>
<td>Month 5</td>
<td>A250</td>
<td>Product B</td>
<td>119</td>
<td>735</td>
</tr>
<tr>
<td>Month 6</td>
<td>A250</td>
<td>Product A</td>
<td>250</td>
<td>985</td>
</tr>
<tr>
<td>Month 7</td>
<td>A250</td>
<td>Product B</td>
<td>500</td>
<td>1,485</td>
</tr>
<tr>
<td>Month 8</td>
<td>A250</td>
<td>Product C</td>
<td>135</td>
<td>1,620</td>
</tr>
<tr>
<td>Month 9</td>
<td>A250</td>
<td>Product A</td>
<td>125</td>
<td>1,745</td>
</tr>
<tr>
<td>Month 10</td>
<td>A250</td>
<td>Product E</td>
<td>100</td>
<td>1,845</td>
</tr>
</tbody>
</table>
Defining partitions in a calculation

In IBM Cognos Incentive Compensation Management, you can divide your calculated results into sub-results based on columns selected from the data source.

Procedure

1. In the Define Partitions step of the Calculation Wizard, drag the columns from the data sources to the Define Partitions pane.
2. If you select a date column as a partition, the Partition By window is displayed.
   a. Select the Calendar to use for the partition.
   b. Select the time interval to group by from the Calculation drop-down.
   c. Select when to reset the accumulated values to zero from the Accumulate drop-down.
   d. You can also select a starting and ending date for the partition.
3. To change the order of the partitions, drag the partitions in the Define Partitions pane and place them in the order you want.
4. To set accumulating partitioning, click the drop-down arrow next to the Preview button and select Accumulating Partitions.
5. To include empty partitions in the results, click the drop-down arrow next to the Preview button and select Include Empty Partitions.

Define restrictions

In IBM Cognos Incentive Compensation Management, restrictions provide the ability to exclude certain records from the calculation.

You may not want your calculation results to either include every record in the source data table or all of the results from a prior calculation.

By defining a restriction, you can limit the records included in the calculation by specifying conditions for their selection. For example, sales that include product 2 or transactions that exceed $50,000 and are sold to a customer in New York are examples of the types of restrictions you can impose to define the records that are included in your calculated results.

Each restriction will require you to define a data source, an operator, and a value to determine if the restriction should be applied. The following operators are available when defining restrictions:

- `=` (equals)
- `<>` (does not equal)
- `<` (is less than)
- `>` (is greater than)
- `<=` (is less than or equal to)
- `>=` (is greater than or equal to)
- `is empty`
- `is not empty`

Restrictions can be defined based on both individual values and calculation sources. For example,

Value: PayeeID = 1234
Defining a restriction for a calculation

In IBM Cognos Incentive Compensation Management, you can restrict the calculation to show specific results.

For example, you can restrict a calculation to only show sales of a specific product for each month.

Procedure

1. In the Define Restrictions step of the Calculation Wizard, right-click in the Define Restrictions pane and select Add New Restriction, or drag a column from the data source to the Define Restrictions pane.

   Tip: Pick list columns are denoted by a folder icon in the Data Source pane. You can double-click the folder icon to access the columns of the pick listed table.

2. Drag the column that you want to restrict from the data source to the first restriction field in the Define Restrictions pane.

   For example, drag the ProductID column.

   a. If the column is a pick list, a drop-down menu will display the columns from the pick listed table. You can select any column from the pick listed table for your restriction.

   For example, select the ProductID.Name field.

3. Select an operator from the drop-down list.

   For example, select the equal operator.

4. To select a value from the selected column to define the restriction, click the drop-down arrow in the second restriction field.

   For example, select the equal operator.

5. To select another column from a data source to define the restriction, drag the column from the Data Source pane to the second restriction field in the Define Restrictions pane.

Deleting a restriction

Restrictions can be removed after they have been created in the IBM Cognos Incentive Compensation Management Calculation Wizard.

Procedure

1. In step 5 of the Calculation Wizard, select the restriction in the Define Restrictions pane.

2. Right-click the restriction and select Delete Selected.

Defining multiple restrictions using AND or OR groups

If you need to get two sets of results in one IBM Cognos Incentive Compensation Management calculation, you can use OR within AND restrictions.

For example, you can show all data that is either Product ID 001 and Payee ID Huddle OR all data that is Payee ID 001 and Payee ID Young.

AND Groups

When multiple restrictions are defined, they will be separated with an AND operator by default. For example, if you define the following restrictions, you get results for payee ID 1234 in January:
Payee ID = 1234
Month = January

**OR Groups**
You can use Any groups to define the following type of restriction: Payee ID = 1234 OR Payee ID = 3456.

**Adding an AND or OR group**
You can define multiple restrictions for your IBM Cognos Incentive Compensation Management calculation results by adding AND or OR groups.

**Procedure**
1. In the Define Restrictions step of the Calculation Wizard, right-click and select Add AND or Add OR.
2. Select the AND or OR group, right-click, and select Add New Restriction.
3. Define the restriction.

**Creating a user-defined calculation**
In IBM Cognos Incentive Compensation Management, you can create a user-defined calculation to perform mathematical operations on data.

**Before you begin**
Before creating a calculation, make sure to analyze the business requirement to determine the data you need to perform the calculation, the formula you need to apply to the data, how you need to group the results, and whether you need to exclude any data.

**Procedure**
1. To create a calculation, perform one of the following steps:
   - Drag the Calculation element onto the Composer window.
   - Right-click and select Add Calculation.
2. Type a name for the calculation, select User-Defined Calculation as the calculation type, and type a description for the calculation.
3. Click Next.
4. Drag a source from the Available Sources pane into the Add Data Source pane.
   - **Important:** You can use the Search field to find a specific source in the Available Sources window.
5. To join another source, click-and-drag a second source into the Add Data Source pane.
6. Define restrictions for the join.
7. Click Next.
8. Drag columns from the Data Source pane into the Define Formula pane to create your calculation.
9. Click Next.
10. Drag columns from the Data Source pane to the Define Partitions pane of the window to define the partitions.
a. To include empty partitions, click the drop-down menu next to the Preview button and select Include Empty Partitions.
b. To include accumulating partitioning, click drop-down menu next to the Preview button and select Accumulating Partitions.

11. Click Next.

12. To add a restriction, right-click in the Define Restrictions pane and select Add New Restriction.
   a. Drag a column from the Data Source pane to the first empty restriction field.
   b. Select an operator for the restriction from the Operator drop-down menu.
   c. To restrict results by a value in the selected column, click the drop-down menu in the second restriction field.
      For example, you can restrict results to only include payees whose job title is Account Executive (TitleID = AE).
   d. To add a second source column to create the restriction, drag the column you want from the Data Source pane to the second restriction field.

13. To use an OR operator to separate your restrictions, right-click in the Define Restrictions pane and select Add OR.

14. You can continue to define more restrictions.

15. When you are finished adding restrictions, click the Preview button to check the calculation.

16. Click Finish.

---

Creating a sort calculation

In IBM Cognos Incentive Compensation Management, data can be organized from lowest to highest or highest to lowest using a sort calculation.

You can also limit the number of results returned after the sort has been applied to produce, for example, a list of top performers.

Procedure

1. To create a calculation, perform one of the following steps:
   • Drag the Calculation element onto the Composer window.
   • Right-click and select Add Calculation.
2. Type a name for the calculation, select Sort as the calculation Type, and type a description for the calculation.
3. Click Next.
4. Drag a table or calculation from the Available Sources pane into the Add Data Source pane.

   Important: You can use the Search field to find a specific source in the Available Sources window.

5. To join another source, drag a second source into the Add Data Source pane and define restrictions for the join.
6. Click Next.
7. Drag a column to sort by from the Data Source pane to the Sort Data pane.
8. Select either the Sort Ascending or Sort Descending option.
9. You can select the Limit to check box and select the number of records per partition.
10. From the **Sequential Ranking** drop-down menu, select the ranking option you want.
   - **Dense Ranking** - ranks ties in the following way: "1,2,2,3".
   - **Sequential (default)** - does not rank ties.
   - **Standard Ranking** - ranks any ties in the following way: "1,2,2,4".

11. Click **Next**.
12. Drag columns from the **Data Source** pane to the **Define Partitions** pane to define partitions for the calculated results.
   For example, if you want to sort the list for each payee, drag the Payee column to the Define Partitions pane.

13. Click **Finish**.

---

### Creating a time shift calculation

In IBM Cognos Incentive Compensation Management, you can create a calculation that offsets the results of another calculation by a specified number of time periods.

This is helpful to compare results from a previous period with those from a current period.

**Procedure**

1. To create a calculation, perform one of the following steps:
   - Drag the **Calculation** element onto the Composer window.
   - Right-click and select **Add Calculation**.
2. Type a name for the calculation, select **Time Shift** as the calculation **Type**, and type a description for the calculation.
3. Click **Next**.
4. Select the calculation you want to time shift from the **Pick a source** drop-down menu.

   **Important:** The Source drop-down menu will list all available calculations in alphabetical order. If you enter the first letter of the data source in the text box, you will be brought to the first source that begins with that letter.

5. Type the number of time periods to shift the calculation or use the minus (-) or plus (+) icons.
6. Click **Next**.
7. To create a starting date for the calculation, select the **Starting** check box and specify the date.
8. To create an ending date for the calculation, select the **Ending** check box and specify the date.
9. Click **Finish**.

---

### Creating a category calculation

In IBM Cognos Incentive Compensation Management, you can use the Category calculation to separate large volumes of transactional data into different groups.

**Procedure**

1. To create a calculation, perform one of the following steps:
   - Right-click and select **Add Calculation**.
• Drag the Calculation element onto the Composer window.

2. Type a name for the calculation, select Category as the calculation Type, and type a description for the calculation.

3. Click Next.

4. Drag a table or calculation from the Available Sources pane into the Add Data Source pane.

   Note: You can use the Search field to find a specific source in the Available Sources window.

5. To join another source, drag a second source into the Add Data Source pane, and define restrictions for the join.

6. Click Next.

7. If you have selected a calculation with a time partition as the source, you must define the start and end dates of the calculation then click Next.

8. To create a category, click Add, and type a category name for the new category.

9. To define a set of restrictions for the category, select the category.
   a. In the restrictions pane at the bottom of the window, right-click and select Add New Restriction.
   b. Drag columns from the Data Sources pane to the fields in the Define Restrictions pane to create the restriction for the category.

   Important: If a category has no restrictions, every row that does not fall into a higher ordered category will be placed in the category with no restrictions.

10. To import categories and their restrictions from a Microsoft Excel or Text file, click Import.

   Important: Before importing or exporting using a Text file, you must change the default Import Escape Character in the Administrative Options window from a quotation mark (") to another symbol that is not used in your category restrictions, such as a tilde (~), in order for the import or export to be successful.
   a. Select either Microsoft Excel or Text as the file type to import and click Next.
   b. Click Browse and select the Microsoft Excel or Text file to import.
   c. If the first row of the file contains a header, select The first record is a header check box.
   d. If you selected Microsoft Excel file, select the worksheet from the drop-down menu.
   e. Click Select to choose the cell range to import, and then click Confirm.
   f. If you selected Text file, select the Fields delimited by character.
   g. If you want the selected categories to replace existing ones, select the Overwrite existing categories check box.
   h. Click Finish.

   Important: If you are using Microsoft Excel 2003, you will not be able to import from a Microsoft Excel file with a cell that contains more than 255 characters.

11. To change the order of the categories, select a category and drag it to the position you want on the list.
Important: The order of the categories is important. If a row falls into two categories, it will be categorized by whichever category is higher on the list.

12. To export all categories and their restrictions to a Microsoft Excel or Text file, click **Export**.
   a. Select either Microsoft Excel or Text as the file type to export.
   b. If you selected Text, click **Next**.
   c. Select the **Delimiter** and click **Finish**.

13. When you have created and defined all the categories, click **Next**.

14. Define any restrictions to filter the final results.

15. Click **Finish**.

   **Important:** When viewing current values or previewing the Category calculation, rows that do not fall into any category will not be displayed in the results.

**Copying and pasting categories in a category calculation**

You can copy and paste previously created categories in the IBM Cognos Incentive Compensation Management Calculation Wizard.

If you need to create a large number of categories you can edit a copied category as opposed to creating a new one.

**Procedure**

1. Navigate to the Define Categories step in the Calculation Wizard.
2. Select a category to copy, right-click, and select **Copy**.

   **Tip:** You can use Ctrl+click or Shift+click to select multiple categories to copy.

3. Right-click in the Category window and select **Paste**.
Chapter 9. Working with calculations

You can right-click any calculation to preview, view the current values, view history, see a list of compensation plans, tailored reports, or Presenter reports that use the calculation, and modify the calculation in IBM Cognos Incentive Compensation Management.

Previewing a calculation
In IBM Cognos Incentive Compensation Management, you can generate results for the calculation that include any edits made since the last save.

You can examine the results generated by any changes you have made prior to running a calculation.

Procedure
1. In Composer, right-click the calculation you want to preview.
2. Select Preview.
   If the Show warning when previewing calculations check box has been selected in the Administrative Options window, a warning message is displayed.
3. Click OK.
   A table displaying only the top 100 rows of calculation data opens in a new tab.

Viewing current calculation values
In IBM Cognos Incentive Compensation Management, the current values are the values as of the last calculation.

This option shows results of any changes made since the last time the calculation was calculated, but you can view the current calculated results.

Procedure
1. In Composer, right-click the calculation of which you want to view the current values.
2. Select View Current Values.
   A table displaying the current values of the calculation opens in a new tab.

Filtering calculation data
In IBM Cognos Incentive Compensation Management, when previewing or viewing calculations, you can optionally filter the results.

Important: When you preview a calculation only the first thousand rows are displayed. If you filter the results, only the first thousand rows that are displayed will be filtered. To filter all the calculation results, use the View Current Values feature.
**Procedure**

1. When previewing or viewing calculations, click the filter icon in the column header.
2. Set filter parameters. You can filter results based on a range of values or by a specific value.
3. Click **Filter**. You can choose multiple columns to filter results by.

**Viewing calculation history**

Each time a calculation is edited in IBM Cognos Incentive Compensation Management, the user who changed the calculation, the date and time the calculation was edited, and the type of change that was made is added to the calculation history viewer.

These changes are recorded regardless of whether or not the calculation is locked.

**Procedure**

1. Right-click a calculation and select **View History**.
2. Double-click the row entry of a version of the calculation to view the details of the calculation at the time the change was made.

**Viewing sources that use the calculation**

In IBM Cognos Incentive Compensation Management, you can view the calculations, compensation plans, Presenter reports, and tailored reports that use the calculation as a source.

**Procedure**

1. To show only the calculation and the objects that use the calculation as a source in the Composer window, perform one of the following steps:
   - Right-click the calculation and select **View > Used By Tree**.
   - Select the calculation and click the **Used By** icon.
2. To show all the objects on the Composer window again, perform one of the following steps:
   - Right-click a blank area in Composer and select **View > All**.
   - Click the **All** icon in the Composer toolbar.

**Viewing sources the calculation uses**

In IBM Cognos Incentive Compensation Management, you can view the sources that the calculation is using.

**Procedure**

1. To show only the calculation and the sources it uses on the Composer window, perform one of the following steps:
   - Right-click the calculation and select **View > Uses Tree**.
   - Select the calculation and click the **Uses** icon.
2. To show all the elements on the Composer window again, perform one of the following steps:
   - Right-click a blank area in Composer and select **View All**.
• Click the View All icon in the Composer toolbar.

**Viewing a calculation description**

Descriptions added to calculations can be viewed from the IBM Cognos Incentive Compensation Management Composer window.

**Procedure**

In Composer, hover your mouse over the calculation. The name of the calculation displays in bold along with the description.

**Editing calculations**

In IBM Cognos Incentive Compensation Management, you can modify a calculation after it has been created; however, you will not be able to modify the calculation type.

**Procedure**

1. In Composer, right-click the calculation you want to modify.
3. Make the necessary changes in the Calculation Wizard.
4. Click Finish to save the changes.

**Editing locked calculations**

When a calculation uses a source that is associated with a locked calendar in IBM Cognos Incentive Compensation Management, you can edit the calculation source, unions or joins, restrictions, and the formula.

You cannot, however, edit the type of calculation and the partitions of the calculation, or add new partitions, or delete partitions.

If you have changed your calculation source, you may need to change your partitions to reference the new source. In this case, you can change the partitions as long as the partition columns are the same in both sources. For example, you can delete a payee partition that references your old source and add a payee partition that references your new source. You cannot delete a payee partition that references your old source and add a product partition that references your new source.

You can never change the calendar accumulation or start date of the time partition of a locked calculation. If you delete a date partition and add a new date partition to reference a new source, the starting date will be in the first unlocked period for the associated calendar.

Formulas for locked calculations can be changed, unless the calculation uses accumulating partitioning. If the Accumulating Partitions option is selected, you will only be able to make changes to arguments of aggregate functions and make changes to the structure of the formulas.

Locked calculation results will not change. Calculation results for any unlocked periods will change to reflect any modifications that have been made to the
calculation. When viewing results in the Payee Ledger on the web client, the results will be displayed seamlessly. Payees will not be able to detect when a change in the calculation was made.

**Copying calculations**

The copy feature in IBM Cognos Incentive Compensation Management will simultaneously copy a selected calculation along with the calculations and tables that it uses or depends upon.

The copied group of calculations then appears in a new element.

**Procedure**

1. In Composer, right-click the calculation to be copied and select **Copy**.
2. Type a **Paste suffix**.
   This ensures that you do not have two calculations with the same name and you can distinguish copied calculations from the originals.
3. Specify the new source by either clicking **Automatch** or by selecting a source.
   You need to map the old sources to the new sources.
4. Click **OK**.
   All connections (if any) stay intact.

**Important**: If any calculations in the selected group are locked, you will be provided with the option of generating new calculations beginning with the first unlocked period and continuing until the end of the calendar.

**Publishing calculations**

In IBM Cognos Incentive Compensation Management, you can use the Publisher feature to publish data from the model directly to a Microsoft Excel file, Microsoft Dynamics CRM database, PDF file, Salesforce.com, or a text file.

**Procedure**

1. In Composer, right-click a calculation element.
2. Select **Publish Calculation**.
3. Select either **Publish to my computer** or **Publish to the server**.
4. If you want to save this publish, type a name in the **Save this publication as** field.
5. Click **Next**.
6. Select how you want to publish the calculation and click **Next**.

**Publishing calculations to a Microsoft Excel file**

You can use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Microsoft Excel file.

**Procedure**

1. In Composer, right-click a calculation element.
2. Select **Publish Calculation**.
3. Select either **Publish to my computer** or **Publish to the server**. If you want to save this publish, type a name in the **Save this publication as** field.
4. Click **Next**.
5. Select Microsoft Excel to publish the calculation and click **Next**.
6. Format the headers and cells and click **Next**.
7. Select where you want to save the file and click **Finish**.

**Publishing calculations to a Microsoft Dynamics CRM database**

You can use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Microsoft Dynamics CRM database.

**Procedure**

1. In Composer, right-click a calculation element.
2. Select **Publish Calculation**.
3. Select either **Publish to my computer** or **Publish to the server**.
4. If you want to save this publish, type a name in the **Save this publication as** field.
5. Click **Next**.
6. Select **Microsoft Dynamics CRM database** to publish the calculation and click **Next**.
7. Type your login credentials.

**Publishing calculations to PDF file**

You can use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a PDF file.

**Procedure**

1. In Composer, right-click a calculation element.
2. Select **Publish Calculation**.
3. Select either **Publish to my computer** or **Publish to the server**.
4. If you want to save this publish, type a name in the **Save this publication as** field.
5. Click **Next**.
6. Select **Portable Document Format** to publish the calculation and click **Next**.
7. Select **Orientation and Scaling** options.
8. Select the **Use header image** check box if you want an image displayed as the header on each PDF file and click **Browse** to locate the file.
9. Select the **Include page numbers** check box to show page numbers in the footer.
   a. You can also select the **Show total page number** check box and type a footer.
10. Click **Next**.
11. Format the headers and cells and click **Next**.
12. Select where you want to save the PDF file and click **Finish**.

**Publishing calculations to Salesforce.com**

You can use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a Salesforce.com file.
Procedure
1. In Composer, right-click a calculation element.
2. Select Publish Calculation.
3. Select either Publish to my computer or Publish to the server.
4. If you want to save this publish, type a name in the Save this publication as field.
5. Click Next.
6. Select Salesforce.com to publish the calculation and click Next.
7. Type your user name, password, and security token for Salesforce.com.

Publishing calculations to a text file
You can use the Publisher feature to publish data from the IBM Cognos Incentive Compensation Management model directly to a text file.

Procedure
1. In Composer, right-click a calculation element.
2. Select Publish Calculation.
3. Select either Publish to my computer or Publish to the server.
4. If you want to save this publish, type a name in the Save this publication as field.
5. Click Next.
6. Select text file to publish the calculation and click Next.
7. Select a delimiter and click Next.
8. Select where you want to save the file and click Finish.
Chapter 10. Draws

In IBM Cognos Incentive Compensation Management, a draw is a guaranteed minimum compensation payment that is paid in advance of performance.

For example, if the draw amount is $2000, but the payee's earnings are $1000, $2000 will still be paid to the payee because the draw amount is guaranteed. On the other hand, if the payee's earnings are higher than the draw amount, they will receive the full amount of their earnings.

There are two types of draws: recoverable and non-recoverable.

**Recoverable Draw**

If the sales representative's incentive earnings are less than the draw amount, the unearned amount is carried forward to the next performance period and will be recovered by the employer after the earnings amount exceeds the draw amount.

**Non-recoverable Draw**

If the incentive earnings do not exceed the draw amount, the draw balance is not carried forward, and the rep gets to keep the draw.

The following table shows month 1 and 2 results for a guaranteed draw of $2000. Notice that even though the earnings are the same in both months for the recoverable and non-recoverable draw, the payment in month 2 is greater with the non-recoverable draw.

*Table 31. Results for Guaranteed Draw of 2000*

<table>
<thead>
<tr>
<th></th>
<th>Month 1 Earnings</th>
<th>Month 1 Payment</th>
<th>Month 2 Earnings</th>
<th>Month 2 Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recoverable</td>
<td>1000</td>
<td>2000</td>
<td>5000</td>
<td>4000</td>
</tr>
<tr>
<td>Non-recoverable</td>
<td>1000</td>
<td>2000</td>
<td>5000</td>
<td>5000</td>
</tr>
</tbody>
</table>

Creating a draw

Draws are added in the IBM Cognos Incentive Compensation Management Client, and then enabled for the web client where managers can assign payees to appropriate draws and view pre-configured draw reports.

At a high level, these are the steps that need to be taken to define a draw, assign payees to the draw and view draw reports.

**Procedure**

1. In Composer, create a draw and draw templates.
   A draw is a container that holds one or many templates. Templates define the terms of the draw such as draw type (recoverable, non-recoverable), amount, and effective time period.

2. In **Portal Access > Web Tabs**, create web tabs for Draw Assignment and Draw Reports.

3. In **Portal Access > Assignment**, define report and assignment access for each draw by selecting the appropriate access tree.
4. In the web client, select the **Draw Assignment** tab to assign payees to the appropriate draw template.

5. In the web client, select the **Draw Report** tab to view pre-configured draw reports.

**Adding a draw in Composer**

Using draws begins with defining the draw in the IBM Cognos Incentive Compensation Management Composer module.

The following steps demonstrate how to add a draw at a high level.

**Procedure**

1. Add a **Draw** object to house draw templates.
2. Select the **Effective Date Column** to use as a source for the draw.
   The table used is the Payee table that contains the payee ID for each payee that will be assigned to the draw and the draw start date for each payee.
3. Select the **Earnings** calculation to use as a source for the draw.
4. Create one or more draw **Templates**.
   Templates define the terms of the draw such as draw type, amount, and time period.

**Adding a draw object**

A draw is an IBM Cognos Incentive Compensation Management Composer object that can hold one or more draw templates.

This needs to be added to Composer before the terms of the draw can be defined.

**Procedure**

1. Right-click in a Composer component and select **Add Draw** or drag the **Draw** object from the **Palette** tab of the Composer sidebar.
2. Give the draw a **Name**.
   All draws must have a unique name.
3. Define the **Calendar** for the draw.
   This is the same calendar that is used by the earnings calculation that draw payments are based on.

   **Important:** Only one calendar and period partition can be associated with each draw.
4. Select the time **Earnings Period** to partition the draw results by.
   This is the same as the draw earnings calculation time partition.
5. Select the **Draw Start Date** column from the Payee table that contains the draw start date for each payee.
   The **Draw Start Date** source for the draw is the Payee table and will automatically be connected to the draw. In order for a payee to be assigned to a draw, the date in the **Draw Start Date** column needs to be in an open period.

   **Tip:** Add a Draw Start Date column to the Payee table to house start dates for draws and do not use the Date of Hire column. You can change the draw that a payee is assigned to, if necessary, without having to change the date of hire.
Selecting a draw calculation

After a draw object has been added to the IBM Cognos Incentive Compensation Management Composer module, a calculation needs to be connected to the Earnings input port of the draw.

About this task

This calculation needs to contain earnings results, prior to a draw being applied, for all the payees that will be assigned to the draw. The time partition in the calculation needs to be the same as the time period selected when the draw was added. For example, you may want to apply a draw to the earnings of a monthly commission calculation.

Procedure

1. Turn on Link mode in Composer.
2. Drag the output port from the calculation to the Earnings input port of the draw.
   - If Cognos Incentive Compensation Management cannot automatically match the columns in the source to the Earnings input port, the Connection Wizard will be displayed.
3. Drag the columns from the calculation source to the appropriate draw fields.
   - The Automatch button can be used if the column names are the same in both the draw and the calculation. Your earnings calculation must have a payee, time period, and value column.

Adding a draw template

After adding a draw in the IBM Cognos Incentive Compensation Management Composer module, templates can be added to the draw.

Templates define the terms of the draw such as draw type, draw amount and effective time period. There is no limit to the number of templates that can be added to each draw.

Procedure

1. Double-click the draw or right-click and select Manage Templates.
2. Click Add to add a new template.
   - There is no limit to the number of templates that can be added.
3. Give the template a descriptive Name.
4. Select the Draw Type.
   - Recoverable Draw - If the sales representative’s incentive earnings are less than the draw amount, the unearned balance is carried forward to the next performance period and will be recovered by the employer once the earnings amount exceeds the draw amount.
   - Non-recoverable Draw - If the incentive earnings do not exceed the draw amount, the draw balance is not carried forward, and the rep gets to keep the draw.
5. Add a description to explain the terms of the draw and click Next.
6. Select the duration of the draw.
   - For fixed term draws, the number of periods needs to be selected. The length of each period is determined by its granularity.
- **Ongoing** - An ongoing draw has no set end date. Draw payment amounts will be calculated for all the open periods in the draw calculation.

- **Fixed-term** - A fixed-term draw will calculate draw payments for a predefined number of periods. If the Fixed box is unchecked the number of periods can be increased via the web client up to the number of periods entered in the max field.

**Important**: The number of periods selected for a fixed term template cannot exceed the number of open periods in the calendar for the selected granularity. For example, if the duration is four periods and the granularity selected is quarters, there needs to be four open quarters in the calendar.

7. Define the output draw period of the draw.
   This can be any time period in the calendar associated with the draw. The draw period defines the output of the draw results: if the draw period is Months, the draw template output port will be partitioned by months.

8. Select either **Flat Amount** or **Schedule** for the **Draw Amount**.
   A flat amount means that the draw payment is the same for each period in the draw. A scheduled amount means that different draw amounts can be paid for each period in a fixed term draw.
   - **Flat Amount** - If Flat Amount is selected, enter the amount of the draw. This amount will be the fixed draw payment for the duration of the draw. If the Fixed box is unchecked, the draw amount can be changed in the Web Client to any amount that does not exceed the amount entered in the max: field.
   - **Schedule** - You can select Schedule to enter a different draw amount for each period in the draw. This option is only available for fixed term draws.

9. If you selected Schedule, click **Edit** and type a draw amount for each period in the schedule.

10. You can type the draw amount in the **Set an amount for each period** field. This is useful if the majority of the periods in your schedule will have the same draw amount.

11. Unselect the **Fixed** check box if you want web users to be able to increase the number of periods via the web client. The number of periods can be increased to the number set in the **Max** field.

### Editing the draw name and earnings period

After a draw has been created in the IBM Cognos Incentive Compensation Management Composer module, only its name and the draw start date column can be changed; the calendar and period length cannot be changed.

**Procedure**

1. Select the draw, right-click and select **Edit**.
2. Change the **Name** of the draw and the **Draw Start Date** column and click **OK**.
   The **Draw Start Date** is the column in the Payee table that contains the draw start date for each payee.

### Copying and pasting a draw

Draws can be copied and pasted and sources can be remapped in the IBM Cognos Incentive Compensation Management Composer module.

Any draw templates are copied along with the draw structure.
**Procedure**
1. Right-click a draw and select **Copy**.
2. In the component where you want to paste the copied draw, right-click and select **Paste**.
3. Drag the input earnings calculation from the **Sources** list to the **New Source** column.
   The **Automatch** button can be used to map the exact same sources.

**Important:** You can use different input sources for the copied draw as long as the column names and type are exactly the same in both the original draw and copied draw.

**Deleting draw connections**
After a draw connection has been added in the IBM Cognos Incentive Compensation Management Composer module, it is not possible to view or edit the details of the connection.

If you are unsure whether you have used the correct source or columns for the draw input, it is best to delete the connection and recreate the connection.

**Procedure**
1. Turn on **Link** mode in Composer.
2. Select the connection to delete and press the Delete key on your keyboard.

**Editing draw templates**
After a template has been created in IBM Cognos Incentive Compensation Management, its name can be changed, it can be copied with a new name, or it can be deleted.

**Procedure**
1. Double-click the draw or right-click and select **Manage Templates**.
2. Select a template and click either **Edit**, **Copy** or **Delete**.

**Editing a draw template name**
In IBM Cognos Incentive Compensation Management, the only part of a template that can be edited is its name.

**Procedure**
1. Double-click the draw or right-click and select **Manage Templates**.
2. Select a template and click **Edit**.
3. Change the name of the template and click **Next**.
4. If your template has a scheduled draw amount, you can click **View** to review the details of the schedule.

**Copying a draw template**
In IBM Cognos Incentive Compensation Management, you can copy a draw template.

**Procedure**
1. Double-click the draw or right-click and select **Manage Templates**.
2. Select a template and click **Copy**.
3. Provide a unique name for the copied template.
4. Draw Type, Description, Duration, Granularity, and Draw Amount fields can be changed if necessary.

**Draw web tab settings**

After a draw has been created, settings for the Draw Assignment and Draw Report tabs in the web client need to be defined in both the IBM Cognos Incentive Compensation Management Composer and Portal Access modules.

**Defining draw assignment web tab settings**

In IBM Cognos Incentive Compensation Management, you can define draw assignment web tab settings

**Procedure**

1. Right-click the draw and select Draw Assignment Web Tab Settings.
2. Define which payees are visible to the web user in the Draw Assignment tab.
   - **Use Portal Access Hierarchy** - There are two groups of users that need to be defined for draws; users who assign other payees to draws and view draw reports and users who are assigned to draws. If you select the Use Portal Access Hierarchy option, both groups of users will be determined in Portal Access by assigning a two-level tree to the draw. The members of the first level of the Portal Access tree would be allowed to assign users in the last group to the draw.
   - **Allow group selection** - Selecting the Allow group selection check box will allow web users to filter based on Portal Access group. This means that when viewing the Draw Assignments tab in the web client, the user can view and edit the assignment of a selected payee or all payees in a selected group.
   - **Define Restrictions** - If you select the Define Restrictions option, users who can be assigned to draws are determined by creating restrictions on the Payee table. For example, if all Account Executives are eligible to be assigned to a draw, you can determine that all payees with the Account Executive job title should be listed in the web client by creating the appropriate restriction on this window. Users specified here will not be able to view the Draw Assignments tab.

   **Important:** Users who can assign payees to draws and view draw reports are then granted access via Portal Access. This is done by creating a one level access tree in Portal Access that contains all web users that can create draw assignments. All users who are granted access to the draw assignment window through Portal Access will be able to assign the payees defined in the Define Restrictions section to this draw.

3. The number selected in the Rows per page field determines the number of rows that will be displayed on each page of the Draw Assignment web tab.
4. The Numeric Style selected determines the web client value display.

**Defining draw report web tab settings**

In IBM Cognos Incentive Compensation Management, you can determine the look and feel of certain elements in the draw report.

You can opt to add a logo to the report, change the color of report headers and define the number of rows to display per page.
Procedure
1. Right-click the draw and select **Draw Report Web Tab Settings**.
2. Browse for an image if you want a logo displayed on the report in the Draw Report tab.
3. Click the box in the **Color scheme** field to select a color for the Draw Report headers. The selected color is used for the draw reports in the web client.
4. Select the **Allow group selection** check box to let web users filter based on Portal Access group. This means that when viewing the Draw Assignments tab, the user can view or edit the assignment of a selected payee or all payees in a selected Portal Access group.
5. The number selected in the **Rows per page** field determines the number of report rows that will be displayed on each page in the web client. By default, 25 rows per page is displayed.
6. Select the **Numeric Style** of the values displayed in the report.

Creating web tabs for draw assignment and draw reports
After draws have been created in the Cognos Incentive Compensation Management Composer module, web tabs need to be created in Portal Access so draw assignments and draw reports can be accessible via the web client.

About this task
To be able to assign payees to the draw, a Draw Assignment type tab needs to be added via Portal Access. In order for users to view pre-configured draw reports, a Draw Report web tab type needs to be added via Portal Access.

Once draw assignment and report tabs have been created and appropriate access defined on the Assignment tab in Portal Access, users can access them via the web client.

Procedure
1. In **Portal Access > Web Tabs**, right-click and select **Add Web Tab** or click the **Add** button on the toolbar.
2. Give your web tab a name. This is displayed as the label of the tab in the web client.
3. Select a tab **Type** from the first drop-down menu and the draw name from the second drop-down menu.
   - **Draw Assignment** - selected payees can be assigned to the draw.
   - **Draw Report** - authorized users can pre-configure draw reports. This includes an overview, draw assignment report, YTD payouts, and payout by period.

Defining web access for draw report and assignment tabs
Access to the contents of each draw report and draw assignment tab needs to be defined on the Assignment tab in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In **Portal Access**, open the Assignment tab.
2. Select the Draw Assignment or Draw Report that should be enabled for the 
web client.
3. In the **Access** column, select the appropriate access tree from the drop-down 
menu.

**Important:** Sign off and inquiry functionality is not available for draws so you 
do not need to assign trees for those categories.

---

**Assigning payees to draws in the web client**

After a draw has been defined in the IBM Cognos Incentive Compensation 
Management Client and appropriate access has been granted, authorized web users 
can assign payees to draws and view reports.

**Assigning payees to draw templates**

You can assign payees to draw templates on the draw assignment tab in the IBM 
Cognos Incentive Compensation Management web client.

**Procedure**

1. Select the draw assignment tab in the web client.
2. Select the **Unassigned** sub-tab.
   - All payees that have not yet been assigned to a draw are listed here.
3. To populate the list with available payees, select a specific payee, a Portal 
   Access group or all from the drop-down menu and click **Apply**.
4. Select the draw template that you want to add payees to.
5. Select the check box for each payee that you want to add to the selected draw 
   template.
   - The check box in the header will select all payees displayed on the page.
6. Click the **Apply** button to assign payees to the selected template, then click 
   **Save**.

**Important:** If there are multiple pages of eligible payees, draw assignments 
need to be done separately for each page. Using the check box in the header to 
select all payees, will only select payees on the page that is displayed.

---

**Viewing and editing draw assignments for payees on fixed 
term draws**

You can view or edit draw assignments for payees on fixed term draws from the 
draw assignment tab on the IBM Cognos Incentive Compensation Management 
web client.

**Procedure**

1. To view or edit draw assignments for all employees who have been assigned to 
   fixed-term draws, select the draw assignment tab, then the **Fixed Term** tab.
2. Select an individual payee, a Portal Access group, or all to display payees who 
   have been assigned to a fixed term draw.
3. Use the **Mass Edit** section to change the draw start date, amount paid for each 
   period, and the amount of periods in the draw for all payees listed.
   a. Make changes in the **Mass Edit** section.
   b. Select employees that changes should be applied to by selecting the check 
      box for each payee's name.
c. Click **Apply** and **Save**.

4. Changes can also be made for individual payees by making changes directly to individual rows.
   a. Make changes for an individual payee.
   b. Click **Apply** and **Save**.

    **Important:** A setting selected at the time of the draw template creation determines if the number of periods in the draw or the draw amount can be modified here.

**Viewing or editing draw assignments for payees on ongoing draws**

You can view or edit draw assignments for payees on ongoing draws from the draw assignment tab in the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. To view or edit draw assignments for all employees who have been assigned to ongoing draws, select the draw assignment tab, then the **Ongoing** tab.
2. Select an individual payee, a Portal Access group, or all to display payees who have been assigned to an ongoing draw.
3. Select an individual payee, a Portal Access group, or all to display payees who have been assigned to an ongoing draw.
4. Use the **Mass Edit** section to change the draw start date and the amount paid for all payees selected.
   a. Make changes in the **Mass Edit** section.
   b. Select employees that changes should be applied to by selecting the check box for the payee's name.
   c. Click **Apply** and **Save**.

**Unassign payees and hide inactive payees**

You can unassign payees and hide inactive payees on the draw assignments tab in the IBM Cognos Incentive Compensation Management web client.

To unassign payees that have been assigned to a fixed term draw, select the appropriate payee or payees, and click the Unassign button.

Even after unassigning payees, they will still show up in the fixed term list. To hide them from the list, select the Hide inactive payees check box.

**Viewing draw reports in the web client**

You can view draw reports in the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. To view pre-configured draw reports, select the draw report tab.
2. Select an individual payee or a Portal Access group to define the parameters of the report.
3. Select the **Period** to include in the report.
4. Select the draw **Template**.
5. Click **Apply**.
6. Select one of four following report tabs; Overview, Draw Assignments, YTD Payouts, and By Period Payouts.

**Overview report**

The Overview report tab on the IBM Cognos Incentive Compensation Management web client provides graphical representations of the following values; percentage of participants assigned to a draw, percentage of participants carrying a negative balance, average percentage of draw amount paid out by month, and draws paid versus commission expenditures.

**Exporting the overview report to a PDF file**

You can send the overview report to PDF file from the IBM Cognos Incentive Compensation Management web client.

**Procedure**

2. Click the **Generate PDF** icon in the Overview Report.
   
   A PDF of the report displays.
3. View and save the PDF file.

**Draw assignments report**

You can view the draw assignments report from the draw reports tab on the IBM Cognos Incentive Compensation Management web client.

The draw assignments report shows all payees who have been assigned to the selected draw template and their start dates. If a fixed term template is selected, the payee's end date is also displayed.

**YTD payouts report**

The YTD payouts report on the IBM Cognos Incentive Compensation Management web client displays year-to-date amounts for the selected payees and draw template.

**Important:** If a specific period was selected when report parameters were applied, the data displayed in the report will be for the selected period and not the YTD values.

- **YTD Earnings**
  
  These are the YTD earnings based on the earnings source draw input.

- **YTD Draw**
  
  The YTD draw payment. This is the guarantee YTD payout amount less the earnings amount. For example, if the guaranteed YTD payout amount for a payee is $1000 and their YTD earnings are $600, the YTD draw is $400.

- **YTD Balance**
  
  For recoverable draws, this is the amount that is still owed. This column is not displayed for non-recoverable draws.

- **YTD Payout**
  
  This is the total payout to date. YTD Earnings + YTD Draw = YTD Payout.
By period payout report

On the draw reports tab in the IBM Cognos Incentive Compensation Management web client, you can view the By Period Payout report to see the payout amounts for each payee by period.

**Earnings**
These are the calculation earnings for the period prior to a draw being applied.

**Draw**
This is the amount of the draw for the selected period.

**Period Draw**
This is the draw amount paid for the period. This is the guarantee period payout amount less the earnings amount. For example, if the guaranteed period payout amount for a payee is $1000 and their period earnings are $600, the period draw is $400. If the payee’s earnings for the period exceed the draw amount, the period draw will be 0.

**Balance**
For recoverable draws, this is the amount that is still owed. This column is not displayed for non-recoverable draws.

**Payout**
This is the total payout for the period. Earnings + Period Draw = Payout.

Exporting report results to Microsoft Excel

The Draw Assignments, YTD Payouts, and By Period Payouts reports in the IBM Cognos Incentive Compensation Management web client have similar features to Presenter report data grids.

Users can send the reports to Microsoft Excel or choose to show or hide columns in the report.

**Procedure**
1. Hover over the header of the report.
   Notice an arrow is displayed in the header of the final column.
2. Click the arrow.
   A drop-down menu displays.
3. To send the report to Microsoft Excel, select either the .xls or .xlsx icon.
4. To hide a column, select the column.
   A checkmark will no longer be displayed next to the column and it will be hidden on the report.

**Important**: The published report in Microsoft Excel will reflect the shown or hidden columns selected in the web client.
Chapter 11. Data stores

Data stores are IBM Cognos Incentive Compensation Management Composer objects that you can use to join sources, such as tables, calculations, and draw results, into one large repository.

For example, a data store can be used to pull together results required for reporting purposes into one object. The data store can then be used as a source in Presenter to build reports. Reporting users can then easily create reports as all the sources they require will be available in one place. All tables, calculations, and draws within the model can be used as sources in the data store no matter what component the data store is in.

Data stores can be wrapped into components within Composer but are globally visible. Users can then select the data store as a source from anywhere in Composer. Security can also be applied to any data store to give users permission to view, edit, and delete the object.

---

Data store creation

Data stores are created in the IBM Cognos Incentive Compensation Management Composer module and are available as sources in Presenter and Microsoft Excel through the use of the Cognos Incentive Compensation Management add-in for Microsoft Excel.

At a high level, there are five steps involved in creating a data store.
1. Add a data store object in Composer.
2. Join the data sources you want in the data store.
3. Select the detail columns from the added sources that are available to users from the data store.
4. Define any restrictions to the data available to users.
5. Rename the detail columns with meaningful names. The Source wizard is used to create data stores. This wizard contains tabs for each step. You can use the tabs to navigate through the wizard; however, all required fields must be completed before you can finish the wizard.

---

Adding a data store object

A data store is an IBM Cognos Incentive Compensation Management Composer object that can contain multiple data sources joined together.

The data store object needs to be added to Composer before the sources can be selected and joined.

Procedure
1. To add a data store, perform one of the following steps:
   - Drag the Data Store element onto the Composer window.
   - Right-click and select Add Data Store.
2. Type a name for the data store.
   - The data store must have a unique name.
Selecting the sources for the data store

You can add any tables or calculations to the data store in the IBM Cognos Incentive Compensation Management Composer module.

Multiple data sources can be added in a data store by joining columns or by joining rows.

Procedure
1. In the Select Sources step of the Source Wizard, select an initial source from the Source drop-down menu.
2. To add an additional source, click Add.

Joining a source by columns

You can add a source by columns in an IBM Cognos Incentive Compensation Management data store to join together tables or calculations based on a point of commonality.

Procedure
1. In the Select Additional Data window, select the Add Columns option.
2. From the Source drop-down menu, select the source from which you want to add columns.
3. In the Name field, you can rename the source.
4. Click Next.
5. Define restrictions for the join.
   If you do not want to define restrictions, simply click Finish without joining any columns. If you want to define restrictions, perform the following steps:
   a. Drag a column to the restriction definition list.
      You can define the join in the Define Restriction window that is displayed.
      For example, if you want to join the sources based on the PayeeID column, drag the PayeeID column from the left to the right.
   b. In the Define Restriction window, select the operator for the restriction.
      For example, to join the PayeeID columns, select the equal operator.
   c. On the Values or Source tab, drag the value or source to the question mark to finish the restriction.
      For example, to join the PayeeID columns, click-and-drag the PayeeID column from the second source to the question mark.
   d. Click OK.
   e. When you have finished defining restrictions for the join click Finish.

Joining a source by rows

You can join sources by adding table rows from one source to another source in an IBM Cognos Incentive Compensation Management data store.

The columns in the source table should be similar to the columns in the union table as all columns in the source table must be mapped to a column in the union table.

Procedure
1. In the Select Additional Data window, select the Add Rows option.
2. From the Add Rows From drop-down menu, select the source you want to add rows from.
3. Click Next.
4. Click Automatch to map the fields.
   Information from the selected tables will then be mapped over to the original source table. You can also drag the fields to map them.
5. Click Finish.

Creating a left outer join
Use the Anchor Source Rows button in the Select Sources tab to join sources using a left outer join when creating an IBM Cognos Incentive Compensation Management data store.

This join type will display rows for all records of the first data source even if the join does not find matching records in the second data source; however, only matched records from the second data source will be returned.

Procedure
1. On the Select Sources tab of the Source Wizard, join two sources by columns.
   
   Important: Restrictions for the outer join need to be defined during this step and not on the Select Restrictions tab of the Source Wizard.
2. Click the Anchor source rows button.
   The Anchor source rows feature is enabled when the button is blue. When the button is black, the feature is not in use.

Selecting columns for a data store
After you have selected and joined the sources in the IBM Cognos Incentive Compensation Management data store, you must select the columns from the data sources that will be available to users.

Procedure
1. In the Select Columns step of the Source Wizard, drag the columns into the detail column list.
2. To remove a detail column from the list, right-click the column and select Remove Selected.

   Important: You can select up to 50 detail columns in a data store.

Selecting restrictions
A restriction can be defined to limit the records visible to users in the IBM Cognos Incentive Compensation Management data store.

Procedure
1. In the Select Restrictions step of the Source Wizard, drag a column from the left into the restriction definition list on the right.
   You can define the restriction in the window that displays.
2. Select an operator for the restriction from the Operator drop-down menu.
3. To select a value from the selected column to finish the restriction, click the Values tab and drag the value required for the restriction to the question mark above.
4. To select a column from a source to finish the restriction, click the Sources tab and drag the required column from the list to the question mark.

5. Click OK.

6. When you are done defining restrictions for the data store, click Next.

**Naming columns in data stores**

In the last step of creating an IBM Cognos Incentive Compensation Management data store, you can rename the detail columns you selected to give them meaningful names for reporting users.

**Procedure**
1. On the Naming Columns tab of the Source Wizard, highlight the Display Name and type a new name.
2. Click Finish.
   The data store is added to the Composer window.

---

**Data store security**

Access to specific data stores can be granted in the IBM Cognos Incentive Compensation Management Manage Roles window.

Users can be granted permission to view, edit, and delete the data store object in Composer.

**Setting permission for a role to view a data store**

Roles can be granted view-only permission for specific data stores in IBM Cognos Incentive Compensation Management.

Users assigned to the role have permission to add the data store to the Favorites list and view the Uses and Used By trees but they will not have permission to make changes to the data store.

**Procedure**
1. Go to Admin > Manage Roles.
2. Select or add the role you want to grant permission for.
3. Expand Composer.
4. Right-click View and select Grant.
5. If the data store is in a component, also grant view access to the component.
6. Expand Data Stores.
7. Expand the data store you want to grant view permission for.
8. Right-click View and select Grant.

**Setting permission for a role to view and edit a data store**

Roles can be granted permission to view and modify the data store object in the IBM Cognos Incentive Compensation Management Composer module.

Users assigned to the role have the ability to open the Source Wizard and make changes to the data store.
Procedure
1. Go to Admin > Manage Roles.
2. Select or add the role you want to grant permission for.
3. Expand Composer.
4. Right-click View and select Grant.
5. Right-click Edit and select Grant.
6. If the data store is in a component, also grant view and edit permission for the component.
7. Expand Data Stores.
8. Expand the data store you want to grant view and edit permission to.
9. Right-click View and select Grant.
10. Right-click Edit and select Grant.

Setting permission for a role to view and delete a data store
Roles can be granted permission to view and remove the data store object from the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. Go to Admin > Manage Roles.
2. Select or add the role you want to grant permission for.
3. Expand Composer.
4. Right-click View and select Grant.
5. Right-click Edit and select Grant.
6. If the data store is in a component, also grant view and edit permission for the component.
7. Expand Data Stores.
8. Expand the data store you want to grant view and delete permission for.
9. Right-click View and select Grant.
10. Right-click Delete and select Grant.

Importing data from a data store to Microsoft Excel
Records contained in data stores can be imported into Microsoft Excel using the IBM Cognos Incentive Compensation Management add-in for Microsoft Excel.

About this task
For information on installing the Cognos Incentive Compensation Management add-in for Microsoft Excel, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide. After the Cognos Incentive Compensation Management add-in for Microsoft Excel has been installed, you can import data from any data stores created in your model into Microsoft Excel. The data can then be used to create pivot tables, charts, and graphs for reporting purposes. If changes are made to the model, the data in Microsoft Excel can be updated with the most recent data.

Procedure
1. In Microsoft Excel, open the IBM Cognos Incentive Compensation Management tab.
2. Connect to your model by typing the Service Address, the Server, and the Database name.
3. Click Login Information and type the user name and password you use to connect to the Cognos Incentive Compensation Management Client.
4. Click Import Data Store.

    **Important:** You will not be able to import a data store if you are already logged into the Client.
5. Select a data store to import from the drop-down menu.
   The columns available in the data store will be displayed in the Define Restrictions step.
6. Define the restrictions for the data you want to import by clicking-and-dragging columns from the left pane to the right pane.
   a. In the Restriction Wizard, select an operator from the drop-down menu.
   b. Type a value to define the restriction in the **Enter a value** field.
   c. Click **OK**.
7. Click Import Data Store.

**Refreshing data store data in Microsoft Excel**

At any time, users can modify or update the data in Microsoft Excel with the most recent data from the IBM Cognos Incentive Compensation Management database.

If users are opening a previously saved report, they must log in to the model to refresh the data.

**Procedure**

1. On the IBM Cognos Incentive Compensation Management tab in Microsoft Excel, click **Refresh Data Store Import** to update the data.
2. To make changes to the restrictions used in the import, click **Edit Data Store Import**.
Chapter 12. Plans and tailored reports

In the IBM Cognos Incentive Compensation Management Composer module, you can create reports to display compensation results to payees. Use compensation plans to display calculation results related to a payee's compensation.

Tailored reports can be used to analyze compensation results. For example, you may want to view payment amounts segmented by geographic location, or see a compensation report of payees that passed certain thresholds or failed to meet targets.

Compensation plans

Compensation plans are added and edited through the IBM Cognos Incentive Compensation Management Composer module.

The following list outlines the main steps to creating a compensation plan:
1. Define plan parameters – name the plan and specify the start and end dates.
2. Create calculations – select data sources and specify the formula.

   Important: Calculations can be created during the creation of a compensation plan or separately and then added to the plan.
   • Select reporting settings – indicate how you want results to be displayed in Payee Ledger.
3. Specify payment details – for example, the payee group that this compensation plan belongs to, any holds, payment minimums or maximums, and payment accounts.

Associating plans with payee groups

IBM Cognos Incentive Compensation Management uses payee groups to reduce the time spent setting up and maintaining each compensation plan.

The following list outlines the parts to each payee group:
• The compensation plans.
• The payee members belonging to each plan.
• Any attached plan documentation.
• Any tailored reports for the payee group.

All compensation plans and tailored reports are created and edited in the Composer module and assigned to payee groups through the Compensation Plan and Tailored Report wizards. Payee group members and documents are managed in the Payee Groups window.

The individuals who will have their compensation calculated in the system (payees) can be added to a single group, and subsequently a compensation plan can be added to the group to complete the setup process. You can then set up plans for large groups of people at the same time, rather than repeating the process for each individual.
Payees are frequently grouped by title. For example, if all salespeople receive five percent commission on everything they sell, every salesperson can be added simultaneously to a single payee group in the system. To complete the process, a compensation plan that specifies that each member of this group will receive a five percent commission can then be added.

**Tip:** You should consider which payees might be grouped together prior to beginning the model creation process.

---

**Compensation plan creation**

In IBM Cognos Incentive Compensation Management, you can add calculations to compensation plans for specific payee groups to display summary and detail information related to a payee’s compensation.

**Step 1. Naming the plan and defining the calendar**

In the first step of the IBM Cognos Incentive Compensation Management Compensation Plan Wizard, you will choose a name and set the start and end dates for the plan.

**Procedure**

1. In Composer, navigate to the component where you want to add the plan.
2. To add a compensation plan, drag the Plan element onto the Composer window.
3. Type a name for the plan.
   - Give the compensation plan a descriptive name so that it will be easily identified for potential editing later.
4. Set the plan’s start and end dates.
5. Type a description for the compensation plan.

**Step 2. Adding calculations**

In the second step of the IBM Cognos Incentive Compensation Management Compensation Plan Wizard, you will add the calculations to the compensation plan.

**About this task**

Every compensation plan must contain at least one calculation (many plans contain several calculations). When designing your compensation plans, the complexity of the calculations will determine if they can be performed in a single step or if they need to be broken down into multiple steps.

**Procedure**

1. In the Compensation Plan Wizard, click Add to add an existing calculation to the compensation plan.
   - Select the calculation and click OK.
     - The Payee Ledger Display Options wizard opens.
2. To create a new calculation to add to the plan, click New.
3. Click Colors to define the appearance of your Payee Ledger report for this plan.
   - Select Apply to All if you want to apply the report styles defined here to all compensation plans.
b. When you are done selecting colors, click **OK**.

**Selecting Payee Ledger display options**

For each calculation added to an IBM Cognos Incentive Compensation Management compensation plan, you will need to specify reporting settings.

**About this task**

If required, the Payee Ledger module can generate detailed results for each calculation within a compensation plan. It can be very helpful to enable these reporting options so users can review and verify each calculation in a compensation plan.

**Procedure**

1. To track summary results for each period, for each payee, select the **Show calculation results in Payee Ledger** check box.
2. To show all results, select **Show All Results** in the **Show results by PayeeID** field.
3. To show the calculation results by payee, select **PayeeID** in the **Show results by PayeeID** field.
   The calculation must have PayeeID as a partition.
4. Type in the **Result Name**.
5. Click **Format** to modify the number format style and number of decimal places for the results.
6. Select the **Show transactional details in Payee Ledger** check box to expand the results tracked within Payee Ledger to include detailed transaction-by-transaction contribution to the period total.

   **Tip:** Under most circumstances, selecting **Show calculation results in Payee Ledger** and **Show transactional details in Payee Ledger**, initially, is the best choice. After results are validated, calculations can be reviewed and reporting detail can be reduced.

7. You can optionally select the **Show prior periods** check box to show the periods leading up to the selected time period.
8. You can optionally select the **Suppress empty reports** check box to suppress any compensation plan that does not have data for the time period selected.
9. You can optionally select the **Show description as header** check box to show the calculation description as a header in Payee Ledger.
10. You can optionally select the **Suppress summary rows** check box to remove the summary rows in Payee Ledger.
11. Click **Next**.
12. To select which calculation columns to include in the report, drag available columns from the left to the right.
13. Click **Next**.
14. Double-click any row to edit the column properties.
   a. Type the **Display Name** the column will have in Payee Ledger.
   b. For a numeric column, select the **Operation**.
      You can select the sum, average, minimum, maximum, or last operator to have an operation performed on the column and displayed in the report. For example, if you select SUM, all the entries in that column will be summed up and the result will be displayed at the end of the report.
c. For a numeric column, select the **Style**.
   The numeric styles available are standard number, percentage, and currency.

d. For a numeric column, select the **Decimal Places**.

15. **Click Finish.**

After adding any calculations needed for the compensation plan report, you will be brought back to the add calculation window where you can click either **Edit** or **Delete** to make changes to the calculation reporting settings or remove the calculation from the report.

### Step 3. Selecting a payee group and defining holds, caps, and guarantees

The final step in creating a compensation plan in Cognos Incentive Compensation Management requires you to select the payee group that this plan applies to and define a hold period and any caps or guarantees for the compensation plan.

**Procedure**

1. In the **Payee Groups** section of the Compensation Plan Wizard, use the drop-down menu to associate this plan with any payee group that has been set up in the Payee Groups window.

2. In the **Payment Rules** section, select the **Hold** type.
   After adding any calculations needed for the compensation plan report, you will be brought back to the add calculation window where you can click either **Edit** or **Delete** to make changes to the calculation reporting settings or remove the calculation from the report.

3. Select the **This plan includes guaranteed incentive of** check box to provide the specified value as the minimum compensation possible for each payee in each period.

4. Select the **This plan includes an incentive cap of** check box to limit the maximum earnings for each payee in each period to the specified value.

5. In the **Accounts** section, select the **Expense Account** and the **Cash Account** from the drop-down menus.

6. **Click Finish.**

### Locked compensation plans

When a compensation plan is locked in IBM Cognos Incentive Compensation Management, you can change the end date of the plan, and if transactional details are displayed in Payee Ledger.

You cannot add or delete calculations included in the report, change the colors or formatting, or change the payee group associated with the plan.

When you edit the Payee Ledger Display Options for a locked compensation plan, the changes will take effect in the first unlocked period. Payee Ledger will continue to show the original display settings for all locked periods. For example, if you add another display column in the Payee Ledger Display Options - Step 2 window, define the column properties, and click Finish, the added column will only show in unlocked periods.
Copying compensation plans
Use the copy feature to copy a selected compensation plan in IBM Cognos Incentive Compensation Management into another component; however, inbound connections must be created in the new component for the calculations that it uses or depends upon.

Procedure
1. Right-click the compensation plan to be copied, and select Copy.
2. Navigate to the component where you would like to copy the plan to, right-click inside the new component, and select Paste.
3. Type a Paste Suffix.
   The suffix ensures that you do not have two compensation plans with the same name, so you can distinguish copied compensation plans from originals.
4. Specify the new sources by either clicking Automatch or by selecting a source.
   You need to map the old sources to the new sources.
5. Click OK.

Tailored reports
Within the IBM Cognos Incentive Compensation Management Composer module, you can create tailored reports to analyze compensation results.

Creating a tailored report involves the following steps:
1. Name the report, add calculations, and select report settings.
2. Select a payee group.
3. Enable alert generation through Task Manager.

You can use any previously created calculations in the tailored report or create a new one specifically for reporting purposes. After calculations have been added, you can partition and restrict your results to suit your reporting needs.

Every tailored report must contain at least one calculation. When designing your reports, the complexity of the calculations will determine if they can be performed in a single step or if they need to be broken down into multiple steps.

Step 1. Naming the report, adding calculations, and selecting reporting settings
You can use the IBM Cognos Incentive Compensation Management Composer module to name the report, add calculations, and select reporting settings.

Procedure
1. In Composer, navigate to the component where you want to add the report.
2. Drag the Tailored Report element onto the Composer window, or right-click the window and select Add Tailored Report.
3. Type a Name for your tailored report.
4. To add a previously created calculation, click Add, select a calculation, and click OK.
   The Payee Ledger Display Options wizards are displayed.
5. Click New to launch the Calculation Wizard and create a new calculation.
6. Use **Edit** or **Delete** to make changes to the calculation reporting settings or remove the calculation from the report.

7. Click **Colors** to define the appearance of the report. The Report Color Selector window opens.

**Step 2. Selecting a payee group**

Each tailored report added in IBM Cognos Incentive Compensation Management will calculate results for all payees who are a part of the payee group that the report is associated with (payee groups are defined in the Payee Groups window).

**Procedure**

In the Add/Edit Tailored Report window, select the payee group from the **This tailored report is associated with the following payee group** drop-down menu.

**Step 3. Enabling alert generation through Task Manager**

If you have created a tailored report in IBM Cognos Incentive Compensation Management that is meant to only generate data when certain milestones or exceptions occur, you can opt to be notified when the report is not empty.

**About this task**

This will save you from having to remember to check the results on a regular basis. For example, you may want to create a report that lists payees who failed to meet their monthly targets or exceeded a certain threshold.

**Procedure**

In the Add/Edit Tailored Report window, select the **Create an Alert when this report is not empty** checkbox. The Task Manager module displays an alert in the Tasks & Alerts tab when the report generates results.

**Important:** In order for the Task Manager alert to be generated, the Specified reports generate one or more rows option needs to be enabled in the Task Manager Alerts tab.

**Editing locked tailored reports**

When a tailored report is locked in IBM Cognos Incentive Compensation Management, you can change the end date of the plan and whether or not transactional details are displayed in Payee Ledger.

**About this task**

You cannot add or delete calculations included in the report, change the colors or formatting, or change the payee group associated with the report.

**Procedure**

1. In Composer, right-click the tailored report.
2. Select **Edit**.
3. Make your changes and click **Finish**.
Important: When you edit Payee Ledger display options for a locked tailored report, the changes will take effect in the first unlocked period. Payee Ledger will continue to display the original display settings for all locked periods. For example, if you add another display column in Payee Ledger Display Options - Step 2 window, define the column properties, and click Finish, the added column will only show in unlocked periods.

Copying tailored reports
Use the copy feature to copy a selected tailored report in IBM Cognos Incentive Compensation Management into another component; however, inbound connections must be created in the new component for the calculations that it uses or depends upon.

Procedure
1. To copy a tailored report, right-click the tailored report to be copied and select Copy.
2. To paste the tailored report, navigate to the component where you want to add the tailored report. Right-click inside the new component and select Paste.
3. Type a Paste Suffix.
   The suffix ensures that you do not have two tailored reports with the same name so you can distinguish new tailored reports from originals.
4. Specify the new sources by either clicking Automatch or by selecting the sources.
   You need to map the old sources to the new sources.
5. Click OK.
   Any connections stay intact.

Report results in Payee Ledger
To view the results of your compensation plan or tailored report in the IBM Cognos Incentive Compensation Management Payee Ledger module, simply select the report you want, period, payee, and calculation from the drop-down menus.

Compensation plans are prefixed with a "P" and tailored reports are prefixed with an "R". For more information about viewing report results in Payee Ledger, see Chapter 24, “Payee Ledger,” on page 247.
Chapter 13. Adjustments

Use the adjustments feature in IBM Cognos Incentive Compensation Management to modify previously calculated compensations.

Use adjustments to correct mistakes while preserving initial data values so that locked period values always tie out to actual paid compensation. The adjustments feature will automatically calculate calculation result deltas that are caused by changes made to locked data. The difference, positive or negative, can then be allocated in selected future periods.

When to use an adjustment

In IBM Cognos Incentive Compensation Management, adjustments can be used in specific situations after a calendar has been locked.

The following situations are some examples of when an adjustment could be used:
• A sales representative recorded incorrect product information for a sale, and as a result, they received less compensation than they should have.
• A client's sales team neglected to inform payroll that a payee was demoted four months ago. This resulted in months of overpayment and scorecarding ramifications.
• A company regularly manually corrects thousands of rows of transactional source data and it is unrealistic to assume that these manual corrections will be perfect prior to close every time.

Creating adjustment categories

Since there are many reasons why an adjustment may need to be made, you can use IBM Cognos Incentive Compensation Management to set up adjustment categories, so that you can easily keep track of the types of adjustments you are making.

Procedure
1. In Payee Ledger, click the Adjustment Details tab.
2. Select the Adjustment Categories icon.
3. Click Add.
4. Type a name for the adjustment category, and click OK.
5. When you are finished adding adjustment categories, click Close.

Adjustments and calculation speed

When an adjustment is performed in IBM Cognos Incentive Compensation Management, the calculation engine will compute the difference between the locked earnings and the adjustment amount to determine a net earnings amount for that period.

This information is displayed on the Adjustment Details tab in Payee Ledger.

Important: Since a calculation is the only way to update results, it must be used to process the results of an adjustment.
In the first calculation run after making an adjustment, there will be an increase in calculation time. This is because, in addition to calculating results for data in unlocked periods, Cognos Incentive Compensation Management must also compute the net payment amount after adjustments. In order to do this, Cognos Incentive Compensation Management needs to recalculate every locked period affected by the adjustment to compute the deltas.

**Important:** Your calculation speed will only be affected for the first calculation after the adjustment has been made.

The number of adjustments has no bearing on calculation time (whether you have made one adjustment or ten, your calculation speed will remain the same). However, the number of periods affected by the adjustment will have an effect on calculation time.

### Manual adjustments

Manual adjustments in IBM Cognos Incentive Compensation Management are one-time solutions that are applied in specific scenarios.

Manual adjustments tend not to have specific rules and are typically applied in the current period. An administrator can add a manual adjustment to any payee for any open period. The date, time, and amount of the adjustment will be logged and a comment can be included. Since manual adjustments do not involve making changes to a table, they are created through the Adjustment Details tab of the Payee Ledger module.

### Creating a manual adjustment

Adjustments can be added manually through the IBM Cognos Incentive Compensation Management Payee Ledger module.

**Procedure**

1. In Payee Ledger, select the **Adjustment Details** tab.
2. Select the relevant plan and the payee.
3. Click the **Generate Report** icon.
4. Double-click the row of an unlocked period.
   - An unlocked period has a white background.
5. In the **Adjustment Viewer** window, select the Manual tab and click **Add**.
6. Enter the **Adjustment Value**, **Adjustment Category**, and an optional comment.
7. Click **OK** then click **Close**.
   - You will notice the adjustment amount in the manual adjustments column. This amount is paid on the same check as the rest of the compensation earnings for the selected month and selected plan.

### When not to use an adjustment

Adjustments cannot be made to partial periods in IBM Cognos Incentive Compensation Management. If it is imperative that a change be made midway through a period, start and end date columns should be included in the table.
The following tables show how start and end date columns can be effective for changing a commission rate mid-period. To change the commission rate part way through January, we changed the end date for the 3% rate and added a new row.

**Table 32. Example A**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Plan</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1, 2009</td>
<td>January 31, 2009</td>
<td>Plan 1</td>
<td>3%</td>
</tr>
<tr>
<td>February 1, 2009</td>
<td>February 28, 2009</td>
<td>Plan 1</td>
<td>5%</td>
</tr>
</tbody>
</table>

**Table 33. Example B**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Plan</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1, 2009</td>
<td>January 14, 2009</td>
<td>Plan 1</td>
<td>3%</td>
</tr>
<tr>
<td>January 15, 2009</td>
<td>January 31, 2009</td>
<td>Plan 1</td>
<td>4%</td>
</tr>
<tr>
<td>February 1, 2009</td>
<td>February 28, 2009</td>
<td>Plan 1</td>
<td>5%</td>
</tr>
</tbody>
</table>

**Start and end dates in adjustments**

It is important to note that most values do not need to be changed midway through a period in IBM Cognos Incentive Compensation Management.

As a result, start and end date columns should not be necessary. For example, if a commission rate field changes, the change will normally take effect at the beginning of a new period. Additionally, using start and end dates will increase calculation time and should be avoided. Changes that affect partial periods should be treated as exceptions and handled with manual adjustments or prorating.

**Payee Ledger reports**

After a period has been locked, the IBM Cognos Incentive Compensation Management Payee Ledger module reports for that period will not change.

If you make an adjustment to that period, the adjustment amount will show in the adjustments column of the summary ledger for the period that the adjustment amount was allocated to. Examples include the following scenarios:

- Month 1 is locked
- An adjustment is made to month 1 data
- Adjustment amount is allocated to month 2
- Payee ledger reports for month 1 will not change

**Viewing adjustment details on the web**

After an adjustment has been made, IBM Cognos Incentive Compensation Management web client users can view adjustment details through an expandable interface.

**Procedure**

1. Log in to the Cognos Incentive Compensation Management web client.
2. On the Payee Ledger tab, click the Summary screen link, and open the plan or report for a specific payee.

   In the **Net Adjustments** column there is an information icon next to each adjustment.
3. Click the icon, then click the information icon, to view details (including comments) regarding the selected adjustment.
Chapter 14. Scenarios

Use scenario planning for the analysis of how variations in the output of a IBM Cognos Incentive Compensation Management model can be apportioned to different sources of variation.

The Scenarios module can be used to build what-if scenarios, view a side-by-side comparison of targets to actual results, and analyze significant variances from the plan. This enables you to test the impact of proposed changes before they are implemented. If you like the changes you have tested in the scenario, they can then be promoted to the model for implementation.

When a scenario is created, you can add calculations and tables associated with compensation plans to be included in the scenario. You can then perform the following actions:

- Alter the data and logic, including adding or removing data rows
- Easily determine what changes were made in the scenario
- Calculate the scenario
- Compare scenario results to actual calculated results or other scenarios in a report

Imagine you have the following basic plan layout and many calculations are needed in each component to fully build out the logic.

![Figure 1. Basic Plan Layout](image)

1. Data
2. Credit
3. Attainment rules
4. Earning rules
5. Payment rules

By creating a scenario based on the basic plan layout in Figure 1, you can create many combinations of what-if modeling including the following changes:

- A change to crediting rules
- A change to goals or attainment rules
- A change to earnings rules
For example, if you want to view how the Account Executives compensation plan will change if you increase their commission rates by 2%, you can create a scenario based on the Account Executives compensation plan, add the table that contains the Account Executives commission rates, and add a transform change set to the table in which you adjust the commission rates by 2%.

If you want to view how the Inside Sales Representatives compensation plan will change if you decrease the commission rate on a particular product, you can create a scenario based on the Inside Sales Representatives compensation plan, add the table that contains the product commission rates for Inside Sales Representatives, and add an overwrite change set to the table in which you change the commission rate for the specific product.

Scenarios are based on the current data in tables and calculations in your model. If you make changes to tables or calculations in Composer, these changes are reflected in Scenarios.

You can use the Scenarios module to forecast the impact of changes in compensation plans prior to implementation for budgeting and cost management. You can get visibility into specific individuals who will be the most and least impacted by any changes. Then you can proactively and effectively communicate any plan changes. Scenarios can be created and compared to each other or to the current plan so you can better understand the impact of prospective changes across historical, future, or current data.

### Step 1. Creating a workspace

Before adding and working with scenarios in IBM Cognos Incentive Compensation Management, you must add a workspace to contain your scenarios.

#### About this task

Each workspace must be associated with at least one compensation plan. Only the tables and calculations associated with the compensation plans are available for modification in the scenarios within the workspace.

#### Procedure

1. Click the **Add New Workspace** icon.
2. Type the **Name** and **Description** for the workspace.
3. Select either **Public** or **Private Accessibility**.
   - A public workspace is available to any user with access to the Scenarios module. A private workspace is available only to the user who created it and users assigned the administrator role.

   **Important:** You can grant users access to private workspaces in the Manage Roles window.
4. Select the start date and end date.
   - This defines the periods that will be accessible for modification in the scenario.
5. Select the compensation plan to be used in the workspace.
6. Click **OK**.
Editing workspace properties

You can modify the name, description, and accessibility of the workspace after it has been created in the IBM Cognos Incentive Compensation Management Scenarios module.

Procedure
1. Open the workspace.
2. Click the Workspace Properties icon.
3. Make your changes and click OK.

Searching for and viewing workspaces

You can view a list of workspaces you have created and filter the list of workspaces in the IBM Cognos Incentive Compensation Management Scenarios module.

Procedure
1. In the Scenarios module, click the Sidebar icon.
   - A list of workspaces displays.
2. To filter the results, type a name in the Filter box.

Step 2. Creating scenarios

In IBM Cognos Incentive Compensation Management, use scenarios for side-by-side comparison of data to help with modeling of compensation plans for the next year.

About this task

After a workspace has been created, you can add scenarios that can make logic changes, edit or delete source data, transform data, and add to source data. For example, if you want to see how changing a payee's quota will affect his or her total compensation payment, add the table that contains quotas to your scenario and change the amount.

Procedure
1. In a workspace, click the Add New Scenario icon.
2. To change the name and add a description to the scenario, click Edit.
3. When you are finished, click Save.

Step 3. Adding items

In IBM Cognos Incentive Compensation Management, you can add tables and calculations to the scenarios that are associated with the compensation plans included in your workspace.

About this task

For example, you could add a quota table to see how changing a payee's quota will affect his or her total compensation payout. The data from added calculations will be displayed in table form. However, the workspace must first be calculated before the table will be populated with the calculated results. You can then edit, add, delete, or transform the calculation results in any way you choose. You can modify results such as attainment or annual compensation without having to go
back to source data or early calculation results.

**Procedure**

1. In your workspace, under the scenario tab, click the **Add New Item** icon.
2. Search for an item using the **Filter** box, or scroll down and select a table or calculation that you would like to modify.
   The item will be added to the scenario.

   **Important:** If you add a calculation, a warning sign will be displayed next to the item. This indicates that the workspace must first be calculated before changes can be made to the item. It may also indicate that the table is too large to be used in the workspace.

3. If you selected a calculation, perform the following steps:
   a. Open the **Calculate** module.
   b. From the **Calculation Type** drop-down menu, select **Scenarios Workspace**.
   c. From the **Workspace** drop-down menu, select the workspace you would like to calculate.
   d. Click **Calculate**.
   e. After the calculation has run successfully, navigate back to the scenario and click the **Refresh** icon.
   The warning sign is no longer displayed and you can modify the calculated results.

---

**Step 4. Change sets**

You can add change sets to modify the data in the tables and calculations you added to the scenario in IBM Cognos Incentive Compensation Management.

There are two type of change sets: overwrite change sets and transform change sets.

Use an overwrite change set to add rows to tables and calculations and change values for columns that are not primary key columns. The table or calculation data will be presented in table form and you can modify the data to suit your scenario. This change set is most useful if you want to make a change to a specific value in a table or calculation.

Use a transformation to make changes to a table or calculation across multiple rows for non-primary key columns at the same time. You can create restrictions to only replace or adjust specific data in a column of a table or calculation. For example, if you only want to change the quota for managers, you can restrict the data to only include managers. The change set is most useful when you want to make a uniform change to more than one row of data.

**Adding overwrite change sets**

You can add an overwrite change set to make specific changes to each row in the table in the IBM Cognos Incentive Compensation Management Scenarios module.

For example, you can use an overwrite change set to view the effects on a compensation plan when you increase the quantity sold for a specific payee.
Procedure
1. In the workspace, under the scenario tab, select the table or calculation you want to add an overwrite change set to.
2. Click the Add Overwrite Change Set icon.
   Overwrite 1 is added under the selected item.
   A table of the data is displayed.
4. Make the changes you want to the rows.
   You cannot make changes to primary key columns.
5. Click OK.

Adding transform change sets
In the IBM Cognos Incentive Compensation Management Scenarios module, you can add a transform change set to apply a uniform change over multiple rows.

For example, you can use a transform change set to view the effects on a compensation plan when you decrease the quota by 10% for all managers.

Procedure
1. In the workspace, under the scenario tab, select the table or calculation you want to add a transform change set to.
2. Click the Add Transform Change Set icon.
   Transform 1 is added under the selected item.
   The Transform Data wizard is displayed.
4. Define any restrictions for the transformation, then click Next.
   If you want to replace only some of the values in a column, define restrictions here to indicate which values to update. For example, if you only want to update values for John Smith, restrict the data in the table to only include records for John Smith.
5. From the Column drop-down menu, select the column you want to perform the transformation on.
6. From the Transform Type drop-down menu, select either Replace or Adjust.
   You can choose to replace the data with new data or adjust the data in the column by a percent or value.
   • If you select Replace, in the Replace With field, select a column or type a value. The value you type or select will replace all values in the selected column.
   • If you select Adjust, in the Adjust Type field select Value or Percentage, and in the Adjust By field type a value. You can increase or decrease the values in the selected table by a percentage or a set value.
7. Click Finish.

Editing transform change set and overwrite change set properties
In the IBM Cognos Incentive Compensation Management Scenarios module, you can rename or write a description for a transform change set or overwrite change set.
Procedure
1. In Scenarios, select the transform change set or overwrite change set.
2. At the bottom of the scenario window, click the properties heading.
3. Click Edit.
4. Type a name and description.
5. Click Save.

Previewing scenario results
After creating a transform data change set, you can calculate and preview your scenario to see the effects of any changes you have made in the IBM Cognos Incentive Compensation Management Scenarios module.

Procedure
1. In the workspace, under the scenario tab, select the transform change set you want to preview.
2. Click Preview.
   A table displays with the results.

Modifying the order of change sets
In the IBM Cognos Incentive Compensation Management Scenarios module, when you have multiple change sets for one table or calculation, you can change the order of the change sets.

If there are multiple change sets for a table or calculation, the change set that is listed last will be used to calculate the report.

Procedure
1. In the workspace, under the scenario tab, select the change set.
2. To move the change set, drag it up or down in the list, or use the up and down arrows.

Step 5. Generating reports
Generate a report to present your results and compare your scenario to the current IBM Cognos Incentive Compensation Management model or other scenarios.

Before you begin
Before generating a report, you must calculate the workspace for which you want to generate the report.

Procedure
1. In the workspace, click Reports.
2. From the Report Type drop-down list, select to compare results by payee or by period.
3. From the Base Scenario drop-down list, select the scenario you want to compare the data from the target scenario to.
   If you select (Base), your scenario is compared to the current data in the model.
   If you have more than one scenario created, you can also compare two scenarios to each other.
4. From the **Target Scenario** drop-down list, select the scenario you want to compare with the base scenario.

5. From the **Compensation Plan** drop-down list, select the compensation plan you want to generate results for.

6. If you selected **Period Comparison** as the **Report Type**, from the **Payee** drop-down list, select a payee to view. If you selected **Payee Comparison**, from the **Period** drop-down list, select a period to view.

7. From the **Number of Chart Items** drop-down list, select the number of items that you want displayed in the chart.

8. Click the **Generate Report** icon.

---

**Step 6. Promoting a scenario**

In IBM Cognos Incentive Compensation Management, scenarios can be promoted to replace the current data in your model with the new data from the scenario.

This replaces the items in Composer that you used to create your scenario with the modified scenario items.

**Procedure**

1. In the workspace, select the scenario you want to promote.
2. Click **Promote Scenario**.
Chapter 15. Web forms

Use web forms in IBM Cognos Incentive Compensation Management to create forms and enable them for web review or data submission.

Web form creation begins with selecting the data sources you want to use and the detail columns to display. Any of the columns can optionally be made editable for the web user or be displayed for review only. After defining the data that will be displayed in the form, restrictions can then be created that will limit the information displayed to individual web users. For example, you may want to create a restriction that will only let web users see their own information.

Adding a web form

In IBM Cognos Incentive Compensation Management, a web form is a completely configurable grid.

When creating a web form, the content and design of the form is completely up to you. You can select any fonts, cell colors, or text justification you want.

Procedure
1. In Composer, navigate to the component where you want to add the web form.
2. To add a web form, right-click the window and select Add Web Form.
3. Name the web form and click OK.
   You will see the web form element.
4. Double-click the element to open the web form.

Defining web form filters

In IBM Cognos Incentive Compensation Management, you can define filters to restrict the web form data to a certain subset of the results.

For example, a web user may want to filter the data to display only rows for a particular payee. You can create and save as many filters as you like, then apply them to specified web forms.

Procedure
1. Select the Define Source Filters button.
   The Web Form Source Filters window will open.
   Important: You must define a filter for web forms with sources that have more than 1,000 rows of data.
2. Click Add.
3. Type a filter Name.
4. Select the filter Type.
   You can choose a Simple filter, Portal Access filter, or Custom filter.
5. Select the Matching Operator to use in your filter.
6. Select the Display.
You can choose a drop-down menu as the display for the filter or an editable field.

7. Click **Next**.
   
The next step is determined by the type of filter you selected in step 4.

**Defining a simple filter**

In IBM Cognos Incentive Compensation Management web forms, simple filters provide web users control over what is displayed on their screen.

Users can filter data based on one column in one source table. For example, a simple filter can be created that will filter web form data based on job title.

**Procedure**

1. In step 2 of the Add Web Form Source Filter wizard, select the **Table**, the **Value Column**, and the **Name Column** that will be the source for the filter.
2. Click **Finish**.

**Defining Portal Access filters**

In IBM Cognos Incentive Compensation Management web forms, this filter displays payee data based on a compensation plan's Portal Access hierarchy.

**About this task**

When you add a Portal Access filter you will be prompted to select a Portal Access plan hierarchy. The plan hierarchy is determined by the access tree assigned to the plan in the Portal Access module.

**Procedure**

1. In step 2 of the Add Web Form Source Filter wizard, select a **Portal Access Hierarchy**.
2. Click **Finish**.

**Defining a custom filter**

In IBM Cognos Incentive Compensation Management web forms, the custom filter is a generic filter that is completely customizable.

Use custom filters to link a given set of sources to the web user in order to restrict result rows without relying on the Portal Access hierarchy.

**Procedure**

1. Select the source for the filter.
2. Select the detailed columns by dragging one value column and one name column to the right side of the screen.

   **Important:** The column selected determines the values that form data can be sorted by.
3. Define any restrictions.
4. Click **Finish**.
Adding sources to web forms

Any calculated results or tables can be used as data sources in your IBM Cognos Incentive Compensation Management web form, except for the Time table.

About this task

When you add data sources you can choose which columns will be editable for the web user or be displayed for review only. Restrictions can also be created that will limit the information displayed to individual web users.

Procedure

1. Right-click a cell in the web form and select Add Source.
2. Select a Source.
3. To join another source, click Add.
4. Click Next when you are finished adding sources.
5. Drag any columns that you want displayed on your form to the pane on the right side.
6. Right-click a column name and select Toggle Editable if you would like the column to be editable by web users.
   Editable columns will be displayed in bold.
7. Click Next.
8. Drag columns into the restricted definition list to create a restriction.
   For example, if you pulled in an ERP data table with a web user table, you can ensure that web users can only view their own results by restricting on the payee ID: web user payee ID = source data payee ID.
9. Click Next.

Adding validation rules to editable web form columns

Create and assign validation rules to put constraints on what data can be entered in editable IBM Cognos Incentive Compensation Management web form columns.

Data can be restricted to a particular numeric, text or date value, or a web form source column.

Procedure

1. In step 4 of the Web Form Source Wizard, click Add.
2. Select the Table and Column that will be the source of the validation rule.
3. Select the Operator.
4. Select the Value or Source from the tabs to complete the input rule.
5. Click OK.

   Important: If calculation results are appended to a web form source, the joined calculated results can be used to define the validation rule.

Adding saved web form filters

You can attach saved filters to your web form source in IBM Cognos Incentive Compensation Management.

Procedure

1. In step 5 of the Web Form Source wizard, click Add.
2. From the Available Filters drop-down that you would like web users to be able to apply to the source, select the previously created filter.
3. Select the Source Table and the Source Column that the filter will apply to.
4. Click OK.

**Important:** In order for filters to be added to a web form, they must first be defined using the Define Filters Wizard located on the Web Forms toolbar.
5. Click Finish.

On the form, you will now see the columns you selected from the source.

---

## Adding a row form

Create web forms so enabled users can add rows to a table (as opposed to simply editing existing rows) in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Right-click an empty cell in the web form and select **Add Row Form**.
2. Select the **Destination Table**.
   The destination table is the table that the rows will be added to and can be a custom or structural table.
3. Click Next.
4. Add any **Validation Rules**.
5. Click Finish.

The rows will be displayed in your web form.

## Adding a required flag to a row form

When adding rows to an IBM Cognos Incentive Compensation Management web form, all fields will be editable.

If certain fields are required, there is an option to have a required flag added to particular cells to let web users know that data needs to be entered in the field in order to submit the row.

**Procedure**

1. Right-click the field in the row form and select **Input Options**.
2. Select **Required**.

## Setting a field width

You can set the width of an editable field in an IBM Cognos Incentive Compensation Management web form.

**Procedure**

1. Right-click the editable field in the web form and select **Input Options > Field Width**.
2. Set the **Field Width** and click OK.

## Adding web resources

IBM Cognos Incentive Compensation Management web forms can include company logos, other images, or links to other web sites.
Procedure
1. Right-click an empty cell in the web form and select Add Web Resource.
2. Type the name of your web resource.
3. Type in the URL for your image or link.
4. Select either the Image or Link option.
5. Click OK.
   On the web form, you will see either the name of your link underlined in blue or the image.

Adding an admin form

In an IBM Cognos Incentive Compensation Management web form, the admin form column provides data approve or reject functionality for submitted data.

About this task

After the user has submitted data using the web form, the admin form displays the data that is added to the table as well as a column where users can approve or reject the changes they have made.

Procedure
1. In Composer, enable the target table for web data edit.
2. Right-click a cell in the web form and select Add Admin Form.
3. Select the target table that you enabled for web data edit.

   Important: Approval or rejection of the changes made on this web form will be sent to the table.
4. Click Finish.

   Important: You must select Administrator approval required in the Web Form Options window. The Admin Form will not be displayed if results will be submitted directly to the database.

Formatting web forms

The font, alignment, and shading of the cells in IBM Cognos Incentive Compensation Management web forms can be modified.

Procedure
1. Select the cell in the web form to be formatted.
2. To format the cell, right-click and select Format Cells.
3. Click the Format Cells icon. Use the Format Cells window to format the font, alignment, and shading of text in the selected cells.
4. Make your changes and click OK.

Setting the cell span

You can configure the contents of a cell to cover a range of cells in an IBM Cognos Incentive Compensation Management web form.

Procedure
1. Highlight the number of columns in the web form that you want the cell to span.
2. Right-click the highlighted cells and select **Set Cell Span**.
   The cell span is outlined in red.

### Copying and pasting web form cells

Cells that contain text or data can be moved around the IBM Cognos Incentive Compensation Management web form.

**Procedure**

1. Select the cells in the web form to be copied, right-click the selection and select **Copy**.
2. Go to the paste location, right-click and select **Paste**.

### Setting web form options

You can choose whether or not the web form should be displayed in the IBM Cognos Incentive Compensation Management web client prior to filters being applied, what the export filter will be, and whether data submission requires administrator approval first.

**Procedure**

1. In the web form, select the **Set Form Options** button.
2. You can select the **Do not show form until filter applied** check box.
   - If this check box is selected, the filters will show after the web form is chosen from the drop-down menu. The user must select the filters, and click **Apply** in order to produce the web form.
   - If the check box is cleared, the entire web form will be displayed as soon as the form is chosen.
3. In the Date Submission section, select either **Direct to database** or **Administrator approval required**.
   - If administrator approval is required, a model administrator will have to approve the changes through the Composer module before the changes are committed to the database.
   - If you select the **Direct to database** option, edits are made directly to the database. Since there is no approval process, use caution when selecting this option.
4. Select the **Export Filter**.
   This is the filter that users will need to apply to view the web form.
5. Click **OK**.

### Select web form preferences

You can choose the default number of rows and columns displayed in the IBM Cognos Incentive Compensation Management web forms editor window.

**Procedure**

1. In the web form, select the **Preferences** icon.
2. Select the editor dimensions.
3. If you want the payees available for selection in the web client to be determined by the Portal Access filter, select the **Restrict payee selection when Portal Access Filter present** check box.
4. Click **OK**.
Adding JavaScript

Users can add JavaScript to a dialog window in IBM Cognos Incentive Compensation Management web forms.

The JavaScript codes are displayed before the web form and are enclosed in the <script type="text/javascript"> tag. Users can optionally add JavaScript in the web form cells.

Procedure
1. In the web form, click the Add JavaScript button.
2. Type or paste the JavaScript code into the JavaScript window.

   Important: There is no limit of characters in the JavaScript text box.
3. Click OK.

Linking reports, web forms, and web pages

IBM Cognos Incentive Compensation Management web forms can optionally be linked together by inserting a link on a web form item.

A link can be created from text and sources, or added as a web resource.

Links can be made to web forms, web pages, and Presenter reports. You can choose to pass parameters from Presenter reports into existing web form filters.

Linking a web form to a Presenter report

You can link text, web resources, or a sources in a web form to a Presenter report in IBM Cognos Incentive Compensation Management.

Procedure
1. Select the text, web resource, or source in the web form, and right-click and select Add Link.
2. In the Link to section, select Report.
3. Select the Presenter report from the Report drop-down menu.
4. To link a parameter, double-click the row with the parameter.
   a. In the Link Parameter window, select the Type and Value of the parameter.
   b. Click OK.
5. Click OK.

Linking a web form to another web form

You can link text, web resources, or sources in a web form to another web form in IBM Cognos Incentive Compensation Management.

Procedure
1. Select the text, web resource, or source in the web form, right-click and select Add Link.
2. In the Link to section, select Web Form.
3. Select the web form from the Web Form drop-down menu.
4. To link a filter, double-click the row with the filter.
   a. In the Link Parameter window, select the Type and Value of the filter.
When linking to a web form, you do not have to carry over the filters. The filters you created in the web form will be displayed in the Parameter column of the Link Wizard.

b. Click OK.

5. Click OK.

Linking web forms to web pages

You can link text, web resources, or sources in an IBM Cognos Incentive Compensation Management web form to a web page.

Procedure

1. Select the text, web resource, or source in the web form, and right-click and select Add Link.
2. In the Link to section, select Web Page.
3. Type in the URL that you are linking to in the Address field.

Publishing web forms

IBM Cognos Incentive Compensation Management web forms can be published as PDF files.

Procedure

1. Open the web form.
2. Click the Export to PDF icon.
3. Select either Publish from my computer or Publish from the server.
4. Select the Portal Access Group whose members you are generating the report for.
5. If you have added filters to the web form, select the filters to apply and click Next.
6. Under PDF options, select either Portrait or Landscape and the Scaling options.
7. Select the Use header image check box to display an image as the header on each PDF file and click Browse to find the image.
8. You can select the Include page numbers check box to show page numbers in the footer, the Show total page numbers check box, and type a Footer.
9. Click Browse to select where you want to save the PDF file.
10. You can define a prefix that will be added to the file name of each PDF file. By default, when you publish reports, the file name will consist of the web form name, payee name, and date and time that the web form was published to a PDF file.
11. Click Finish.
Chapter 16. Presenter report data components

In IBM Cognos Incentive Compensation Management, you can use Presenter to report on your data. In the Presenter module, you can create, compose, and post Presenter reports in the web client for review.

Presenter reports are highly configurable in terms of both design and content. Presenter reports can also be configured for data submission. Report administrators can create editable fields so that web users can edit or add data through data grids to tables in Composer.

Presenter reports consist of the following main components that are the building blocks for report creation:

- Data components
  - Parameters
  - Values
  - Sources
  - Row Form Sources
- Presentation components
  - Layout tables
  - Value displays
  - Grids
  - Images, charts, maps, and gauges
  - Controls and submit buttons

Presenter report creation

IBM Cognos Incentive Compensation Management Presenter report creation involves several steps.

At a high level, the following steps describe how to create a Presenter report:

1. Create parameters that restrict the results that are displayed.
2. Create values that are based on tables, calculations, and constant values, or computed from existing values.
3. Create a source.
4. Pull calculations, tables, parameters, and values into the Presenter report source.
5. Define the report layout tables for all of the report components.
6. Add report components to the layout tables.

How the pieces fit together

IBM Cognos Incentive Compensation Management Presenter report sources drive all final display objects and can be built from any combination of calculations, tables, values, parameters, and other sources. At a high level, calculations, tables, values, and parameters provide the information needed to create a report. These pieces then get compiled into a Presenter report source.
After a source has been created, it can be displayed visually on a report.

Presenter report sources can be used as building blocks for other sources, and the steps of gathering and compiling information into sources can be repeated several times before a source is displayed in a grid on a report, as in the following example:

- Create source 1
- Source 1 feeds source 2
- Source 2 feeds source 3
- Source 3 is displayed in a grid on a report

**Presenter naming conventions**

Before you begin building a report in IBM Cognos Incentive Compensation Management, it is important to take some time to develop standard naming conventions for your report components.

Organizing your report pieces will save you a great deal of time down the road. These naming conventions should apply to all parameters, values, and sources for each report.

**Important:** The naming convention rules presented here are only a suggestion and can be modified to suit the needs of your organization.

For example, your naming conventions could be composed of component type and component purpose.

The first part of the name could specify the type of component. For example,

- Pa = parameter
- Va = value
- So = source

You could also add additional letters to indicate types of values and sources, such as table values. For example,

- SoCc = source with a computed column
- VaTa = table value

The last part of the name should clearly state the purpose of the component. An example of a parameter that will be used to filter results by months is "PaMonthlyDateFilter2013".

**Adding a Presenter report**

To begin to create a Presenter report in IBM Cognos Incentive Compensation Management, you must first add a Presenter report to Composer.

**Procedure**

1. In Composer, navigate to the component where you want to add the Presenter report.
2. To add a Presenter report, perform one of the following steps:
   - Right-click and select **Add Presenter Report**.
   - Drag the **Presenter Report** element onto the Composer window.
3. Type a name for the Presenter report.
   The Presenter report element is added to the component.
4. Double-click the element to create the Presenter report.
   The Presenter report tab opens.

Data components

Before creating the actual layout of the report in IBM Cognos Incentive Compensation Management, you will need to build the report pieces.

Data components include, parameters, values, sources, and editable sources.

Parameters

Use parameters to place restrictions or rules on the results that are displayed in your IBM Cognos Incentive Compensation Management report.

Parameters are often used to make sure that report results are only displayed if the parameter is true. Multiple parameters can be included in sources, so you can compose the results in any way you like. You can access the records that are particularly useful and omit those that are irrelevant by combining parameters. The following parameters are examples of parameters you could include in Presenter reports:

- **Payee filter** - is used to filter the report to include only results for a selected payee.
- **Date filter** - is used to filter the report to include only results for a particular date or time period.
- **Threshold filter** - is used to show results that exceed or fall below certain thresholds. For example, payees who surpassed their quota by more than 10 percent.

The default value of a parameter can be set to another parameter or a Value (stored, calculated, and constant) when the Value option is selected as the Default Value Type. The items displayed in the Default Value drop-down list will only include items that match the selected parameter type. When User Entered is selected as the Default Value Type, a user determined value can be keyed into the Default Value field.

**Important:** Null values can be default values, but keep in mind that if the Parameter is a Required Parameter, the report will not render with a null value. If a non-null value is the default for a required parameter and the user submits a blank value, the default value will be used instead to render the report.

Creating a parameter

In IBM Cognos Incentive Compensation Management, you can add text, date, or numeric parameters to your Presenter report to restrict and filter the results displayed in the report.

**Procedure**

1. To add a parameter, perform one of the following steps:
   - Right-click the parameters folder and select **Add Parameter**.
   - Select the parameters folder, click the **Add** icon, and select **Add Parameter**.
2. Type a name for your parameter.
3. Select a **Parameter Type**.
4. Select a Default Value Type.
   - If you want to set a static value as the Default Value, select User Entered.
   - If you want to choose another parameter or a Stored, Calculated, or Constant Value as the Default Value, select Value.

5. You have the option to type in a Default Value that will populate the parameter when a web user opens the report.

6. If you select the Required Parameter check box, the data in the report will not be rendered until the user has specified a parameter.

   **Important:** You must type a Default Value for a Value Parameter if you select the Required Parameter option.

7. If you select the Use Current Web User check box, any payee parameter will be populated with the Payee ID of the user logged in to the web client.

8. Click OK.

   **Important:** Parameters cannot function on their own. They need to be joined into a Presenter report source in order to function as intended. It is within the Presenter report Source wizard that you set restrictions on source fields or values to indicate what data gets restricted by the parameter.

**Report parameter links**

Parameters that are used in one Presenter report in IBM Cognos Incentive Compensation Management can also optionally be carried over into a linked report.

The following example explains how a linked report with linked parameters could work:
- Filter Report 1 by payee and month
- Create a link from Report 1 to Report 2
- Display records in Report 1 for John Smith in Month 1
- Select link to Report 2
- Report 2 displays showing only records for John Smith in Month 1

Linking reports and parameters is done using the Link button that is found in the report component wizards. When linking to another report, you do not have to carry over the parameters. If you choose to, you will need to drag parameters from the current report to corresponding parameters in the report that you are linking to.

**Values**

Values are variables that can be applied to the Presenter report in IBM Cognos Incentive Compensation Management to display additional data.

Use values to scale back the results of a report or table to single cell.

There are three type of Values; Stored, Calculated, and Constant.

Often values are used to feed other values. For example, different types of values can act as building blocks for other values in order to retrieve the information that needs to be displayed in a report cell or on a fixed grid.
Creating a stored value
A stored value returns a single value from a table in IBM Cognos Incentive Compensation Management.

The value can be retrieved from any table in the Composer module or any Composer or Presenter calculation in the model.

Procedure
1. To add a stored value, perform one of the following steps:
   - Right-click the Value folder and select Add Value > Stored.
   - Select the Value folder, click the Add icon, and select Add Stored Value.
2. Type a name for the stored value and click Next.
3. Select a source and click Next.
   In order to pull a single value from a table, you need to indicate which column and row to pull data from.
4. Select a Value Column.
   The Value Column is the table column that contains the information you need.
5. Double-click the first row to enter in an ID Value.
   An ID Value needs to be specified for each ID column which are the primary keys of the table. The ID Value is the value that must be inputted by the user in order to determine which row to pull data from.
   - To set the ID Value as a parameter, right-click the row and click Select.
   - Select the parameter from the drop-down menu and click OK. The value type will automatically populate. If you select a parameter for the ID value, then the value type will be Selected. If you enter in a constant, then the value type will be User Entered.
6. Click Finish.

Stored value examples:

In the following example, a stored value is used to pull specific information from the IBM Cognos Incentive Compensation Management Payee table and display it in a report.

If you have a table that contains payees and their commission rates, you could create a stored value that will pull a payee's commission rate from the table and display it on the report. Assume that the following information is contained in your commission rate table.

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Job Title</th>
<th>Commission Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Account Executive</td>
<td>2%</td>
</tr>
<tr>
<td>002</td>
<td>Sales representative</td>
<td>4%</td>
</tr>
<tr>
<td>003</td>
<td>Account Executive</td>
<td>3%</td>
</tr>
</tbody>
</table>

You could create a stored value using the commission rate table as your source.

Since the commission rate field contains the data you want to display, the commission rate field is selected as the value column. The payee ID is the primary key in the table, so you would use a payee restricting parameter to pull the
appropriate rate for the payee into the report. This value could then be pulled into a report. If payee 001 is selected on the report, the resulting value could be displayed on the report.

Creating calculated values

Use calculated values to perform calculations on other numeric values in an IBM Cognos Incentive Compensation Management Presenter report.

For example, if you have a numeric value that shows a payee’s total sales and another value that displays monthly quota, you could pull these two values into a calculated value that shows the percentage of quota achieved.

Procedure

1. To create a calculated value, perform one of the following steps:
   - Right-click the Value folder and select Add Value > Calculated.
   - Select the Value folder, click the Add icon, and select Add Calculated Value.
2. Type a Name for the calculated value.
3. Create a formula using the Value Sources.
   The result of the computed value could then be displayed on the report.
4. Click OK.

Formula operators:

Several formula operators are available to aid in setting up calculations in IBM Cognos Incentive Compensation Management Presenter reports.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUM()</td>
<td>This will take the aggregate of whatever is within the brackets and give you a total.</td>
<td>To calculate 5% of the value of each sale as commission: Sum(SourceTable.ValueColumn) *0.05</td>
<td>Sum(Value)</td>
<td>The use of SUM is recommended for most calculations as it will not only provide you with the proper summed amount for your calculation, but will also enable clear reporting in Payee Ledger. If you are showing negative values in Payee Ledger, make sure your formula is using the SUM operator.</td>
</tr>
<tr>
<td>COUNT()</td>
<td>This will give a value of 1+ for each record that has a value. This means that each record will be one more than the previous amount.</td>
<td>To calculate the total number of deals in a period: COUNT(SourceTable.Value Column)</td>
<td>Count(Value)</td>
<td>If the data is partitioned by PayeeID and Month, the count will reset back to zero after each month and start again.</td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>MAX()</td>
<td>This will take the maximum value of a set of results.</td>
<td>If, for each deal, you will receive a 5% commission but there is a minimum of $5 per deal you will earn, you can use the following formula to determine if the 5% commission is higher than the $5 minimum: MAX(Data.Value*0.05, $5) MAX can also be used on a single value to be used as an aggregate function (like SUM, AVG, COUNT). For example, MAX(Data.Value)</td>
<td>MAX(Value1, Value2, Value3, etc.)</td>
<td>If you have an if statement similar to the following: IF(A&gt;B,A,B), you may want to use the MAX operator.</td>
</tr>
<tr>
<td>MIN()</td>
<td>This will take the minimum value of a set of results.</td>
<td>If 5% commission is paid on each deal to a maximum of $100, the following formula will pay either 5% commission or $100, whichever is less: MIN(Data.Value*0.05 , 100) MIN can also be used on a single value to be used as an aggregate function (like SUM, AVG, COUNT): MIN(Data.Value)</td>
<td>MIN(Value1, Value2, Value3, etc.)</td>
<td></td>
</tr>
<tr>
<td>AVG()</td>
<td>This will take the average of the value within the brackets.</td>
<td>If a product has a set price, but sales reps can sell at a price that is greater than or less than this value, the following formula compares their average monthly sale value to the set price and pay commission based on their gross margin: (AVG Sale - Set Price)/ Set Price</td>
<td>AVG(Value)</td>
<td></td>
</tr>
<tr>
<td>IF()</td>
<td>Use this operator to perform a logical test and provide a true and false result.</td>
<td>If the sale amount is greater than $100, you will receive a 5% commission, otherwise you will receive a 2% commission. IF(Data.Value &gt; 100, Data.Value * 0.05, Data.Value * 0.02) <strong>Nested IF() Example</strong> If your sale amount is greater than $100, you will receive 5% commission. If your sale is greater than $50 you will receive 3%, otherwise you will receive 2%. IF(Data.Value &gt; 100, Data.Value * 0.05, IF(Data.Value &gt; 50, Data.Value * 0.03, Data.Value * 0.02))</td>
<td>IF(Logical Test, True Result, False Result)</td>
<td></td>
</tr>
</tbody>
</table>
### Table 35. Formula operators (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISEMPTY()</td>
<td>This will take a Date or Numeric field and provide a true result if the field does not have a value (i.e. the equivalent of NULL in the database).</td>
<td>If(IsEmpty(Payee.DateOfHire), DefaultDate, Payee.DateOfHire)</td>
<td>ISEMPTY (Value)</td>
<td></td>
</tr>
<tr>
<td>AND()</td>
<td>This will return results if all conditions are true. If you use the AND operator to return results for Logical Test 1 AND Logical Test 2, results that include both Value 1 and Value 2 will be returned.</td>
<td>If you only want to show results for transactions that are bigger than $1,000 and less than $10,000, use a formula similar to the following: AND(SourceTable.ValueColumn &gt; 1000, SourceTable.ValueColumn &lt; 10000)</td>
<td>AND(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td>OR()</td>
<td>This will return results if one or more conditions are true. If you use the OR operator to return results for Logical Test 1 OR Logical Test 2, any records with either value will be returned.</td>
<td>If you want to show a result of 1 for values that fall between 10,000 and 20,000 and a result of zero for all other values, use a formula similar to the following: IF(OR(SourceTable.ValueColumn &lt; 10,000, SourceTable.ValueColumn &gt; 20,000),0,1)</td>
<td>OR(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td>NOT()</td>
<td>This will return results when a condition is not met. You can use this function to exclude records from your results.</td>
<td>If you want to apply a 5% commission to all transactions, except when the transaction value is less than $1,000, use a formula similar to the following: SUM((SourceTable.ValueColumn) *0.05, NOT(SourceTable.ValueColumn &lt; 1000))</td>
<td>NOT(Logical Test)</td>
<td></td>
</tr>
<tr>
<td>ABS()</td>
<td>Use this operator to take the value within the brackets and show the number as a positive, regardless of whether or not the value within the brackets is positive or negative.</td>
<td>If you want to show the difference between this month’s sales and last month’s sales as a percentage, but you do not want the percent change to be a negative value, use a formula similar to the following: ABS(Current - Prior)/Prior</td>
<td>ABS(Value)</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>ROUND()</td>
<td>This will use Banker’s Rounding to round the results in the brackets. For example, 0.5 will round to 0, but 0.51 will round to 1.</td>
<td>If you want to round your results to the nearest cent, use a formula similar to the following:</td>
<td>ROUND (Value, Decimal Places)</td>
<td>You must specify the value you want to round, then the amount of decimal places you want to round to. Type 0 for a whole number, 1 for one decimal place, 2 for two decimal places, etc.</td>
</tr>
<tr>
<td>ROUND DOWN()</td>
<td>This will round any number down towards zero by the number of decimal places you define in the formula.</td>
<td>If you want to round your results down to two decimal places, use a formula similar to the following:</td>
<td>ROUND DOWN (Source Table.Value Column, num_digits)</td>
<td>num_digits in the number of digits to which you want to round the number. If num_digits &gt; 0, then the number is rounded down to the specified number of decimal places. If num_digits = 0, then the number is rounded down to the nearest integer. If num_digits &lt; 0, then the number is rounded down after the decimal point.</td>
</tr>
<tr>
<td>MULT()</td>
<td>This is used to multiply numerous numbers together.</td>
<td>If you wanted to multiply all the values in your data table together, use a formula similar to the following:</td>
<td>MULT(Value)</td>
<td></td>
</tr>
<tr>
<td>PREV ()</td>
<td>The Prev() operator references to the previous value of the calculation you are modifying along it's accumulating partition. This is important any time you have a situation where you need to have explicit access to the previous iteration of the calculation you are modifying in order to come up with the required current period results.</td>
<td>If a minimum of $500 is to be paid each month to each rep but if commissions fall short, they have to be clawed back in subsequent months, use a formula similar to the following:</td>
<td>PREV()</td>
<td>PREV does not have any values inserted in the brackets. This function will only work properly if your data only has one row per partition in the calculation table.</td>
</tr>
</tbody>
</table>
Table 35. Formula operators (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>POW()</td>
<td>This is used to create an exponent. Instead of using A^B for A to the power of B, Cognos Incentive Compensation Management will use the formula POW(A,B).</td>
<td>If you want to calculate the value of a deal which is sold today but paid upon completion in 5 years, use a formula similar to the following: Present Value = Future Value / (1+Interest Rate)^Term</td>
<td>POW(Value, Exponent)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you will be paid $20,000 in 5 years where the interest rate is 5% the formula would look like this: 20,000 / POW((1+.05),5)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Creating constant values**

A constant value is a single value that is added to your IBM Cognos Incentive Compensation Management Presenter report. It can be a date, text, or numeric value.

Constant values can be used as sources in calculated values, so if you need to perform a calculation on a numeric value based on a value that does not change, you could use a constant value.

**Procedure**

1. To add a constant value, perform one of the following steps:
   - Right-click the Value folder and select Add Value > Constant.
   - Select the Value folder, click the Add icon, and select Add Constant Value.
2. Type a name for the constant value.
3. Select the type of constant value.
   You can choose from Date, Numeric, or Text.
4. Type in a Value.
5. Click OK.

**Sources**

An IBM Cognos Incentive Compensation Management Presenter report source provides a way to pull relevant information together into a single object that is well-structured for inclusion in a report.

Sources can include any combination of calculations, tables, parameters, and values.

For example, imagine that you have the following pieces:
- A calculation that calculates total sales for each payee that is partitioned by payee, product, and month
- A calculation that calculates total commission paid to each payee that is partitioned by payee, product, and month
- A calculated value that will show the total commission paid for the year
- A parameter that restricts by payee
A parameter that restricts by product

You can pull all these items together into a Presenter report source. This source can then be added to a data grid on the layout tab to show a report that contains value columns from each calculation, filters for payee and product, and a computed cell that will display the sum of the values displayed.

The following list outlines the types of sources:

- Data Sources
- Transformations

**Adding a data source**

You can add a calculation, data store, or table from the IBM Cognos Incentive Compensation Management Composer module as well as information from the Audit log as a source for your Presenter report.

**Procedure**

1. To add a data source, perform one of the following steps:
   - Right-click the Sources folder and select Add Source > Add Data Source.
   - Select the Sources folder, click the Add icon, and select Add Data Source.

   **Tip:** The Source wizard window is resizable.

2. Type a Name for the source and click Next.

   **Important:** You can also use the tabs to navigate to different steps in the wizard; however, all required fields must be completed before you can finish the wizard.

3. Select a calculation, table, or the Audit log as a source.

   **Note:** Whether or not the Audit Log is displayed as a source depends on the permissions set up for the user in the Manage Roles window.

4. Click Add if you want to add additional data to use in the source.
   You will be prompted to define restrictions for the data sources.

   **Tip:** You can use parameters created in Presenter as additional data.

5. If you have joined sources and want empty fields to be included when there is no matching data (outer join), click the Anchor Source Row button.

   **Important:** Restrictions for the outer join need to be defined during this step and not on step 4 of the Data Source Wizard. For more information on the Anchor Source Rows feature, see "Adding an anchor to a Presenter report source" on page 156.

6. Click Next.

7. Select the fields to display in your report by dragging columns into the right pane.

   **Tip:** To remove a selected field, right-click the field and select Remove Selected.

8. Click Next.

   If you added a parameter as an additional source, then you need to define the parameter restriction. For example, if you created a parameter that requires
users to select a payee in order to generate the report, the payee parameter needs to be linked to the payee ID in the source as follows: Payee Parameter ID = Payee Source ID.

**Important:** If you created an outer join using the anchor feature, restrictions for that join cannot be defined here. Restrictions defined on Step 4 of the wizard will define an inner join and rows that do not match will not appear.

10. Click **Next**.
11. To rename a column, click under **Display Name** and type in a new name. This step will be necessary if you have two columns with the same name. For example, if you have joined in two calculations that both contain a value column, you will need to give one of your value columns a new name.

**Important:** Changing the column name in this step will not change the display name of the column on the actual report. This is done in the Data Grid wizard.

12. Click **Finish**.

**Adding an anchor to a Presenter report source:**

Use the **Anchor Source Rows** button in the IBM Cognos Incentive Compensation Management Add Data Source wizard to join sources using a left outer join.

This join type displays rows for all records of the first data source even if the join does not find matching records in the second data source; however, only matched records from the second data source are returned. If the second data source returns one row and the first data source returns more than one matching row for it, the values in the second source are repeated for each distinct row in the first data source.

For example, consider the situation where you have the following two data sources.

*Table 36. Data source 1*

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
</tr>
<tr>
<td>Brian Acton</td>
<td>001</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
</tr>
</tbody>
</table>

*Table 37. Data source 2*

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>005</td>
<td>Training</td>
</tr>
</tbody>
</table>
When the Anchor Source Rows feature is used, records from the first data source are returned even when there is no matching record in the second source and gives you results like the following table:

Table 38. Results using Anchor Source Rows feature

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>Brian Acton</td>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Transformations

After an initial data source has been created in an IBM Cognos Incentive Compensation Management Presenter report, it can be used to create additional sources. The new sources are called transformations, because you can use them to transform the appearance of your source in order to present the data in a different way.

The following transformations are available:
- Aggregate transformation
- Computed column
- Transpose

**Important:** Creating a transformation based on a data source will create a brand new source. The original source will not be modified.

Adding aggregate transformations:

Use aggregate transformations to create a new source that performs a calculation on a set of data from the original source in an IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. In Presenter, expand the Sources folder.
2. To add an aggregate transformation, perform one of the following steps:
   - Right-click the data source you want to use for the transformation and select Add Source > Add Transformation > Add Aggregate Transformation.
   - Select the data source you want to use for the transformation, click the Add icon, then select Add Aggregate Transform.
3. Type a Name for the aggregate transformation and click Next.
4. Select a numeric column within the source and apply a formula to it.
5. Click Next.
6. Select partitions to display.
   - Use aggregate transformations to redefine the partitions of the original source to completely change the rows and columns that are displayed. Values can then be applied to further refine the data.
7. Click Finish.
   - The result is a new source with an aggregated results column.
Adding a computed column:

Add a computed column to a source to append an additional column to the source in an IBM Cognos Incentive Compensation Management Presenter report. The data in the computed column is the result of applying a formula to numeric columns in the original source. Numeric values can be pulled into the formula as well.

Before you begin

The following examples show scenarios for which you would use a computed column:

% Attainment Column: If your original source displays total sales for each payee, you may want to add a computed column that will display their quota attainment percentage. In this case, your computed column would display the results of a calculation that divides the sales amount by the quota amount.

Based on this example, your results would be comparable to the following computed column table.

<table>
<thead>
<tr>
<th>Payee</th>
<th>Quota</th>
<th>Sales</th>
<th>% Quota Attainment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2000</td>
<td>1000</td>
<td>50%</td>
</tr>
<tr>
<td>2</td>
<td>3000</td>
<td>2000</td>
<td>67%</td>
</tr>
<tr>
<td>3</td>
<td>1000</td>
<td>1500</td>
<td>150%</td>
</tr>
</tbody>
</table>

Procedure
1. Expand the Sources folder.
2. To add a computed column, perform one of the following steps:
   - Right-click the data source you want to add a computed column to and select Add Source > Add Transformation > Add Computed Column.
   - Select the data source you want to add a computed column to, click the Add icon, and select Add Computed Column.
3. Type in a name for the computed column.
4. Type in a new column name.
5. Click Next.
6. Define the formula.
7. Click Finish.
The result of a computed column transformation is a new source that displays the same information as the original source, along with an additional column that displays results of your computation.
Adding a transpose:

Use a transpose to transpose rows into columns to change the way your data is displayed in an IBM Cognos Incentive Compensation Management Presenter report.

About this task

Transpose can be helpful if the data you want to present is displayed in a different format than the final source results.

Table 41. Original data

<table>
<thead>
<tr>
<th>Payee</th>
<th>Month</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>Month 1</td>
<td>10</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 2</td>
<td>20</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 3</td>
<td>30</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 4</td>
<td>40</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 1</td>
<td>15</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 2</td>
<td>25</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 3</td>
<td>35</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 4</td>
<td>90</td>
</tr>
</tbody>
</table>

Table 42. Transpose original data

<table>
<thead>
<tr>
<th>Payee</th>
<th>Month 1</th>
<th>Month 2</th>
<th>Month 3</th>
<th>Month 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>15</td>
<td>25</td>
<td>35</td>
<td>90</td>
</tr>
</tbody>
</table>

In order for the Transpose functionality to be available, it needs an explicit key structure to work with. The workaround to define this key structure is to create an aggregated transformation of your source and partition by all of the columns. After this has been completed, you should be able to create a transposed source from the original source.

Procedure

1. Expand the Sources folder.
2. To add a transpose, perform one of the following steps:
   • Right-click the data source and select Add Source > Add Transformation > Add Transpose.
   • Select the data source, click the Add icon, and select Add Transpose.
3. Type a name for the transposed source and click Next.
4. Select the column to transpose.
5. Name the new column and click Next.
6. Choose the rows in the Row Value column and select >> to move them to the New Columns pane.
7. Click Finish.
Workflow Form ID
In an IBM Cognos Incentive Compensation Management Presenter report, the Workflow Form ID is an auto-generated number that can be used to distinguish results that were submitted by a specific workflow.

The Workflow Form ID number can be used to restrict data submitted in a workflow to be viewed only by users that view the same workflow. For example, if User A starts a workflow that submits Vacation Form 1 and User B starts a workflow that submits Vacation Form 1, then the Workflow Form IDs can be used so that the manager of both User A and B can view User A’s vacation form without seeing User B’s vacation form at the same time. To build a report like this, the Workflow Form ID must be entered into a table when users are starting the workflow, then this table is used as the source of the data grid for the record approver and the source must be restricted by the Workflow Form ID parameter.

Portal Access Inquiries source
The Portal Access Inquiries source contains inquiry information that can be reported on in an IBM Cognos Incentive Compensation Management Presenter report.

You can use the Portal Access Inquiries source to create a custom report on inquiries. The ID of the inquiry, the person who created the inquiry, the person who has been assigned the inquiry, the date the inquiry was created, updated, and closed, as well as the category of the inquiry can all be reported on. You can also use this source to determine the age of an inquiry by using a computed column in a data grid and subtracting the Created date column from the Updated date column.

Row form sources
A row form source provides a way to create an input row form that can be used by web users to submit rows of data to a table from an IBM Cognos Incentive Compensation Management Presenter report.

A row form source can only be created from a table. This source can then be used to create a data grid on the layout tab. The data grid will display table data with an input row located before or after the data grid for web users to submit data. Optionally, report administrators can choose to only display the input row and not the table data as well as whether to display this input row vertically or horizontally on the report.

Adding a row form source
In order to add an input row form to a data grid in your IBM Cognos Incentive Compensation Management Presenter report that allows web users to submit data, a row form source must be created using a Composer table as a source.

Procedure
1. To add a row form source, perform one of the following actions:
   - Right-click the Row Form Sources folder and select Add Row Form Source.
   - Select the Row Form Sources folder and click the Add icon.
2. Type a name for the input row source and click Next.
3. Select the table you want web users to be able to submit data to from the drop-down menu and click Next.
4. Drag the detail columns you want the users to be able to view and submit data from the left pane to the right pane.
5. When you are done defining the detail columns click **Next**.
6. Drag a column to the right to create a restriction for the data visible to web users.

   **Tip:** Click the **Preview** button to view the first 100 records of table data that are visible.

7. Click **Finish**.
Chapter 17. Presenter report layout and display options

After you have created the parameters, sources, and values you will need to add layout tables and the report components necessary to complete your IBM Cognos Incentive Compensation Management Presenter report.

Layout tables

After you have created your report building blocks, you are ready to start building the report in the Layout tab of your IBM Cognos Incentive Compensation Management Presenter report.

Layout methodology

Although ever report is different, the following methodology can help you layout the rows and columns in your IBM Cognos Incentive Compensation Management Presenter report in a logical manner.

Procedure

1. Create a layout table with three rows and three columns.

   You will only be using the middle cell for the report, so make the other cells as small as possible. The outside cells are used for padding.

2. Add a nested table with five rows and one column into the center column.

3. Add more nested tables to subdivide the rows as needed.

   Tip: Plan out your Presenter report before you start building your table.
Adding a layout table
You will need to create a layout table to contain the components of your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Select the Layout tab.
2. Right-click and select Add Layout Table.
3. You can give the layout table a name.

   Tip: Naming the layout tables is useful when creating workflows in the Workflow Manager module. As part of the workflow in Workflow Manager, you can select which layout tables in the report you want to be viewable and editable to web users.

4. Select the number of rows and columns for your table.
5. To enter row heights or column widths for the layout table, click the Set Row Heights or Set Column Widths links.
   a. Enter the percentage height or width for each row or column.
      The total percentage must equal 100%.
   b. Click OK.
6. When you are finished creating the layout table, click OK.

   Important: You cannot merge cells and columns, but you can add nested tables into cells. You can also easily resize any of your cells by selecting the cell border and dragging the grid lines.

Layout table lock
Use the Lock Table Layout button in the IBM Cognos Incentive Compensation Management Presenter toolbar to lock the layout tables sizes and to prevent accidental resizing.

The layout tables can be unlocked by clicking the Lock Table Layout button again.

Deleting a layout table
You can remove a layout table from the Layout tab in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Select the table.
   The selected area is highlighted in blue.
2. Right-click and select Delete.

Editing a layout table
You can make changes to a layout table after it has been created in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Select the table.
   The selected area is highlighted in blue.
2. Right-click and select Edit Layout Table.
3. Edit the number of columns and rows.
Swapping two layout tables

Layout tables can be swapped as long as one layout table is not the parent of the other in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Click the border of the table you want to swap.
2. Press Ctrl, and click the border of the other table.
3. Right-click and select Swap.

Resizing cells in a layout table

The row heights and column widths of a layout table can be resized after the table has been created in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. To resize the layout table, perform one of the following steps:
   - Drag the borders of the cells to the size that you want. A percentage of the layout table width or height is displayed.
   - Right-click the layout table, and select Edit Layout Table.
2. Click the Set Row Heights link to change the percentage of each row height and click OK.
3. Click the Set Column Widths link to change the percentage of each column width and click OK.
4. Click OK.

Report components

After you have created the structure of your IBM Cognos Incentive Compensation Management Presenter report, you can begin to add all of the components such as, text, data grids, charts, and maps.

Adding text and links

You can add text and format text in the selected cell as well as add links to your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table and select Add Text.
2. Type in your text.
3. Click Link to create a link from the text to another Presenter report, web form, or web page.
   For more information, see “Chart, report, and web page links” on page 185.
4. To format the text, see “Presenter report modifications” on page 186.

Setting the default font in Presenter

You can set the default font and size of the text used in IBM Cognos Incentive Compensation Management Presenter reports.

The default font will be applied automatically to any object with a configurable font that is added to the layout table.
Procedure
1. Click the Preferences button.
2. Under Default Font, click Font.
3. Select the Font, Font Style, Size, Effects, and Color you want.
4. Click OK.

Adding a date value display
You can add the current date into the selected cell of your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table, and select Add Data Value Display.
2. Type a name for the date value display.
3. Select the Value Source.
4. Select either the LongDate format, for example, Monday, January 17, 2013, or ShortDate format, for example, 1/17/13.
5. Click Link to create a link from the date value to another Presenter report, web form, or web page.
   For more information, see “Chart, report, and web page links” on page 185.
6. Click OK.

Adding a numeric value display
Add a numeric value display to add a numeric value to the selected cell of your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table, and select Add Numeric Value Display.
2. Type a name for the numeric value display.
3. Select the Value Source.
   You can choose from any saved constant, calculated, or stored values based on a numeric column.
4. Select the Decimal Places.
5. Select the number Type.
6. Click Conditional Formatting to set the format conditions for the numeric value display.
   For more information, see “Setting conditional formatting” on page 180.
7. Click Link to create a link from this value to another Presenter report, web form, or web page.
   For more information, see “Chart, report, and web page links” on page 185.
8. Click OK.

Adding a text value display
From any saved constant or stored value, you can add a text value to the selected cell of your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table, and select Add Text Value Display.
2. Type a name for the text value display.
3. Select the **Show Value**.
   You can choose from any saved constant or stored values based on a text column.

4. Click **Link** to create a link from this value to another Presenter report, web form, or web page.
   For more information, see “Chart, report, and web page links” on page 185.

5. Click **OK**.

### Adding a data grid

Data grids are used to display the results of a single data source in a table in your IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. To add a data grid to the layout table, perform one of the following steps:
   - Right-click a cell in your layout table, and select **Add Data Grid**.
   - Drag the source you want to use in the data grid onto a cell in the layout table.

2. In the Display Selector window, select **Data Grid** and click **OK**.
   
   **Important:** If a source is dragged into a layout table that does not contain a numeric column, a data grid will be created automatically.

3. Right-click the data grid, and select **Edit Data Grid**.

4. Type a name for the data grid.

5. Select a source.
   You can select any Presenter report sources to add to your grid. If you dragged a source onto the layout tab, this field will be pre-populated with the source.

6. Click **Next**.

7. Drag a column from the left to the right screen to sort the data.
   You can select more than one column to sort by.
   a. Right-click the column, and select either **Order Ascending** or **Order Descending**.

   **Important:** If a column is sorted at the time of data grid creation, it will not be sortable in the web client. Columns need to be sorted separately for each section of the grid. Sorting will not go beyond section breaks.

8. Click **Next**.

9. Select your data grid display options.
   For more information, see the **Data grid display options** section.

10. Click **Next**.

11. If you are sorting your data source by a date column from a table and want to create section breaks by time, select a calendar from the **Calendar** drop-down menu to associate with the date column.

   **Important:** A calendar only needs to be selected if you are sorting your grid by a date column that does not have a calendar associated with it. For example, you have a Custom table with a date column and you want to create a section break by time period. If you are not sorting your data grid by a date column, a calendar does not need to be selected. If you are sorting your data
grid by a time partition, all potential section breaks will be associated with the calendar tied to the data grid source, and the calendar drop-down will be disabled.

12. To delete any repeated group partitions, select the **Suppress Repeated Partitions** check box.

13. If you want payees to have the ability to export this grid to Excel via the web client, select the **Enable Export to Microsoft Excel** check box.

14. To display headers for each section, select the **Show Section Headers** check box.

15. Click **Add** to specify any section breaks and to add information to the sections.
   a. Select a section to add from the drop-down menu and click **OK**.
   b. To modify the section break, select it and click **Edit**.

16. Select a section break and click **Base Font** to format, align, and select the shading for section breaks.

17. Drag the section breaks to change their order.

   **Important:** Section breaks display in the order they appear in the window.

18. Click **Finish**.

**Adding a data grid with an input row form**

A row with data submission fields can be added to a data grid or displayed by itself on a IBM Cognos Incentive Compensation Management Presenter report so web users can submit data to a table.

**Procedure**

1. Add a data grid to the layout table using a row form source.

2. To display only the input row and not the entire data grid, select the **Display only input row** check box in step 4 of the Data Grid Wizard.

3. Select where you want the input row to be placed.
   - If you select **Display only input row** check box, you can choose to display the input row vertically on the report by selecting the **Show vertical** check box.

4. In the Local column drop-down menus, select **Blank**, **Auto-Generate**, or an existing parameter for any primary key columns.
   - If you select **Blank**, the field will be displayed as empty on the report. For each non-primary key column, you can select **Blank** or an existing parameter to fill the input field.
   - If you select **Auto-Generate**, a new primary key will automatically be created in the field.

5. If you have a pick list column, you can choose how the pick list input row is displayed by performing the following steps:
   a. Click the **Configure Pick List** button.
   b. In the Pick List Control window, select the field you want to be displayed as the description.
   c. Select to sort the pick list by the **ID** or by the **Description**.
   d. Select **Ascending** or **Descending** as the **Sort Order**.
   e. You can choose to **Hide ID** or **Hide Description** in the pick list.
   f. Click **OK**.

6. You can add validation rules for each input field by following these steps:
a. Click Add.
b. Select the column you want to add the validation rule to.
c. Select the operator.
d. Select the Value, Source, or Parameter to finish the validation rule.
7. You can add filters to the pick list columns by following these steps:
   a. Click Add.
   b. Select the Column to Filter.
   c. Type a Filter Name.
   d. Click Next.
   e. Define the filter restrictions.
8. Finish the Data Grid Wizard.

Adding a fixed grid

A fixed grid is a static number of rows and columns used to display items on your IBM Cognos Incentive Compensation Management Presenter report.

Fixed grids are commonly used to display more than one value.

Procedure

1. Right-click a cell in your layout table, and select Add Fixed Grid.
2. Type a name for the fixed grid.
3. Drag the value sources from the list into the grid.
4. Enter the Date Value, Numeric Value, or Text Value display information and click OK.
5. To add text, select the cell and type in the text you want to be displayed.
6. Right-click any cell to resize the grid, resize the columns, show grid lines, change the font, edit the cell, or delete the cell.
   You can select multiple cells of the same type to edit at the same time by using Ctrl + click.
7. To add a submit button, right-click a cell, and select Add Submit Button.
8. To add a text control, right-click a cell, and select Add Text Control.
9. To add a pick list control, right-click a cell, and select Add Pick List Control.
10. Use the toolbar to format the cells of the fixed grid.
11. If you want payees to have the ability to export this grid to Microsoft Excel via the web client, select the Enable Export to Microsoft Excel check box.
12. Click OK.

Exporting data grids and fixed grids to Microsoft Excel

When the export to Microsoft Excel option is enabled, the IBM Cognos Incentive Compensation Management web user will have the option of exporting the grid to Microsoft Excel in either the .xls or .xlsx format.

For data grids, the Excel export file type is selected from a drop-down menu on the report header. For fixed grids, the Microsoft Excel export file type is selected by clicking the appropriate icon above the grid.

Important: The export to Microsoft Excel option is not displayed if the grid is empty.
Adding images

You can add a logo or other image to your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table and select Add Image.
2. Type a name for the image.
3. Click Browse to locate the image on your computer.
4. Click Link if you want the image to act as a link to another Presenter report, web form, or web page.
5. Click OK.

Adding a single series chart

A single series chart displays the results of one source on your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. To add a single series chart, perform one of the following steps:
   - Right-click a cell in your layout table, and select Add Single Series Chart.
   - Drag the source you want to use in the single series chart onto a cell in the layout table.
2. In the Display Selector window, select Single Series Chart and click OK.
3. Right-click the chart component, and select Edit Single Series Chart.
4. Type a name for the single series chart and click Next.
5. Select a Chart Type.
   a. Select Classic Style or Solid Style from the drop-down menu.
   b. Click Next.
6. Select the chart Source.
   If you have clicked and dragged a source onto the layout tab, this field will be pre-populated with the selected source.
   Tip: Any sources created in Presenter can be used.
7. Select the Display Column.
8. Select the Value Column.
9. Click Add Link if you want the chart to act as a link to another Presenter report, web form, or web page.
10. Click Next.
11. Select the Chart Details by performing the following steps:
   a. Type a Name for the chart, and click Font to change the style of the text.
   b. Type the Axis Titles, and click Font to change the style of the text.
   c. Select the Size of the chart in pixels
   d. Click Next.
12. Select the Additional Chart Details by performing the following steps:
   a. Set the Font for the X-axis and Y-axis labels, and select the X-axis style from the drop-down menu.
   b. To sort the X-axis by an ascending or descending order, select the Sort X-axis check check box, and select either Order Ascending or Order Descending.
c. To have no values displayed on the chart, select the **Hide Value Labels** check box.

d. You can define a **Value Prefix** and **Value Suffix**. Typical examples include $ or %.

e. Select the **Percentage** check box to display results as a percentage.

f. Select a decimal or comma as the **Decimal Separator** for the displayed results.

g. Select the **Number of Decimal Places** for the displayed results.

h. Select a comma or period as the **Thousand Separator** for the displayed results.

i. If you select the **Number Scaling** check box, larger values will be shortened and represented by $K or $M (for example, 50K instead of 50,013). If you do not select the **Number Scaling** check box, the full value will be displayed.

13. Click **Finish**.

### Adding a multi-series chart

A multi-series chart displays the results of more than one source on your IBM Cognos Incentive Compensation Management Presenter report.

### Procedure

1. Right-click a cell in your layout table, and select **Add Multi-Series Chart**.

2. Type a name for the multi-series chart and click **Next**.

3. Select a **Chart Type**.
   a. Select either **Classic Style** or **Solid Style** from the drop-down menu.
   b. Click **Next**.

4. To set the sources for the chart, preform the following steps:
   a. Click **Add**.
   b. Select the chart **Source**.
   c. Select the **Display Column**.
   d. Select the **Value Column**.
   e. Click **OK**.

5. Right-click a row, and select **Set Link** if you want the chart to act as a link to another report, web form, or web page.

6. You can select a row, and click **Up** or **Down** to reorder the sources.

7. You can select a row, and click **Remove** to delete the source.

8. You can select a row, and click **Edit** to modify the source.

9. Click **Next**.

10. Select the **Chart Details** by performing the following steps:
    a. Type a name for the chart, and click **Font** to format the title.
    b. Type names for the **Axis Titles**, and click **Font** to format the titles.
    c. Set the **Size** of the chart.
    d. Select the **Show Legend** check box, and select the position and format of the legend.
    e. Click **Next**.

11. Set the **Additional Chart Details** by performing the following steps:
    a. Select either **Horizontal** or **Slanted** for the X-axis labels.
b. Click Font to modify the text and click the colored square to modify the font color.

c. Select the Hide Value Labels if you do not want to show the value labels on the chart.

d. Select the Sort X-axis check box to set the sort order of the X-axis to ascending or descending.

e. You can define the Value Prefix and Value Suffix.

f. Select the Percentage check box to display results as a percentage.

g. Select a decimal or comma as the Decimal Separator for the displayed results.

h. Select the Number of Decimal Places for the displayed results.

i. Select a comma or period as the Thousand Separator for the displayed results.

j. If you select the Number Scaling check box, larger values will be shortened and represented by K or M (for example, 50K instead of 50,013). If you do not select the Number Scaling check box, the full value will be displayed.

12. Click Finish.

Adding a map
Maps can be used to view values of data sources for regions in territories in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. To add a map to your layout table, perform one of the following steps:
   • Right-click a cell in your layout table and select Add Map.
   • Drag the source you want to use in the map onto a cell in the layout table.
2. In the Display Selector window, select Map and click OK.
3. Right-click the map component, and select Edit Map.
4. Type a Name for the map and click Next.
5. Select a Map Type to display the results of the selected cell and click Next.

   Important: Territory codes must be set up in a Territory table in Composer. Cognos Incentive Compensation Management will provide you with the Microsoft Excel data to import.

6. Select the chart Source, Display Column, and Value Column.
   If you dragged a source onto the Layout tab, the source field will be pre-populated.
7. Click Next.
8. To add value ranges to color code the map, perform the following steps:
   a. Click Add.
   b. Type a Name for the label.
   c. Select the Min and Max ranges.
   d. Select the Color.
   e. Click OK.
9. When you have finished adding value ranges, click Next.
10. Click Add to specify links for the map drill-down.
    a. Type the Display Value.
       This is the ID of the map you want to link to.
b. Click Add to add a link to another Presenter report with a map.

11. Click Next.

12. Select the map details by performing the following steps:
   a. Click Font to format the map labels, and click the colored square to change
      the font color.
   b. You can select the Hide Value Labels check box to stop values from
      appearing on the map.
   c. You can define the Value Prefix and Value Suffix.
   d. Select the Percentage check box to show the values as a percentage.
   e. Specify the width and height in pixels.
   f. Select the Show Legend check box to display a legend for the map, select
      either On Bottom or On Right to set the position of the legend, and
      format.
   g. Select a decimal or comma as the Decimal Separator for the displayed
      results.
   h. Select the Number of Decimal Places for the displayed results.
   i. Select a comma or period as the Thousand Separator for the displayed
      results.
   j. If you select the Number Scaling check box, larger values will be shortened
      and represented by K or M (for example, 50K instead of 50,013). If you do
      not select the Number Scaling check box, the full value will be displayed.

13. Click Finish.

Adding a gauge

Gauges can be created to represent calculations that do not contain partitions on
your IBM Cognos Incentive Compensation Management Presenter report. They
show the result of the calculation. For example, gauges can be useful when you
want to look at a total value.

You need at least three numeric values to create any gauge, including minimum,
maximum, and current values.

Procedure

1. Right-click a cell in your layout table and select Add Gauge.
2. Type a name for the gauge and click Next.
3. Select either an Angular, Cylindrical, or Horizontal Linear gauge type.
   a. Select either Classic Style or Solid Style from the drop-down menu.
   b. Click Next.
4. Select the Min Value Source, Max Value Source, and Current Value Source.
5. You can select the Show Trendpoint check box, and select a trendpoint value
   source.
6. Click Set Link if you want the chart to act as a link to another report, web
   form, or web page.
7. Click Next.
8. To add a value range, perform the following steps:
   a. Click Add to add a value range.
   b. Type a Name for the label.
   c. Select a Min, Max, and Color.
   d. Click OK.
Tip: You should have three ranges such as weak, average, and strong.

9. Click Next.

10. Select the gauge details by performing the following steps:
   a. Type and format the Limit and Tick Labels.
   b. Select and format the Size of the gauge, the Pointer Value, and the Trendpoint.

11. Click Finish.

Adding a text control

Use the text control option to add a text box that a user will use to enter information that fills a selected parameter on the IBM Cognos Incentive Compensation Management Presenter report.

About this task

If you have added a parameter to your Presenter report source, you will need to create a place on the report for the user to select the parameter. This can be done by creating either a text control or a pick list control. For example, if you add a text control that fills a parameter based on payee ID, the user will type the payee ID into the box to render report information. The ability for web users to perform a wild card search of a data source for the value to enter in the text control can be enabled from the Cognos Incentive Compensation Management Client.

Procedure

1. Right-click a cell in your layout table, and select Add Text Control.
2. Type a name for the input box.
3. Select a parameter that the input box will fill.
4. You can select the Hide Value For Export check box to make sure the value is not displayed on a published report.
5. To let web users type in the exact value or use an asterisk to perform a wild card search for a value to enter in the text control, follow these steps:
   a. Select the Enable Wild Card Search check box.
   b. From the Source drop-down menu, select the data source that contains the values to be searched in the text control.
   c. From the Column drop-down menu, select the column of the data source that contains the values to be searched in the text control.
6. Click OK.

Important: To use a text control, you must have a Submit button on the form.

Adding a pick list control

Create a pick list control to create a drop-down list in your IBM Cognos Incentive Compensation Management Presenter report based on a source table.

The item selected from the list will be used to fill the selected parameter.

About this task

For example, if you add a pick list control based on the Payee table that fills a parameter based on payee ID, the user will select the payee ID from the menu to render report information. Pick lists can be configured to display either ID,
description, or both in the drop-down menu. Options have also been provided to sort pick lists by either the description or ID field in ascending or descending order.

**Procedure**
1. Right-click a cell in your layout table, and select **Add Pick List Control**.
2. Type a name for the pick list control.
3. Select the **Source**.
4. Select column from the source for the **Description**.
5. Select a parameter.
6. Select either **ID** or **Description** for the **Sort By** option.
7. Select the **Sort Order**.
8. You can select the **Hide ID Column** check box to show only the **Description** column in the pick list.
9. You can select the **Hide Value For Export** check box to make sure the pick list control is not displayed on published reports.

**Filtering pick lists based on selected parameters**
Options listed in pick list controls can be filtered based on what was selected in another pick list control in your IBM Cognos Incentive Compensation Management Presenter report, for example, a pick list that only displays employees that report to a selected manager.

**Procedure**
1. Create structural tables to use as sources for pick list controls.
   For example, you could create one table that contains territories to be selected and another table that contains cities. The table containing cities would have a pick list field linked to the territories table.
2. Create parameters needed for your pick list controls.
   For example, create a Territory parameter and a City parameter.
3. Add your first pick list control by right-clicking a cell and selecting **Add Pick List Control**.
4. Define the pick list control by selecting its data source and the parameter it fills.
   For example, create a pick list control that fills the territory parameter.
5. Create a Presenter source for your second pick list control. This source will be linked to the parameter used for your first pick list control.
   For example, this source would contain the city table and the territory parameter: CityTable.Territory = PaTerritory.Territory.
6. Add the second pick list control.
   For example, use the source created in step 4 as the source for the pick list control.
7. Add a submit button and complete the report.

**Adding a workflow dashboard**
Links to workflows created in the Workflow Manager module can be included in an IBM Cognos Incentive Compensation Management Presenter report.

When a web user clicks the workflow link in the Presenter report, the workflow will open.
Procedure
1. Right-click the layout table, and select Add Workflow Dashboard.
2. Type a name for the workflow dashboard control.
3. From the Workflow Status drop-down menu, select the status of the workflows that you want to display on the dashboard.
   For example, if you want the dashboard to display links to pending workflows, select Pending from the drop-down menu.
4. If you do not want headers displayed on the workflow dashboard, unselect the Enable Headers check box.
5. Select the additional columns that you want to display.
6. Use the toolbar to set the format of the dashboard.
7. Click OK to save your changes.

Adding a submit button
Submit buttons are necessary for rendering data based on selected parameters in your IBM Cognos Incentive Compensation Management Presenter report.

Pick list and text controls require a submit button for the selected or entered parameter to populate.

Procedure
1. Right-click a cell in your layout table, and select Add Submit Button.
2. Type in the button text.
3. Click OK.

Deleting layout table contents
The contents of the selected cell in the layout table of your IBM Cognos Incentive Compensation Management Presenter report can be cleared.

Procedure
Right-click a component in your layout table, and select Delete.

Data grid display options
Data grids in IBM Cognos Incentive Compensation Management Presenter reports have very configurable display options.

When you get to the Data Grid Display Options step when adding a data grid, you can use the toolbar to format the cells in the grid or you can select a column or row and right-click it, to show several other available options. From the data grid display options window you can specify report formatting, set conditional formatting, set alternating row fonts, or set links by right-clicking the appropriate column.

Creating editable columns
You can allow web users to edit existing data in IBM Cognos Incentive Compensation Management Composer tables through Presenter data grids.
Procedure
1. In the Data Grid Display Options step of the Data Grid Wizard, highlight the column that you want to make editable.
2. Right-click the column and select Toggle Editable.
3. To add validation rules for the editable column, click Next.
5. In the Input Rule window, select the Column you want to make the validation rule for, and select an Operator from the drop-down menu.
6. Create the Constraint using the Value, Source, or Parameter tabs.
7. Click OK.

**Important:** You must add a submit button to the report after creating editable columns in the data grid.

Adding validation rules on submit of data grid values
You can create rules that web users must follow before submitting data through a Presenter report data grid or row form on the Cognos Incentive Compensation Management Web Client.

These rules are used to validate an aggregation of data for the whole data grid, such as a maximum or minimum, average, or sum of all the data. If a web user enters data that does not follow the validation rule, a user-defined error message will display when the user clicks the Submit button. For example, a regional sales manager has a discretionary bonus of $1000 that he can spread amongst his team as a reward for high performance. You can create a computed row in the data grid to calculate the total amount of bonuses distributed, and add a validation rule to ensure that the total amount does not exceed $1000 before the regional sales manager can submit the data. This feature is not meant to validate individual rows of data that a user enters into the data grid. For more information on creating those types of validation rules, see “Creating editable columns” on page 176.

Procedure
1. Create a data grid with at least one editable column or a data grid using a row form source.
2. In the Data Grid Display Options step of the Data Grid Wizard, right-click the data grid, and select Add/Edit On Submit Validation Rules.
3. Click Add.
4. Create the validation rule in the Rule pane.
   You can drag any source from the Available Source pane to create the rule.
5. In the Set error message pane, type the message you want web users to receive if they attempt to submit invalid data.
6. Click OK.

Setting the show or hide columns feature for the web client
You can enable a feature that lets web users show or hide data grid columns in the IBM Cognos Incentive Compensation Management web client.

When web users export a data grid to a PDF file or Microsoft Excel, only columns that are visible at the time of export are included.
**Procedure**

1. On the Data Grid Display Options window, right-click and select Enable Show/Hide Columns.
   
   Users can select which columns in the data grid to show or hide via the web client.

2. After the option has been enabled, right-click a column and choose Select Column.

3. Right-click the selected column, and select Column Display, and then select Hidden or Initially Hidden.
   - If Initially Hidden is selected, the column will not be initially displayed when the user loads the report in the web client. But the user will have the option to show the column.
   - If Hidden is selected, the column will not display in the web client, and the user will not have the option to show the column.
   - If the Enable Show/Hide Columns option is selected, and no Column Display option is selected for a column, the column will be initially displayed. The user will have the option of hiding the column.

   **Important:** Showing or hiding columns will not change column ordering.

**Renaming data grid columns**

You can change the display name of the data grid column in your IBM Cognos Incentive Compensation Management Presenter report.

Special characters can be used in data grid column headers; however, the column name cannot end in an underscore.

**Procedure**

1. In the Data Grid Display Options step, highlight all the cells in the column you want to rename then right-click the column.

2. Select Rename Column.

3. Type a name for the column and click OK.

**Resetting data grid column names**

You can change the column name of a data grid back to its original name in your IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. In the Data Grid Display Options step of the Data Grid Wizard, highlight all the cells in the column then right-click the column.

2. Select Reset Column Name.
   
   The column name returns to its original name.

**Setting column widths**

When creating a data grid or a fixed grid in an IBM Cognos Incentive Compensation Management Presenter report, column and table widths can be specified.

Specify the width as a percentage of grid columns to have more control over the appearance of the report.
**Procedure**

1. In the Data Grid Display Options step, right-click the column, and select Set Column Widths.
2. Set a width for each column as a percentage of the total width of the data grid.

   **Tip:** Press the Tab key to move from one column to another.
3. You can click Reset to allocate all column widths evenly.
4. Click OK.

   **Note:** The Total % number is dynamically updated. The widths of all the columns must add up to 100.

**Adding computed columns**

A column can be added to a data grid to display the value of a simple math function using the available numeric columns in the data grid on your IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. In the Data Grid Display Options step, right-click the data grid, and select Add Computed Column.
2. Type a name for the column and click OK.
3. To create a formula, highlight the computed column, right-click it and select Computed Column Formula.
4. In the Formula pane, type the formula for the cell using the Available Sources.
5. Click OK.

**Adding computed rows**

A row can be added to a data grid to display text or the value of a simple math function using the available numeric columns in the data grid of your IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. In the Data Grid Display Options step, right-click the data grid and select Add Computed Row.
2. To add text to a cell, highlight the column the cell is in, right-click the column, select Computed Row Formula and perform the following steps:
   a. Select Text and type the text into the Text field.
   b. Click OK.
3. To add a formula to a cell, highlight the column the cell is in, right-click the column, select Computed Row Formula and perform the following steps:
   a. Select Formula.
   b. In the Formula pane, type the formula for the cell using the Available Sources.
   c. Click OK.

**Links**

You can create a link from an item in a column to another IBM Cognos Incentive Compensation Management Presenter report, web form, or a web page.

For more information, see "Chart, report, and web page links" on page 185.
Clearing links
You can clear any links you have added to the selected data grid column in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. In the Data Grid Display Options step in the Data Grid Wizard, highlight all the cells in a column, then right-click the column.
2. Select Clear Link.
   Any link that has been added will be cleared.

Formatting columns
You can format the headers, apply conditional formatting, and set the numeric format of values in the data grid of your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. To modify the column headers, perform one of the following steps:
   • Select a header or press Shift and highlight all the headers, use the toolbar to set the font, font size, font style, font color, background color, and alignment of the column headers you selected.
   • Select a header, right-click, and select Format Headers > All Headers. In the Format Cells window, select the font, alignment, and shading for the cells.
2. To modify a numeric column, perform one of the following steps:
   • Highlight the numeric column, and select the number style and number of decimal places from the drop-down menus in the toolbar.
   • Highlight the numeric column, right-click the column, and select Format Column > Numeric Format. Set the Decimal places and numeric format Type and click OK.

Suppressing data grid headers
You can choose to not display the headers of a data grid in your IBM Cognos Incentive Compensation Management Presenter report.

When this option is selected, data grid headers will not be displayed in the web client. This option applies to the entire grid and not specific columns.

Procedure
1. In the Data Grid Display Options step, right-click the data grid.
2. Select Format Headers > Suppress Headers.

Setting conditional formatting
You can specify different text and numeric formatting for values in a data grid column of your IBM Cognos Incentive Compensation Management Presenter report when certain conditions are true.

For example, when a value in the results column is less than a certain amount, you may want to display those numbers in red.

Procedure
1. In the Data Grid Display Options step of the Data Grid Wizard, highlight a column, then right-click the column.
Note: Conditional formatting can only be applied to numeric columns.

2. Select Format Columns > Conditional Formatting.
3. Click Add.
4. Drag an available column into the condition pane.
5. Type a condition.
   To define the condition, you can use any of the formulas that are available in Composer.
   a. To define multiple conditions, type AND(<condition1>,<condition2>).
      For example, type AND(Source.YTDSales>= 0,Source.YTDCommission< 0).
6. Use the toolbar to indicate what formatting should be applied to values that meet the condition and click OK.

   Tip: To make sure the conditional formatting does not interfere with the alternate row formatting of the data grid, set the cell shading color to transparent.
7. Repeat the steps above to add as many conditions as necessary.
   Multiple conditions can be applied to a column.
8. Use Up and Down to order multiple conditions.
   Formatting will be applied in the order that the conditions are listed.
9. When you are done adding conditional formatting, click OK.

Setting alternating row fonts
If this option is selected, you can define different formatting for odd and even rows in your IBM Cognos Incentive Compensation Management Presenter report. If unselected, the same formatting is applied to all rows.

**Procedure**
1. In the Data Grid Display Options step, highlight a column, then right-click the column.
2. Select Format Rows > Allow Alternating Row Fonts.

Formatting data grid rows
You can modify the format of the rows in the data grid of your IBM Cognos Incentive Compensation Management Presenter report.

If you have set alternating rows, you will need to define formatting for both odd and even rows.

**Procedure**
1. If you have set alternating rows, in the data grid, select an odd or even row.
   All odd or even rows are highlighted.
2. If you have not set alternating rows, select a row in the data grid.
   All the rows are highlighted.
3. Use the toolbar to set the font, font size, font style, font color, background color, and alignment of the rows.

Showing the date and time in data grid columns
Users can display either date only or date and time for a date column in an IBM Cognos Incentive Compensation Management Presenter report data grid.
Procedure

In step 3 of the Data Grid Wizard, perform one of the following steps:

- Right-click a date column, click Select Column, and select either Date or Date and Time from the drop-down menu in the toolbar.
- Right-click a date column, select Format Column > Date Format, and select either Date or Date and Time.

Important: When the date and time format is applied to the Audit.Time column, the recorded time will be added to the end of the date. If the Date and Time option is selected for a date column that does not have a time, 12:00AM will be appended to each date.

Showing grid lines

If this option is selected, the grid lines for the data grid will be displayed in your IBM Cognos Incentive Compensation Management Presenter report. If unselected, the grid lines will not be displayed on the report.

Procedure

1. In the Data Grid Display Options step of the Data Grid Wizard, highlight a column, then right-click the column.
2. Select Show Grid Lines.

Output null numeric values in data grids

Null numeric values will be displayed as empty in the data grid of your IBM Cognos Incentive Compensation Management Presenter report.

If an empty row appears (either because it has null partitions or empty string partitions with null numeric values), then it will not display in the data grid.

How null values are handled in Presenter

The following chart outlines the expected results of formulas using null values in IBM Cognos Incentive Compensation Management Presenter reports.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Effect Using the Null Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add (x+y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
<tr>
<td>Divide (x/y)</td>
<td>If any argument is empty, the result is empty. If the denominator is 0, the result is 0.</td>
</tr>
<tr>
<td>Subtract (x-y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
<tr>
<td>Multiply (x*y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
<tr>
<td>Negation (-x)</td>
<td>The negative of an empty value is empty.</td>
</tr>
<tr>
<td>Equal (x=y)</td>
<td>If both operands are empty, then the result is True. If only one operand is empty, then the result is False.</td>
</tr>
<tr>
<td>Not Equal (x!=y)</td>
<td>If both operands are empty, the result is False. If only one operand is empty, the result is True.</td>
</tr>
<tr>
<td>Formula</td>
<td>Effect Using the Null Value</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Greater (x&gt;y) and (x&gt;=y), Less(x&lt;y) and (x=&lt;y)</td>
<td>If any operand is empty, then the result is False.</td>
</tr>
<tr>
<td>AVG(x)</td>
<td>The sum of non-empty items is divided by the count of non-empty items.</td>
</tr>
<tr>
<td>COUNT(x)</td>
<td>The Count returns the number of rows.</td>
</tr>
<tr>
<td>MAX(x,y+) and MIN(x,y+)</td>
<td>If all values are empty, it returns empty. Otherwise, it returns the maximum or minimum of non-empty values.</td>
</tr>
<tr>
<td>MAX(x) and MIN(x)</td>
<td>This will get the aggregate maximum or minimum. If all values are empty, it returns empty. Otherwise, it returns the maximum or minimum of all non-empty values.</td>
</tr>
<tr>
<td>MULT(x)</td>
<td>If all values are empty, it returns empty. Otherwise, it returns the result of multiplying all the non-empty values.</td>
</tr>
<tr>
<td>SUM(x)</td>
<td>This will aggregate all the non-empty values and return their sum. If all values are empty, then the result is empty.</td>
</tr>
<tr>
<td>IF(x,y,z)</td>
<td>This has the same behavior as version 7.1.0</td>
</tr>
<tr>
<td>AND(x,y+), OR(x,y+), NOT(x)</td>
<td>These have the same behavior as version 7.1.0</td>
</tr>
<tr>
<td>POW(x,y)</td>
<td>If either value is empty, it returns empty.</td>
</tr>
</tbody>
</table>
| PREV() | If the previous value is empty, it returns empty.  
**Note**: For the first row, the PREV value is considered to be 0. |
| ROUND(x,y), ROUNDDOWN(x,y) | If either value is empty, it returns empty. |
Chapter 18. Working with completed Presenter reports

IBM Cognos Incentive Compensation Management Presenter reports can be modified, previewed, published, and linked to other reports, web forms, or web pages.

Chart, report, and web page links

IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

A link can be created from an image, text, or the contents of a report column. Links can be made to web forms, web pages, Presenter reports, and parameters. You can set a link to a web form, web page, or other report using parameters. This functionality is available for text, numeric, and date values, both directly in the layout and in a fixed grid.

Linking to a report

You can link an image, text, or the contents of a report column to another IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. When adding an image or text to the layout table, click the Link button.
2. When adding a link to the contents of a report, right-click the column and select Set Link.
3. In the Link to section, select Report.
4. Select the Report you want to link to from the drop-down menu.
5. Double-click the row to select the Parameter Type and Value.
   When linking to another report, you do not have to carry over the parameters. If you choose to, you will need to drag the parameters from the current report to corresponding parameters in the report being linked to.

Linking to web forms

You can link an image, text, or the contents of an IBM Cognos Incentive Compensation Management Presenter report column to a web form.

Procedure
1. When adding an image or text to the layout table, click the Link button.
2. When adding a link to the contents of a report, right-click the column and select Set Link.
3. In the Link to section, select Web Form.
4. Select the web form you want to link to from the drop-down menu.
5. Double-click the row to select the Parameter Type and Value.
   When linking to a web form, you do not have to carry over the parameters. The filters you created in the web form will be displayed in the Parameter column of the Link Wizard.
Linking to web pages

You can link an image, text, or the contents of an IBM Cognos Incentive Compensation Management Presenter report column to any HTTP, HTTPS, FTP, or MAILTO location.

Procedure
1. When adding an image or text to the layout table, click the Link button.
2. When adding a link to the contents of a report, right-click the column and select Set Link.
3. In the Link to section, select Web Page.
4. Type in the URL that you are linking to in the Address field.

Presenter report link with parameters example

Consider the following scenario. You have two IBM Cognos Incentive Compensation Management Presenter reports: one that contains a summary of each payee's total sales for each month, and another that contains detailed transactional information for each payee's sales for each month.

You want users to be able to view the first report for specific payees in specific months. Then you want users to be able to link to the detailed report, without having to reselect the appropriate payee and month.

1. Create Report 1, which contains a summary of each payee's total sales for each month.
2. Add two parameters to this report: a payee and a month filter.
3. Create Report 2, which contains detailed transactional information for each payee's sales for each month.
4. Add two parameters to this report: a payee filter and a month filter.
5. Add text to a cell in the first report that says "Link to detailed report" and create a link from that text.
7. Match the payee filter from Report 1 to the payee filter in Report 2, and match the month filter from Report 1 to the month filter in Report 2.

Presenter report modifications

After creating an IBM Cognos Incentive Compensation Management Presenter report, you can easily make changes to the whole layout table or to specific objects.

When an object has been placed in the report, you can make changes to the font, cell shading, cell border, cell padding, and alignment. You can edit one object at a time, or select multiple objects of the same type to edit at once.

Tip: To select multiple objects of the same type, right-click and choose Select All With Same Type in the menu, or use Ctrl + click.

Editing the font in Presenter reports

You can modify the font, cell shading, and alignment of text in the layout table in your IBM Cognos Incentive Compensation Management Presenter report.
Procedure
1. In the layout table, select an object to modify.
2. Use the toolbar to change the font, cell shading, and alignment.

Editing the padding in layout tables
You can specify the amount of space in pixels that will be displayed outside a component in your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. In the layout table, select an object to modify.
2. Right-click and select Edit Padding.
3. Set the Top, Bottom, Left, and Right padding in pixels.
4. Click OK.

Editing the border in a layout table
Each component added to the IBM Cognos Incentive Compensation Management Presenter report can have a border around it.

Procedure
1. In the layout table, select an object to modify.
2. Right-click and select Edit Border.
3. Set the Width and Color, or set the Top, Bottom, Left, and Right border Width and Color.
4. Click OK.

Editing alignment in the layout table
The alignment of the object within the cell of the layout table can be set in your IBM Cognos Incentive Compensation Management Presenter report.

You can choose from nine different types of alignment.

Procedure
1. In the layout table, select an object to modify.
2. Use the toolbar to modify the alignment.

Undo and redo buttons in Presenter
You can use the Undo and Redo buttons on the toolbar to correct mistakes made in your IBM Cognos Incentive Compensation Management Presenter report up to and beyond the last save.

However, if you perform a Save As or Refresh, the actions in the undo history are cleared and you will not be able to undo any actions.

Previewing a Presenter report
After you have created an IBM Cognos Incentive Compensation Management Presenter report on the Layout tab, you can view what the report will look like to web users.
Preview the report to make sure the Presenter report will be displayed as you want in the web client.

**Procedure**

1. First, set the parameter values for the report by clicking the **Set Parameter Values** icon and performing the following steps:
   a. Select the **Current Web User** from the drop-down menu.
   b. Select any other parameters required in the report.
   c. Click **OK**.
2. Click the **Preview** tab.

**Printing a Presenter report chart**

From the **Preview** tab, you can choose to print charts that you have added to the IBM Cognos Incentive Compensation Management Presenter report.

**Procedure**

1. Right-click a chart.
2. Select **Print Chart**.

**Enabling rotation or slicing movement in charts**

For some charts, you can enable rotation or slicing movement when the chart is viewed in the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. Right-click a chart.
2. Select **Enable Rotation** or **Enable Slicing Movement**.

**Publishing Presenter reports**

Presenter reports can be published from the IBM Cognos Incentive Compensation Management Client and web client as PDF files.

Before publishing Presenter reports, make sure you have selected the appropriate PDF options and preferences.

**Selecting publishing preferences**

Options selected in the **Preferences** window are displayed in the **Preview** tab of the IBM Cognos Incentive Compensation Management Presenter module and when viewing the Presenter report in the web client.

**Procedure**

1. In Presenter, click the **Preferences** icon.
2. Define the dimensions in pixels of the report when previewing the report in Presenter.
   In the web client, the report will resize to fit to the screen.
3. Select the **Accessible by report list box** check box to make a report accessible from the available reports drop-down menu in the web client.
4. Select the **Allow PDF export** check box so web users can generate PDF files of the Presenter report from the web client.
   If a report has a payee drop-down list, the web user will have the ability to publish reports for each payee to a PDF file.
5. You can select a color for the background of the Presenter report from the Color drop-down menu.

6. Click Choose Image to select an image to display on the background of your Presenter report.

7. You can perform the following steps to modify the image:
   a. Click Remove Image to delete the image from the Presenter report.
   b. From the Image Tile drop-down menu, select whether the image will repeat Vertically, Horizontally, Both, or None.
   c. From the Image Scroll drop-down menu, select Scroll to have the image move when the user scrolls down the report, or Fixed to have the image remain in the same position.
   d. From the Image Position drop-down menu, select Absolute to set the image location on the X and Y axes in pixels, or select Percent to set the image location by percentage.

**Selecting PDF options**

Users can define PDF options for publishing Presenter reports from the IBM Cognos Incentive Compensation Management web client in the Presenter module.

**Procedure**

1. In Presenter, click the PDF Options icon.
2. Select the Orientation and Scaling.
3. You can select Include page numbers to have the page number display, and select Show total page numbers to have the total number of pages in the report displayed on the page.
4. You can type a Footer to include on the published report.
5. Click OK.

**Publishing Presenter reports from the client**

You can use Publisher in IBM Cognos Incentive Compensation Management to generate Presenter reports as PDF files for specific payees and save them to your computer or server.

**Procedure**

1. Open the Presenter report.
2. Select the Publish icon.
3. Select either Publish to my computer or Publish to the server.
   If you publish from the server, define a Saved Publisher File Directory in the service configuration file. For example, edit the service configuration file in the following way:
   ```xml
   <!-- Saved Publisher File Directory -->
   <add key="PublisherFileDirectory" value="C:\Presenter Reports\"/>
   ```
4. Click Next.
5. Select which Portal Access Group you want to generate reports for.
   **Important:** A report will be created for each member in the Portal Access group.
6. Depending on the Presenter report, you may need to select a Parameter using the drop-down menu.
7. Click Next.
8. Select the **Orientation** and the **Scaling**.

   **Important**: If you already set the web PDF options, these settings will be pre-populated.

9. You can select **Use header image**.

   If you want to use a header image, the image has to be located in the Saved Published Image Directory specified in the service configuration file. For example, edit the service configuration file in the following way:

   ```xml
   <!-- Saved Publisher Image Directory -->
   <add key="PublisherImageDirectory" value="C:\Presenter Reports\"/>
   ```

10. In the **Footer** section, you can select the **Include page numbers** and **Show total page number** check boxes and type in a **Footer**.

11. Click **Next**.

12. If you **Publish from my computer**, click **Browse** to select a location on your computer.

13. You can add a prefix.

14. Click **Finish**.

   By default, when you publish reports, the file name will consist of the Presenter report name, payee name, and date and time that the Presenter report was published to a PDF.

   **Important**: When publishing a Presenter report with a data grid, headers will show in the PDF even if there is no data in the column.
Chapter 19. Workflow Manager

The task of compensating sales forces is typically a compound process that involves the cooperation of many different groups of individuals, processes, and tools. Use the IBM Cognos Incentive Compensation Management Workflow Manager module to create and manage these complex processes.

Processes in Workflow Manager are triggered by specific business events, rather than static times in a calendar, and can initiate communications to users and relay contextual information based on the current state of the system. For example, a Presenter report can be created that outlines compensation details for sales representatives. A workflow can be created for the approval process of the compensation details Presenter report. Each sales representative will need to approve or escalate their compensation details report. If the report is escalated, it will be sent to their regional sales manager to make the correction. After the correction has been made, the report will be sent back to the sales representative to approve.

At a high-level, the following steps are required to create a business process:
1. Create a workflow.
2. Add swim lanes for each user or group of users involved in the workflow.
3. Create action, alert, and process nodes, or any combination of the nodes, for each step of the workflow.
4. Connect the nodes to create the path for the workflow.
5. Start the workflow.

Workflows

Use workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module to create logic to automatically push a Presenter report into the next required state based on predefined business rules.

Each workflow is associated with one Presenter report and consists of a series of alert, action, and process nodes that are linked together. The path created by linking the nodes together defines the logical flow of the business process.

Two different types of workflows can be created in Workflow Manager: admin-initiated and user-initiated workflows.

Admin-initiated workflow
This type of workflow prevents users from submitting additional data until the original submission has been completed. After the original submission has completed, it is up to the administrator to start the workflow again. For example, an admin-initiated workflow can be created for an MBO self-scoring form in which a user submits scores for various objects that must be approved by a manager. However, the user cannot submit more than one set of scores per quarter.

User-initiated workflow
Use this type of workflow to submit additional data, even if the originally submitted data has not yet completed the workflow process. Each time a user submits data, an instance of the workflow starts. For example, a
user-initiated workflow can be created for an expense report in which a user must submit more than one expense at a time.

Adding a workflow
The first step to creating a business process is to create an admin-initiated or user-initiated workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. To create a new workflow, perform one of the following steps:
   - Click the New Workflow icon in the toolbar.
   - Right-click in the Workflows sidebar, and select Add Workflow.
2. In the Workflow Manager Wizard, type a name for the workflow, and give it a description.
3. Select the workflow type.
   - To create a workflow where data can be submitted multiple times, select User Initiated.
   - To create a workflow where data can be submitted only once, select Admin Initiated.
4. Click Next.
5. Select the Presenter report that the workflow will be associated with.
6. To use the Presenter report’s default value for a parameter, leave the Use Report Default Value check box selected.
7. To select or enter a different value for a parameter, unselect the Use Report Default Value check box.
   - To select the web user or form initiator for a parameter, select Value from the drop-down menu next to the parameter, and then select the value from the next drop-down menu.
   - To type a constant value for a parameter, select Constant from the drop-down menu next to the parameter, and then type the constant value in the field.
8. Click Next.
9. If you selected a user-initiated workflow, select which layout tables in the Presenter report will be Visible and Editable to the form initiator.
10. Click Next.
11. Select the workflow type.
This determines the payee that makes up the first swim lane.
   - To choose the payee to be the form initiator, select Explicit User.
   - To select the payee to be the form initiator based on restrictions, select Define Restriction.
12. Click Next.
13. Add any additional data sources required to define the form initiator.
   - Any table or calculation with a payee partition can be used as a source.
14. Click Next.
15. Define the restrictions for the payees.
16. If you selected Define Restrictions, click Finish.
17. If you selected Explicit User, click Next.
18. Select the payee you want to add from the Available Payees pane and click Move Right.
19. When you have finished selecting payees, click Finish.

**Editing a workflow**

You can make changes to a workflow after it has been created in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**About this task**

To change the form initiator, you must edit the Form Initiator swim lane. If the workflow is in progress, you can open the Workflow Manager Wizard, but you will not be able to make any changes.

**Procedure**

1. In the Workflows sidebar, select the workflow you want to edit.
2. Click the Edit Workflow button in the toolbar.

**Deleting a workflow**

You can remove a workflow from the IBM Cognos Incentive Compensation Management Workflow Manager module.

You cannot delete a workflow that is in progress.

**Procedure**

In the Workflows sidebar, right-click the workflow you want to delete, and select Delete Workflow.

**Setting default parameters for a workflow**

If the form initiator swim lane has a group of payees assigned to it, you can choose one payee to be the default form initiator in the Set Default Parameters window of the IBM Cognos Incentive Compensation Management Workflow Manager module.

This is useful when creating additional swim lanes, because you can preview the selected payees defined by a restriction using the form initiator.

**Procedure**

1. In the Workflows sidebar, select the workflow you want to set default parameters for.
2. Click the Set Defaults button in the toolbar.
3. Select a Form Initiator from the drop-down menu.

**Starting a workflow**

Workflows must be initiated by an administrator in the IBM Cognos Incentive Compensation Management Workflow Manager.

**Procedure**

1. In the Workflows sidebar, select the workflow you want to start.
2. Click the Start Workflow button in the toolbar.
Adding payees after a workflow has started
Payees can be added to swim lanes in the IBM Cognos Incentive Compensation Management Workflow Manager module after a workflow has begun.

Procedure
1. After starting a workflow, click the Add Workflow Payees button in the toolbar.
2. If payees have been defined using restrictions, click Yes in the window that is displayed.

   Important: If payees have been defined using restrictions, you can choose to schedule the addition of workflow payees in the Scheduler module.
3. If you selected Explicit User to define swim lane payees, in the Add Workflow Payees wizard, add any sources required to define the additional workflow payees.
4. Create the restrictions to define the additional payees you want to add to the workflow.
5. Select the payees you want to add to the workflow.

Organizing workflows
Folders can be created on the Workflows sidebar to organize the workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. Right-click in the Workflows sidebar, and select Add New Folder.
2. Type a name for the folder.
3. Drag workflows into the folder.
4. To add a new workflow to a folder, right-click the folder, and select Add Workflow in Folder.

Searching for a workflow
A specific workflow can be found by using the search field on the sidebar of the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
In the workflow sidebar, type the name of the workflow in the Search field.

Swim lanes
When a workflow is created in the IBM Cognos Incentive Compensation Management Workflow Manager module, it contains two swim lanes by default: a System swim lane and a Form Initiator swim lane.

The System swim lane contains start and end nodes for the workflow. This swim lane, and the nodes inside it, are not configurable. The Form Initiator swim lane is configured based on the workflow initiators selected when the workflow was first created. The Form Initiator swim lane can be modified after the workflow has been created and additional swim lanes can be added. Swim lanes in a workflow define the person or group expected to take action or the person or group that is to be the recipient of a notification. For example, if a swim lane is defined as any payee with
the title "Sales Reps", then any notifications in this swim lane are sent to payees with the title "Sales Reps" or any forms in this swim lane must be actioned by payees with the title "Sales Reps".

**Editing the form initiator swim lane**

The payees defined by the Form Initiator swim lane in the IBM Cognos Incentive Compensation Management Workflow Manager module are defined when you create the workflow.

**About this task**

In an admin initiated workflow, the Form Initiator is the payee expected to perform an action as the first step of the workflow. In a user-initiated workflow, the Form Initiator is the payee expected to start the workflow. The Form Initiator can be modified after the workflow has been created.

**Procedure**

1. Select the workflow, right-click the **Form Initiator** swim lane, and select **Edit Current Swim Lane**.
2. You can rename the swim lane, and type a description.
3. Select the swim lane type.
   - Select **Explicit User** if you want to select specific payees to be involved in the workflow step.
   - Select **Define Restriction** if you want to select a group of payees that fall under a given restriction to be involved in a workflow step.
4. If you selected **Explicit User**, select the payees from the list, and click **Move Right** to create the list of users involved in the first step of the workflow.
5. If you selected **Define Restrictions**, add the data sources required to create the restriction.
6. Click **Next**.
7. Define the payees involved in the first workflow step by creating restrictions.

**Adding a swim lane**

Additional swim lanes can be added to the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module to define the other payees involved in the process.

**Procedure**

1. Select the workflow, and click the **Add Swim Lanes** button.
2. Type a name and description for the swim lane.
3. Click **Next**.
4. Add any tables, the current date, Presenter report parameters, or calculations that include a payee partition to define your source.
5. Click **Next**.
6. Define the restrictions to define the payees involved.

**Deleting a swim lane**

Swim lanes can be removed from the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module along with any nodes contained in the swim lane.
Procedure
1. Select the workflow, right-click the swim lane you want to delete, and select Delete Current Swim Lane.
2. In the Warning window, click Yes.

Adding or removing columns in swim lanes
The number of columns in swim lanes can be increased or decreased in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. To remove an extra column, right-click the column, and select Remove Column.
2. To add a column, right-click a column, and select either Add to Left or Add to Right.

Important: Each workflow can be a maximum of 32 columns wide.

Nodes
In addition to swim lanes, a workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module is made up of a series of nodes.

Each node represents a step in the workflow that notifies payees, requires payees to take action, or the system to execute an action.

There are several different types of nodes: Start nodes, End nodes, Alert nodes, Action nodes, and Process nodes.

When a workflow is first created, a Start node and End node are added by default to the System swim lane. The Start node defines the beginning of the workflow, and the End node defines where the workflow process stops.

Alert node
Use this node to send customizable notifications to users either by email or through web messages delivered to the web client. You can use this type of node to notify specific users or groups of users when a workflow requires their input or action in order to proceed.

Action node
This node defines the path the workflow will take based on an action taken by a user. Each Action node contains action paths associated with a Presenter report and different routes in the workflow. For example, if a user has the choice to either approve or cancel a report, the action node will define a different workflow path that will be followed based on which option the user chooses.

Process node
This node runs a saved Scheduler process. The scheduled process will only run when the Scheduler is refreshed. By default, Scheduler refreshes every hour. This can be modified by changing the SchedulerRefreshSeconds value in the Cognos Incentive Compensation Management Windows service configuration file. The process will only be run with the Cognos Incentive Compensation Management Windows service and not the console service; the Scheduler user must not be logged into the client at the same time.
After the nodes required for the workflow have been created in the appropriate swim lanes, they can then be connected to create the workflow process.

**Editing the Start node**

The Start node can be modified so users can both submit report data and move the report to the next step in the workflow when they click the start button on the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. In a workflow, right-click the Start node and select Edit Node.
2. Select the Submit when selected check box.

**Creating an Alert node**

Specific payees or groups of payees can be notified either through the IBM Cognos Incentive Compensation Management web client or via email when a Presenter report requires their input.

Alert nodes can also be configured to send emails to users who are not involved in the workflow.

**Procedure**

1. In the workflow, click the column in the swim lane where you would like to place the alert node.
2. In the Add Node wizard, type a name and description for the node.
3. Select Alert Node and click Next.
4. Select the message type you want to send and click Next.
   - Select Internal Message and External Email to send a web message to the payees through the web client and external email addresses specified in the Payee table.
   - Select External Email Only to send a message to specified email addresses only.
5. Type the subject for the message in Email Subject field.
6. If you are sending an email, type the email address of the payee in the To and BCC field, and click Add.

   **Tip:** To remove an email address, click the red X located next to the email address.

7. Type the message. You can click the buttons to insert the following variables into the message:
   - **Form Initiator** - adds the name of the payee specified by the form initiator swim lane.
   - **Recipient Name** - adds the name of the payee receiving the message.
   - **Report Name** - adds the name of the Presenter report specified by the workflow.
   - **Report Name with Link** - adds the name of the report and links to the Presenter report on the web client (this variable is available only when sending a message through the web client and requires configuration of the Base URL in the Administrative Options window).

   **Tip:** It is helpful to add the Report Name with Link variable to the web message so web users can quickly navigate to the report.
Configuring the Report Name with Link variable in an alert node

For the Report Name with Link variable to function correctly in the message sent through Workflow Manager to the IBM Cognos Incentive Compensation Management web client, the Base URL for the web client must be configured in the Administrative Options window.

Procedure
1. Go to Admin > Administrative Options.
2. Click the Web tab.
3. In the Base URL field, type the URL of your WAR file.
   For example, type the following address: http://localhost:8080/ICM, where ICM is the name of your WAR file.
4. Click OK.

Creating an action node

You can define actions that can be performed on a report in a particular step in the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the workflow, click the column in the swim lane where you would like to place the action node.
2. In the Add Node wizard, type a name and description for the node.
3. Select Action Node and click Next.
4. Define the action paths for the web users by performing the following steps:
   a. Click Add New Action.
   b. Click the drop-down arrow next to the New Action Path and select Rename.
   c. Type a name for the action path.
   d. To set the action path button in the web client to both send the report to the next step in the workflow and submit the data, select the Submit when selected check box.
   e. If all payees defined by the swim lane must perform the action before the workflow can proceed, select the Required by all check box.
   f. Click Next.
5. Select the layout tables that will be visible or both visible and editable to the payees in this step.
   - Select or unselect individual check boxes next to the appropriate layout tables.
   - Select or clear the Visible or Editable column check boxes to select or unselect all the layout tables in the column.

Important: The only fields editable in the report are the fields that have been marked as editable in the data grids in Presenter. If you do not select the Editable check box in the Add Node wizard, then the fields will not be displayed as an editable part of the workflow, regardless of the Presenter settings.
6. Click Finish.
Creating a Process node

A process created in the Scheduler module can be added as a step in the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. In the workflow, click the column in the swim lane where you would like to place the process node.
2. In the Add Node wizard, type a name and description for the node.
4. Select the Scheduler process folder you want the node to run.
5. Click Finish.

**Important:** If an error occurs when running the defined process, the workflow will either stop and be put into an error state or will continue running based on the configuration of the Stop Process on Error option in the Cognos Incentive Compensation Management Scheduler module.

Editing or deleting a node

Nodes can be modified or removed from the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

The node type cannot be changed after the node has been created. **Start** and **End** nodes cannot be modified or deleted.

**Procedure**

1. To modify a node, right-click the node, and select **Edit Node**.
2. To delete a node, right-click the node, and select **Delete Node**.

Cutting, copying, and pasting nodes

Nodes can be cut or copied and pasted into different columns in the same workflow or to columns in a different workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. Right-click the node in the workflow that you want to relocate, and select **Cut** or **Copy**.
2. Right-click an empty column in the same workflow or a different workflow, and click **Paste**.

Connecting nodes

After nodes have been created, they must be connected to define the workflow process in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. Connect the **Start** node to the first node of the process by performing the following steps:
   a. Right-click the **Start** node, and select **Connect Node**.
   b. Select the node you want to connect the **Start** node to.
2. Connect the rest of the nodes to the workflow process in the same way.
3. To connect an action node with multiple action paths, perform the following steps:
   a. Right-click the action node, and select **Connect Node**.
   b. Select the node you want to connect an action path to.
   c. Select the action path you want to connect to the node, and click **Finish**.
   d. Repeat the steps above to connect the other action paths to the appropriate nodes.

4. Connect the last node in the workflow process to the end node to complete the workflow.

**Modifying or deleting a connection**

A connection between nodes can be removed or changed in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. To remove a connection, select the connection line, and press **Delete** on your keyboard.
2. To reconnect a connection, right-click the node with the connection you want to modify, and select **Connect Node**.
3. Select the node you want to connect it to.

**Workflow errors and reports**

Workflow history is logged in both the IBM Cognos Incentive Compensation Management Audit module and Workflow Manager.

General workflow history is tracked in the Audit log, while node-specific history is tracked in Workflow Manager.

If a workflow encounters an error, details of the error can be viewed in the **Errors** log in Workflow Manager. Users will be able to view the error and which node caused the error. When an action node encounters an error, such as when the next payee involved in the workflow cannot be determined, an error is recorded on the **Action Node Errors** page. When an alert node encounters an error, such as an invalid email address has been entered, an error is recorded on the **Service Node Errors** page. For the workflow to advance, an administrator must intervene.

**Viewing workflow errors**

Any errors encountered are recorded on the **Errors** page in IBM Cognos Incentive Compensation Management Workflow Manager.

**Procedure**

1. Select the workflow.
2. Click **Errors**.
   - The action node errors are displayed.
3. To view errors created by alert nodes, select **Service Node Errors**.

**Resolving action node errors**

An error encountered by an action node can be fixed in the **Action Node Errors** log in the IBM Cognos Incentive Compensation Management Workflow Manager module.
Procedure
1. Select the workflow that encountered the error.
2. Click **Errors**.
3. In the **Action Node Errors** log, right-click the error, and select **Resolve Error**.
4. You can handle the missing payee in one of the following ways:
   - Select **Reassign Payee** to choose another payee to perform the action required by the node.
   - Select **Remove from Workflow** to remove the action from the workflow, and click **Finish**.
5. If you selected **Reassign Payee**, select the payee you want to reassign to the node, and click **Finish**.

Viewing workflow events in the Audit module
The IBM Cognos Incentive Compensation Management **Audit** log records general workflow actions, such as adding, deleting, starting, and stopping workflows.

Procedure
1. Open the **Audit** module.
2. View the **Audit** log.

Viewing workflow events in Workflow Manager
The history of individual nodes is tracked in the Workflow Manager History window in the IBM Cognos Incentive Compensation Management Workflow Manager module.

The history tracks who has performed actions or received notifications.

Procedure
1. In Workflow Manager, select the workflow for which you want to view the node history.
2. Click the **History** button.

Viewing pending actions
The action node involved in the current step of the workflow, and the users required to perform an action, will be listed in the Pending Actions window of the IBM Cognos Incentive Compensation Management Workflow Manager module.

If the Scheduler service is started after the workflow has begun, any process nodes that were unable to initiate in the workflow will also be listed here.

Procedure
1. In Workflow Manager, select the workflow containing the pending actions you want to view.
2. Click the **Pending Actions** button.

Rerunning a process node
Users can restart a process node that has been stopped due to the IBM Cognos Incentive Compensation Management Scheduler service being started after the workflow began.
Alternatively, users can choose to not run the process node and move on to the next step in the workflow.

**Procedure**
1. Select the workflow containing the process node you want to rerun or skip.
2. Click the **Pending Actions** button.
3. To rerun the Scheduler process, right-click the process node, and select **Rerun Process**.
4. To move on to the next step in the workflow, right-click the process node, and select **Move to next**.

**Filtering workflow errors, pending actions, or history**
Users can view specified errors, actions, and events only on the **Errors**, **Pending Actions**, or **History** pages in the IBM Cognos Incentive Compensation Management Workflow Manager.

**Procedure**
1. Select the workflow.
2. Click **Errors**, **Pending Actions**, or **History**.
3. In the header of a column, click the pin icon.
4. Select the options you would like to filter the errors by and click **Filter**.

**Exporting errors, pending actions, or history**
Users can save the history events, action node errors, or the service node errors from the IBM Cognos Incentive Compensation Management Workflow Manager module as a Microsoft Excel file.

**Procedure**
1. Select the workflow.
2. Click **Errors**, **Pending Actions** or **History**.
3. Click the **Export** button.

**Clearing the pending actions or history**
All the events on the **Pending Actions** or **History** page in the IBM Cognos Incentive Compensation Management Workflow Manager module can be deleted.

**Procedure**
1. Select the workflow.
2. Click **Pending Actions** or **History**.
3. Click the **Clear** button.

**Workflow Manager in the web client**
All activity for Presenter reports involved in workflows can be accessed through the message center in the IBM Cognos Incentive Compensation Management web client.

Any notifications that are sent to payees via the web client will be viewable in the payees’ inboxes. Any reports that require the web user to perform an action can be accessed from the **Workflow Manager** section of the message center. Presenter
reports involved in the workflows do not require tree assignment in the Portal Access module to be viewed in the web client. Presenter report access in the web client is determined through the swim lanes in the workflows of Workflow Manager.

Any user-initiated workflows assigned to a web user can be initiated by the web user on the Available Workflows tab in the Workflow Manager section. The web user can open the report, submit the necessary data, then initiate the workflow from the report. When a web user is required to perform an action in a report, a link to the report involved in the workflow will be displayed on the Pending Workflows tab of the Workflow Manager section. The report will contain buttons for each action the web user can perform as part of the workflow. Web users can also view the workflows that have been completed on the Completed Workflows tab of the Workflow Manager section.

**Initiating a workflow**

Web users can begin a user initiated workflow from within the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. Log in to the web client.
2. Go to the message center.
3. Click Workflow Manager.
4. Click the Available Workflows tab.
5. Click the link to the workflow you want to initiate.
   The report associated with the workflow opens.
6. Click Start.
7. Click Confirm.

**Performing an action in a workflow**

Web users can approve or modify reports from within the IBM Cognos Incentive Compensation Management web client.

The actions available to the web user in the report are defined by the Action node in the workflow.

**Procedure**

1. Log in to the web client.
2. Go to the message center.
3. Click Workflow Manager.
4. Click the Pending Workflows tab.
5. Click the link to the report.
6. To view the history of the workflow, click the View Workflow History button.
7. Click the appropriate action button.
   For example, if an action path defined in the workflow was "Approve", then click the Approve button to send the report along that action path.
8. Click Confirm.
**Viewing completed workflows**

A list of finished workflows can be viewed by web users on the Completed Workflows tab of the Workflow Manager section in the message center of the IBM Cognos Incentive Compensation Management web client.

The name of the workflow, the workflow initiator, the date of initiation, and the date of completion are listed on the tab.

**Procedure**

1. Log in to the web client.
2. Go to the message center.
3. Click **Workflow Manager**.
4. Click the Completed Workflows tab.
5. To view the history of the workflow, click the link to the workflow.
Chapter 20. Portal Access

Use the IBM Cognos Incentive Compensation Management Portal Access module to define web tabs, web access, sign off, and inquiry handling responsibility.

In most cases, users must be included in a Portal Access hierarchy, which plays a role in the process of approvals and sign offs that occurs within the system. Administrators can create web tabs, groups, hierarchical trees, and define assignments, sign off, and inquiries processes.

The following tabs are available in Portal Access:
- Web Tabs
- Groups
- Trees
- Assignment
- Sign Off
- Inquiries

Web tabs

In the IBM Cognos Incentive Compensation Management Portal Access module, you can customize the tabs that are displayed in the web client.

You can select the name, type, and sequence of tabs. You can also build report-driven home pages that are appropriate for different Portal Access groups.

Web tabs can be created for individual plans, Presenter and tailored reports, draw assignment and reports, web forms, and displaying external web pages. Module tabs can be created by selecting either Data Edit, Inquiries, Payee Ledger, Reporting, or Web Forms. Users can organize tabs into web tab groups, which will create sub-tabs in the web client.

When only one object is assigned to a web tab, no sub-tabs are shown, and the plan, report, or form is rendered right away. When more than one object is assigned to a tab group, sub-tabs appear, and selection is required before anything is rendered. After web tabs are created, administrators must assign access to the tab itself and the objects that are included in the tab. If users do not have access to the web tab or the sub-tabs, then they will not see them in the web client.

The following web tabs are available:
- Compensation Plan
- Draw Assignment
- Draw Report
- External URL
- Module
  - Data Edit
  - Inquiries
  - Payee Ledger
  - Reporting
Important: If you are upgrading a 6.0 model, the tabs you have already set up will appear in the Portal Access module and the web client.

Creating a web tab
You can add web tabs in Portal Access that users will be able to use for navigation in the IBM Cognos Incentive Compensation Management web client.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To add a web tab, perform one of the following steps:
   - Click the Add Web Tab icon.
   - Right-click and select Add Web Tab.
3. Type a name for the web tab, and click Next.
   You can use special characters, such as hyphens and apostrophes, when creating a web tab name.
4. Select the Type of web tab.
5. Select the object that is assigned to the type of web tab.
   For example, if you select the Compensation Plan type, you need to select a compensation plan.
6. Click Finish.
   Important: The first tab listed in Portal Access is the first tab that will be displayed on the web client.

Moving web tabs
You can change the location and order of web tabs after they have been created in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. Select a web tab, and hold down the Shift key.
3. Move the web tab to the location that you want.

Editing a web tab
You can change the name, type, and object assigned to the web tab created in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To edit a web tab, perform one of the following steps:
   - Right-click a web tab, and select Edit Web Tab.
   - Select the web tab, and click the Edit Web Tab icon.
3. In the Web Tab Wizard, make your changes.
Deleting a web tab
You can remove a web tab from the IBM Cognos Incentive Compensation Management web client.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To delete a web tab, perform one of the following steps:
   - Right-click a web tab, and select Delete.
   - Select the web tab, and click the Delete Web Tab icon.
3. Click Yes in the Question window.

Adding a web tab group
You can create web tab groups in which to place individual web tabs in the IBM Cognos Incentive Compensation Management Portal Access module.

For example, you can create a web tab group called Plans, and place the web tabs for individual compensation plans into this group.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To add a web tab group, perform one of the following steps:
   - Click the Add Web Tab Group icon.
   - Right-click the window, and select Add Web Tab Group.
3. Double-click the New Web Tab Group, and type in a name.
4. Click a web tab, and drag it into the web tab group.

Removing a web tab from a group
You can move web tabs from one group to another in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. Click a web tab, and move it out of the web tab group while holding down the Shift key.

Setting access to web tabs
The user needs access to both the web tab and the objects inside to view them on the IBM Cognos Incentive Compensation Management web client.

For example, if you have a reporting web tab, you need to set access to the reporting web tab and to the individual Presenter reports.

Procedure
1. In Portal Access, click the Assignment tab.
2. Click under a column to show the drop-down menu arrow.
3. Select the access tree.
Portal Access hierarchy

In Portal Access, you must define groups, create access trees, and assign the access trees to web tabs so that web users can access items in the IBM Cognos Incentive Compensation Management web client.

Perform the following steps to define a Portal Access hierarchy:
1. Create groups.
2. Make trees.
3. Assign trees to the web, and enable compensation plans, tailored reports, documents, and web forms.

Creating Portal Access groups

In the IBM Cognos Incentive Compensation Management Portal Access module, from the Groups tab, you can create Portal Access groups. Any payees that exist in the model can be added to any group.

Typically, you would create a group for each level of the Portal Access hierarchy, for each plan, report, and so on.

Procedure
1. In Portal Access, click the Groups tab.
2. To add a group, perform one of the following steps:
   • Click the Add Portal Access Group icon.
   • Right-click and select Add Portal Access Group.
3. In the Portal Access Group Wizard, type in the group name.
4. Select or unselect the Maintain this group in Task Manager check box, and then click Next.
   If you select this option, it will create a copy of the group in Task Manager, so you can create rules to maintain the group’s members.
5. Define who the Portal Access group members are by using the Payee table as a source, as well as any other sources you want to append.
   a. Click Add to add columns or rows to the Payee table to define your Portal Access group.
6. Create restrictions to define exactly which members of the source will participate in the Portal Access group.
   For example, to create a Portal Access group that contains only Account Executives, you could define a restriction stating that only payees whose title ID = Account Executive should be included.
   Defining restrictions is optional. You can also manually select payees from the next screen in the Portal Access Group Wizard.

   Tip: If you are planning on maintaining your Portal Access group in Task Manager, define your group members on the Define Restrictions window. If you are not maintaining the group in Task Manager, feel free to add members manually as needed.
7. Click Add > or < Remove to create the exact group you want.
   Any members you have already selected through the restrictions screen will automatically be shown in the Selected Payees pane.
8. Click Finish.
**Use Task Manager to add payees to a Portal Access group**

If payees are added to the Payee table after Portal Access groups have been created in the IBM Cognos Incentive Compensation Management Portal Access module, you can use the Task Manager module to add these payees to your Portal Access groups.

For more information, see [Chapter 22, “Task Manager,” on page 235](#).

**Managing web access**

You can enable payees for web access, and edit the web login credentials for any member of a group in the IBM Cognos Incentive Compensation Management Portal Access module.

**Procedure**

1. In the **Groups** tab, perform one of the following steps to manage web access:
   - Select the Portal Access group, and click the **Manage Web Access** icon.
   - Right-click the Portal Access group, and select **Manage Web Access**. The Web Users window lists all the group members.
2. Select any member and click **Enable**.
   - You can press the Ctrl key to select and enable multiple payees simultaneously.
3. Type and confirm a password to enable the member for the web client, and click **OK**.
   - After enabled, web users will use the email address defined in the Payee table as their login ID.

   **Important:** The email address cannot be changed from the Portal Access module.
4. If you want to disable a member’s access, select the member and click **Disable**.
5. If you want to unlock a member who has been locked out of the web client, select the member, and click **Unlock**.
6. When you are done enabling members for the web client, click **Close**.

   **Important:** The Task Manager module provides an option for generating passwords and sending emails informing groups of payees of their passwords. This task can be used anytime a new payee is added to a Portal Access group, or to provide existing users with new passwords in the case of a forgotten password. Task Manager can be used to assign passwords to a large group of individuals at once.

**Forcing web users to change passwords on next login**

When the **Change Password On Next Login** check box is selected, users will be forced to change their password the next time they log in to the IBM Cognos Incentive Compensation Management web client.

**About this task**

This option can only be selected for web enabled users. If the **User Must Have Strong Password** option is selected on the **Web** tab in the Administrative Options window, the user’s new password will have to adhere to the strong password guidelines.
Important: Web users will be forced to enter a password into the New Password field the next time they log in to the web client; however, web users are permitted to reuse passwords. This means that the new password can be the same as the old password.

Procedure
1. In the Groups tab, perform one of the following steps:
   • Select the Portal Access group, and click the Manage Web Access icon.
   • Right-click the Portal Access group, and select Manage Web Access.

   The Web Users window lists all the group members.
2. Select the web enabled user, and click the Change Password On Next Login button.
   A checkmark is displayed next to the user in the Change Password On Next Login column.

Finding a payee on the Groups tab
After all your groups have been created, you may want to find a specific payee in the IBM Cognos Incentive Compensation Management Portal Access module.

This option searches for an exact match by default. To perform a wild card search, use an asterisk (*).

Procedure
1. On the Groups tab, click the Find Payee button.
2. Type the name of the payee.
3. Click Search.

Portal Access trees
From the Trees tab in the IBM Cognos Incentive Compensation Management Portal Access module, you can create hierarchy trees to define access to web tabs, as well as sign off and inquiry handling responsibilities.

A tree can have as many or as few groups as you would like, and there is no limit to the level of complexity of the hierarchy. You may want to create different hierarchy trees for web review, sign off, and inquiry handling for each plan.

After a tree has been created, it can be assigned to as many plans, reports, web forms, or documents as you like.

Access trees
Access trees are created to define who can see information in the IBM Cognos Incentive Compensation Management web client.

Members at the top of the tree will be able to see their own results and the results of anyone below them in the tree. Group members will not be able to see results for others who are in the same group as them.

Only compensation plans have hierarchical access. For this reason, trees used to define report, web form, or document access should only contain one level (or one group).
**Sign off trees**

Sign off trees in the IBM Cognos Incentive Compensation Management Portal Access module determine the order that payees will sign off on results.

Payees in the top group will need to complete sign off before payees in the next group can begin. To create sign off trees, you have to define the hierarchy and decide if all members or one member in the group has to sign off on results.

**Inquiry trees**

Inquiry trees in the IBM Cognos Incentive Compensation Management Portal Access module define the inquiry handling process.

For inquiries, information always flows from the top of the tree to the bottom.

Members at the top of the tree can launch inquiries that will be handled by members of the group below them. For example, you can create an inquiry handling tree where all Account Executives who launch inquiries will have their inquiries handled by the Regional Sales Manager (RSM). If the RSM chooses, she will be able to escalate the inquiry to the vice president by clicking the Escalate button on the web client.

**Making a Portal Access tree**

On the Trees tab, you can use the Portal Access groups to create access trees in the IBM Cognos Incentive Compensation Management Portal Access module.

**Procedure**

1. On the Trees tab, select the New Tree button.
2. Type a Name for your tree.
   
   **Important:** You will now see your tree in the trees drop-down menu.
3. Drag groups to create your tree on to the right side of the window.
   
   a. Place one group on top of another to create the hierarchical structure.
   b. To have two top groups join a single bottom group, place the bottom group on top of one of the top groups, then press Alt, and then drag the bottom group to the second top group.

   **Tip:** There is no limit to the level of complexity that your tree can have.

**Defining hierarchies for sign off**

In the IBM Cognos Incentive Compensation Management Portal Access module, you can choose whether all groups member must sign off or one group member must sign off in a tree.

These settings will only apply to trees that are used to define sign off responsibility.

**Important:** The Sign Off Type for the group needs to be defined in the tree used to define access, not the tree used to define sign off.

**Procedure**

1. On the Trees tab, select the access tree.
2. Right-click any group.
3. Select the Sign Off Type.
4. Select either **All Group Members Must Sign Off** or **One Group Member Must Sign Off**.
   - If you choose **All Group Members Must Sign Off**, all members of the group need to sign off on results in order for the step of the approval process to be complete.
   - If you choose **One Group Member Must Sign Off**, only one member of the group needs to sign off in order for the step of the approval process to be complete.

**Creating web adjustments**

In the Portal Access module, you can grant a group permission to adjust results through the IBM Cognos Incentive Compensation Management web client.

When group members with adjustment privileges log in to the web client, they will be able to make manual adjustments to the results of any members in the group below them on the access tree.

**Procedure**
1. On the **Trees** tab, right-click a group in the tree.
2. Select **Can Adjust On Web**.
3. Log in to the web client.
4. Click the **Payee Ledger** tab.
5. Click the **Summary** link.
6. Select a plan and a payee.
7. Click **Adjust**.
   - Web users can make a manual adjustment to the data in that row.

   **Important**: People with adjustment privileges will not be able to adjust their own results or the results of other members in the same Portal Access group as them.
8. Type in the new **Value**.
9. Type in any comments about the adjustment.

**Viewing web adjustments**

Changes that have been made to compensation plans by web users, can be viewed in the IBM Cognos Incentive Compensation Management Payee Ledger module.

**Procedure**
1. In the Cognos Incentive Compensation Management Client, open **Payee Ledger**.
2. Click the **Summary Ledger** tab.
3. Select the plan and payee.
4. Click the **Generate Report** button.
   - You will see the adjustment in the Adjustment column.

**Using the Portal Access tree builder**

The Portal Access Tree Builder wizard automates the creation of trees and the groups that belong in the trees in the IBM Cognos Incentive Compensation Management Portal Access module.
Trees and groups are generated based on data in the Payee table and any sources joined to the Payee table.

**About this task**

Tree Builder will generate a Portal Access tree hierarchy based on a specified parent-child relationship. After the hierarchy has been defined, you can use the Tree Builder to automate the partitioning of your child groups, giving breadth to your tree.

**Procedure**

1. On the **Trees** tab, click the **Tree Builder** item.
2. Type the name of your Portal Access tree.
   
   The name of the tree must be unique.

3. You can select the **Maintain generated Portal Access groups in Task Manager** check box to place a copy of all of the groups created by this wizard in Task Manager so that they can be maintained using Task Manager rules and tasks.

4. Click **Next**.
   
   **Important:** Only the groups can be maintained in Task Manager. The tree structure needs to be maintained manually in Portal Access.

5. To define any additional sources that need to be joined to the Payee table to provide the source data needed to create the groups and trees, click **Add** and follow the Select Additional Source wizard.

   **Important:** The source data must not contain cycles. That is, there must not be a path from any payee's parent to itself. Also, there can only be one row entry in the source data for each payee selected.

6. Click **Next**.

7. Define any restrictions on the source data.

   Use restrictions to limit the tree to a subset of payees.

   For example, you may want to create a reporting hierarchy tree that only contains payees from a particular territory region. Also, if more than one entry exists for some payees, you can use restrictions to specify which entry to use.

8. Click **Next**.

9. Select the **Parent Column** from the drop-down menu.

   **Important:** The parent column defines the hierarchical structure of the tree and it gives the tree its depth. The parent column can be any column that is a pick list to the Payee table. For example, you could select the **Reports To** column and the tree hierarchy will be created according to who the payees report to.

10. You can select a **Group Definition Column**.

    **Important:** Specifying a group definition column provides a way to divide each hierarchical level of your tree into multiple groups. The group definition column can be any text-based column in your source. For example, if you select job title as the group definition column, separate groups will be created for each job title, at each level of the hierarchy.

11. Click **Finish**.

    The tree will be available in the **Trees** tab and it can be edited by dragging and dropping Portal Access groups. All of the groups created for the tree will
be accessible from the Groups tab inside a folder that uses the following naming convention: \textit{Tree Builder - <tree name>}. 

\section*{Assignments}

In the \textit{Assignment} tab of the IBM Cognos Incentive Compensation Management Portal Access module, you can assign the hierarchies created in the \textit{Trees} tab.

Administrators can validate Portal Access tree assignments and define what periods are available for compensation plan viewing via the web client.

\subsection*{Validating tree assignments}

You can check the validity of tree assignments for web tabs, compensation plans, tailored reports, documents, or web forms in the IBM Cognos Incentive Compensation Management Portal Access module.

\textbf{Procedure}

1. On the \textit{Assignment} tab, click a web tab, compensation plan, report, document, or web form.
2. Select the \textit{Validate Assignments} button.

\subsection*{Setting compensation plan visibility}

You can define the start and end dates that a compensation plan will be visible to payees assigned to the plan in the IBM Cognos Incentive Compensation Management Portal Access module.

\textbf{Procedure}

1. On \textit{Assignment} tab, right-click a plan, and select \textit{Set Compensation Plan Visibility}.
2. Select the \textit{Starting} and \textit{Ending} check boxes, and select the visibility dates.
   You can opt to not have results prior to or after a certain date available from the web client.
3. Click \textit{OK}.

\subsection*{Tree assignment}

You can assign an access, sign off, or inquiry tree to compensation plans, tailored reports, documents, web forms, and Presenter reports in the IBM Cognos Incentive Compensation Management Portal Access module.

If you need to, you can assign the same tree multiple times.

When assigning access, sign off, and inquiry trees to compensation plans, tailored reports, documents, web forms, and Presenter reports, consider the following information:

\begin{itemize}
    \item \textbf{Compensation plan assignment}
        For all compensation plans, the access trees can contain multiple levels.
        Members in the tree will be able to see their own results and the results of any payees in groups below them in the tree.
    \item \textbf{Tailored report assignment}
        For tailored reports, access trees can contain multiple levels. Members in the tree will be able to see their own results and the results of any payees in groups below them in the tree.
\end{itemize}
• Document assignment
  Any documents added to the Document Manager window (accessed from the Admin menu) will be listed in the Assignment tab and can be enabled for web review. When assigning trees to documents, keep in mind that access to the document is either granted or denied (and you cannot give partial access to a document). For this reason, the trees used to define document access should only contain one group.

• Web form assignment
  All web forms created and saved will be listed in the Assignment tab. When assigning trees to web forms, keep in mind that you cannot give partial access to a web form through the Portal Access module. For this reason, the trees used to define web form access should only contain one group. To restrict web form access, assign restrictions directly to the form through the Web Forms module.

• Presenter report assignment
  All Presenter reports created and saved will be listed in the Assignment tab. When assigning trees to Presenter reports, keep in mind that you cannot give partial access to a Presenter report through the Portal Access module. For this reason, the trees used to define Presenter report access should only contain one group. To restrict Presenter reports access, assign restrictions directly to the report through the Presenter module.

Assigning tree access
You must assign Portal Access trees to web tabs, compensation plans, tailored reports, documents, web forms and Presenter reports for them to be viewed by users on the IBM Cognos Incentive Compensation Management web client.

Procedure
1. In the Portal Access module, on the Assignment tab, select a compensation plan, tailored report, document, web form, or web tab.
   The access, sign off, and inquiries columns all contain hidden drop-down menus that list every tree created in the Trees tab.
2. Click under a column to show the drop-down menu arrow.
3. Select the tree from the drop-down menu.

Sign off

The sign off tab in the IBM Cognos Incentive Compensation Management Portal Access module is used to begin or end an approval process, view history of past sign offs, and see the current sign off status.

For each compensation plan, tailored report, document, web form, and Presenter report, you can see what group has signed off, who has yet to sign off, and if necessary, force approvals.

Important: The approval process is not tied to period locking; the process can begin and end at any time.

Sign off colors

After you start a sign off, you will notice that the groups in the tree are no longer blue in the IBM Cognos Incentive Compensation Management Portal Access module. A color coding system will let you know where the sign off process stands.
<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Group members have already approved their results.</td>
</tr>
<tr>
<td>Red</td>
<td>Group members currently need to sign off on results.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Group members are waiting for the group before them to complete sign off before they will be permitted to sign off.</td>
</tr>
</tbody>
</table>

### Starting a sign off
You can begin the sign off process on the web client from the IBM Cognos Incentive Compensation Management Portal Access module.

**Procedure**
1. On the **Sign Off** tab, select a plan, report, document, or web form that has a sign off tree assigned to it.
2. Select the **Start Sign Off** icon.
3. Type a name for the sign off.
4. Click **OK**.

### Signing off in the web client
After the sign off has started, members in the first sign off group can approve results through the IBM Cognos Incentive Compensation Management web client.

**Procedure**
1. Log in to the web client.
2. Click the **Message Center** link.
   - There will be a new message saying that the user has been prompted to sign off on a task.
3. Click the **Summary** link or select **Tasks**.
   - Members that need to approve results will see an **Approve** button.
4. Click the **Object** link to view details of the pending sign off.
5. Click **Approve** to approve the results.
   - If you return to Portal Access in the Cognos Incentive Compensation Management Client, you will see that the members who approved the results are now green.

### Ending the sign off process
A sign off process will end on its own after the members of the final group have signed off; however, you can also cancel the sign off process before it has been completed in the IBM Cognos Incentive Compensation Management Portal Access module.

**Procedure**
1. On the **Sign Off** tab, select the item you want to cancel the sign off for.
2. Select the **Cancel Sign Off** icon.
Sending email notification to pending payees
After the sign off process has started, you can send an email to all members in the tree informing them that the sign off process has started in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Sign Off tab, select the tree from the drop-down menu.
2. Click the Email All Groups icon.
3. Type in a subject and message.
4. You can select the Send to Pending Payees Only check box to notify only payees in the top node of the sign off tree.
5. Click Send.

Sending email notification to one group
After the sign off process has started you can send an email to all members of one group in the tree informing them that the sign off process has started from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Sign Off tab, select the tree from the drop-down menu.
2. Select the group.
3. Click the Email One Group icon.
4. Type in a subject and message.
5. Click Send.

Forcing sign off approval
The administrator can force approval for any pending sign offs in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Sign Off tab, select the tree from the drop-down menu.
2. Right-click a group (highlighted in red) with pending sign offs.
3. Select Force Approve All.
   After you force approve results, sign off moves on to the next group of payees.

Viewing group members
You can open a table that will display all members in a group in the IBM Cognos Incentive Compensation Management Portal Access module.

For any members that have already signed off, the sign off date and approval type will also be listed.

Procedure
1. On the Sign Off tab, select the sign off tree from the drop-down menu in the toolbar.
2. Right-click a group in the sign off tree, and select View Members.
   If Approved is listed in the Approval Type column, the member signed off on results through the web client. If Force Approved is listed, then the company’s administrator forced approval through the Cognos Incentive Compensation Management Client.
3. Click Close.

Inquiry process

The Inquiries tab is used to handle web inquiries in the IBM Cognos Incentive Compensation Management Portal Access module.

The ability to launch inquiries can be enabled or disabled for any plan or report from this tab. Cognos Incentive Compensation Management automatically enables inquiries for plans and reports.

Disabling inquiries

You can choose to not give users the ability to launch inquiries from the IBM Cognos Incentive Compensation Management web client.

Procedure

1. On the Inquiries tab, select the object for which you want to disable inquiries.

   Important: An inquiry tree must be assigned to the object.

2. Click the Disable Inquiries icon.

3. Click Yes in the Question window.

Enabling inquiries

By default, users will have the ability to launch inquiries for compensation plans, tailored reports, documents, and Presenter reports from the IBM Cognos Incentive Compensation Management web client; however, if you have disabled this function, you have the ability to enable it again.

Procedure

1. In the Portal Access module, on the Inquiries tab, select the compensation plan, tailored report, document, or Presenter report you want to enable inquiries for.

   Important: An inquiry tree must be assigned to the object.

2. Click the Enable Inquiries button.

3. Click Yes in the Question window.

Sending email notifications to pending payees

You have the option to send an email to all groups in the inquiry tree from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure

1. On the Inquiries tab, click the Email All Groups icon.

2. Type in a subject and message.

3. You can select the Send to Pending Payees Only check box to notify only payees in the top node of the sign off tree.

4. Click Send.

Sending email notifications to one group

You can send an email to all members of one group in the Inquiry tree from the IBM Cognos Incentive Compensation Management Portal Access module.
**Procedure**

1. On the Inquiries tab, select the group.
2. Click the Email Group button.
3. Type in a subject and message.
4. Click Send.

**Submitting an inquiry from the web client**

If an inquiry handling tree has been enabled for a compensation plan or tailored report, all payees in the tree will be able to launch inquiries through the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. Log in to the web client.
2. Go to the Payee Ledger tab.
3. In either the Details or Summary window, you can click Inquire.
4. Select the inquiry category.
5. Attach any supporting documents.
6. Enter in any details of the inquiry.
7. Click Submit.
   - The inquiry is automatically assigned to the next group in the tree, that is the group immediately after the group of the member who launched the inquiry.
   - The payee who submitted the inquiry sees a new message in his or her Message Center that says he or she has an open inquiry.

**Handling inquiries**

When an inquiry is launched, users who are assigned to handle the inquiry will have the option to view, assign, unassign, escalate, or return the inquiry via the IBM Cognos Incentive Compensation Management web client.

If Return To Submitter has been enabled in Portal Access, users will also be able to resubmit a returned inquiry to the original assignee.

**Procedure**

1. Log in to the web client.
2. Click the Message Center.
3. Select Inquiries.

   **Important:** You can also view inquiries through the Inquiries tab in the Portal Access module.
4. Click View to see the details of an inquiry.
5. You can select either Assign, Unassign, Escalate, or Return.
   - Assign - assigns the inquiry to yourself.
   - Unassign - removes yourself as handler of the inquiry.
   - Escalate - submits the inquiry to the next person on the inquiry handling chain.
   - Return - rejects the inquiry.
   - Resubmit - sends the inquiry back to the user who returned the inquiry to you. This option is only available if the Return To Submitter option is enabled in Portal Access.
Viewing inquiry details
If you select any compensation plan or report in the IBM Cognos Incentive Compensation Management Client, the inquiry handling tree associated with it will be displayed in the right pane.

If any group is highlighted in red, there is an inquiry assigned to that group or an inquiry has been made by that group.

Procedure
1. On the Inquiries tab, right-click the red group.
2. Select View Inquiries Assigned to this Group.
   A screen will be displayed showing any comments or attachments that have been posted with this inquiry. The status and category of the inquiry can be changed from this location.
3. Double-click an entry to see the inquiry details.

Viewing details of an inquiry made by a group
You can view the details of an inquiry assigned to a group or an inquiry that has been made by a group in the IBM Cognos Incentive Compensation Management Portal Access group.

Procedure
1. On the Inquiries tab, right-click the red group.
2. Select View Inquiries Made by this Group.
3. Double-click an entry to see the inquiry details.

Viewing the details of an inquiry assigned to the administrator
You can view the details of an inquiry that has been assigned to the administrator from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Inquiries tab, click the Inquiries Assigned to Administrators button.
2. Double-click an inquiry.
3. You can change the status or the category.
4. You can also add comments on attachments.

Adding and editing inquiry categories
You can create and modify inquiry category names in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Inquiries tab, click the Inquiry Categories icon.
2. Click Add or Edit.
3. Type in the name.
4. When you have finished adding inquiry categories, click Close.

Enabling inquiry resubmission
You can enable web users to resubmit a returned inquiry to the same assignee that returned the inquiry to them from the IBM Cognos Incentive Compensation Management Portal Access module.
Procedure

1. In the Portal Access module, open the Inquiries tab.
2. Right-click the object that you want to enable inquiry resubmission for, and select Resubmit To Returner.
Chapter 21. Scheduler

You can use the IBM Cognos Incentive Compensation Management Scheduler module to create and schedule processes such as imports, calculations, and calendar locking.

Keeping a model up-to-date is essential. Without regular transactional data updates, Cognos Incentive Compensation Management cannot calculate up-to-date compensation amounts. Scheduler can help you stay on top of the import process. Structural and data loads that are saved in the application will be accessible in Scheduler and can be grouped together as steps in a single process. Each process can be run either on demand, or on a scheduled basis, keeping your compensation model in sync with the latest data from your source systems.

In addition to data imports, Scheduler can be used to schedule all administrative tasks that need to be run on a regular basis. Scheduler can also be used to automate the process of calculating results, locking periods, and generating administrative tasks created in Task Manager.

Setting Scheduler properties

You can select Scheduler options such as stopping a process if the IBM Cognos Incentive Compensation Management Scheduler module encounters an error, setting the maximum run time for an external tool, stopping an external tool after it has exceeded the set run time, and sending email warnings when Scheduler encounters an error or runs successfully.

If changes are made to Scheduler properties, the Scheduler Service must be restarted.

Procedure

1. Click the Properties button in the toolbar.
2. Select the External Tool Maximum Run Time check box, and type the maximum time you want Scheduler to allot for an external tool to run.
3. Select the Stop External Tool on Timeout check box if you want the external tool to no longer run after it has exceeded the maximum run time.

   Important: If the external tool is not running on the same machine as the Cognos Incentive Compensation Management Client, stopping the external tool after the timeout cannot be guaranteed.

4. Select the Stop Process on Error check box if you want the whole Scheduler process aborted if an error is encountered when running a task.
5. Select the Email a Warning Message check box if you want Scheduler to email users when Scheduler encounters a problem, completes successfully, or completes with errors.
6. In the Email Addresses field, type the email addresses of the users to whom you want the email warnings sent.
Adding processes

You can use the IBM Cognos Incentive Compensation Management Scheduler module to create processes that can be run on demand or on a scheduled basis.

Processes can include tasks such as calculations, imports, publications, calendar locking, and task generating.

Procedure
1. To add a new process, perform one of the following steps:
   • Click the Add Process icon.
   • Right-click in Scheduler, and select Add Process.
2. Type a Process Name.
3. Click OK.

Tip: It is a good idea to create processes first, and then organize a combination of structural and data imports and calculations into process folders.

Adding calculations

You can add a calculation of the whole model to your process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
To add a calculation to a process folder, perform one of the following steps:
• Select the process folder, click the Add Task icon, and select Add Calculation.
• Right-click a process folder, and select Add Calculation.

Adding plan calculations

You can add a calculation of one or all compensation plans to a process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
1. To add a plan calculation to a process folder, perform one of the following steps:
   • Select the process folder, click the Add Task icon, and select Plan Calculation.
   • Right-click a process folder, and select Add Plan Calculation.
2. Choose a compensation plan, or select All.
3. Click OK.

Adding a tailored report calculation

You can add a calculation of one or all tailored reports to a process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
1. To add a tailored report calculation, perform one of the following steps:
   • Select the process folder, click the Add Task button, and select Tailored Report Calculation.
   • Right-click a process folder, and select Add Tailored Report Calculation.
2. Choose a tailored report, or select All.
3. Click OK.

**Adding a Presenter report calculation**

You can add a calculation of one or all Presenter reports to a process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

**Procedure**

1. To add a Presenter report calculation, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Presenter Report Calculation.
   - Right-click the process folder, and select Add Presenter Report Calculation.
2. Choose a Presenter report, or select All.
3. Click OK.

**Adding external tools**

Scheduler can optionally be used to schedule and run processes that exist outside of IBM Cognos Incentive Compensation Management.

An external tool is any program that can be run from the command line in the Service configuration file.

For example, if you have a scheduled import or calculation, you can schedule an external tool, such as Notepad, to run immediately after the import or calculation finishes. If you type in the name of the file in the arguments (or value) line in the External Tools window, then that specific Notepad file will open.

**Setting up external tools**

Before adding external tools to a process folder, you must first edit the IBM Cognos Incentive Compensation Management Windows Service configuration file to set up the use of external tools.

**Procedure**

1. In the Cognos Incentive Compensation Management Window Service configuration file, uncomment the External Tools section.
   - For example, edit the following section of the Cognos Incentive Compensation Management Windows Service configuration file:
     ```xml
     <!-- External Tools -->
     <add key="ExternalToolDirectory" value="C:\Program Files\IBM Cognos ICM\Service\Tools"/>
     <add key="ExternalToolMaxRunTime" value="3600"/>
     ```
2. Restart the Service.
3. Place your batch files, scripts, and so on in the external tool directory.
   - For example, place them in the following directory: C:\Program Files\IBM Cognos ICM\Service\Tools.

**Scheduling external tools**

You can schedule an external tool that has been added to the External Tools directory in the IBM Cognos Incentive Compensation Management Scheduler module.
Procedure
1. To add a scheduled external tool, perform one of the following steps:
   • Select the process folder, click the Add Task icon, and select External Tool.
   • Right-click a process folder, and select Add External Tool.
2. Select from a list of available tools.
3. In the Arguments field, type in the name of the file.
4. Click OK.

Adding imports
Any imports saved in IBM Cognos Incentive Compensation Management can be added to the Scheduler module to be run on demand or at predefined intervals.

Procedure
1. To add an import to a process, perform one of the following steps:
   • Select the process folder, click the Add Task icon, and select Import.
   • Right-click a process folder, and select Add Import.
2. Select a saved server import.
3. Click OK.

Adding IBM Cognos Sales Performance Management on Cloud table synchronization
You can schedule data synchronization between IBM Cognos Sales Performance Management on Cloud and IBM Cognos Sales Performance Management on Cloud objects in the Cognos Incentive Compensation Management Client.

Important: You will only be able synchronize data between Cognos Sales Performance Management on Cloud and Cognos Incentive Compensation Management through Scheduler if Cognos Sales Performance Management on Cloud connection settings have been configured in the Windows Service configuration file. For more information, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide).

Procedure
1. To add an IBM Cognos Sales Performance Management on Cloud table synchronization, perform one of the following steps:
   • Select the process folder, click the Add Task button, and select IBM Cognos Sales Performance Management on Cloud Table Synchronization.
   • Right-click the process folder, and select Add IBM Cognos Sales Performance Management on Cloud Table Synchronization.
2. Select the IBM Cognos Sales Performance Management on Cloud object to import, and click OK.

Manage and schedule publications
Publications created via the Publisher tool can be saved and scheduled in the IBM Cognos Incentive Compensation Management Scheduler module.

The following publications can be scheduled to run at predefined times in Scheduler:
• Tables in Composer published to Microsoft Excel, Microsoft Dynamic CRM, PDF file, Salesforce.com, or text delimited files.
• Calculations in Composer published to Microsoft Excel, Microsoft Dynamic CRM, PDF file, Salesforce.com, or text delimited files.
• Detail ledgers in Payee Ledger published to Excel, PDF file, or text delimited files. The detail ledger will publish for selected or all compensation plans and payees and will filter on period and calculation. For example, the ledger will publish all plans for a selected payee, or publish a selected compensation plan for all payees, filtered on a selected period and calculation.
• Presenter reports published to PDF files. For example, batch export PDF files for each payee or export PDF files for selected payee.
• Web forms published to PDF files. For example, batch export PDF files for each payee or export PDF files for selected payee.

In order to save a publishing event so that it can be rerun using Scheduler, a Publisher File Directory must be specified in the Cognos Incentive Compensation Management Windows Service configuration file.

The saved Publisher Image Directory is the location where Cognos Incentive Compensation Management will look for image files to be used as header graphics for scheduled PDF file publishing. This setting must refer to a directory on the same computer as the Windows Service.

The following example shows the Cognos Incentive Compensation Management Window Service configuration file modified to point to a Saved Publisher File Directory and a Saved Publisher Image Directory.

```xml
<add key="PublisherFileDirectory" value="/Program Files\IBM Cognos ICM\Publisher Files"/>

<add key="PublisherImageDirectory" value="/Program Files\IBM Cognos ICM\Publisher Images"/>
```

**Managing saved publications**

Saved publications can be modified, removed, or run from the Manage Saved Publications window in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Go to Admin > Manage Saved Publications.
2. Select a Publish Name, and click Edit, Delete, or Run.
3. Click Close.

**Adding a publication**

Publications can be run using the IBM Cognos Incentive Compensation Management Scheduler module.

**Procedure**

1. To add a publish to a process, perform one of the following steps:
   • Select the process folder, click the Add Task button, and select Publish.
   • Right-click a process folder, and select Add Publish.
2. Select an available publication.
3. Click OK.

**Email publications**

Sending publications through email is possible either on demand or scheduled through the IBM Cognos Incentive Compensation Management Scheduler module.
Web forms, Presenter reports, and Payee Ledger Detail reports all have the email functionality.

Email functionality is only available when you select the Publish from the Server option.

In order to email a publication, you need to define a Saved Publisher file Directory in the Cognos Incentive Compensation Management Windows Service configuration file.

When sending publications through email, the following options will be available:
- If you create a separate report for each payee, you can email each individual payee their own report.
- You can specify an email address of your choice to which to send the publication.
- You can select the email addresses to send the publication to from the Payee table.

Adding a task generation
After defining groups, creating rules, or enabling alerts in the IBM Cognos Incentive Compensation Management Task Manager module, task generation can also be scheduled in Scheduler.

Procedure
To add task generation to a process, perform one of the following steps:
- Select the process folder, click the Add Task button, and select Task Generation.
- Right-click a process folder, and select Add Task Generation.

Adding a task run
After tasks have been generated in the IBM Cognos Incentive Compensation Management Task Manager module, the tasks can then be scheduled to run at a specific time in the Scheduler module.

You can automate the process of adding new users to Portal Access groups and granting them web access.

Procedure
To add task generation to a process, perform one of the following steps:
- Select the process folder, click the Add Task icon, and select Task Run.
- Right-click a process folder and select Add Task Run.

Adding a star schema population
If star schemas have been created in the IBM Cognos Incentive Compensation Management Composer module, they can be populated on a scheduled basis using the Scheduler module.

Procedure
1. To add a star schema population to a process, perform one of the following steps:
Adding data transformations

If data transformations have been defined in the IBM Cognos Incentive Compensation Management Composer module and saved, the transformations can be scheduled to run at predefined intervals.

If your source system data is in a format that is different than the data in your table, you may want to save a transformation and schedule that transformation to run after every scheduled import.

Procedure

1. To add a data transformation to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Data Transformation.
   - Right-click a process folder and select Add Data Transformation.
2. Select a saved data transformation.
3. Click OK.

Adding table clearing

Table clearing will delete the contents of the table at the specified time in IBM Cognos Incentive Compensation Management.

Procedure

1. To add a table clearing to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Table Clearing.
   - Right-click a process folder, and select Add Table Clearing.
2. Select a table in the Table Selector window.
3. Click OK.

Adding a model optimization

Users can run the optimize model feature on demand through the IBM Cognos Incentive Compensation Management Scheduler module or schedule it to run at predefined intervals.

Scheduling model optimization during off-peak hours saves time and prevents administrators from having to regularly perform an extra manual step.

Procedure

To run an optimize model, perform one of the following steps:
- Select the process folder, click the Add Task icon, and select Optimize Model.
- Right-click a process folder, and select Add Optimize Model.
Add period locking
You can add period locking for a specific calendar to the next period in the IBM Cognos Incentive Compensation Management Scheduler module.

Important: You can only schedule locking one period at a time.

Procedure
1. To add period locking to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Period Locking.
   - Right-click a process folder, and select Add Period Locking.
2. Select the calendar you want to lock to the next period, and click OK.

Adding web enable or disable
You can schedule the IBM Cognos Incentive Compensation Management web client to be temporarily disabled when the model is being updated.

Temporarily disabling the web client will prevent web users from logging in to the web client and making changes while the model is being updated. The web client can also be enabled again by adding this task to a process.

Procedure
1. To add a task that temporarily disables the web client, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Web Status.
   - Right-click the process folder and select Add Web Status.
2. Select the Disable Web option.
3. Click OK.
4. To add a task that re-enables the web client, perform one of the following steps:
   - Select the process folder, click the Add Task icon, and select Web Status.
   - Right-click the process folder and select Add Web Status.
5. Select the Enable Web option.
6. Click OK.

Adding workflow payees
You can schedule the addition of payees to a workflow in the IBM Cognos Incentive Compensation Management Workflow Manager, as long as the payees in the swim lanes were defined using restrictions.

Procedure
1. To add a task that adds payees to the workflow, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Add Workflow Payees.
   - Right-click the process folder, and select Add Workflow Payees.
2. Select an available workflow, and click OK.
Unassigning idle inquiries

A task can be created to unassign a user from an inquiry if the user has not updated the inquiry in the IBM Cognos Incentive Compensation Management web client after a specified number of days.

After the inquiry has been unassigned, it is returned to the same Portal Access group to be reassigned. A comment is added to the inquiry indicating the assignee has been unassigned from the inquiry because it was inactive for the specified number of days.

Procedure
1. To add a task that unassigns a user from an idle inquiry, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Unassign Idle Inquiries.
   - Right-click the process folder, and select Add Unassign Idle Inquiries.
2. Type the number of days the user has to update the inquiry before it becomes idle in the Number of Days to Expiry field.
3. Click OK.

Adding a purge history task

A task can be created in Scheduler to clear the history for selected tables in IBM Cognos Incentive Compensation Management.

Procedure
1. In Scheduler, select or add a process folder.
2. In the toolbar, click Add Task.
4. Select the table or tables for which you want to remove history data.
5. If you select a data table, you must select a date range for which you want to purge history table data.

Viewing a scheduled history purge

You can view the tables and date ranges selected for scheduled history purge in IBM Cognos Incentive Compensation Management.

Procedure
1. In Scheduler, in the process folder, right-click the Purge Table History task.
2. Select View Scheduled Purge.

Searching for an item

You can use the Search icon in the toolbar to locate a specific task or process in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
1. Click the Find icon in the toolbar.
2. In the Find Node window, type the name of the task or process that you want to find.
3. Click Search.
   The task or process will be highlighted in the Scheduler window.
Scheduling an item

You can set the minute, hour, day of the month, day of the week, and month for a process or item to run in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure

1. Make sure the Scheduler Service is running.
2. Select the process folder or the item in the process folder that you want to schedule a run time for, and perform one of the following steps:
   - Click the Schedule Item button.
   - Right-click the process folder or item, and select Schedule.
3. Select the Minute you want the process or task to run on.
4. Select the Hour you want the process or task to run on.
5. Select either the day of the month or day of the week on which you want the process or task to run.
6. Select the Month when you want the process or task to run.
7. Click OK.

After an item is scheduled, the check box in the Scheduled column will be selected.

Unscheduling an item

Items that have been scheduled can be unscheduled again in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure

1. Select the process folder or the item in the process folder that you want to unschedule a run time for, and perform one of the following steps:
   - Click the Schedule Item button.
   - Right-click the process folder or item and select Schedule.
2. Click Unschedule.
3. Click OK.

Scheduler timing

Sometimes you may find that scheduled processes do not run at exactly the time you specified in the IBM Cognos Incentive Compensation Management Scheduler module.

For example, you may have scheduled Scheduler to run at exactly 11:00 p.m. The next day you notice that the scheduler log file shows that the item ran at 11:02 p.m. This may be due to time changes in the system. For example, Windows Time Services will periodically make minor adjustments to the system time. This can interfere with Scheduler running at exactly the specified time.

Scheduler time conflicts

When scheduling tasks in the IBM Cognos Incentive Compensation Management Scheduler module, keep in mind that two tasks cannot run at the same time.

If one process is scheduled at 11:00 p.m. and another at 11:01 p.m., the second will not run if the first has not been completed. If the second task is unable to run, an
error message will be displayed indicating that the task could not be run due to a scheduling conflict. The conflict will need to be resolved before Scheduler can run successfully.

Scheduler has a ten-minute window to run before the task will be skipped. This means that if Scheduler misses the 11:00 p.m. scheduled time due to a scheduling conflict, it will continue to attempt to run the task until 11:09:59 p.m. If the task is unable to run in the ten-minute window, the task will be skipped.

Important: The Scheduler Service can only run one process at a time. If more than one model is using the same Scheduler Service, scheduled processes need to occur at different times for each model. If scheduled model administration needs to occur simultaneously on more than one model, each model should point to a different service.

Running an item

You can make a process or item run immediately from the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure

1. To run a process or specific item immediately, perform one of the following steps:
   • Select the process folder or item, and click the Run Item icon.
   • Right-click the process folder or item, and select Run.
2. In the Question window, click Yes.

Scheduler error notification

When you run an item from the IBM Cognos Incentive Compensation Management Scheduler module, some items may not run.

If there are any items that could not be run, the following actions will occur:
• A message will be displayed telling you to see the Audit Log for more information.
• A red stop sign will be displayed under the status column.
• No time will be displayed in the Last Run column of the Scheduler module.

Important: The Last Run column will only record the last, successful, error-free completion of each task.

Whenever a scheduled item does not run, the scheduled task will be skipped. Scheduler will, however, attempt to run the task item at the next scheduled interval.

If the item ran successfully, you will see a green check mark in the status column.

If the first item in a process does not run, Scheduler will by default, still attempt to run the remaining items in the process. If you do not want Scheduler to attempt to run the remaining items in the process after a task fails, set the scheduler stop processes on error values in the Cognos Incentive Compensation Management Windows Service configuration file to true. For example, you can modify the Cognos Incentive Compensation Management Windows Service in the following way:

<add key="SchedulerStopProcessesOnErrors" value="true"/>
**Important:** The Audit Log module will also capture all Scheduler activity when any issues are encountered.

To prevent problems that may be associated with a lost import, Scheduler can be configured to send an email (to an individual or distribution list) informing you of the error. Scheduler can also be configured to send an email notification upon successful completion. The email message will be sent to the address indicated in the Service configuration file (Cognos Incentive Compensation Management Windows Service.exe.config).

**Accessing the Scheduler log**
The date, time, step the process failed on, and other vital information is copied into the IBM Cognos Incentive Compensation Management Scheduler log file and the error report is recorded.

**Procedure**
1. To view the Scheduler log, open the Audit module.
2. Click the **Scheduler** tab.
Chapter 22. Task Manager

The IBM Cognos Incentive Compensation Management Task Manager module simplifies the process of maintaining the model by generating lists of model maintenance and Portal Access tasks to be completed based on defined criteria.

Tasks can also be used to alert administrators when certain situations arise, such as when active payees are not included in a compensation plan, or terminated payees continue to be active in a plan.

Creating a task facilitates the process of performing a variety of actions when data in the model changes, such as when new payees are imported into the Payee table. With tasks, you can easily define payee groups and create rules to perform administrative actions on those groups. After the customized task list has been generated, click Run to complete model maintenance.

Task creation

You can use IBM Cognos Incentive Compensation Management Task Manager to perform common model maintenance activities.

The following steps outlines the basic procedure that you need to take:

1. Create a group.
2. Create a rule.
3. Generate task list.
4. Administer the tasks.
5. Create email notification and enable alerts.

Step 1. Creating a group

To define which tasks are performed on payees, you need to create a group in the Groups tab of the IBM Cognos Incentive Compensation Management Task Manager module.

About this task

The Payee table is used by default to create groups; however, you can add any tables or calculated results to the payee table in order to define the source of the payees. You can then use restrictions to specify which payees to include in the group.

When creating groups, think about what actions you want to perform on those groups, such as what rule you want to apply to the group. For example, you could create a Task Manager group that includes all payees whose status is terminated, then create a rule to remove those payees from their payee group.

Procedure

1. On the Groups tab, perform one of the following steps:
   - Select a folder, and click the Add Group icon.
   - Right-click a folder, and select Add Group.
2. Type a name for your group, and click Next.
3. Define your data sources, and click Next.
4. Define any restrictions.
5. Click Finish.

   **Important:** The groups you created in Portal Access will appear in the Groups tab.

**Step 2. Adding a rule**

Use the Rules tab in the IBM Cognos Incentive Compensation Management Task Manager module to determine the actions to be performed on specified groups of payees.

The payee groups that are added or removed are defined in the Groups tab of the Task Manager module.

**About this task**

There are several rule options available.

*Table 45. Task Rules*

<table>
<thead>
<tr>
<th>Module</th>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payee Groups</td>
<td>Add payees to a payee group</td>
<td>Add payees in a defined group to a specified payee group. The start date for the added payees will be the first day of the fiscal year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: Add all payees with job title Inside Sales Rep to the Inside Sales Rep payee group. Payee start date will be first day of fiscal year.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Add payees to a payee group as of today</td>
<td>Add a defined group of payees to a payee group with today’s date as their start date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: Add all payees with job title Inside Sales Rep to Inside Sales Rep payee group. Payee start date will be the day the task is run.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Remove payees from a payee group</td>
<td>Remove payees in a defined group from a specified payee group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Important:</strong> Removing payees from a payee group will remove all their history from Payee Ledger. To avoid this, you can opt to set end dates for payees instead (see next rule).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: Remove all terminated payees from a specified payee group.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Set end dates for payees in a payee group</td>
<td>End dates for a group of payees can be set for anywhere from today to 180 days from today.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: Set end dates for all terminated payees.</td>
</tr>
<tr>
<td>Portal Access</td>
<td>Add payees to a Portal Access group</td>
<td>Add a group of payees in a defined group to a Portal Access group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: Add all Account Executives to the Account Executive Portal Access group.</td>
</tr>
</tbody>
</table>
Table 45. Task Rules (continued)

<table>
<thead>
<tr>
<th>Module</th>
<th>Rule Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Access</td>
<td>Enable a group of payees for web and notify them of their passwords.</td>
<td>This rule will grant web access to specified payees.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Random passwords will be generated and emailed to the address in the Payee</td>
</tr>
<tr>
<td></td>
<td></td>
<td>table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Important:</strong> This rule will not add payees to a Portal Access group; this</td>
</tr>
<tr>
<td></td>
<td></td>
<td>needs to be done separately</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Important:</strong> This rule is created by default for Portal Access groups that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>users have selected to be maintained in Task Manager.</td>
</tr>
</tbody>
</table>

**Procedure**

1. On the **Rules** tab, perform one of the following steps:
   - Select a folder, and click the **Add Rule** icon.
   - Right-click a folder, and select **Add Rule**.
2. Type a name for your rule, and click **Next**.
3. Select the type of action this rule should perform, and click **Next**.
   - The next screens in the wizard are specific to the rule you select.
4. Select the group, payees, or numbers.
5. Select the groups you would like to email and move them from the **All Roles** column to the **Selected Roles** column using **Add >**.
6. If you do not want to enable email notification for a rule, select **Finish** without selecting any roles.

   **Important:** Email notification can optionally be sent to administrators when a task is generated by Task Manager. Email notification is defined individually for each rule and will be sent to all users who are assigned to the selected user role. The user role is defined in the Manage Roles window.
7. Click **Finish**.

**Step 3. Generating a task list**

Generating your task list provides you with a list of tasks to be performed based on the rules you created in the IBM Cognos Incentive Compensation Management Task Manager module.

Task generation can be done manually or within Scheduler.

**Procedure**

1. On the **Tasks & Alerts** tab, click the **Generate** button to populate the tab with a list of tasks to be run based on the rules specified.
   - For example, if you have created a rule to add all payees in a particular group to Portal Access, Task Manager will generate a list of all the payees that need to be added to a Portal Access group. Task generation can also be scheduled in Scheduler.
2. Review the generated list of tasks.
Step 4. Administering the tasks

After generating the task list, administrative tasks will be visible in the Tasks & Alerts tab in the IBM Cognos Incentive Compensation Management Task Manager module.

You have the options to either dismiss, defer, or run a task.

Procedure

1. On the Tasks & Alerts tab, select a task.

   Tip: To select multiple tasks, press Ctrl.

2. To delete a task, perform one of the following steps:
   • Click the Dismiss icon.
   • Right-click the task, and select Dismiss.

3. To run a task, perform one of the following steps:
   • Click the Run icon.
   • Right-click the task, and select Run.

4. To defer a task to a later date, perform one of the following steps:
   • Click the Defer icon.
   • Right-click the task, and select Defer.
   a. Select the date that you would like to generate the selected task.

   When you defer a task, it will be removed from the Tasks & Alerts tab and placed in the Deferred Tasks tab. It will be placed in the Tasks & Alerts tab on the date specified.

Canceling a deferral

Tasks can be removed from the Deferred Tasks tab and placed back in the Tasks & Alerts tab in the IBM Cognos Incentive Compensation Management Task Manager module.

Procedure

On the Deferred Tasks tab, select the task, and perform one of the following steps:
• Click the Cancel Deferral icon.
• Right-click the task, and select Cancel Deferral.

Important: The tasks will be placed back into the Tasks & Alerts tab.

Step 5. Creating email notifications

You can define which administrators receive an email notification if a rule generates a task in the IBM Cognos Incentive Compensation Management Task Manager module.

Procedure

1. On the Tasks & Alerts tab, select the Modify Email Role button.

2. Select the administrator role that you want email notifications sent to, and click Next.

3. Select the rules you want to prompt an email notification, and click Add.

4. Click Finish.
**Important:** Anytime a task is generated for a rule in the **Selected Rules** column, the administrator will receive an email notification.

### Step 6. Alert options

To simplify the maintenance of payee groups, administrators can optionally be informed when certain situations arise using the IBM Cognos Incentive Compensation Management Task Manager module.

Administrators can be notified in the following situations:

- Payees exist in more than one plan.
- Payees are not in a plan.
- Terminated payees are still active in a payee group. If a payee has been marked as terminated in the Payee table but is still active in a payee group (the end date does not match the termination date), you can choose to be notified.
- Specified tailored reports generate one or more rows. If you have created a tailored report that is meant to only generate data when certain milestones or exceptions occur, you can opt to be notified when the report is not empty. This will save you from having to remember to check the report results on a regular basis.

**Important:** Tailored reports need to be enabled for this alert from Composer.

### Activating a payee alert

You can enable specific, default alerts through the **Alert Options** tab in the IBM Cognos Incentive Compensation Management Task Manager module.

If payees fall into any of the enabled alert categories, the alert will be displayed on the **Tasks & Alerts** tab.

**Procedure**

On the **Alert Options** tab, right-click an alert, and select **Enable**. The check box in the Enabled column will be selected.

### Disabling a payee alert

You can disable alert options that have been enabled in the IBM Cognos Incentive Compensation Management Task Manager module.

**Procedure**

On the **Alert Options** tab, right-click an alert, and select **Disable**.
Chapter 23. Audit

The IBM Cognos Incentive Compensation Management Audit module monitors all activity by all users, provides lists of errors, and lists of scheduler and task messages.

Multiple logs can be accessed so users can view a list of errors generated, the date and time the error occurred, a description of the error, and the error type.

From within each log, users can optionally copy the contents of the log, clear the contents of the log, or refresh the data. With the exception of the Computation log, users can also view log entries for a specified date range.

All logs in the Audit module, except for the Error log, show information specific to the model the user is currently logged in to. The Error log is user-specific and not model-specific, so it will show information for all models.

The following logs are available in the Audit module:
- Audit log
- Computation log
- Error log
- Service Error log
- Import log
- Export log
- Scheduler log
- Task log

Audit log

By default, the Audit log monitors all activity by all users in IBM Cognos Incentive Compensation Management.

It logs any database creation, modification, and deletion activity, and presents it in the form of a filter-capable grid for administrator review.

If you ever need to retrace your steps, the Audit log provides all the key information you need to determine the exact process used for building your model.

In addition to monitoring all activity in the Cognos Incentive Compensation Management Client, the Audit log also displays any web data edit or Portal Access entries made by web client users. The user types for any changes made are administrator for the Cognos Incentive Compensation Management Client and web user for the web client. Model Converter events, including start, end, and success messages, are also stored in the Audit log.

Audit log functionality

The Audit log can be used for reviewing events and actions taken by administrators in the IBM Cognos Incentive Compensation Management Client.

The following events can be viewed in the Audit log:
• Adding user roles
• Administrator log on and log off
• Allocations
• Category calculation changes
• Calculation started, stopped, canceled, and completed
• Changing user role permissions
• Column added and removed
• Connections made between components
• Configuration change
• Created or deleted tables, Views, compensation plans, tailored reports, or Presenter reports
• Data and assignments saved
• Data import begun and concluded
• Favorites section modifications
• Folder created and deleted
• Inquiry changes made in the Client and web client
• Items scheduled, unscheduled, saved, added, run, renamed, started, and deleted
• Manual adjustments
• Migration log on, log off, ended, and began
• Model Converter tool events
• Modified user information
• Modified View tables
• Modified Category calculations
• New model created
• Password changed
• Payee enabled for web access
• Plan modified
• Row update submission
• Sign off begun
• Star schema populated
• Started and completed optimization
• Tasks deferred or dismissed
• Task rules edited or added
• Trees and groups created, deleted, edited, and saved
• Updates to Presenter reports
• Upgrade models
• User modified
• Users log on, log on failed, and log off
• Web data edit
• What role the user is when added
• Portal Access entries
• Migrated object and objects deleted during migration
Filtering Audit log results

Results in the IBM Cognos Incentive Compensation Management Audit log can be filtered by user type, user ID, module, and event type.

Procedure

1. On the Audit tab, click the header of the column you want to filter by.
2. Click the arrow to access the drop-down menu.
3. Select an item to filter by.

Important: You can also use the arrows in the toolbar to display the results from most recent to oldest and vice versa.

Viewing details of table modifications

You can view details of changes made to tables in the IBM Cognos Incentive Compensation Management Composer module.

Only the rows that were modified will be displayed in the Show Details window.

Procedure

On the Audit tab, double-click or right-click a row, and select Show Details to open up the affected table.

Important: If a data import into a table results in a new payee being added to the Payee table, the Audit log shows both the update to the data table and the member added to the Payee table.

Cleaning up the Audit log

Use the Clean Up feature to remove old Audit log entries in IBM Cognos Incentive Compensation Management.

Procedure

1. On the Audit tab, click the Clean Up button.
   The Audit Log Clean Up window is displayed.
2. Select a date from the drop-down menu.
   Any entries created before and on the date entered in the Audit Log Clean Up window are cleared.
3. Click OK.

Exporting Audit logs

Use the Export button to export the contents of the IBM Cognos Incentive Compensation Management Audit log to comma delimited, tab delimited, or Microsoft Excel formats.

This is useful for creating an archive of old Audit log contents.

Procedure

1. On the Audit tab, click the Export button.
2. Choose a destination folder for the Audit log, type a File Name, and select the Save as type.
3. Click Save.
**Computation log**

The IBM Cognos Incentive Compensation Management Computation log displays the time breakdown of a calculation by calculated item.

If you find that your calculation time is unusually slow, this log will help you to pinpoint the source of the delay.

The Computation log will list the following information:
- Version of Cognos Incentive Compensation Management
- Date and time of calculation
- Each calculation and length to calculate
- Any calculations that have started, but have not finished, will be listed with a status of "Started".

**Clearing a log**

To erase everything from the logs in the IBM Cognos Incentive Compensation Management Audit log module, you can use the **Clear** button.

This button is also found in the **Error**, **Service Error**, **Import**, **Export**, **Scheduler**, and **Task** logs.

**Generating the Computation log**

Users must select the **Enable generation of Computation Logs** check box in the Administrative Options window in order for information to be recorded in the IBM Cognos Incentive Compensation Management **Computation** log.

By default, the **Enable generation of Computation Logs** check box is selected. When this check box is selected, all the names of your calculations and how long they took are listed. Each time a calculation is run the computation log is recorded on a new page. Users can navigate through the computation logs using the blue arrows in the tool bar.

**Copying a log**

You can copy the IBM Cognos Incentive Compensation Management **Computation** log onto the clipboard and paste it into a document.

You can also copy the **Error**, **Service Error**, **Import**, **Export**, **Scheduler**, and **Task** logs.

**Error log**

The IBM Cognos Incentive Compensation Management **Error** log lists details of errors generated within the system.

For example, if the Cognos Incentive Compensation Management Client is unable to connect with the server, an error is logged.

The **Error** log can list the following information:
- Version of Cognos Incentive Compensation Management
- Date and time error occurred
- Environment
Setting date filters in a log

Users have the ability to filter the IBM Cognos Incentive Compensation Management Error log by a specified date range.

You can also set date filters for the Service Error, Import, Export, Scheduler, and Task logs.

Procedure
1. Click the Set Date Filters button.
2. Select the From and To ranges using the drop-down menus.
3. Click OK.

Service Error log

The IBM Cognos Incentive Compensation Management Service Error log provides a list of all errors generated in the Service.

For example, a failed log in attempt or an expired session is listed in the Service Error log.

The Service Error log can list the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• A statement about the error
• Inner Exception
• Error type
• Stack trace

Import log

In the event the import was unsuccessful, the IBM Cognos Incentive Compensation Management Import log details the problem.

The Import log records the primary key value of each failed import line item so you can easily troubleshoot import errors and detect problems in the data.

The Import log can list the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• Table name
• List of error
• Primary key value
Export log

If an export was unsuccessful, the IBM Cognos Incentive Compensation Management Export log details the problem.

For example, if the user exports a numeric column from a table into a MSCRM or a Salesforce.com date column, the error shows up in the Export log.

The Export log can list the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• Name of what is being exported
• List of errors

Scheduler log

All Scheduler errors and successful run information are captured in the IBM Cognos Incentive Compensation Management Scheduler log.

If the user does not have the Scheduler Service running before they schedule an item, an error is displayed in the Scheduler log. Scheduling conflicts may also affect the specified process run time. If a process is scheduled at 11:00 p.m. and another at 11:01 p.m., the second may not run because the first has not been completed. If the second task is unable to run, a message is displayed in the log.

The Scheduler log can list the following information:
• Date and time error occurred
• Description of error

Task log

If an error is generated during task generation, the details of the error displays in the IBM Cognos Incentive Compensation Management Task log.

For example, if you generate tasks that attempt to email payees without a defined email address, you see a message in the Task log.

The Task log can list the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• A statement about the error
• Error type
• Stack trace
Chapter 24. Payee Ledger

Use the IBM Cognos Incentive Compensation Management Payee Ledger module to view summary and detail level reports of compensation plan results, and tailored reports.

The Payee Ledger has the following tabs:
- Detail Ledger
- Summary Ledger

Detail Ledger

The IBM Cognos Incentive Compensation Management Payee Ledger module provides the link between calculated results and transactional data in the Detail Ledger.

If you want to trace each record that contributed to earnings for each period, Payee Ledger provides that information when you select the Detail Ledger tab.

The Detail Ledger shows a list of transactions that corresponds to each calculation, their value, and the result of the calculation. The information shown can be modified when adding a calculation to the compensation plan.

For compensation plans with more than one calculation, the Detail Ledger shows results for each calculation. For example, consider a compensation plan that performs the following actions:
- Calculates year-to-date sales for each sales rep
- Calculates the difference between year-to-date sales and quota
- Pays a commission on the difference

This would appear in the Detail Ledger as three separate calculations, one after the other, each including results for all periods.

Filter plans by selected payee

When selecting the information to be displayed in the IBM Cognos Incentive Compensation Management Payee Ledger module from the drop-down menus, you have the option of filtering the list of available plans by the selected payee or filtering the list of payees by the selected plan.

Generating a Detail Ledger report

When a report is created in the Detail Ledger of the IBM Cognos Incentive Compensation Management Payee Ledger module, a list of calculated results and transactional data for a specific plan, payee, and period is displayed.

Procedure
1. Click the Detail Ledger tab.
2. Select a plan or report, payee, and period.
3. Select a calculation.
4. Click the Generate Report button.
The results are displayed.

Filtering out payees with no earnings
Payees with no earnings for a selected plan (or report) and period can be filtered out of the payee selection box in the IBM Cognos Incentive Compensation Management Payee Ledger module.

Procedure
1. Select the plan or report.
2. Click the **Hide Payees with No Earnings** button.
   When the earnings filter is turned on, only payees with earnings for the selected plan and period displays in the payee drop-down menu.

Viewing source data
While looking at the **Detail Ledger** in the IBM Cognos Incentive Compensation Management Payee Ledger module, you can optionally review the underlying details of an individual transaction.

Procedure
1. On the **Detail Ledger** tab, select the plan or report.
2. To view the row information from the data source of the calculation, double-click the transaction.
   Viewing the source data will display the row information from the primary source of the calculation. If you appended tables by adding rows or columns, Payee Ledger will only display the row information from the first data source.

Exporting Payee Ledger results
As is the case with all reporting results, any values you want to export from the IBM Cognos Incentive Compensation Management Payee Ledger module into a Microsoft Excel workbook or delimited text file can be sent by clicking the **Send To** button.

The **Send To** option only exports what is currently being viewed on the screen.

Procedure
1. Click the **Send To** button.
2. Select either **Microsoft Excel** or **Delimited Text File**.
3. Click **OK**.

Publishing Payee Ledger results
The entire IBM Cognos Incentive Compensation Management Payee Ledger module (all compensation plans for all payees) can be exported using the **Publish** button.

The **Publish** feature provides many options, including creating individual Microsoft Excel workbooks for each payee. This is useful if Microsoft Excel workbooks are distributed to payees as commission statements.

Procedure
1. Click the **Publish** button.
2. Select how you would like to perform the publication, and click **Next**.
3. Select a destination, and click **Next**.
Depending on the destination you selected, perform one of the following steps:

- If you selected Microsoft Excel, select the Microsoft Excel options and click Next.
- If you selected Portable Document Format, select the PDF Options, and click Next.
- If you selected Text File, select the Text Options and click Next.

4. Select the Payee Ledger Options, and click Next.
5. Select the file destination, and click Finish.

---

**Summary Ledger**

By selecting the Summary Ledger tab, you will prompt the IBM Cognos Incentive Compensation Management Payee Ledger module to present the results for each period, showing base earnings, net earnings, pending payment, and payment.

You can view summary details according to any combination of plan or report and payee.

**Generating a Summary Ledger report**

The Summary Ledger in the IBM Cognos Incentive Compensation Management Payee Ledger module shows the final calculation results only, not the details of each calculation included in the plan.

**Procedure**

1. Select the plan or report and payee.
2. You can choose to filter the available payees by clicking the Hide Payees With No Earnings button.
3. Click the Generate Report icon.
4. You can export what is currently viewed on the screen by clicking the Send To button.

For more information, see “Exporting Payee Ledger results” on page 248.

**Results with caps and guarantees**

When viewing compensation results in the IBM Cognos Incentive Compensation Management Payee Ledger module, the Summary view shows results of the final earnings after caps and guarantees have been applied.

The Detail Ledger view on the other hand, will show results of the final calculation, not including caps and guarantees.

**Tip:** To view consistent results, include caps and guarantees as part of the final calculation, as opposed to defining them in the payment rules section of the Compensation Plan wizard.

---

**Adjustment Details**

The Adjustment Details tab in the IBM Cognos Incentive Compensation Management Payee Ledger module provides a report of adjustment details for the selected plan and payee.

If allocated adjustments have been created in Composer, the Adjustment Details tab is used to allocate the change-due-to-adjustments amount to selected open periods.
Generating an Adjustment Details report

To view the adjustment details in the IBM Cognos Incentive Compensation Management Payee Ledger module, you must select a plan and payee and generate the report.

Procedure
1. Click the Adjustment Details tab.
2. Select a plan and payee.
3. Click the Generate Report button.

Adding an adjustment category

Adjustment categories can be added to define the type of adjustment that is being created in the IBM Cognos Incentive Compensation Management Payee Ledger module.

Procedure
1. On the Adjustment Details tab, select the Adjustment Categories button.
2. Click Add.
3. Type a name for the category and click OK.
4. When you have finished adding categories, click Close.

Viewing adjustments

In the Adjustment Viewer in the IBM Cognos Incentive Compensation Management Payee Ledger module, you can view, add, edit, and delete allocated adjustments and manual adjustments.

Procedure
1. Select a row in the report generated on the Adjustment Details tab.
2. Double-click the row or right-click and select Adjustments.

Adding manual adjustments

Manual adjustments are one-time solutions that are applied in specific scenarios in the IBM Cognos Incentive Compensation Management Payee Ledger module.

An administrator (or adjuster) can add a manual adjustment to any payee for any open period.

Procedure
1. On the Adjustment Details tab, double-click the row of an unlocked period (unlocked periods have white backgrounds) or right-click the row and select Adjustments.
2. Select the Manual tab.
3. Click Add.
4. Select the Adjustment Value.
5. Select the Adjustment Category.
6. Add a Comment.
7. Click OK.
Chapter 25. Calculate

Administrators can open the IBM Cognos Incentive Compensation Management Calculate module to run the calculate engine, view the summary of the last calculations performed in the model, and view the Computation log.

Use the Calculate module to dictate when a calculation (or update) will be performed. After loading data, or making structural changes to your model, you will need to run a calculation to view updated results. Use the Calculate module to run a calculation while working in other areas of Cognos Incentive Compensation Management Client at the same time; however, users will not be able to perform any other global actions while the calculation is running.

**Important:** Compensation plans will not show updated values until a calculation has been performed.

### Calculate results

When performing a calculation, IBM Cognos Incentive Compensation Management lets you determine the specific items to include.

There are several different types of calculations that you can select from.

*Table 46. Calculate Items*

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Active Plans and Reports</td>
<td>This option includes all compensation plans and tailored reports.</td>
</tr>
<tr>
<td>Compensation Plans and Associated Reports</td>
<td>This option will calculate the compensation plan along with any reports associated with the plan.</td>
</tr>
<tr>
<td>Compensation Plans</td>
<td>Use this option to calculate results for either all compensation plans or for a specific one.</td>
</tr>
<tr>
<td>Tailored Reports</td>
<td>Use this option to calculate results for either all tailored reports or for a specific one.</td>
</tr>
<tr>
<td>Results for a Specific Payee</td>
<td>Use this option to select a payee and calculate all plans and reports that the specified payee is a member of.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>Use this option to calculate results for either all web forms or for a specific one.</td>
</tr>
<tr>
<td>Presenter Reports</td>
<td>Use this option to calculate results for either all Presenter reports or for a specific one. When calculating for individual Presenter reports, any Composer calculations used as sources will be calculated as well.</td>
</tr>
<tr>
<td>Scenarios Workspace</td>
<td>Use this option to calculate results for all Scenario workspaces or for a specific one.</td>
</tr>
</tbody>
</table>

### Calculating results

After creating a report, plan, web form, and Scenarios workspace, you can calculate the results in the IBM Cognos Incentive Compensation Management Calculate module.
Procedure

1. To open the Calculate module, perform one of the following steps:
   • Go to View > Calculate.
   • Right-click the tab bar, and select Calculate.
2. From the Calculation Type drop-down, select the items you want to calculate.
3. Click the Calculate button to begin the calculation process.
   You will see a progress bar displaying the elapsed and remaining calculation times.

   **Important:** A progress bar for the calculation will also be displayed in the Activity module. After the calculation has completed, a message detailing successful completion or any errors will be displayed in the Activity module.

Canceling a calculation already in progress

You can cancel a calculation that is already in progress in IBM Cognos Incentive Compensation Management Calculate module.

Procedure

In the Calculate module, click the Cancel button next to the progress bar.

**Important:** When the Cancel button is selected, anything that has been calculated up to that point will remain calculated, and calculations are not reverted to their previous state. The cancelation occurs as soon as you confirm your intent to cancel.

Summary pane

The Summary pane in the IBM Cognos Incentive Compensation Management Calculate module lists the date and time of the last full calculation, the date and time of the last calculation, and the elapsed time of last calculation.

Computation log

While a calculation is running, the IBM Cognos Incentive Compensation Management Computation log displays each completed calculation and the time it took to run.

Clearing the computation log

You can erase the data contained in the computation log in the IBM Cognos Incentive Compensation Management Calculate module.

Procedure

Right-click in the Computation Log pane, and select Clear.

Incremental calculations

When performing a calculation on an IBM Cognos Incentive Compensation Management model, the calculation engine will only recalculate the changes that have been made since the last calculation was run.

If you want to perform a complete calculation and recalculate the entire model, regardless of whether any changes have been made, select the complete calculate option from the Calculation Type drop-down menu. The complete calculate option is typically only used for testing and comparison purposes.
Adjustments and calculation speed

In the first calculation run after making an adjustment, there will be an increase in calculation time in IBM Cognos Incentive Compensation Management.

In addition to calculating results for data in unlocked periods, Cognos Incentive Compensation Management must also compute net payment amounts after adjustments. In order to do this, Cognos Incentive Compensation Management essentially needs to recalculate every locked period affected by the adjustment to compute the deltas. If adjustments have been made since the last calculation, you will be presented with a notification window informing you how many periods have been affected by recent adjustments.

Important: A calculation is the only way to update results. If you generate a preview during compensation plan creation (or maintenance) your model results will not be updated.
Chapter 26. IBM Cognos Incentive Compensation Management Client security

For many tabs and objects, access can be controlled. It can be denied completely, granted for viewing only, or granted for both editing and viewing in the Cognos Incentive Compensation Management model.

If access to a particular feature or module has been denied, and a user tries to gain access, “access denied” will be displayed.

In the Manage Roles window, color coding is used to indicate whether or not access has been denied, granted, or partially granted.

A red flag indicates that the user does not have access to the object. A green flag indicates that the user has access to the object. A yellow flag indicates that a user has partial access to the object.

For example, a role can be granted partial access to the Portal Access module by granting view privileges but not edit privileges. Any users assigned to this role can view any web tabs, Portal Access groups, or access trees, but they are not permitted to edit content.

Manage roles

To protect the integrity of the data in your model, you can define security roles in IBM Cognos Incentive Compensation Management.

The administrator role is created automatically and has full access to all modules by default. Initially, all administrators will be a part of the administrator user group, but additional roles with varying levels of access can be created and assigned. You can create user roles to restrict access to modules within Cognos Incentive Compensation Management. For each role created, accessible modules are defined.

You may, for example, have an administrator who is responsible for setting up and maintaining the Portal Access hierarchy, but is not authorized to modify tables or compensation plans. In this case, you may want to set up a user group that has access to the Portal Access module, but is prohibited access to the Composer module. You can then assign the Portal Access administrator to a user from the Manage Users window.

Important: To manage and assign user roles, you need to be logged in as an administrator with permission to edit and view administrative options.

Adding a role

You can add a role and then assign access permission to the role in IBM Cognos Incentive Compensation Management.
**Procedure**
1. Go to Admin > Manage Roles.
2. Click the Add Role button.
3. Name the new role.
4. Click OK.

**Deleting a role**
You can remove a role that is no longer needed in IBM Cognos Incentive Compensation Management; however, you will not be able to delete a role if a user is still assigned to it.

**Procedure**
1. Go to Admin > Manage Roles.
2. Select the role, and click the Delete Role button.

**Copying a role**
A role, along with its security, can be duplicated in IBM Cognos Incentive Compensation Management.

**Procedure**
1. Go to Admin > Manage Roles.
2. Select the role, and click the Copy Role button.
3. Name the new role, and click OK.

**Renaming a role**
Roles can be given a different name after they have been created in IBM Cognos Incentive Compensation Management.

**Procedure**
1. Go to Admin > Manage Roles.
2. Select the role, and click the Rename Role button.
3. Name the role, and click OK.

---

**Role permissions**
After you have created a role in IBM Cognos Incentive Compensation Management, you can give the role the ability to access certain items and deny access to others.

By default, new roles are denied access to everything.

**Access permissions**
When a user role is given access to a module in IBM Cognos Incentive Compensation Management, there are certain access rights or privileges that go along with the module.
Table 47. Access rights

<table>
<thead>
<tr>
<th>Module</th>
<th>Privileges</th>
</tr>
</thead>
</table>
| Audit Log       | **Edit** - gives user permission to Clean Up the Audit Log (must also have View rights).  
|                 | **View** - gives user permission to view, sort, filter, and show details of the data.                                                                                                                     |
| Calculate       | **View** - gives user permission to view the Calculate module but not perform a calculation on any items in the Calculation Type drop-down list.  
|                 | **Run** - gives user permission to perform a calculation on any items in the Calculation Type drop-down list (must also have View permission).                                          |
| Compensation Plans | **Plan Name (System Code)** - used in conjunction with Composer (View and Edit) and Payee Ledger (View). If a user is granted access to the plan, the user has access to all right-click options for the plan in Composer except editing the plan and changing the In Production status. Granting access to the plan also gives the user permission for the administrator to see results of the compensation plan in Payee Ledger (as long as View permission is granted for Payee Ledger as well). |
| Composer        | **Add Views** - gives user permission to add a View table (must also have View and Edit permission for Composer as well as View and Edit permission for the space the table will be added to, that is either the component the user is adding the table to or the Top level of Composer). |
| Composer        | **Component** - for each component in Composer, users can be granted the following actions:  
|                 | • **Delete** - gives user permission to delete the component (must also have View and Edit permission for Composer as well as View and Edit permission for the space the component is in, that is either the parent component or the Top level of Composer).  
|                 | • **Edit** - gives user permission to modify elements in the component or add new elements to the component (must also have View and Edit permission for Composer and View permission for the component).  
|                 | • **View** - gives user permission to view the elements inside a component (must also have View permission for Composer).  
<p>|                 | <strong>Edit</strong> - gives user permission to modify and add elements to Composer that they have been granted View and Edit permission for. |</p>
<table>
<thead>
<tr>
<th>Module</th>
<th>Privileges</th>
</tr>
</thead>
</table>
| Composer    | **Input Forms** - for all input forms in Composer, users can be granted the following actions (must also have View and Edit permission for Composer as well as View and Edit permission for the space the table is in, that is either the component or the Top level of Composer):  
  - **Add** - gives user permission to create a new input form for a table.  
  - **Delete** - gives user permission to delete input forms (must also have View permission for the input form).  
  - **Edit** - gives user permission to modify pre-existing input forms and their validation rules (must also have View permission for the input form). |
| Composer    | **Table** - users can be granted access to the following actions for input forms and the structure of the table:  
  - **Input Forms** - for each input form, users can be granted access to the following actions (users must have permission to view the input form to perform these actions):  
    - **Add** - gives user permission to add new rows to a table but not to import data.  
    - **Delete** - gives user permission to delete existing rows in a table.  
    - **Edit** - gives user permission to edit existing rows in a table.  
    - **History** - gives user permission to invoke the History button when viewing table data.  
    - **View** - gives user permission to export rows to Microsoft Excel, Publish, view Used By, and Web Data Edit (Edit Column Permissions, View Restrictions, and Direct Edit).  
  - **Structure** - for each table, users can be granted access to the following actions (must also have View and Edit permission for Composer as well as View and Edit permission for the space the table is in, that is either the component or the Top level of Composer):  
    - **Drop** - gives user permission to delete the table.  
    - **Edit** - gives user permission to add or remove table columns (must also have View permission for the table structure).  
    - **History** - gives user permission to purge table history.  
    - **View** - gives user permission to view table structure. |

**Important:** The structure of Hierarchy tables cannot be edited.

"Table 47. Access rights (continued)"
<table>
<thead>
<tr>
<th>Module</th>
<th>Privileges</th>
</tr>
</thead>
</table>
| Composer    | **Top** - gives user permission to perform the following action to the Top level of Composer:  
|             |   • **Edit** - gives user permission to edit the top level of Composer (must also have View and Edit permission in Composer).  
|             |   **View** - gives user permission to view the Composer module and the components and elements on the Top level. Users must be granted access to components to view the elements inside them. Users with View-only permission in Composer will be able to open the Calculation Wizard in read-only mode as well.  
|             |   **Web Data Edit** - gives user permission to view restrictions and edit column permissions, approve or reject edits, and enable direct database editing for tables that are enabled for Web Data Edit (must also have View and Edit permission for Composer as well as View and Edit permission for the space the table is in, that is either the component or the Top level of Composer).  
|             | **Sensitivity** - gives user permission, when viewing table data, to click the History button and display the History Viewer window. |
| Data Store  | **Data Store** - users can be granted access to the following actions for data stores:  
|             |   • **Add** - gives user permission to create data stores in Composer.  
|             |   • **Data Store** - for each data store, users can be granted access to the following actions (must also have view permission for Composer and the component the data store is in):  
|             |     - **Delete** - gives user permission to remove the data store from Composer (must also have view and edit permission for Composer and the component the data store is in).  
|             |     - **Edit** - gives user permission to make changes to the data store.  
|             |     - **View** - gives user permission to view the data store object in Composer. |
| File        | **New Model** - gives user permission to create a new model from the File menu  
|             |   **Tip:** The New Model button on the logon window can be disabled via the configuration file. |
| Home Page   | **Administrative Options**  
|             |   • **Edit** - gives user permission to modify the Administrative Options for the current model (must also have View permission for Admin Options).  
<p>|             |   • <strong>View</strong> - gives user permission to view the Administrative Options for the current model. |</p>
<table>
<thead>
<tr>
<th>Module</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Page</td>
<td><strong>Calendars</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to modify calendars (must also have View access for <em>Calendars</em>).</td>
</tr>
<tr>
<td></td>
<td>• <em>Period Locking</em> - gives user permission to lock and unlock all calendars in the model (must also be granted View access to calendars in order to lock periods).</td>
</tr>
<tr>
<td></td>
<td>• <em>View</em> - gives user permission to view the list of calendars.</td>
</tr>
<tr>
<td></td>
<td><strong>Manage Saved Imports</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Delete</em> - gives user permission to delete saved imports (must have View access to Saved Imports).</td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to edit saved imports (must have View access to Saved Imports).</td>
</tr>
<tr>
<td></td>
<td>• <em>View</em> - gives user permission view the list of saved imports and run saved imports.</td>
</tr>
<tr>
<td></td>
<td><strong>Manage Saved Publications</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Delete</em> - gives user permission to delete saved publications (must have View access to Saved Publications).</td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to edit saved publications (must have View access to Saved Publications).</td>
</tr>
<tr>
<td></td>
<td>• <em>View</em> - gives user permission to view the list of saved publications and run saved publications.</td>
</tr>
<tr>
<td></td>
<td><strong>Manage Saved Transformations</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Delete</em> - gives user permission to delete saved transformations (must have View access to Saved Transformations).</td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to edit saved transformations (must have View access to Saved Transformations).</td>
</tr>
<tr>
<td></td>
<td>• <em>View</em> - gives user permission to view the list of saved transformations and run saved transformations.</td>
</tr>
<tr>
<td></td>
<td><strong>Manage Theme</strong></td>
</tr>
<tr>
<td></td>
<td>- gives user permission to enable custom headers that will appear in the web client.</td>
</tr>
<tr>
<td></td>
<td><strong>Migrations</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to create a migration (must also have Execute permission).</td>
</tr>
<tr>
<td></td>
<td>• <em>Execute</em> - gives user permission to execute and run a migration (must also have Edit permission).</td>
</tr>
<tr>
<td></td>
<td><strong>Optimize Model</strong></td>
</tr>
<tr>
<td></td>
<td>- gives user permission to run the Model Optimization SQL process.</td>
</tr>
<tr>
<td></td>
<td><strong>Payee Groups</strong></td>
</tr>
<tr>
<td></td>
<td>• <em>Edit</em> - gives user permission to edit payee groups (must also have View permission).</td>
</tr>
<tr>
<td></td>
<td>• <em>View</em> - gives user permission to view the list of payee groups.</td>
</tr>
<tr>
<td>Module</td>
<td>Privileges</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Home Page</strong></td>
<td><strong>Process Lists</strong></td>
</tr>
<tr>
<td></td>
<td>- Add - gives user permission to add a process list.</td>
</tr>
</tbody>
</table>
|                 |  - Process List Name - gives user permission to perform the following actions on a specific process list:  
|                 |  - Delete - gives user permission to delete the process list (must also have View permission).  
|                 |  - Edit - gives user permission to edit the process list (must also have View permission).  
|                 |  - View - gives user permission to view the process list. |
| **Home Page**   | **Star Schema** |
|                 |  - Edit - gives user permission to edit existing star schemas and create new ones (must also have View permission).  
|                 |  - View - gives user permission to view existing star schemas. |
| **Import**      | **Advanced** - gives user permission to select the Use Advanced Settings check box to enter a custom connections string when importing from a ODBC database (must also have View and Edit permission for Composer, View and Edit permission for the space the table is in, that is either the component or the Top level of Composer, edit permission for the table, and Import > Data permission).  
|                 |  - Data - gives user permission to import data into a table (must also have View and Edit permission for Composer as well as View and Edit permission for the space the table is in, that is either the component or the Top level of Composer and edit permission for the table). |
| **Payee Ledger**| **View** - gives user permission to view all tabs in Payee Ledger and all tailored reports (must have access to Compensation Plans to view them in Payee Ledger). |
| **Portal Access**| **Edit** - gives user permission to edit all items contained within Portal Access tabs (must also have View permission for Portal Access and access to compensation plans, Presenter, and web forms to view their assignment, sign off, and inquiries in Portal Access).  
|                 |  - View - gives user permission to view all tabs in Portal Access and the items contained within (must also have access to compensation plans, Presenter, and web forms to view their assignments, sign off, and inquiries in Portal Access). |
| **Presenter**   | **Audit Log** |
|                 |  - View - gives user permission to use the Audit log as a data source in Presenter reports (must have View access to Presenter).  
|                 |  - View - gives user permission to perform all functions in Presenter (must have Presenter Audit Log View access to use the Audit Logs as a data source). |
### Process list security

By default, all administrators can see the IBM Cognos Incentive Compensation Management Home page module. To give roles permission to create, view, modify, duplicate, or delete process lists from the Home page, additional access must be granted.

**Giving roles permission to add process lists**

Roles can be granted permission to create process lists in IBM Cognos Incentive Compensation Management.

Users assigned to these roles will also have permission to edit, duplicate, and delete any process list they create.

---

**Table 47. Access rights (continued)**

<table>
<thead>
<tr>
<th>Module</th>
<th>Privileges</th>
</tr>
</thead>
</table>
| Scenarios         | **Promote** - gives user permission to promote scenarios (must also have View permission).  
                    **View** - gives user permission to view the Scenarios module, create workspaces, and scenarios (to create workspaces, the user must also have permission for specified compensation plans).  
                    **Workspace**  
                    • **Workspace Name** - gives user permission to view and modify the workspace (must also have View permission for Scenarios module). |
| Scheduler         | **View** - gives user permission to perform all functions in Scheduler. |
| Tasks             | **View** - gives user permission to perform all functions in Task Manager. |
| Web Forms         | **View** - gives user permission to perform all functions in web forms (users do not need separate access to tables and calculations to use them in web forms). |
| Workflow Manager  | **Workflow Manager** - users can be granted the following access for Workflow Manager:  
                    • **Edit** - gives user permission to modify pre-existing workflows (must also have View permission for the workflow).  
                    • **View** - gives user permission to view the Workflow Manager.  
                    • **Workflow Name** - for each workflow, the user can be granted the following actions (users must also have View permission for Workflow Manager):  
                      – **Execute** - gives user permission to start the workflow process (must also have View permission for the workflow).  
                      – **Edit** - gives user permission to add new workflows in Workflow Manager (must also have View permission).  
                      – **View** - gives user permission to view the workflow. |
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
3. Right-click Add, and select Grant.

Giving roles permission to view a process list
Roles can be granted view-only permission for specific process lists in IBM Cognos Incentive Compensation Management.

Users assigned to this role will not be able to create or modify process lists.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
3. Expand the process list you want the role to have permission to view.
4. Right-click View, and select Grant.

Giving roles permission to view and edit a process list
Roles can be granted permission to modify and duplicate specified process lists in IBM Cognos Incentive Compensation Management.

If users assigned to this role create a duplicate of a process list, they will automatically have view, edit, and delete permissions for the new process list.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
3. Expand the process list you want the role to have permission to view.
4. Right-click View, and select Grant.
5. Right-click Edit, and select Grant.

Giving roles permission to delete a process list
Roles can be granted permission to permanently remove a specified process list from the IBM Cognos Incentive Compensation Management Client.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
3. Expand the process list you want the role to have permission to delete.
4. Right-click View, and select Grant.
5. Right-click Delete, and select Grant.

Composer security
Users can be granted permission to view and modify the IBM Cognos Incentive Compensation Management Composer module.

Security can be set for specific components, tables, and input forms in Composer. Permission to add Views and Web Form Territory tables, and permission to perform web data edits can also be granted.
Giving roles permission to view the Composer module

Users assigned to a role with view-only permission in the IBM Cognos Incentive Compensation Management Composer module can open and view the Composer module and view components and other objects on the Top level of Composer but can not drill into components.

About this task

Users with view-only permission can perform the following actions on objects in the Top level of Composer: view the Uses and Used By trees of objects, use the Visibility icons, export the Composer diagram, publish table and calculation data, view calculation history, open the Calculation Wizard in read-only mode, edit table descriptions, and add objects to the Favorites list.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Right-click View, and select Grant.

Giving roles permission to view and edit the Top level of Composer

This grants users assigned to the role the ability to view the Top level of the IBM Cognos Incentive Compensation Management Composer module and add objects to the Top level.

To add Views to Composer, users must be granted additional permissions.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.
5. Right-click Top, and select Grant.

Component security

Access to each component in the IBM Cognos Incentive Compensation Management Composer module can be granted or restricted. In order to access a component, the role must also be granted view permission for Composer.

To modify and add elements to a component, the role must have edit permission for the component as well as Composer.

Giving roles permission to view a component

Roles granted view-only permission for a component in the IBM Cognos Incentive Compensation Management Composer module can drill into the component and view the objects inside.

Users assigned to this role will be able to open the component from the Home page and Composer.
About this task

Users will be able to perform the following actions to the objects inside the component:
- view the Uses and Used By trees of objects
- publish table and calculation data
- preview and view current values of calculations and connections
- edit table descriptions
- edit connections
- view the parent component of objects
- add objects to the Favorites list

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Right-click View, and select Grant.
4. Expand the component you want to grant the role permission to view.
5. Right-click View, and select Grant.

Giving roles permission to view and edit a component
Roles granted view and edit permission for a component can add objects inside the component in the IBM Cognos Incentive Compensation Management Composer module, add connections to the component, edit calculations in the component, and wrap objects into child components.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Grant View and Edit permission for Composer. If the component is in the Top level of Composer, right-click Top, and select Grant.
4. Expand the component you want to grant the role permission to view.
5. Right-click View, and select Grant.
6. Right-click Edit, and select Grant.

Giving roles permission to delete a component
Roles can be granted permission to delete components in the IBM Cognos Incentive Compensation Management Composer module.

To be able to delete a component, the role must also have view and edit permission for its parent component as well as the Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Grant View and Edit permission for Composer.
   - If the component is in the Top level of Composer, right-click Top, and select Grant.
   - If the component is inside a parent component, grant View and Edit permission for the parent component.
4. Expand the component you want to give the role permission to delete.
5. Right-click **Delete**, and select **Grant**.

**Table security**

Roles can be granted access to create, view, and modify input forms and the structure of tables in the IBM Cognos Incentive Compensation Management Composer module.

Roles can also be granted permission to perform data imports, web data edits, and add Views.

**Giving roles permission to view the structure of a table**

Granting view-only permission to the structure of a table gives users assigned to the role the ability to view the table structure, add the table to the favorites list, edit the table description, publish the table data, and view its uses in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant **View** permission for Composer.
3. Grant **View** permission for the component the table is in.
4. Expand **Table**.
5. Expand the table you want the role to be able to view the structure of.
6. Expand **Structure**.
7. Right-click **View**, and select **Grant**.

**Giving roles permission to view and edit the structure of a table**

Granting a role edit permission for a table's structure grants users assigned to the role the ability to add and remove columns in the table in the IBM Cognos Incentive Compensation Management Composer module.

The role must also have view permission for the table's structure to make changes.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant **View** permission for Composer.
3. Grant **View** permission for the component the table is in.
4. Expand **Table**.
5. Expand the table you want the role to be able to view and edit.
6. Expand **Structure**.
7. Right-click **View**, and select **Grant**.
8. Right-click **Edit**, and select **Grant**.

**Giving a role the permission to purge change log history**

In IBM Cognos Incentive Compensation Management, you can grant a role the permission to clear history collected for specific tables in Composer.

**Procedure**

1. Go to **Admin > Manage Roles**, and select or add the role for which you want to grant permissions.
2. Expand **Composer**.
3. Expand the table for which you want to grant the role permission.
4. Expand **Structure**.
5. Right-click **History** and click **Grant**.

**Giving roles permission to delete a table**
Granting a role permission to drop a table lets users assigned to the role delete the table from the IBM Cognos Incentive Compensation Management Composer module as long as the table does not have any dependencies.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant **View** and **Edit** permission for Composer.
3. Grant **View** and **Edit** permission for the component the table is in. To delete a table from the Top level of Composer, right-click **Top**, and select **Grant**.
4. Expand **Table**.
5. Expand the table you want the role to be able to delete.
6. Expand **Structure**.
7. Right-click **Delete**, and select **Grant**.

**Giving roles permission to add View tables**
Granting a role permission to add Views gives users assigned to the role the ability to create View tables in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Composer**.
3. Right-click **Add Views**, and select **Grant**.
4. Grant **View** and **Edit** permission for Composer.
5. To add a View table to a component, grant **View** and **Edit** permission for the component.
6. To add a table to the Top level of Composer, right-click **Top**, and select **Grant**.

**Giving roles permission to enable web data edit for tables**
In IBM Cognos Incentive Compensation Management, granting web data edit access for a role gives users assigned to the role permission to view the row restrictions for the table, edit the column permissions, approve or reject edits made by web users, and enable direct database editing for tables that have been enabled for web data edit.

**Procedure**
1. Go to **Admin > Manage Roles**, and select or add the role you want to grant permissions for.
2. Expand **Composer**.
3. Right-click **Web Data Edit**, and select **Grant**.
4. Grant **View** and **Edit** permission for Composer.
5. To access the **Web Data Edit** menu options for a table in a component, grant **View** and **Edit** permission for the component.
6. If the table is in the Top level of Composer, right-click **Top**, and select **Grant**.
Import data security
Roles can be granted permission to import data into tables in the IBM Cognos Incentive Compensation Management Composer module.

If users are importing data from an ODBC compliant database, the role can be granted permission for advanced settings, which allows the role to enter a custom connection string during data import.

Giving roles permission to import data
Granting a role import data permission gives users assigned to the role the ability to import data into specified tables in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Import.
3. Right-click Data, and select Grant.
4. Expand Composer > Table.
5. Expand the table you want to let the role import data to.
7. Right-click Edit, and select Grant.
8. The role must have View and Edit permission for Composer.
9. To import data into a table in a component, the user must have View and Edit permission for the component.
10. If the table is in the Top level of Composer, right-click Top, and select Grant.

Giving roles permission to use advanced settings when importing data
Granting roles permission to advanced data import gives users assigned to the role the ability to select the Use Advanced Settings check box in the IBM Cognos Incentive Compensation Management Import Data Wizard to enter a custom connections string when importing data from an ODBC compliant database.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Import.
3. Right-click Advanced, and select Grant.
4. Right-click Data, and select Grant.
5. Expand Composer > Table.
6. Expand the table you want to let the role import data to.
7. Expand Structure.
8. Right-click Edit, and select Grant.
9. The role must have View and Edit permission for Composer.
10. To import data into a table in a component, the user must have View and Edit permission for the component.
11. If the table is in the Top level of Composer, right-click Top, and select Grant.
Input form security

Roles can be granted permission to view input forms, view the history of changes made to input forms, as well as add rows, delete rows, and edit rows in specified input forms in the IBM Cognos Incentive Compensation Management Composer module.

Giving roles permission to add an input form

Granting a role permission to add input forms gives users assigned to the role the ability to create input forms for any tables in the IBM Cognos Incentive Compensation Management Composer module.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Input Forms.
3. Right-click Add, and select Grant.
4. Grant View and Edit permission for Composer.
5. To add input forms to a table in a component, grant View and Edit permission for the component.
6. If the table is in the Top level of Composer, right-click Top, and select Grant.

Giving roles permission to delete input forms

Granting a role permission to delete input forms gives users assigned to the role the ability to delete input forms they have been granted View access to in the IBM Cognos Incentive Compensation Management Composer module.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Input Forms.
3. Right-click Delete, and select Grant.
4. Expand Table.
5. Expand the table that contains the input form you want to let the user delete.
6. Expand the input form you want to let the user delete.
7. Right-click View, and select Grant.
8. Grant View and Edit permission for Composer.
9. To add input forms to a table in a component, grant View and Edit permission for the component.
10. If the table is in the Top level of Composer, right-click Top, and select Grant.

Giving roles permission to edit input forms

Granting a role permission to edit input forms lets users assigned to the role modify the input form they have been granted access to along with its validation rules in the IBM Cognos Incentive Compensation Management Composer module.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant View and Edit permission for Composer.
3. To edit the input forms of a table in a component, grant View and Edit permission for the component.
4. If the table is in the Top level of Composer, right-click Top, and select Grant.
5. Expand Composer > Input Forms.
6. Right-click **Edit**, and select **Grant**.
7. Expand **Table**.
8. Expand the table you want to let the user edit.
9. Expand the input form you want to let the user edit.
10. Right-click **View**, and select **Grant**.

**Giving roles permission add rows to an input form**
Users can be granted permission to add rows to a table using an input form in the IBM Cognos Incentive Compensation Management Composer module.

This does not give the user permission to import data into the table.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Composer** > **Table**.
3. Expand the table that contains the input form you want to let the user add rows to.
4. Expand the input form you want to let users add rows to.
5. Right-click **View**, and select **Grant**.
6. Right-click **Add**, and select **Grant**.

**Giving roles permission to delete existing rows in a table**
Users can be granted permission to remove rows from tables in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Composer** > **Table**.
3. Expand the table that contains the input form you want to let the user delete rows from.
4. Expand the input form you want to allow the user to delete rows from.
5. Right-click **View**, and select **Grant**.
6. Right-click **Delete**, and select **Grant**.

**Giving roles permission to edit data in a table**
Users can be granted permission to edit existing rows in a table in the IBM Cognos Incentive Compensation Management Composer module.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Composer** > **Table**.
3. Expand the table that contains the input form you want to let the user edit rows in.
4. Expand the input form you want to let the user edit rows in.
5. Right-click **View**, and select **Grant**.
6. Right-click **Edit**, and select **Grant**.

**Giving roles permission to view the history of a table**
Users can be granted permission to use the **History** button to view the details of modifications made to rows in the table in the IBM Cognos Incentive Compensation Management Composer module.
**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Composer > Table**.
3. Expand the table that contains the input form you want to let the user delete rows from.
4. Expand the input form you want to let the user view the history of.
5. Right-click **View**, and select **Grant**.
6. Right-click **History**, and select **Grant**.

**Data store security**

Access to specific data stores can be granted in the Manage Roles window in IBM Cognos Incentive Compensation Management.

Users can be granted permission to view, edit, and delete the data store object in Composer.

**Giving roles permission to view a data store**

Roles can be granted view-only permission for specific data stores in the IBM Cognos Incentive Compensation Management Composer module.

The users assigned to the role then have permission to add the data store to the **Favorites** list and view the **Uses** and **Used By** trees but they will not have permission to make changes to the data store.

**Procedure**

1. Go to **Admin > Manage Roles**.
2. Select or add the role you want to grant permission for.
3. Grant **View** access to Composer.
4. If the data store is in a component, also grant **View** access to the component.
5. Expand **Data Stores**.
6. Expand the data store you want to grant **View** permission for.
7. Right-click **View**, and select **Grant**.

**Giving roles permission to view and edit a data store**

Roles can be granted permission to view and modify the data store object in the IBM Cognos Incentive Compensation Management Composer module.

Users assigned to the role then have the ability to open the Source Wizard and make changes to the data store.

**Procedure**

1. Go to **Admin > Manage Roles**.
2. Select or add the role you want to grant permission for.
3. Grant **View** and **Edit** permission for Composer.
4. If the data store is in a component, also grant **View** and **Edit** permission for the component.
5. Expand **Data Stores**.
6. Expand the data store you want to grant **View** and **Edit** permission to.
7. Right-click **View**, and select **Grant**.
8. Right-click **Edit**, and select **Grant**.
Giving roles permission to view and delete a data store

Roles can be granted permission to view and remove the data store object from the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. Go to Admin > Manage Roles.
2. Select or add the role you want to grant permission for.
3. In the right pane, expand Composer.
4. Right-click View, and select Grant.
5. Right-click Edit, and select Grant.
6. If the data store is in a component, also grant View and Edit permission for the component.
7. Expand Data Stores.
8. Expand the data store you want to grant View and Delete permission for.
9. Right-click View, and select Grant.
10. Right-click Delete, and select Grant.

Compensation plan security

Access to compensation plans must be granted for users to be able to modify existing plans in the IBM Cognos Incentive Compensation Management Composer module.

Access to compensation plans must also be granted for users to be able to view compensation results in Payee Ledger or to create workspaces in the Scenarios module.

Giving roles permission to view a compensation plan

You can grant users permission to view the compensation plan object in the IBM Cognos Incentive Compensation Management Composer module, view the objects that use and are used by the compensation plan, and add the plan to the Favorites section.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Compensation Plans.
3. Right-click the compensation plan, and select Grant.
4. To allow the compensation plan object to be viewed in Composer, grant View permission for Composer.
5. To allow a compensation plan in a component to be viewed, grant View permission for the component that contains the compensation plan.

Giving roles permission to view and edit a compensation plan

You can grant users permission to cut, copy, paste, and delete a compensation plan as well as edit the plan details, change the "In Production" status, and wrap the plan into a component in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Compensation Plans.
3. Right-click the compensation plan, and select Grant.
4. Grant View and Edit permission for Composer.
5. To allow a compensation plan in a component to be viewed and edited, grant View and Edit permission for the component that contains the plan.

Scenarios security

Users can be granted permission to create workspaces and scenarios in the IBM Cognos Incentive Compensation Management Scenarios module.

Users can also be granted permission to promote these scenarios to replace the current data in the model. In order to add workspaces, users must also have access to the compensation plans required for the scenarios.

Giving roles permission to view the Scenarios module and create a workspace

You can grant users permission to open and view the IBM Cognos Incentive Compensation Management Scenarios module.

As workspaces are associated with compensation plans, users must also be granted permission for the compensation plans they will be using in the workspace.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Scenarios.
3. Right-click View, and select Grant.
4. To let the user create workspaces, expand Compensation Plans, and right-click the compensation plan you want to give the role permission to use in the Scenarios workspace, and select Grant.

Important: When a user creates a public workspace, all users with permission to view the Scenario module will be able to view the workspace. When a user creates a private workspace, only the user who created the workspace and the administrator will be able to view it. Public and private access to the workspace can be changed in the Manage Roles window.

Giving roles permission add and modify scenarios in workspaces

You can grant users permission to view and modify workspaces in the IBM Cognos Incentive Compensation Management Scenarios module.

Users will not be able to add workspaces unless they have permission for one or more compensation plans.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Scenarios.
3. Right-click View, and select Grant.
4. To let the user view and modify scenarios in a workspace, expand Workspace.
5. Right-click the workspace you want to give the role permission to modify, and select Grant.
**Giving roles permission to promote scenarios**

You can grant users permission to replace the current data in the model with the new data from their scenario in the IBM Cognos Incentive Compensation Management Scenarios module.

The user must also have permission for the compensation plans used in the scenarios.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand *Scenarios*.
3. Right-click *View*, and select *Grant*.
4. Right-click *Promote*, and select *Grant*.
5. Expand *Workspaces*.
6. Grant the role permission for the workspace containing the scenarios.
7. Grant the role permission to the compensation plans used in the workspace.

**Web form security**

Users can be granted permission to make changes to existing web forms in the IBM Cognos Incentive Compensation Management Composer module.

**Giving roles permission to open and edit web forms**

You can grant users permission to perform all functions in web forms that have been added in the IBM Cognos Incentive Compensation Management Composer module.

**About this task**

Users do not need separate access to tables to use them in web forms. To add web forms to Composer, users will also need view and edit permission for Composer and for the component they want to add web forms to.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand *Web Forms*.
3. Right-click *View* or *Web Forms*, and select *Grant*.

**Presenter report security**

Users can be granted permission to modify Presenter reports in IBM Cognos Incentive Compensation Management and use the Audit log as a source in Presenter.

**Giving roles permission to view the Presenter report object in Composer**

You can grant users permission to view the Presenter report object in the IBM Cognos Incentive Compensation Management Composer module.

Users must also have permission to view Composer and the component the report is in.
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Presenter, right-click View, and select Grant.
3. Grant View permission for Composer.
4. Grant View permission for the component the Presenter report is in.

Giving roles permission to open and edit Presenter reports
You can grant users permission to perform all functions in Presenter reports that have already been added to the IBM Cognos Incentive Compensation Management Composer module.

About this task
To have permission to open existing Presenter reports and add new Presenter reports in Composer, the user must also have view and edit permission for Composer and view and edit permission for the component they want to add Presenter reports to.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Presenter, right-click View, and select Grant.
3. Grant View and Edit permission for Composer.
4. Grant View and Edit permission for the component the report is in.
5. If the report is in the Top level of Composer, right-click Top, and select Grant.

Giving roles permission to use the Audit log as a source in Presenter
You can grant users permission to add the IBM Cognos Incentive Compensation Management Audit log as a data source in their reports.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Presenter.
3. Right-click View, and select Grant.
4. Expand Audit Log.
5. Right-click View or Audit Log, and select Grant.

Portal Access security
Users can be granted view-only permission for the IBM Cognos Incentive Compensation Management Portal Access module.

To view the assignments, sign offs, and inquiries for compensation plans, Presenter reports, and web forms, users must also be granted view permission for compensation plans, Presenter reports, and web forms. Users can also be granted the ability to perform all actions in the Portal Access module. In order to set Portal Access assignments for compensation plans, Presenter reports, and web forms, user must have view permission for them.

Giving roles permission to view the Portal Access module
You can grant users view-only permission for the IBM Cognos Incentive Compensation Management Portal Access module.
About this task

To be able to view the assignments, sign off and inquiry trees for compensation plans, Presenter reports, and web forms on the Assignment, Sign Off, and Inquiries tabs, users must have view permission for compensation plans, Presenter reports, and web forms.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Portal Access.
3. Right-click View, and select Grant.
4. To allow users to view the assignment, sign off, and inquiries for compensation plans, grant permission to compensation plans.
5. To allow users to view the assignment, sign off, and inquiries for Presenter reports, grant View permission for Presenter.
6. To allow users to view the assignment, sign off, and inquiries for web forms, grant View permission for web forms.

Giving roles permission to view and edit the Portal Access module

You can grant users permission to edit all items in the IBM Cognos Incentive Compensation Management Portal Access module.

Users must also have access to compensation plans in order to view and modify the assignment, sign off, and inquiries for the plans.

Procedure

1. Go to Admin > Manage Roles and select or add the role you want to grant permissions for.
2. Expand Portal Access.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.
5. To let users view and modify the assignment, sign off, and inquiries for compensation plans, grant permission to compensation plans.
6. To let users view the assignment, sign off, and inquiries for Presenter reports, grant View permission for Presenter.
7. To let users view the assignment, sign off, and inquiries for web forms, grant View permission for web forms.

Scheduler security

Roles can be granted access to edit or view the IBM Cognos Incentive Compensation Management Scheduler module.

When users have view-only access to the Scheduler module, they will be able to open the Scheduler module and run processes and tasks. To add processes and tasks, and change the Scheduler properties, a user must have edit permission as well as view permission.

Giving roles permission to view Scheduler

You can grant users access to see the IBM Cognos Incentive Compensation Management Scheduler module and run processes.
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Scheduler.
3. Right-click View, and select Grant.

Giving roles permission to edit the Scheduler module
You can grant users access to make changes to the IBM Cognos Incentive Compensation Management Scheduler module and set Scheduler properties.

Users must also have view permission for the Scheduler module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Scheduler.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

Setting Task Manager security
You can grant access users access to the IBM Cognos Incentive Compensation Management Task Manager module to add tasks and alerts.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Tasks.
3. Right-click View, and select Grant.

Audit module security
Users can be granted view-only permission for the IBM Cognos Incentive Compensation Management Audit module or can be granted access to make modifications to the Audit module as well.

Giving roles permission to view the Audit module
You can grant users view-only permission for the IBM Cognos Incentive Compensation Management Audit module.

This gives users permission to view, sort, filter, and show the details of the data in the Audit module; however, the users are not able to remove data.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Audit Log.
3. Right-click View, and select Grant.

Giving roles permission to view and edit the Audit module
You can grant users permission to view and modify the IBM Cognos Incentive Compensation Management Audit module.

This gives users permission to view, sort, filter, show the details of data and clean up the Audit module.
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Right-click Audit Log, and select Grant.

Setting Payee Ledger security
You can grant users permission to view all the tabs in the IBM Cognos Incentive Compensation Management Payee Ledger module and view tailored reports in Payee Ledger.

To view compensation plan results, users must also have permission for the compensation plans.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Payee Ledger.
3. Right-click Payee Ledger or View, and select Grant.
4. To give users permission to view compensation plan results, grant permission to compensation plans.

Workflow Manager security
You can grant users access to view the IBM Cognos Incentive Compensation Management Workflow Manager module, create new workflows, modify existing workflows, and execute workflows.

Giving roles permission to view Workflow Manager
You can grant users view-only access to the IBM Cognos Incentive Compensation Management Workflow Manager module.

To view workflows, users must be granted view access to each workflow.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Workflow Manager.
3. Right-click View, and select Grant.

Giving roles permission to view Workflow Manager and create new workflows
You can grant users permission to add new workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Workflow Manager.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

Giving roles permission to view an existing workflow
You can grant users view-only permission for existing workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Workflow Manager**.
3. Right-click **View**, and select **Grant**.
4. Expand the workflow you want the user to be able to view.
5. Right-click **View**, and select **Grant**.

**Giving roles permission to modify a workflow**
You can grant users permission to edit existing workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Workflow Manager**.
3. Right-click **View** and select **Grant**.
4. Expand the workflow you want the user to be able to modify.
5. Right-click **View**, and select **Grant**.
6. Right-click **Edit**, and select **Grant**.

**Giving roles permission to start a workflow**
You can grant users permission to execute workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Workflow Manager**.
3. Right-click **View**, and select **Grant**.
4. Expand the workflow you want the user to be able to start.
5. Right-click **View**, and select **Grant**.
6. Right-click **Execute**, and select **Grant**.

**Setting Calculate security**
You can grant users access to view the Calculate module in the IBM Cognos Incentive Compensation Management Client and to perform a calculation on any items in the **Calculation Type** drop-down list.

To preview or view calculation data in the Composer model, a user must also have view permission for the Calculate module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand **Calculate**.
3. To let the user view the Calculate module, right-click **View**, and select **Grant**.
4. To let the user view and perform a calculation, grant **View**, and **Run** permission.

**Administration security**
Roles can be granted access to set administrative options, run and edit saved imports, run and edit saved publications and edit saved transformations in the IBM Cognos Incentive Compensation Management Client.
By default, all administrator users can see the Home page module, including the information in the Admin and Tools menus. Additionally, all administrators are able to create web messages, manage documents, change their password, and view and export the Model Summary from the Admin menu. All other rights must be granted to a user’s role in order for the user to be able to act upon items.

**Permitting a role to view administrative options**
You can grant users permission to view the administrative options for the current IBM Cognos Incentive Compensation Management model but not make any changes.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Admin Options.
3. Right-click View, and select Grant.

**Permitting a role to view and edit administrative options**
You can grant users permission to view and make changes to the administrative options in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page.
3. Right-click Admin Options, and select Grant.

**Permitting a role to view and run saved imports**
You can grant users permission to view and run saved imports in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View, and select Grant.

**Permitting a role to view, run, and edit saved imports**
You can grant users permission to view, run, and modify saved imports in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

**Permitting a role to view, run, and delete saved imports**
You can grant users permission to view, run, and delete saved imports in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View, and select Grant.
4. Right-click Delete, and select Grant.

**Permitting a role to view and run saved publications**
You can grant users permission to view and run saved publications in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View, and select Grant.

**Permitting a role to view, run, and edit saved publications**
You can grant users permission to view, run, and make changes to saved publications in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

**Permitting a role to view, run, and delete saved publications**
You can grant users permission to view, run, and delete saved publications in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View, and select Grant.
4. Right-click Delete, and select Grant.

**Permitting a role to view saved transformations**
You can grant users permission to view saved transformations in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View, and select Grant.

**Permitting a role to view and edit saved transformations**
You can grant users permission to view and make changes to saved transformations in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.
Permitting a role to view and delete saved transformations
You can grant users permission to view and delete any saved transformation from
the IBM Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View, and select Grant.
4. Right-click Delete, and select Grant.

Permitting a role to add documents to the Manage Documents window
Users must have view and edit permission for the IBM Cognos Incentive
Compensation Management Portal Access module before they can open the
Manage Documents window and add documents.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Right-click Portal Access, and select Grant.

Tools security
From the Tools menu in the IBM Cognos Incentive Compensation Management
Client, users can be granted permission to optimize the model, view and modify
calendars, view and modify payee groups, view and create star schemas, perform
migrations, and manage the Cognos Incentive Compensation Management Client
and web theme.

Permitting a role to optimize the model
You can grant users permission to run the Model Optimization SQL process from
the IBM Cognos Incentive Compensation Management Client.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page.
3. Right-click Optimize Model, and select Grant.

Permitting a role to view calendars
You can grant users view-only permission for the list of calendars in the IBM
Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Calendars.
3. Right-click View, and select Grant.

Permitting a role to view and edit calendars
You can grant users permission to view and edit the calendars in the IBM Cognos
Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Calendars.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

**Permitting a role to view and lock calendars**
You can grant users permission to view and lock calendars in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Calendars.
3. Right-click View, and select Grant.
4. Right-click Period Locking, and select Grant.

**Permitting a role to view existing payee groups**
You can grant users view-only permission for the list of payee group in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Payee Groups.
3. Right-click View, and select Grant.

**Permitting a role to view and edit payee groups**
You can grant users permission to make modifications to the payee groups in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Payee Groups.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.

**Permitting a role to view existing star schemas**
You can grant users view-only permission for the star schemas in the IBM Cognos Incentive Compensation Management model.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
3. Right-click View, and select Grant.

**Permitting a role to view and edit star schemas**
You can grant users permission to view, delete, and create new star schemas in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.
Permitting a role to perform a migration
You can grant users permission to perform a migration in the target IBM Cognos Incentive Compensation Management model.

About this task
To perform the migration, the user must connect to the source model using the administrator role user name and password and must have both edit and execute permission in the target model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Migrations.
3. Right-click Edit, and select Grant.
4. Right-click Execute, and select Grant.

Permitting a role to enable custom headers
You can grant users permission to add a logo to the header or change the IBM Cognos Incentive Compensation Management web client theme from standard to Salesforce.com.

The header image will be displayed in both the Cognos Incentive Compensation Management Client and the web client.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page.
3. Right-click Manage Theme, and select Grant.

Manage users
Use the Manage Users window in the IBM Cognos Incentive Compensation Management Client to add, edit, or delete administrator user IDs, email addresses, and passwords.

The Manage Users window is also used to assign user roles.

From this window, each administrator can be assigned a user role that grants them appropriate access rights. Users without sufficient privileges to access a given module will be denied access.

Whenever a new model is created, Administrator (main administrator) and Scheduler users are automatically created. These users should both be edited to include a secure password; by default the password is blank. An email address must also be added if either of these users needs to receive emails from Cognos Incentive Compensation Management.

Important: The Scheduler password in the Cognos Incentive Compensation Management Client must match the Scheduler password in the Windows Service configuration file (IBM Cognos ICM Windows Service.exe.config file and ConsoleService.exe.config file). If the password is changed in the Client, an administrator also must change the password in the Service configuration file (and vice versa). If these passwords do not match, Scheduler will not be able to run.
Adding a new user
New users can be added and assigned roles that grant them access to the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Manage Users.
2. Click Add.
3. Type all of the information required in the User Editor window.
   Make sure that when a new user is added, a user name is created along with a user ID. The user name is used in the Audit log to track the user’s actions.
4. Assign a role to the user from the Role drop-down menu.
5. Click OK.
6. When you have finished adding users, click Save.

Disabling a user account
After an account has been created, it can later be disabled when the user no longer requires access to the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Manage Users.
2. Select the user.
3. Click Edit.
4. Select the Disabled check box.
   When the Disabled check box is selected, the user will be unable to log in to the web client.
5. Click OK.
6. When you have finished disabling accounts, click Save.

Publishing a users and permissions report
A list of users in the IBM Cognos Incentive Compensation Management Client, their roles, and their access permissions in the Client can be exported from the Manage Users window.

Procedure
1. Go to Admin > Manage Users.
2. Click the Export Access button.
3. Choose a destination file, type a file name, and click Save.

Concurrent users
After different users have been defined and assigned to roles, they can each be logged into the IBM Cognos Incentive Compensation Management Client simultaneously, which means multiple users can perform actions on the model at the same time.

For example, while Administrator User 1 is adding a new table to the model, Administrator User 2 can be logged in concurrently to edit a calculation.

The exception to this rule occurs when more than one administrator tries to simultaneously perform a global action on the model, such as a calculation or data import. One calculation needs to be completed before another one can start, and only one data import can occur at a time. If a second administrator tries to perform a calculation or data import while another one is in progress, they will see
the following warning message: "Administrator <user name> started a global action <amount of time passed> ago. No changes may be made while this action is in progress".

This message lets them know that they need to wait for another administrator's global action to complete before they can begin their own global action. The second administrator will also see the global action icon next to the welcome message on the home page when he or she first logs on indicating a global action is being run by another administrator.

In general, when two or more administrators are making unrelated changes in the model, all administrators will be able to make changes without any type of warning. When two administrators are making changes to the same information, the second administrator will be prompted to refresh their data prior to the save being made.

The following table provides examples of multi-administrative situations. This table covers common examples of multiple administrators attempting to simultaneously make changes in the same module, as well as administrators attempting to make changes while a calculation or import is in progress. In all cases where administrators are making unrelated changes in different modules, all administrators will be able to make and save changes without warnings.

<table>
<thead>
<tr>
<th>Module/Action</th>
<th>Situation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imports</td>
<td>If multiple administrators attempt to import data into a table, the first administrator to click Finish on the Import Data wizard can complete their import without warning. All other administrators will be informed that the first administrator’s import needs to complete before they can complete their imports.</td>
</tr>
<tr>
<td>Imports</td>
<td>If an administrator is performing an import and a second administrator attempts to add a row to the same table, the second administrator will be informed that the first administrator’s import needs to complete before they can add a row.</td>
</tr>
<tr>
<td>Calculate</td>
<td>If an administrator attempts to calculate the model while another calculation is in progress, the second administrator will be informed that the calculation cannot proceed because another calculation is in progress.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators attempt to add or edit different rows in a table, all administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator attempts to edit a table while another administrator is attempting to clear the same table, the first administrator to click Save can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator attempts to edit a table while another administrator is attempting to clear a different table, all administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators are editing the same row simultaneously, the first administrator to click Save can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
</tbody>
</table>
### Table 48. Common multi-administrative situations (continued)

<table>
<thead>
<tr>
<th>Module/Action</th>
<th>Situation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composer</td>
<td>If two administrators attempt to add new payee groups, both administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators attempt to add a new calculation, compensation plan, or tailored report to the same folder, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators attempt to add a new calculation, compensation plan, or tailored report to different components, all administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator attempts to edit a compensation plan while a model calculation is already in progress, the administrator will be prompted to refresh their data prior to saving.</td>
</tr>
<tr>
<td>Portal Access</td>
<td>If multiple administrators are simultaneously creating Portal Access groups, all administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Input Forms</td>
<td>If multiple administrators are creating input forms simultaneously, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>If multiple administrators create web forms, all administrators will be able to make and save changes without warning.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>If multiple administrators attempt to add a web resource to the same web form, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
<tr>
<td>Payee Ledger</td>
<td>If multiple administrators attempt to generate a Payee Ledger report at the same time, both administrators will be able to view the report.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>If multiple administrators attempt to edit the same scheduled process in Scheduler, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators will be prompted to refresh their data prior to saving.</td>
</tr>
</tbody>
</table>

### Global action restrictions:

In order to protect the integrity of the model, IBM Cognos Incentive Compensation Management prevents certain model modifications from being made while a global action is in progress.

Additionally, only one global action can be performed at a time. Global actions include calculations, imports, exports, period locking, calendar modification, and migration.

The following actions cannot be performed while a global action is in progress:
- Imports into tables, new table or input form creation, manual submissions to tables and any other modifications to the data or structure of a table.
- Generation and modification of a star schema.
• Access to data via the IBM Cognos Incentive Compensation Management add-in for Microsoft Excel.
• Scenario creation, edit, and promotion.
• Calculation modification or creation.
• Running of the Optimize Model feature.

**Changing IBM Cognos Incentive Compensation Management Client users' passwords**

Use the Change Password window in the Cognos Incentive Compensation Management Client to change your password.

If an administrator (with appropriate access rights) wants to change the password of another administrator, they must do this from the Manage Users window.

**Procedure**

1. Go to **Admin > Change Password**.
2. Type in the **New Password**, and confirm the new password.
3. Click **OK**.

**Role segregation example**

The following example outlines role segregation in the IBM Cognos Incentive Compensation Management Client.

You have a compensation plan builder, John, who is responsible for building all of your company's compensation plans. Since all building is done in the development environment, he should only have access to build in the development environment. He will, however, need to be able to see compensation plan results in the quality assurance (QA) and production environments, so his user role will be different in those environments.

Your company also has a Portal Access manager, Sally, who is responsible for setting up and maintaining the Portal Access hierarchy. She will not require access to the development and QA environment. In the production environment, she requires the ability to assign Portal Access trees and add Task Manager rules, but does not need to have access to any other model component.

**Table 49. Role segregation example**

<table>
<thead>
<tr>
<th>Role</th>
<th>Development Environment</th>
<th>QA Environment</th>
<th>Production Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>John - Plan Builder</td>
<td>Build plans</td>
<td>View plans</td>
<td>View plans</td>
</tr>
<tr>
<td></td>
<td>Add and edit tables</td>
<td>View Payee Ledger</td>
<td>View Payee Ledger</td>
</tr>
<tr>
<td></td>
<td>Import Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sally - Portal Access Manager</td>
<td>no access</td>
<td>no access</td>
<td>Assign Portal Access trees</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Add Task Manager rules</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Environment roles creation**

To create different roles for each environment in IBM Cognos Incentive Compensation Management, the primary administrator must log in to each environment separately and define appropriate user role access.

First, the primary model administrator has to log in to the model to create user roles for the plan builder and the Portal Access manager.

Within the development environment, a user role is created that grants the plan builder access to all compensation plans, the Composer module, selected tables within Composer, import capabilities, and access to the Payee Ledger module. The plan builder role does not have access to Scheduler, Task Manager, or any other area that is not specifically required for building plans.

Within the development environment, the Portal Access manager role does not have any access to any model components.

While logged into the QA and production environments, the primary administrator creates slightly different access rights for the plan builder and Portal Access manager roles. In these environments, the plan builder role has access to view compensation plans, but not change them, as well as access to view Payee Ledger reports.

The Portal Access manager role is permitted to perform actions in the Portal Access and Task Manager module but not permitted to perform any other actions in the model. The Portal Access manager must also have access to compensation plans in order to assign access trees to them in the Portal Access module.

**User role assignment**

After roles have been created in the IBM Cognos Incentive Compensation Management Client, they need to be assigned to specific users.

After roles have been assigned and users log in to their model, they will only be permitted to view and perform actions that are permitted in their user roles. Sally has been assigned to the role of Portal Access Manager. If Sally logs in to the production environment of the model, she will only have access to the Portal Access and Task Manager modules.

When Sally logs in to the production environment, she will have the ability to perform any action in the Portal Access module and Task Manager module.

When John logs into the development environment, he will have access to build and change compensation plans. If he logs into the QA environment, he will be presented with the following message if he attempts to make any plan changes: "You do not have sufficient rights to perform this action. Contact your system administrator for assistance."
Chapter 27. Administration

On the Administrative Options window in the IBM Cognos Incentive Compensation Management Client, you can set general, Audit log, Portal Access, and Payee Ledger options, user and web user security, calculation options, as well as statistics information.

Changing the model name

The model name appears in the header of the IBM Cognos Incentive Compensation Management Client and in the drop-down menu of the login screen.

The name of the database will not change if the model name is changed.

Procedure
1. Go to Admin > Administrative Options.
2. On the General tab, type a new Model Name.
3. Click OK.

Changing the import escape character

Set the import escape character to import files that contain a delimiter into the IBM Cognos Incentive Compensation Management Client.

About this task
The following import escape characters are available: (/ \ * " ^ '). If you choose a quotation mark (") as the import escape character, Payee, Date, Value from a comma delimited file would import as "First Name, Last Name", 1/1/2009, 50.

Important: By default, the import escape character is set to a quotation mark ("). This is a global setting for all imports. Make sure that your data does not contain the import escape character that you have specified, otherwise your import will fail.

Procedure
1. Go to Admin > Administrative Options.
2. On the General tab, type the Import Escape Character.
3. Click OK.

Defining the export tagline

Define the tag line text that will be displayed on the Microsoft Excel spreadsheet when the Send to Microsoft Excel option is used in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Administrative Options.
2. On the General tab, type the Export Tagline.
3. Click OK.
Changing the default edit date

Change the default edit date that is displayed when you add a new record to a table that contains a date field in the IBM Cognos Incentive Compensation Management Client.

It can be either today’s date or the first day of the fiscal year.

Procedure
1. Go to Admin > Administrative Options.
2. On the General tab, select the Default Edit Date from the drop-down menu.
3. Click OK.

Setting user log in security options

From the User tab in the Administrative Options window you can define security options for the IBM Cognos Incentive Compensation Management Client.

If none of the boxes in this tab are checked, users will have unlimited log on attempts, passwords will never expire, and users will not be required to create strong passwords.

Procedure
1. Go to Admin > Administrative Options.
2. Select the User tab.
3. Select the Disable user after check box to indicate how many attempts users have to log on before their accounts are disabled.
   After an account has been disabled, an administrator with permission to edit users will need to re-enable the account by clearing the Disabled check box from the Admin Menu > Manage Users window.
4. Select the Passwords expire in check box to force users to create new passwords at predefined intervals.
   The number of days entered indicates how often users will be prompted to create new passwords for themselves.
5. Select the Users must have strong passwords check box.
   Password must adhere to the following criteria:
   • must be at least eight characters in length
   • must contain at least three of the following character types:
     – lowercase letter
     – uppercase letter
     – number
     – symbol !@#$%^&*() <>

Important: The Audit log will track all password changes.
6. Select the Show warning when previewing calculations check box to display a warning message after users click the Preview option.
7. Select the Keep password history for check box to indicate how many times users must create a new password before they can reuse a previous password.
Setting web user login security

From the **Web** tab on the **Administrative Options** window, you can set security for the IBM Cognos Incentive Compensation Management web client.

If none of the boxes on this tab are checked, web users will have unlimited log on attempts, users will not be able to reset forgotten passwords, and web users will not be required to create strong passwords.

**Procedure**

1. To temporarily disable the web client while the model is being updated and prevent web users from logging in, unselect the **Enable Web** check box.
2. Select the **Users must have strong passwords** check box.
   
   Passwords must adhere to the following criteria:
   
   - must be at least eight characters in length
   - must contain at least three of the following character types:
     - lowercase letter
     - uppercase letter
     - number
     - Symbol !@#$%^&*() <>

3. Select the **Enable self-service password reset** check box to let users reset a forgotten password via a link on the web client.
   
   To use this feature, web server email settings must already be configured. After selecting this feature, you must choose the length of time (in seconds) that web users have to reset their password before it expires.

4. Select the **Lockout user after** check box to indicate how many attempts web users have to log in to the web client before their accounts are disabled.
   
   After an account has been disabled, an administrator with permission to edit users will need to re-enable the account by clearing the **Disabled** check box from the **Admin Menu > Manage Users** window. Additionally, web users can unlock their accounts using the password reset feature.

5. To force web users to change their passwords after a set number of days, select the **Password expires after** check box, and type the number of days you want the password to expire after.

6. Select the **Keep password history for** check box to indicate how many times users must create a new password before they can reuse a previous password.

Setting email address for Request Assistance link on the web client

You can configure the email address that will be used when a user clicks the following links on the IBM Cognos Incentive Compensation Management web client: **Request Assistance**, **Forgot your user name and password**, and **Don't have an account**.

**Procedure**

1. Go to **Admin > Administrative Options**.
2. Select the **Web** tab.
3. In the **Help Email** field, type the email address of the user you want to be notified when a web user requests assistance on the web client.
4. Click **OK**.
Forcing web users to change passwords on first login

When the User must change the password the first time they log in option is selected, users must change their password the first time they login to the IBM Cognos Incentive Compensation Management web client.

About this task

If the User Must Have Strong Password option is checked, the user’s new password will have to adhere to the strong password guidelines. The forced password reset will apply to new web users who are logging in for the first time and re-enabled web users who are logging in for the first time after being re-enabled via the Portal Access module.

Important: This option is only available for users enabled for web through Portal Access who are not using LDAP authentication.

Procedure

1. Go to Admin > Administrative Options.
2. Select the Web tab.
3. Select the User must change the password the first time they log in option.
4. Click OK.

Important: Web users will be forced to enter a password into the New Password field the first time they login; however, web users are permitted to reuse passwords. This means that the new password can be the same as the old password.

Setting the base URL for the web client

For the Report Name With Link variable in the IBM Cognos Incentive Compensation Management Workflow Manager module to function correctly in a message by an alert node to the web client, the base URL for the web client must be configured in the Administrative Options window.

Procedure

1. Go to Admin > Administrative Options.
2. Click the Web tab.
3. In the Base URL field, type the URL of your WAR file.
   For example, type the following address: http://localhost:8080/ICM, where, "ICM" is the name of your WAR file.
4. Click OK.

Setting Audit log options

You can choose to have an entry created in the Audit log every time a user logs on or off the IBM Cognos Incentive Compensation Management web client and set the order the events will be sorted in.

Procedure

1. Go to Admin > Administrative Options.
2. Select the Audit Log tab.
3. You can select the Track web user log on/off check box to have an entry created in the Audit log every time a user logs on or off of the web client.
4. You also have the option to select the **Reverse the sort to show newest events first** check box.

**Setting Payee Ledger options**

In the **Payee Ledger** tab, you can select how many times you want to repeat the header in the IBM Cognos Incentive Compensation Management web client and if web users will be able to select all their dimensions such as plan or report, payee, period, and calculation, from the Detail page, and then manually generate the report.

If this check box is cleared, each time a web user selects a dimension, a report will generate.

**Procedure**

1. Go to **Admin > Administrative Options**.
2. Select the **Payee Ledger** tab.
3. Use the arrows to select how many rows there will appear before the header is repeated.

**Exporting Payee Ledger to Excel**

Users will have the option of either applying report dimensions prior to rendering the report on the IBM Cognos Incentive Compensation Management web client or exporting a report to Microsoft Excel without rendering the report when they choose the **Apply selected dimensions manually** option.

**About this task**

Three buttons will display on the web client: **Apply**, **To Microsoft Excel (.xls)**, and **To Microsoft Excel (.xlsx)**.

**Apply** This will display the report on the web client with selected dimensions applied. The **Inquire** button will be displayed after the report has been rendered.

**To Microsoft Excel (.xls)**

This will export the report to a Microsoft Excel .xls file. The row limit for this file type is 65,000 rows.

**To Microsoft Excel (.xlsx)**

This will export the report to a Microsoft Excel .xlsx file. This file format, introduced with Microsoft Excel 2007, supports exports of up to 1 million rows.

**Tip**: This option should be selected for all large reports to avoid web performance issues.

**Procedure**

1. Go to **Admin > Administrative Options**.
2. Select the **Payee Ledger** tab.
3. Select the **Apply selected dimensions manually** check box.
Sending emails to users when a sign off is pending

You can choose to send an email automatically to users whenever a sign off is pending in the IBM Cognos Incentive Compensation Management web client.

About this task

This will inform web users when they need to log in and approve results on the web client. Email notifications about pending sign offs will be sent in the following situations:

- When a sign off is started from the Cognos Incentive Compensation Management Client, all users in the top node of the sign off tree will be notified.
- When all members of a sign off tree have been force approved by the administrator through the Client, members of the next node down the tree will be notified that they have a sign off pending (if applicable).
- When all members of a node in the sign off tree have approved the sign off via the web client, members of the next node down the sign off tree will be notified that they have a pending sign off (if applicable).

Procedure

1. Go to Admin > Administrative Options.
2. Select the Portal Access tab.
3. Select the Email users when a sign off is pending check box.

Important: You must also configure the email settings in the Service configuration file. For more information, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Sending emails to users when an inquiry is pending

You can choose to send an email automatically to the designated inquiry handler when an inquiry is launched and pending review in the IBM Cognos Incentive Compensation Management web client.

Procedure

1. Go to Admin > Administrative Options.
2. Select the Portal Access tab.
3. Select the Email users when an inquiry is pending check box.

Important: You must also configure the email settings for the web client in the mail.properties file to point to the correct mail server. For more information, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Using incremental calculation

You can specify whether to use existing results that are still current (for example, nothing has been changed to potentially change the result) during the calculation to speed up the overall calculation time in the IBM Cognos Incentive Compensation Management Client.

By default, the Enable incremental calculation option is selected.
Procedure
1. Go to Admin > Administrative Options.
2. On the Calculation tab, select the Enable Incremental Calculation check box.
3. Click OK.

Enabling data tier performance optimization

The data tier performance optimization feature can improve calculation performance in the IBM Cognos Incentive Compensation Management Client, especially in models that have a large number of calculations that perform multiplication and division operations.

About this task

Use this feature to process a larger portion of calculations by the database and reduce the need for transfers between the database and Service. For more information on configuring this feature, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Procedure
1. Go to Admin > Administrative Options.
2. On the Calculation tab, select the Enable data tier performance optimization check box.
3. Click OK.

Disabling generation of computation logs

By default, the generation of computation logs in the Audit module is enabled. You can disable the generation of computation logs in the Administrative Options window.

Procedure
1. Go to Admin > Administrative Options.
2. Click the Calculation tab.
3. Clear the Enable generation of Computation Logs check box.

Participating in the statistics monitoring program

An optional statistics monitoring program is available that will alert IBM Cognos Incentive Compensation Management whenever a client's calculation or import process fails (without accessing the data, plans, or confidential information associated with that process).

About this task

The Cognos Incentive Compensation Management support team can then contact each client to resolve the situation promptly. Each time an import or calculation is completed, information is gathered and packaged by Cognos Incentive Compensation Management and transmitted to our servers. All communication occurs over a secure TCP connection established via the Transport Layer Security protocol. This ensures that all information is sent in a secure fashion to an authenticated host.
**Procedure**
1. Go to Admin > Administrative Options.
2. Select the Statistics tab.
3. Select the Yes option.
4. Click Test to test the connection to the statistics server.

---

**Testing the connection between the IBM Cognos Incentive Compensation Management Client and the server**

You can perform a test on the connection of the Client with the server and view how long it takes to ping the server, upload 10 Mbits to the server, and download 10 Mbits from the server.

**Procedure**
1. Go to Admin > Administrative Options.
2. Select the Connection tab.
3. Click Connection Test.

---

**Viewing and publishing the model summary**

The IBM Cognos Incentive Compensation Management model summary provides basic model statistics.

In the title, the model name appears next to Model Summary. The information can be published to Microsoft Excel.

**Procedure**
1. Go to Admin > Model Summary.
2. To publish the information to Microsoft Excel, click the To Microsoft Excel button.
   A new Microsoft Excel spreadsheet with the model information will be displayed.

---

**Web messages**

Use IBM Cognos Incentive Compensation Management web messages to create, edit, or delete messages for the web client.

Administrators can also notify all web users about the message.

**Creating a web message**

You can write a message that you can then send to all IBM Cognos Incentive Compensation Management web client users.

**Procedure**
1. Go to Admin > Web Messages.
2. Click Add.
3. Type a Subject for the message.
4. Type a message.
5. Click OK.
Viewing a web message
You can read a message sent to IBM Cognos Incentive Compensation Management web client users.

Procedure
1. Go to Admin > Web Messages.
2. Double-click the row to view the message.

Editing a message
You can modify a message after it has been created in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Web Messages.
2. Select the message you want to edit.
3. Click Edit.
4. Make your changes, and click OK.

Delete a message
You can remove a message after it has been created in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Web Messages.
2. Select the message, and click Delete.

Notifying all web users
You can send the message to all IBM Cognos Incentive Compensation Management web client users.

Procedure
1. Go to Admin > Web Messages.
2. Select Notify.
3. Click Yes to the popup question.

Managing saved imports
Use the Manage Saved Imports feature in IBM Cognos Incentive Compensation Management to delete saved or local imports or edit details of the import, such as the name of the import, the data source, the destination table, or column mapping.

Users can also run client-side imports from this window. Server-side imports can only be run from the Scheduler module.

Important: To edit a server import, you must specify an import directory in the Cognos Incentive Compensation Management Windows Service configuration file.

Procedure
1. Go to Admin > Manage Saved Imports.
2. Click the Local or Server tab.
3. Select the import.
4. Click **Edit**, **Delete**, or **Run**.

### Managing saved publications

Any publications that have been created and saved can be viewed, edited, or deleted from the Manage Saved Publications window in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Go to **Admin > Manage Saved Publications**.
2. Select the publication.
3. Click **Edit**, **Delete**, or **Run**.

### Managing saved transformations

Any data transformations that have been created and saved can be viewed, edited, or deleted from the Manage Saved Transformations window in the IBM Cognos Incentive Compensation Management Client.

Data transformations are created in Composer and can be scheduled in the Scheduler module.

**Procedure**

1. Go to **Admin > Manage Saved Transformations**.
2. Select the transformation.
3. Click **Edit** or **Delete**.

### Managing documents

In the Document Manager window, users can add any files associated with compensation management to the IBM Cognos Incentive Compensation Management database.

Any documents added here will be visible from the Portal Access Assignment window and can be enabled for web client review.

**Procedure**

1. Go to **Admin > Manage Documents**.
2. Click **Add**.
3. Click **Browse**.
4. Select the file.

The file will be automatically encoded and saved within Cognos Incentive Compensation Management, available for you to download at any point in the future.

#### Downloading a document to your computer

You can select a document from the Document Manager window in IBM Cognos Incentive Compensation Management, and save it to your computer.
Procedure
1. Go to Admin > Manage Documents.
2. Click Save As.
3. Select a location to store the file.
4. Click Save.

Enabling or disabling table history collection

Administrators can choose to enable or disable the logging of changes to tables in IBM Cognos Incentive Compensation Management. By default, history for all tables is recorded.

Procedure
1. Go to Admin > Manage History Tracking.
2. To disable the collection of history for all future tables created in Composer, clear the Track history for new tables check box.
3. To disable the logging of history for a table, perform the following actions:
   a. In the Tables with History Tracking Enabled pane, select the check box next to the table for which you want to disable history collection.
   b. Click > to move the table into the Tables with History Tracking Disabled pane.
4. Click Save.
Chapter 28. Tools

The Tools menu is accessible from any module within the IBM Cognos Incentive Compensation Management Client and includes options such as model optimization, modifying calendars, creating payee groups, creating star schemas, and migrations.

Optimize model

For increased performance, use the Optimize Model feature to manually optimize the IBM Cognos Incentive Compensation Management model at the database level.

About this task

Prior to using the Calculate module, this feature can be used to ensure favorable calculation time after data has been updated. Model optimization can also be scheduled as part of a process in the Scheduler module.

When used, the database calculates statistics to improve query performance, so that data can be accessed more efficiently. It is recommended that optimization is done after a large number of changes have been made to the model, a period has been locked, or a large data import has occurred.

Important: More frequent use will not necessarily provide a noticeable improvement in calculation time.

Procedure

1. Go to Tools > Optimize Model.
2. Click Yes.
   The Activity module will open and display the progress of the optimization process. After the process is complete, a message indicating the model was successfully optimized will be displayed in the Activity module.

Calendars and period locking

Each calendar is created either automatically at model creation or manually by a IBM Cognos Incentive Compensation Management model administrator.

The calendar period locking functionality ensures that calculated results never change, and the amount paid to each payee corresponds exactly to the values shown for that payee and period in the application.

Calendar creation

Within IBM Cognos Incentive Compensation Management, multiple calendars may be created to address the needs of different lines of business.

For example, consider a company that has a sales and a consulting line of business. The sales line of business may define the end of a period as the last day in a month, whereas the consulting line of business might plan around full weeks, ending their period after the completion of the last full week in any month.
Cognos Incentive Compensation Management is able to manage the different ways each line of business aggregates data through the use of calendars. Each compensation plan uses a single calendar that tells the compensation plan how to aggregate data in time-based calculations. A set of compensation plans for consulting will aggregate correctly based on one calendar, and a different set of compensation plans for sales can simultaneously calculate correctly based on a different calendar.

The selected calendar combines date ranges into periods. Date ranges can be either created manually for precision, or automatically using the integrated Add Year button found inside any existing calendar.

Creating a new calendar
You can add different calendars to your IBM Cognos Incentive Compensation Management model.

Procedure
1. Select Tools > Calendars.
2. Click Add.
3. Type a Name for the calendar.
4. Select the start date.
5. Select the template format.
6. Click Finish.

Important: Custom calendars may also be created.

Editing a calendar
After a calendar has been created in IBM Cognos Incentive Compensation Management, it can be modified.

Procedure
1. Go to Tool > Calendars.
2. Right-click a calendar.
3. Select Edit.
4. Click either Add Year, Add (a Period), Edit, or Delete to make any changes.
   After multiple ranges have been defined, they can then be grouped for calculation and reporting purposes. Ranges must be continuous for Cognos Incentive Compensation Management to accept the changes.
5. Click Next.
6. Click either Add (a Time Roll up), Edit, or Delete to edit the time hierarchy.
7. Click Finish.

Multiple calendars
While multiple calendars can be used in one IBM Cognos Incentive Compensation Management model, only use one calendar (or as few as possible) for payout purposes.

Within a compensation plan, certain calculations may reference different calendars, but the calculation that payment is based on (final calculation in the plan) should be the same for each compensation plan. This will simplify the process of period locking by eliminating the need to lock multiple calendars.
Use existing compensation plans in the new year

After you have added a new year to your IBM Cognos Incentive Compensation Management model, you will want to ensure that you have compensation plans for your new fiscal year.

You have the following options:

1. If a compensation plan will remain unchanged for the new year, you can continue to use the same plan. Edit the plan by extending its end date.

2. If you would like to make changes to a plan for the upcoming year, it is best to create a new compensation plan. The simplest way to do this is to make a copy of the group of calculations that are used by the compensation plan. You can then make any necessary modifications to the copied calculations, and create a new plan.

Period locking

IBM Cognos Incentive Compensation Management is capable of calculating highly accurate compensation results based on varied information and then locking the calendar.

Before payees and their managers can approve their compensation calculations, Cognos Incentive Compensation Management provides a mechanism to lock periods in order to prevent these accepted results from changing. As a result, Cognos Incentive Compensation Management is completely transparent to both the administrator and the user. Period locking ensures that the amount on each check written for each payee corresponds exactly to the values shown for that payee and period in the application.

With period locking, the following actions can occur:

- Administrators can freeze the calculation (and record list) for closed, commissioned periods.
- The system can protect the results for closed periods and enforce restrictions that ensure that the results are fully auditable and do not change.

Ensure accuracy in IBM Cognos Incentive Compensation Management

Without period locking, steps must be taken to ensure that the new results agree with the original payment amounts for that period.

All of the following circumstances need to be met in order for Cognos Incentive Compensation Management to be accurate:

- All errors in the data must be corrected prior to the close of a period. All relevant meta data must be up-to-date before the close of each period.
- Records associated with a period will never be added after that period is closed.
- Payee titles, quotas, and other non-period-specific data must not change.

If these circumstances are not met when Cognos Incentive Compensation Management recalculates, the system will determine new results based on any new (or altered) data. The new results will not agree with the original payment amounts for that period.

How period locking works

A period is locked for a given calendar in IBM Cognos Incentive Compensation Management and prevents any values from changing through the lock date.
All associated compensation plans and data tables are locked simultaneously, preventing any calculation results (or source data) from changing. This ensures the integrity of prior period results.

When periods are locked, all data tables associated with that calendar are locked by the date field (other table types are not locked). If more than one date field in the table is selected as a primary key, the system will prompt you to choose a Lock by Date when the table is created. This lets the system know what field to look at when locking the table.

Prior to locking a period, when the Calculate module is used to calculate all items, Cognos Incentive Compensation Management will calculate results for all calculations and all periods. After a period has been locked, the system will enforce rules that will prevent administrative actions that would invalidate locked calculation results. For example, any new calculations created after a period is locked can only contain unlocked periods in the results set. If you want to lock multiple calendars consecutively, you can do so without running another full model calculation as long as no further changes have been made in the model.

Locked calculations can, however, be edited. Formulas for locked calculations can be changed, as long as the calculation does not use accumulating partitioning. If the Accumulating Partitions checkbox is selected, you will be prohibited from editing the calculation. Locked calculation results will not change; however, results for any unlocked periods will change to reflect any modifications that have been made to the calculation. When viewing results in Payee Ledger on the web client, the results will be displayed seamlessly. Payees will not be able to detect at which point in time a change in the calculation was made.

While locked periods can be unlocked, it is recommended that you avoid doing this. The purpose of period locking is to prevent accepted results from changing and to ensure that payments made always match calculated results. If you unlock a period, even to make a minor change, you may inadvertently change accepted payment results beyond the change that you intended to make.

**Locking a period**

You can lock a period to prevent the results from being modified in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Go to **Tools > Calendars**.
2. Select the calendar you want to lock.
3. Click **Lock**.
   - The Time Locking Wizard will be displayed and show all compensation plans and data tables that will be affected by locking the selected calendar.
4. Click **Next**.
5. Select the **Period** that you are locking through.
   - **Tip**: You cannot have open periods that exist prior to a locked period. For example, if you lock period 1 of 2012, all of 2011 will automatically be locked as well.
6. Verify the action.
7. Click **Finish**.
8. Click either **Calculate and Lock** or **Lock Only**, and click **OK**.
If any changes have been made since the last calculation, the Lock Only option will not be available.

**Important:** A calendar lock is considered a change in the model. If you have more than one calendar and another calendar was locked after the last calculation, another calculation will be required prior to locking the current calendar.

9. The Activity tab will open to show the progress of the calendar locking process.
After the process is complete, a message indicating that the calendar is locked will be displayed in the Activity tab.

**Tip:** Performing a calculation prior to locking is recommended to ensure that all calculated results are up-to-date as of the calendar locking.

10. If you go back to Composer and open a data table, you will notice that none of the rows with a date in a locked month can be edited, but you will still be able to edit rows with dates in an unlocked period.

**Important:** When you create a data table with more than one date field, you are prompted to select a locked-by date. This is the date that will be used when locking periods.

**Unlocking a period**
When you unlock periods, the results for these periods will become editable, therefore potential inconsistencies between payments and results become possible in IBM Cognos Incentive Compensation Management.

**Procedure**
1. Go to Tools > Calendars.
2. Select the calendar.
3. Click Lock.
4. Select a period prior to the current locked period, or select Unlock all periods.
5. Verify the action.
6. Click Finish.
   The Activity module will open to show the progress of the calendar unlocking process. After the process is complete, a message indicating that the calendar is unlocked will be displayed in the Activity module.

**Important:** Unlocking a period is an irreversible operation. All adjustments for that period will be deleted.

**Period locking and system functions**
The following table provides system function and how they affect and are affected by period locking in IBM Cognos Incentive Compensation Management.

**Table 50. System functions and period locking**

<table>
<thead>
<tr>
<th>System functions</th>
<th>Effect of period locking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new calculation</td>
<td>Partition may only reference unlocked periods.</td>
</tr>
<tr>
<td>Change an existing calculation</td>
<td>Changes will not be possible if the calculation includes locked periods. Copied calculations will begin in the first unlocked period.</td>
</tr>
<tr>
<td>Create a new compensation plan</td>
<td>The start date of the plan is unrestricted, but only unlocked calculations may be added to a compensation plan.</td>
</tr>
</tbody>
</table>
Table 50. System functions and period locking (continued)

<table>
<thead>
<tr>
<th>System functions</th>
<th>Effect of period locking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify an existing compensation plan</td>
<td>If any calculations in a plan have any locked periods, the plan cannot change. Copied plans will begin in the first unlocked period. If there are no unlocked periods, the plan cannot be copied.</td>
</tr>
<tr>
<td>Calculate</td>
<td>If a calculation is performed on a compensation plan that includes locked periods, the locked periods within the plan will not be recalculated.</td>
</tr>
<tr>
<td>Add a member to a payee group</td>
<td>New members can be added to a payee group at any time.</td>
</tr>
<tr>
<td>Modify a calendar</td>
<td>Cannot edit time periods that have been locked.</td>
</tr>
<tr>
<td>Add a new record to a table in Composer</td>
<td>Prohibited from adding a record that contains a date in a locked period.</td>
</tr>
<tr>
<td>Create a new table</td>
<td>Period locking does not affect the creation of a new table.</td>
</tr>
<tr>
<td>Import data</td>
<td>Records containing dates that reside in a locked period will not be imported.</td>
</tr>
<tr>
<td>Edit Portal Access permissions</td>
<td>Locked periods do not affect edit Portal Access permissions.</td>
</tr>
<tr>
<td>Change the Portal Access tree</td>
<td>Editing Portal Access trees is still possible with locked periods.</td>
</tr>
<tr>
<td>Enable and disable a table for web edit</td>
<td>Tables can be enabled and disabled for web edit when periods have been locked.</td>
</tr>
<tr>
<td>Edit web edit permissions</td>
<td>Editing web edit permissions is still possible when periods have been locked.</td>
</tr>
</tbody>
</table>

Period locking and calculation speed:

Editing web edit permissions is still possible when periods have been locked in IBM Cognos Incentive Compensation Management.

Because period locking freezes calculated results for prior periods, using the Calculate module to update results will normally not calculate data in locked periods. By marking a large amount of the total system data as inactive, the number of active records included in a recalculation is reduced and, as a result, calculation time speeds up. You will notice that as the number of locked periods in your model increases, your calculation time will decrease.

Period locking and calendar changes

Each calendar in IBM Cognos Incentive Compensation Management is locked independently so that different companies or divisions can freeze their results at different times.

When making calendar changes, unlocked periods may be moved provided they do not cause a period to go from locked to unlocked or vice versa. After a period has been locked it cannot be moved. Additionally, any new periods added to the calendar must be unlocked and a locked period can never exist after an unlocked period.
Adding new periods to a locked calendar:

You should add new periods to a calendar before locking the final period in your IBM Cognos Incentive Compensation Management model; however, you can add new periods to a locked calendar if necessary.

About this task

Only calendars that contain at least three hierarchies can have periods added to them after they have been locked. You cannot add new hierarchies to a locked calendar.

Procedure

1. Go to Tools > Calendars.
2. Select the locked calendar, and click Edit.
3. Click Next to navigate to step 2.
4. Right-click the node you want to add levels to, and select Add.
   For example, add the next year to the calendar, then add the next Quarter to the year.
   a. Type a Name for the level (for example, 2011), and click OK.

   Important: You can only add n-2 levels, where "n" is the number of hierarchies you have. For example, if you have four hierarchies (such as, Total, Years, Quarters, Months), you can only add two levels (such as, Year and Quarters).
5. Click Previous to navigate to step 1.
6. Click Add to add a new period.
   a. Type a Name for the period (such as 2011, Month 01).
   b. Select a Period Start date and a Period End date.
   c. Click OK.

   The new period will move to the newest level you created.

Payee groups

IBM Cognos Incentive Compensation Management uses payee groups to reduce the time spent setting up and maintaining each compensation plan.

The following list outlines the parts to each payee group:

1. The compensation plans.
2. The payee members belonging to each plan.
3. Any plan documentation the administrator has attached.
4. Any tailored reports that have been created for the payee group.

All compensation plans and tailored reports are created and edited in the Composer module and assigned to payee groups through the Compensation Plan and Tailored Report wizards. Payee group members and documents are managed in the Payee Groups window.

The individuals who will have their compensation calculated in the system (payees) can be added to a single group and, subsequently, a compensation plan
may be added to the group to complete the setup process. You can then set up plans for large groups of people at the same time, rather than repeating the process for each individual.

Payees are frequently grouped by title. For example, if all salespeople receive five percent commission on everything they sell, every salesperson can be added simultaneously to a single payee group in the system. To complete the process, a compensation plan that specifies that each member of this group will receive a five percent commission can then be added. It is helpful to consider which payees might be grouped together prior to beginning the model creation process.

**Important:** Compensation plans themselves are composed of one (or more) calculations within the system.

### Adding a payee to a group

Payees must be added to groups to view results on the IBM Cognos Incentive Compensation Management web client and to be part of an inquiry and sign off process.

**Procedure**

1. Go to **Tools > Payee Groups**.
2. Click **Add**.
3. Type a **Name** for the group, and click **Next**.
4. Add any tables to the Payee table to use as the source, and click **Next**.
5. Create restrictions to define exactly which members of the source will participate in the Payee group. 
   For example, to create a payee group that contains only Account Executives, you could define a restriction stating that only payees whose title ID = Account Executive should be included.
6. Click **Next**.
7. Select the payee group members.
   Any members you have already selected through the restrictions window will automatically be shown in the selected payees pane.
8. To edit the Start Date and End Date for the payee, right-click the payeeID, and select **Edit**.
   a. Select the new **Starting** date or **Ending** date.
   b. Click **OK**.
9. Click **Finish**.

**Important:** A payee group can contain one or more compensation plans, as well as one or more payee members.

### Deleting a payee from a payee group

Payees can be removed from a payee group in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Go to **Tools > Payee Groups**.
2. Select a payee group, and click **Edit**.
3. In step 3 of the wizard, select the payee, and click **Remove**.
Important: This will only remove the payee from the payee group (not from the system).

Star schemas

In IBM Cognos Incentive Compensation Management, star schemas are used for creating OLAP cubes for performance analytic purposes.

They facilitate the export of information to an external analytical software solution. Empty fact and dimension tables are created in Composer, and imports can be scheduled using Scheduler. In this window, you can view star schemas and their tables, and you can add or remove a star schema.

The star schema consists of a fact table referencing any number of dimension tables. The fact table holds the main data (for example, calculation results), while the dimension tables are joined in to describe each value of a dimension. The results of calculations can be analyzed along multiple dimensions. Each dimension table has a single primary key, while fact tables have a compound primary key consisting of the aggregate of relevant dimension keys.

Creating a star schema

You can add a star schema based on a fact table referencing dimension tables in IBM Cognos Incentive Compensation Management.

Procedure

2. Click Add.
3. In the Star Schema Name field, type a name for the star schema.
4. From the Data Store drop-down list, select a data store.
5. Click Finish.

Importing star schemas using the IBM Cognos Incentive Compensation Management Add-in for Microsoft Excel

The IBM Cognos Incentive Compensation Management add-in for Microsoft Excel gives users an easy way to do self reporting using up-to-date results.

Users can import star schemas created in their model into Microsoft Excel using the IBM Cognos Incentive Compensation Management tab. The data can then be manipulated by creating pivot tables, charts, and graphs. If any changes are made to the model, the data in Microsoft Excel can be updated with the most recent data. Users can save their work in Microsoft Excel and reuse the same report sources and formatting. For more information on installing the IBM Cognos Incentive Compensation Management add-in for Microsoft Excel, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Connecting to the model

Before importing data, the correct connection information must be entered on the IBM Cognos Incentive Compensation Management tab in Microsoft Excel.

Procedure

1. In Microsoft Excel, click the IBM Cognos Incentive Compensation Management tab.
2. Connect to your model by typing the Service Address, the Server, and the Database name.

3. Click Login Information, and type the user name and password you use to connect to the Cognos Incentive Compensation Management Client.

4. Click Import Star Schema to download data into Microsoft Excel from your model.

   **Important:** You will not be able to import a star schema if you are already logged in to the client with the same login information used on the IBM Cognos Incentive Compensation Management tab in Microsoft Excel, or if you do not have permission to access star schemas.

**Importing a star schema**

After you are authenticated, you can select from a list of predefined star schemas created in IBM Cognos Incentive Compensation Management.

**Procedure**

1. To import a star schema into Microsoft Excel, click Import Star Schema.
2. Select a star schema to import from the list.
3. Click Import.
   
   The fact table and dimension tables are displayed in a Microsoft Excel spreadsheet.

   **Important:** If you have not populated the star schemas using the Add Star Schema Population task in Scheduler, you will not see any data in Microsoft Excel.

4. You can use the data to create and format a report in Microsoft Excel.

**Refreshing data**

At any time, users can update the data in Microsoft Excel with the most recent data from the IBM Cognos Incentive Compensation Management database.

If users are opening a previously saved report, they must log in to the model to refresh the data.

**Procedure**

1. To update the data, click Refresh.
2. To update the data in pivot tables, click Refresh PivotTables.
   
   You must first click Refresh before refreshing the pivot tables.

**Exporting components**

If you have two IBM Cognos Incentive Compensation Management models, you can transfer components between them.

For example, you can export components from the Dev model and import them into the QA model. In the Export Component window, you can select to export any component you have created in the model.

**Procedure**

1. Go to Tools > Export Library.
2. Select a component.
3. Type a **Package Name** for the component, and type a **Description** for the component.
4. Click **Export**.
5. Select a folder to save the file in, type the **File Name**, and click **Save**.

   **Important:** The file will be saved as a .vpbc file.

### Importing components

Users have the ability to import components into their IBM Cognos Incentive Compensation Management model.

Users can import components that have been exported from another model or downloaded from the IBM Cognos Incentive Compensation Management Library.

**Procedure**
1. Go to **Tools > Import Library**.
2. Click **Browse** to select a component destination file.
   - You will notice all the fields will be automatically populated.
3. Click **Import**.
4. In the **Import Library Wizard**, you can type a suffix that will be added to connections with the same names as Global tables in the target model.
   - If you do not type a suffix, Cognos Incentive Compensation Management will add one to any connections with the same name as Global tables in the target model.
5. In step 2, map the imported calendar with a local calendar then click **Next**.
   a. Select the **Local Calendar** from the drop-down menu.
   b. Drag to match the **LevelIDs** or use the **Automatch** button.
   c. Click **Save**.

### Changing the web client theme

The logo displayed in the web client can be customized from the Themes window in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. Go to **Tools > Themes**.
2. Select the **Enable Custom Header** check box.
3. Browse for the image that you want.

   **Important:** The image must be less than 250 pixels wide.
4. Select either **Standard** or **salesforce.com** for the web client theme.
5. Click **OK**.

### Turning off warning message when deleting rows in tables pick listed by other tables

Users can turn off the warning message received when rows are deleted from a table with a pick list column in IBM Cognos Incentive Compensation Management.
Procedure

1. Go to Tools > User Preferences.
2. Unselect the Warn before deleting rows in a table that may affect one or more other tables check box.
3. Click OK.
Chapter 29. Migration

IBM Cognos Incentive Compensation Management model elements, along with dependent objects, can be migrated between models of the same version number, as long as there are no conflicts.

These are the objects that can be selected during migration:
- Composer
- individual components
- process lists
- saved imports
- Portal Access trees
- roles
- users
- Workflow Manager workflows
- web tabs
- web form filters
- calendars

Migration between models is done by pulling the data from the source model to your current working model (target model).

Migration will migrate only the selected items, so you must use remapping to resolve dependencies. During migration, you can remap items used outside of a component to matching local items. If there is no matching, local item, migration will not proceed. To ensure that all dependencies are migrated, click the Select Dependencies button in the migration wizard.

Tip: Individual tables, reports, and calculations cannot be selected in the migration wizard. In order to migrate an individual model element, wrap the item into a component and migrate the component.

General practice and rules

In general, migration conflicts are determined and managed based on the name of an object in IBM Cognos Incentive Compensation Management.

If an object in the source model has the same name as an object in the target model, Cognos Incentive Compensation Management understands that the object exists in both models, regardless of the object’s composition.

1. If an object from the source model does not exist in the target model, it will be created in the target model during migration.
2. If an object with the same name exists in both models, and there are no conflicts, it can be migrated.
3. If the target model has an item with the same name as an item in the source model and the user has selected the Replace conflicts option, the target model item will be overwritten by the source model item during migration.
4. If an item exists in the target model, but does not exist in the source model it may be deleted during migration. For example, if you are migrating a
component that exists in both the target model and source model, any elements inside the target model component that do not exist in the source model component will be deleted.

Rules for migrating Composer

If you choose to migrate all of the IBM Cognos Incentive Compensation Management Composer module, then the Composer module in the target model will match the Composer module in the source model exactly after migration is complete.

This means that elements not present in the target model will be added, and any elements that exist in the target model but not in the source model will be deleted. If you want elements in the target model that are not in the source model to remain after migration, it is a good idea to migrate specific components only and not the entire Composer module.

• If the source and target model contain the same table in two different components, it will produce a conflict.

  **Important:** If a table is global in both source and target models but exists in different components, there will be no conflict during migration. The global table will stay in the same component in the target model after migration completes.

• When migrating all of Composer, calculations, web forms, Presenter reports, tailored reports, and compensation plans that exist in both models will remain in the same components as the source model after migration and overwrite any objects with the same name in the target model.

• Migration will add columns to tables if needed but will not add key columns or remove columns. If key columns need to be added to a table, it will produce a conflict.

Rules for migrating components

There are a few rules you should know when migrating components in IBM Cognos Incentive Compensation Management.

• All sources for connections must exist somewhere in the target model. If the sources for the connections in a component cannot be remapped to sources in the target model, there will be a conflict. For example, if you try to migrate a component containing only a report and the report source does not exist in the target model, the migration will not complete.

• When migrating specific components, any object that exists in the component in the source model but exists in a different component in the target model will be listed as conflicted. You can avoid this by migrating a mutual parent component of both components, such as Composer.

• When migrating a component that exists in both the source and target model, everything inside the component in the target model will be replaced with everything inside the component from the source model. This includes deleting objects in the target model component that do not exist in the source model component.

Rules for migrating tables with pick lists

A few rules should be observed when migrating tables with pick lists in IBM Cognos Incentive Compensation Management.
1. If a table with a pick list is migrated along with the structural table it pick lists to, or the structural table exists in the target model, migration will complete successfully.

2. If a table with a pick list is migrated without the structural table it picks from, it can be migrated if there is a corresponding structural table in the target model with the exact same column structure, even if the table name is different. Migration will remap the pick list to the new structural table as long as it has the same global setting as the table in the source model and the same column structure.

3. If a table with a pick list is migrated without its structural table and an appropriate structural table does not exist in the target model, the structural table will appear as conflicted.

Rules for migrating global tables

A few rules should be observed when migrating global tables in IBM Cognos Incentive Compensation Management.

1. If a table is local in the source model but global in the target model, it will appear as conflicted during migration.

2. If a table is global in the source model but local in the target model, it will be made global in the target model; however, if the table is used by connections on the same level in the target model, it will appear as conflicted.

3. If a component has a connection with the same name as a global table in the target model, the connection will appear as conflicted during migration.

4. If a component exists in both the source and target model but the component in the target model contains a global table, the global table will be deleted unless objects outside the component use the table as a source.

5. If a global table exists in different components in the source and target model, the global table will remain in the same component as the target model after migration.

Rules for migrating web forms and Presenter reports

There are a few rules that you should observe when migrating web forms and Presenter reports in IBM Cognos Incentive Compensation Management.

- If a component is migrated that contains a Presenter report or web form that links to another report or web form, the linked report or web form must exist in the target model or be part of the migration.

- If you migrate a component that will delete a Presenter report or web form in the target model component that is linked to another report or web form, the report that would be deleted will appear as invalid.

- If you migrate a web form that passes a filter value to a Presenter report parameter that does not exist in the target model’s Presenter report, the report will appear as invalid.

Rules for migrating web form filters

There are a few rules you should observe when migrating web forms filters in IBM Cognos Incentive Compensation Management.

- Web form filters will not overwrite web form filters with the same name in the target model.

- If the table the web form filter uses does not exist anywhere in the target model or is not included in the migration, the table the web form filter uses will be listed as conflicted.
Rules for migrating web tabs

There are a few rules you should observe when migrating web tabs in IBM Cognos Incentive Compensation Management.

- Items used by web tabs will not be deleted when Replace conflicts is selected (delta migration).
- Migrating web tabs from the source model will always create new tabs in the target model. Since web tabs can have the same name, there is no conflict when a web tab with the same name as an existing web tab is migrated into a model.
- Migrating web tabs will not automatically include items used by them. To migrate dependent items, select the Select Dependencies check box.
- Web tabs can have the same name.

Important: If you want to overwrite existing web tabs in the target model with web tabs with the same name in the source model, you must delete the web tabs you want to overwrite in the target model before migration.

Rules for migrating process lists

There are a few rules you should observe when migrating process lists in IBM Cognos Incentive Compensation Management.

- Delta migration of process lists (Replace Conflicts)
  When migrating a process list, if a process list of the same name exists in the target model and the Replace conflicts check box is selected, the process list in the destination model will be overwritten. If two or more process lists in the destination model have the same name as the process list you are attempting to migrate (while Replace conflicts is selected), no process list in the destination model will be overwritten and an invalid status will be displayed. If Replace conflicts is not selected, a new process list is created and no overwriting occurs.

- Migrating process list links
  When process list tasks are linked to other objects such as components, input forms, Presenter reports, web forms, tables, and so on, links will be maintained during migration when possible. If the object that the task links to is being created by the migration or exists in the destination model, the links will be maintained as expected. If the linked object does not exist in the destination model, it is then up to the user to remap the invalid links. If links are left as invalid, a “this item is no longer available” message will be displayed when a user clicks them from the Home page. When process lists link to objects, there are three rules that govern the possible migration outcomes.
  - If the object already exists in the target model (same name, type) and that linked object is being migrated, the link will be maintained.
  - If an object (that is linked to by a process list task) does not exist in the target model but will be created by migration, the task link will be maintained. On the re-mapping window the task link will appear next to the object that it is linked to.
  - If an object (that is linked to by a process list task) exists in the target model but will be deleted by the migration or does not exist in the target model and will not be created by migration, the process list's status will appear as "Needs Review". Double clicking the process list will take users to the remapping window. On the remapping window any links to objects that exist in the source model that do not exist in the target model will appear in red. The user can remap these links or finish the migration with invalid links.
Important: Process list task links work based on name and object type only. When migrating a process list that has task links, migration will attempt to maintain those links by associating the links with objects in the target model of the same name and type, regardless of the component it resides in or its structure.

- Remapping links during migration
  During migration a process list’s task links can be remapped from the process list page of the migration wizard. Double clicking any process list will bring up a re-mapping page regardless of its status.
  - On the remapping page, users will see a list of all of the process list's tasks. Next to each task, users will see the destination model object that the task will be linked to.
  - On the right side of the window, users will see a list of local sources. Users can drag any object from the local sources list over to the left to associate that object with a process list task.
  - When the migration completes, each process list task will be linked to the object it is mapped to on this window, regardless of what the task was linked to in the source model.

- Removing links during migration
  To remove a link during migration without having to remap it to a different task, click and hold the invalid linked object (the one in red), and drag it into the right-hand pane. When the box containing the name of the linked object becomes empty, the link is cleared.

Rules for migrating Workflow Manager workflows
There are a few rules you should observe when migrating Workflow Manager workflows in IBM Cognos Incentive Compensation Management.
- The target model must contain a Payee and Title table that has the same columns and global table status as the Payee and Title in the source model.
- The Presenter reports associated with the workflows must be migrated along with the workflows or must already exist in the target model.
- Any Scheduler processes that are associated with process nodes in workflows can be remapped to Scheduler processes that exist in the target model. Double-clicking any process node will bring up a remapping wizard regardless of its status.
  - On the remapping page users will see a list of all the Scheduler folders.
  - Users can select the Scheduler folder they want to be associated with the process node, and click OK.

Objects that do not migrate
There are objects within IBM Cognos Incentive Compensation Management that cannot be migrated.

These items need to be created manually in the target environment by following the same steps which were used to create them in the source environment.

Portal Access tree assignments
Workflow groups and trees can be migrated, but the assignment of the trees for web access security, inquiries, or approvals has to be done manually within the Portal Access module.
Portal Access group members
Since migration only brings over structures and not data, Portal Access groups are not populated with any members after a migration; however, if they have been created with the option **Maintain this group in task manager** selected, you may generate tasks within Task Manager and then run each task to add the appropriate payees to their respective groups.

Web-enabled groups
After populating Portal Access groups with members using Task Manager, you may or may not need to web-enable certain groups depending on whether they have been used to populate Portal Access trees that define your web security.

Import connection strings
After imports have been migrated, the connection strings for each import need to be modified to reflect the new environment's data sources.

Import schedules
After imports have been migrated, and connection strings have been modified, any scheduled imports need to be rescheduled in the Scheduler module.

Themes
Personalized client themes need to be reconfigured.

Saved publications
Any saved publications need to be recreated and possibly rescheduled.

Admin options
Any options chosen within the **Admin Options** menu need to be reconfigured manually in the target system.

Performing a migration
You can select elements from a source model to move to a destination IBM Cognos Incentive Compensation Management model.

Procedure
1. Go to **Tools > Migration**.
2. Specify which model you want to pull data from by selecting the source model using the drop-down menu.
3. Type in your **User ID** and **Password**.
   To connect to the source model, you must use the administrator role user ID and password.
4. Click **Connect**.
   A list of available objects that can be migrated or pulled into your current model are displayed.
5. Select the elements to migrate.
6. You can click the **Select Dependencies** button to have Cognos Incentive Compensation Management automatically select all items in the source model that an object being migrated depends on.
   This will ensure that all dependent objects are migrated. If this option is not selected, you must use remapping to resolve dependencies. During migration, you will be prompted to remap items used outside of a component to matching local items. If there is no matching, local item, migration will not proceed.
7. You can select the Replace conflicts check box to have Cognos Incentive Compensation Management overwrite objects with the same name in the target model with those from the source model. If this option is not selected, overwriting will not take place and migration will not proceed if there are conflicts. For example, if two calculations both have the same name but their formulas are different, or they have different sources, the Replace Conflicts feature will replace the calculations in the destination model with the calculations in the source model.

8. Click Migrate.

9. Click Next to scroll through the plan components.

The next series of migration wizard windows will display migration statuses for all the components of the selected objects.

Table 51. Migration wizard screens

<table>
<thead>
<tr>
<th>Migration Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The object does not exist in the destination model. The new object will be migrated from the source model to the destination model.</td>
</tr>
<tr>
<td>Exists</td>
<td>The object exists in the destination model. There are no conflicts that will prevent migration.</td>
</tr>
<tr>
<td>Conflicted</td>
<td>The object exists in the destination model and there are conflicts. Conflicts need to be resolved before the migration can take place. If a calculation is listed as conflicted because the calculation in the target model is locked and has a different start date than the calculation in the source model, you can choose to ignore the conflict and proceed with the migration.</td>
</tr>
<tr>
<td>Overwriting</td>
<td>The object exists in the destination model and is different from the source model. The migration process will replace the object in the destination model with the changed object in the source model. Overwriting will only occur if the Replace conflicts option is selected.</td>
</tr>
<tr>
<td>Deleting</td>
<td>The object exists in the target model but not in the source model and will be removed during migration.</td>
</tr>
<tr>
<td>Needs Review</td>
<td>This status is used for process lists only. This status lets the user know that the process list contains links to objects that do not exist in the destination model. The user can remap those links by double-clicking the Process list name or finish the migration with invalid links.</td>
</tr>
</tbody>
</table>

a. For an element to be eligible for migration, none of its objects can be labeled as Conflicted. If there is a conflict, double-click the item to view its cause and resolve it before migration can continue.

b. To copy a migration window, right-click the window, and select Copy. The name and status of every object being migrated as well as the conflict details message for every object that is invalid, conflicted, modified, overwritten, or required will be copied.

c. For process list migration, if the status is labeled as Needs Review, double-click the name of the process list to remap links. On the remapping screen, any links to objects that exist in the source model but not in the target model will appear in red. To remap, drag the item that you want to link to from the Local Targets column to the Imported Targets list.
• **Local Targets** are objects that exist in the target model that process list tasks can link to.
• **Imported Targets** are objects from the source model that process list tasks will be linked to after migration. When imported targets are displayed in red, the links are broken and need to be replaced with a valid local target.

10. Click **Finish** to perform the migration.

### Migrating individual Composer objects

You can move specific objects, such as Presenter reports, calculations, and tables in Composer from one IBM Cognos Incentive Compensation Management model to another.

**Procedure**

1. In the source model, right-click the Presenter report, calculation, or table you would like to migrate to the target model, and select **Wrap**.

   **Important:** Compensation plans, tailored reports, and web forms cannot be wrapped without also wrapping their sources.

2. Name the component, and click **OK**.

3. In the target model, go to **Tools > Migration**.

4. In the Migration window, connect to the source model.

5. Expand **Composer**, and select the component containing the object you want to migrate.

6. Select the **Replace conflicts** check box.

7. Click **Migrate**.

### Migration methodology and approach

It is important to plan migrations properly to reduce any risks of failed or incomplete migrations in IBM Cognos Incentive Compensation Management.

After migrations are complete, it is wise to validate that a successful migration has occurred.

There should never be an assumption of success without testing and verifying. Consider the following approach for each phase of the migration:

1. **Plan**
   - Determine migration requirements.
   - Identify migration environments.
   - Create migration plan.
   - Create migration procedures.
   - Create a migration schedule.
   - Create migration log.
   - Develop test plan.

2. **Migrate**
   - Communicate migration and deployment plan.
   - Customize any migration procedures.
   - Run pre-validation test.
- Back up both source and target models.
- Perform migration.

3. **Validate**
   - Verify migration completion with migration log.
   - Run post-migration test.
   - Communicate project information.
   - Conduct migration closeout meeting.
   - Perform knowledge transfer.

**Planning phase**

There are a few steps you should take to plan a migration in IBM Cognos Incentive Compensation Management.

1. Determine migration requirements.
2. Identify migration environments.
3. Create migration plan.
4. Create migration procedures.
5. Create a migration schedule.
6. Create migration log.
7. Develop test plan.

While the amount of planning depends on the size and scope of the migration, the planning process generally should involve determining the requirements of the migration, identifying the source and target environment, and documenting the migration plan. During the planning stage, a determination of the migration requirements includes identifying the environments that are involved in the migration. If there are more than two environments, there needs to be a determination of which environments will act as sources to the other environments and in which order the migration would occur. The user who has the correct role and privileges to run the migration between the environments also needs to be identified.

The migration procedure details the steps to take to accomplish the migration. This involves taking screen shots of the migration wizard and listing which items to select and in which order. The migration procedure should also include any manual steps needed to complete the migration. Some items within Cognos Incentive Compensation Management cannot be migrated using the migration tool. It is good practice to list out these items and to make sure they are accounted for in your deployment plan with specific manual steps to replicate them in the source system.

Migration planning can also help define which items to migrate first, whether it is necessary to take applications offline, and which internal and external audiences should be informed regarding the migration. Proper migration planning involves more than just the information technology (IT) staff. The business owners of the applications should also be included; particularly as the IT organization determines how important a given application or set of data is to the business.

In planning a migration, it is important to understand migration requirements such as source and target environments, time schedule, users involved, and the configuration of the software. In looking at the time schedule, the IT organization should create estimates for planning (planning typically accounts for 25 percent of the total schedule), setup time, migration time, and production cut over.
Table 52. Example of migration plan

<table>
<thead>
<tr>
<th>Action item</th>
<th>Assigned to</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish a migration management team.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gather availability and production schedules.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document change control procedures so they can be incorporated into the migration procedures and plans.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document the timeline for activities for both hardware changes and the data migration.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Announce the migration at least 30 days before the intended target migration date.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a technical migration team.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inform the security and compliance groups about the migration.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule a pre-migration rehearsal that includes all the members of the migration team and a data sampling that will enable the application groups to appropriately conduct the pre- and post-migration verification process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Follow the required change control process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establish a migration status call-in process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utilize a migration planning checklist to ensure that all the pre-migration planning steps have been executed.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following schedule is an example for a simple data migration:

- Planning: two days
- Setup: two hours
- Migration: two hours and 30 minutes for one server
- Production cut over: minimal, performed in offline mode
- Migration team on site: eight hours
- Post-migration validation: two hours

A migration log will identify objects that need to be migrated to the target system which have been tested during and after development using standard development life cycles and methodology. For example, if we are developing ten new plans and five new reports for a new fiscal year, we would have a log that identified those fifteen new objects, their names, if they have been fully tested, when they passed testing and who created or tested those objects. This list will be used as a checklist for post-migration validation.

Table 53. Example of migration log

<table>
<thead>
<tr>
<th>Item to be migrated</th>
<th>Assigned to</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component: Quarterly Sales Bonus</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Component: Annual MBO Bonus</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Report: Finance Accruals</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
</tbody>
</table>
Table 53. Example of migration log (continued)

<table>
<thead>
<tr>
<th>Item to be migrated</th>
<th>Assigned to</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved Imports: Payee Promotion History</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Web Form: Revenue Split Approval</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
</tbody>
</table>

A test plan should be developed to validate that each migrated object has been integrated properly into the new target environment and that they work. This test plan should be similar to a system integration test (SIT); except at a more granular level for each item being migrated.

**Migration phase**

There are a few steps you should take to perform the migration in IBM Cognos Incentive Compensation Management.

- Communicate migration and deployment plan.
- Customize any migration procedures.
- Run pre-validation test.
- Back up both source and target models.
- Perform migration.

During the migration phase, the migration team will need to communicate its plans; review and customize any migration procedures, such as manual steps required or not required due to migration limitations; back up all source and target systems; and perform the actual migration. A pre-migration validation test is recommended, in addition to post-migration validation testing. These tests confirm that the objects being migrated are in the same state after the migration as they were before.

The most important part of this stage is the migration itself. In addition to using the Cognos Incentive Compensation Management migration tool, the deployment plan should be followed step-by-step to ensure a successful migration. While the migration tool automates migration of most objects within the model, the key steps to emphasize in the deployment plan are the items which are not automatically migrated by the tool. These items will need to be replicated manually in the target model.

If this is not the first time you have migrated from one environment to another, some of these manual items may have been migrated in the past and may not have changed, or are not items identified in the migration log to be migrated. This is where customization of the migration procedure in the deployment plan is necessary. You would identify what items to remove or add to account for objects that cannot be migrated.

**Validation phase**

There are a few steps you should take to validate the migration in IBM Cognos Incentive Compensation Management.

- Verify migration completion with migration log.
- Run post-migration test.
- Communicate project information.
- Conduct migration close out meeting.
• Perform knowledge transfer.

It should be emphasized that the items being migrated from the source systems will have been tested prior to planning for a migration but also that a test plan is in place post-migration that involves validating that the items from the migration log have been migrated and that each one is integrated properly into the new environment.

This is especially critical in production environments where poorly tested migrations would impact user experiences. Migration to a UAT environment that is mirrored with a production environment gives you the ability to do proper testing as well as catch any missed processes in a migration plan.

After the migration has been completed, the team should compile migration statistics and prepare a report to highlight what worked, what did not work, and lessons learned. The report should be shared with all members of the migration team. These types of reports are critical in building a repeatable and consistent process through continuous process improvement-building on what worked and fixing or changing what did not work. Further, documenting the migration process can help train staff and simplify or streamline the next migration, reducing both expense and risk.

Configuration-only models

A configuration only model is an intermediate model between the source environment and the target environment in IBM Cognos Incentive Compensation Management.

It is a dedicated model used for migrations only.

The purpose of the configuration only model is to validate the migration process. This model contains only build components such as Composer, Portal Access, Scheduler, and Saved Imports. There is no transaction data in this model, and it may or may not have minimal supporting data, such as populated reference tables that are identical and static in all environments.

In some large and complex enterprise models, having a configuration model is the only way to ensure a clean and controlled migration process. For example, the configuration-only model would sit between the source development environment and the target environments (UAT, SIT, Performance, Data Integration, and Production).

Pros and cons of configuration-only models

There are pros and cons to working with configuration-only IBM Cognos Incentive Compensation Management models.

The following examples are some of the pros of a configuration-only model:
• Clean controlled migration process
• Portability - database footprint is small (easy to send to support for troubleshooting in case of failed migration)
• Seed environment - creation of a model is fast and easy and great as a seed for other environments
• A clean model is maintained
The following examples are some of the cons of a configuration-only model:
- Overhead - extra time required for migration process as well as creation of initial support data
- One extra model for maintenance

**Keys for success**

Using the configuration-only IBM Cognos Incentive Compensation Management model requires careful planning and practice to ensure success.

Migration plans and procedures need to be developed and reviewed periodically for completeness. Developing a plan and list of procedures is required for migrating to the configuration only model as well as from the configuration model to other target models. Discipline in this process and over communication to the teams involved is the main criteria for success.

**Change management**

After IBM Cognos Incentive Compensation Management has been implemented and all the environments have been synchronized, you will need to manage future changes to all the environments.

The following scenarios outline where change is typically required.

*Table 54. Change management*

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Required changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New year, new plans</td>
<td>New plans are designed by management for the new year and need to be implemented.</td>
</tr>
<tr>
<td></td>
<td>Compensation business rules have changed.</td>
</tr>
<tr>
<td>Build in development</td>
<td>Data structures have been validated for new rules.</td>
</tr>
<tr>
<td></td>
<td>Design of calculations and additional components, reports, and so on.</td>
</tr>
<tr>
<td></td>
<td>Build new components and items.</td>
</tr>
<tr>
<td>Migrate to configure-only model</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
<tr>
<td>Migrate to QA or UAT</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
<tr>
<td>Migrate to production</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
</tbody>
</table>
Table 54. Change management (continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Required changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>Communicate changes to sales field.</td>
</tr>
<tr>
<td></td>
<td>Train necessary support team and users.</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.
Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Glossary

This glossary includes terms and definitions for IBM Cognos Incentive Compensation Management.

The following cross-references are used in this glossary:
- See refers you from a term to a preferred synonym, or from an acronym or abbreviation to the defined full form.
- See also refers you to a related or contrasting term.

To view glossaries for other IBM products, go to [www.ibm.com/software/globalization/terminology](http://www.ibm.com/software/globalization/terminology) (opens in new window).

A

Active Directory (AD)
A hierarchical directory service that enables centralized, secure management of an entire network, which is a central component of the Microsoft Windows platform.

AD  See [Active Directory](#).

administrator
A person responsible for administrative tasks such as access authorization and content management. Administrators can also grant levels of authority to users.

aggregate
A calculation that returns a single result value from several relational data rows or dimensional members. Typical examples are total and average.

allocated adjustment
An adjustment to the results of the difference between the original value calculated for a closed period and the value that would be currently calculated based on the new data.

application server
A server program in a distributed network that provides the execution environment for an application program.

attribute
In markup languages such as SGML, XML, and HTML, a name-value pair within a tagged element that modifies features of the element.

C

calculation
The process used to transform a series of records into a new result. Typically a calculation is mathematical, but may also include sorting, shifting, or adding to a prior result. Calculations enable the model admin to select records from their source data, perform operations on the data, segment results, and begin another calculation based on those results.

certificate
In computer security, a digital document that binds a public key to the
identity of the certificate owner, thereby enabling the certificate owner to be authenticated. A certificate is issued by a certificate authority and is digitally signed by that authority.

**component**

A container that is used to organize a model. When creating a new model, components should be created first, in order to give the model a framework and ensure that it is easy to navigate. Once components have been created, model elements, such as tables, calculations, and plans can be built.

**configuration file**

A file that specifies the characteristics of a program, system device, system, or network.

---

**D**

**database (DB)**

A collection of interrelated or independent data items that are stored together to serve one or more applications. See also _database server_.

**database server**

The server on which the database application and database are installed.

**DB**

See _database_.

**delimiter**

A character, such as comma or tab, used to group or separate units of text by marking the boundary between them.

**digital certificate**

An electronic document used to identify an individual, a system, a server, a company, or some other entity, and to associate a public key with the entity. A digital certificate is issued by a certification authority and is digitally signed by that authority.

**dimension table**

The representation of a dimension in a star schema. Each row in a dimension table represents all of the attributes for a particular member of the dimension.

---

**F**

**fact table**

A relational table that contains facts, such as units sold or cost of goods, and foreign keys that link the fact table to each dimension table.

---

**I**

**inbound connection**

A resource that is used to import data from selected outbound connections to a component. They are created to specify which component the selected outbound component should connect to.

---

**J**

**join**

An action that combines records from two or more tables or calculations based on a point of commonality. Joins are produced by adding columns to the initial data source.

left outer join
A join whose result consists of the matched rows of the two tables that were joined and the unmatched rows of the first table. See also join.

Lightweight Directory Access Protocol (LDAP)
An open protocol that uses TCP/IP to provide access to directories that support an X.500 model and that does not incur the resource requirements of the more complex X.500 Directory Access Protocol (DAP). For example, LDAP can be used to locate people, organizations, and other resources in an Internet or intranet directory.

manual adjustment
A one-time change to a value that is applied in specific scenarios. Administrators can add manual adjustments to any payee for any open period.

optimization
The process of achieving improved runtime performance or reduced code size of an application. Optimization can be performed by a compiler, by a preprocessor, or through hand tuning of source code.

outbound connection
A resource that is used to export calculation results or table data from a component. They are created from tables, calculations, and other sources.

parameter (parm)
A value or reference passed to a function, command, or program that serves as input or controls actions. The value is supplied by a user or by another program or process. See also configuration file.

parm  See parameter.

partition
The division of a single calculated result into sub-results. Partitions are used to define how the results of the calculation will be displayed. For example, if the partitioning is by payee ID, the calculation results will show the calculated amount for each payee.

payee
An individual who is being compensated or is approving the compensation results.

period
A date interval that reported values are saved in. An example of a period is December 2000.

pick list
A list of cell values available to a user when entering data into a cell.

primary key
An object that uniquely identifies an entity bean of a particular type.
**Q**

**query**  A request for information from a database that is based on specific conditions: for example, a request for a list of all customers in a customer table whose balances are greater than USD1000.

**R**

**root certificate**  
The certificate (proof of identity and keys) of the original trusted signer or certificate authority that certifies the authenticity of the end user/entity (or of intermediate signers).

**S**

**server**  A software program or a computer that provides services to other software programs or other computers.

**server certificate**  
An electronic stamp stored in the server’s key ring file that contains a public key, a name, an expiration date, and a digital signature. The server certificate uniquely identifies the server.

**servlet container**  
A web application server component that invokes the action servlet and that interacts with the action servlet to process requests.

**single sign-on (SSO)**  
An authentication process in which a user can access more than one system or application by entering a single user ID and password.

**SQL**  See [Structured Query Language](#).

**SSO**  See [single sign-on](#).

**Structured Query Language (SQL)**  
A standardized language for defining and manipulating data in a relational database.

**V**

**validation rule**  
A rule defined on an attribute definition that specifies the criteria that must be met by the data stored in an instance of this attribute for that attribute to be valid.

**view**  A virtual table that is created by joining two or more tables together. Views can also include the results of calculations.

**W**

**web application server**  
The runtime environment for dynamic web applications. A Java™ EE web application server implements the services of the Java EE standard.

**web client**  
An interface where payees can review and approve their compensation payments via a web browser. The Cognos ICM web client runs on a variety of servlet containers.
web server
A software program that is capable of servicing Hypertext Transfer Protocol (HTTP) requests.

workflow
The sequence of activities performed in accordance with the business processes of an enterprise.
Index

A
Activity tab 63
error details 63
view 63
Adjustment Details
generate report 250
adjustments 125, 127
add category 250
add manual adjustments 250
adjustment details 249
calculate 125
calculation speed 253
categories 125
dates 127
manual adjustment
create 126
manual adjustments 126
reports 127
view 250
web client 127
admin client
security 255, 292
administration
security 280
administration options 291
Audit 241
clear logs 244
copy 244
date filters 245
security 277
view workflow events 201
Audit log 241
clean up 243
events 241
export 243
filter 243
set options 294
view details 243

C
Calculate 251
adjustments 253
calculation type 251
cancel 252
computation log 252
clear 252
incremental calculations 252
period locking 308
results 252
security 279
summary 252
calculate results 252
Calculation Wizard
anchor feature 74
category calculation 89
column icons 70
define formula 77
define partitions 82
define restrictions 85
Calculation Wizard (continued)
formula operators 78
icons 70
join sources 71, 73
left outer join 75
partitions 85
preview 77
rename joined source 75
shortcut keys 71
sort calculation 88
switch source 75
time shift calculation 89
unions 76, 77
user-defined calculation 87
calculations 69, 93
auto join 76
calculation types 69
calculation values 93
copy 96
data sources 70
data tier performance optimization 297
description 95edit 95
filter 94
incremental calculations 297
locked calculations 95
preview 93
publish 96
used by 94
uses 94
view history 94
calendars 303
compensation plans 305
create 304
edit 304
locking
add new periods 309
multiple calendars 304
period locking 303, 305, 306, 307
unlocking periods 307
category calculation 89
copy categories 91
client
create model 2
date format 2
environment 1
language 1, 2
login 1
Client
change password 288
keyboard shortcuts 5
navigation 4
tabs 4
Cognos Sales Performance Management on Cloud
schedule import 62
switch report 62
compensation plans 117, 305
add calculations 118
copy 121
create 118
dates 118
compensation plans (continued)
locked 120
payee groups 117, 120
Payee Ledger display options 119
security 272
components 19, 21
add 21
add documents 22
color 22
connections 21, 25
copy 23
data flow 20
delete 23
drill-through 20
export 312
import components 313
navigation 20
open 22
organization 19
parent component 21
rename 22
security 24, 25, 264
sibling components 21
unwrap 23, 24
wrap 23, 24
Composer 13
arrange 14
breadcrumbs 20
build model 13
delete 13
change font 17
component color 17
components 19
connections 21
expand or collapse links 18
export Composer diagram 18
favorites 16
add 16
IBM Cognos Sales Performance Management on Cloud
object 61
link 14
mouse controls 18
multi-edit mode 14
navigation 18
Overview window 17
Palette tab 16
purge history 15
search 16
security 263
select elements 19
Sidebar 16
single-edit mode 14
tables 33
Toolbar 13
tooltips 19
Used by mode 15
Uses mode 15
Viewer 17
visibility 15
Computation log 244
generate 244
concurrent users 285
connection wizard (continued)
references 28
structural 29
tables 29
view connection 29
connections 21, 25
create 26
delete 27
edit 26, 27
edit connection mapping 27
inbound connection 25, 26
naming conventions 28
outbound 25
replace with global table 27
view current values 26
D
data grids
conditional formatting 180
data stores 111
add 111
creation 111
delete permission 115
join sources 112
left outer join 113
Microsoft Excel Add-in 115, 116
name columns 114
restrictions 113
security 114, 115, 271
edit permission 115
view permission 114
select columns 113
select sources 112
data tier performance optimization 297
default edit date 292
Detail Ledger 247
generate report 247
view source data 248
draws 99, 100
add draw object 100
assign payees 106
by period payout report 109
create 99
copy template 103
edit 99
delete connection 103
draw assignments 107
draw assignments report 108
draw assignments tab 107
draw reports 107
draw reports 107
edit 102
templates 103
delete 103
name 103
export reports 109
fixed term draws 106
overview report 108
paste 103
select calculation 101
templates 101
web access 105
web tab settings 104, 105
web tabs 105
YTD payouts report 108
model (continued)
rename 291
Unicode 3
model summary
publish 298
modules 4, 5
multilingual support 3

O
optimize model 303
options 294
Options menu
date format 2
environment 1, 2
language 1, 2

P
partial periods 127
partitions 82
accumulating partitioning 84
include empty partitions 83
partitions define
define 85
password 288
payee groups 309
add 310
compensation plans 117
delete payees 310
Payee Ledger 247
Adjustment Details 249
Detail Ledger 247
export 248
Excel 295
filter 247, 249
options 295
publish 248
reports 123, 127
security 278
Summary Ledger 249
web adjustments 212
PDF 97
period locking 305, 306
accuracy 305
calculations 308
calendar changes 308
system functions 307
permissions 257
placeholder connection 30
placeholder connections
create 30
link sources 31
Portal Access 205
access trees 210
assignments 214
compensation plan visibility 214
email 217, 218
email groups 219
end sign off 216
find a payee 210
groups 208, 209
hierarchies 208
hierarchy trees 210
inquiries 218
inquiry categories 220
Portal Access (continued)
inquiry trees 211
resubmit returned inquiry 221
security 275
sign off 215
colors 216
force approval 217
view group members 217
sign off trees 211
start sign off 216
tree access 215
tree assignment 214
tree builder 213
trees 211
validate tree assignments 214
view inquiries 220
view inquiry details 220
web access 209
web adjustors 212
web tab groups 207
web tabs 205
Presenter 145, 146
data components 147
links 185
naming conventions 146
parameters 147
creation 147
link 148
PDF options 189
preferences 188
publish from admin client 189
row form sources 160
security 274
sources 154
anchor feature 156
data source 155
Portal Access Inquiries 160
Workflow Form ID 160
transformations 157
aggregate transformations 157
computed columns 158
transpose 159
undo and redo 187
values 148
calculated values 150
constant values 154
stored value 149
stored values 149
workflow dashboard 176
Presenter report
preview 188
text control 174
Presenter reports 145, 185
add 146
add text 165
charts
enable rotation or slicing 188
conditional formatting 180
creation 145
data grid display options 176
data grids 167
alternating rows 181
clear links 180
column widths 179
computed columns 179
computed rows 179
editable columns 177
Presenter reports (continued)
data grids (continued)
  export to Excel 169
  format 180
  format rows 181
  input row form 168
  links 180
  null numeric values 182
  rename columns 178
  reset column names 178
  show data and time 182
  show grid lines 182
  show/hide columns 178
  suppress headers 180
  validation rules 177
  date value display 166
  default font 166
  delete components 176
  display options 163
  edit 186
  edit alignment 187
  edit borders 187
  edit font 187
  filter pick lists 175
  fixed grids 169
  gauges 173
  images 170
  layout 163
  layout tables 163
  add 164
  delete 164
  edit 164
  lock 164
  resize 165
  swap 165
  links
    example 186
    to report 185
    to web forms 185
    web pages 186
  maps 172
  multi-series chart 171
  null values 182
  numeric value display 166
  padding 187
  pick list controls 174
  printing charts 188
  publish 188
  report components 165
  single series charts 170
  submit buttons 176
  text value display 166
  process lists 7, 9
  add tasks 9
  completed tasks 11
  create 9
  filter 10
  modify 10
  resize windows 9
  security 11, 262
  view 10
Publisher
  calculations 96
  Excel 96
  MDCRM 97
  PDF 97
  Salesforce.com 98
Publisher (continued)
calculations (continued)
  text 98
  tables
    Excel 45
    MDCRM 45
    PDF 45
    Salesforce.com 46
    text 46
  purge history 15
R
  restrictions 85
    AND group 87
    define 86
    delete 86
    multiple restrictions 86
    OR group 87
  roles 255
    add 256
    copy 256
    delete 256
    environments 289
    example 288
    permission 256
    rename 256
    user assignment 289
S
  Salesforce.com 46, 98, 313
  saved imports 60, 299
  saved publications 300
  saved transformations 300
  Scenarios 129
    add change set 132
    add items 131
    change set order 134
    creation 131
    edit change sets 134
    overwrite change set 133
    preview 134
    promote 135
    reports 134
    security 273
    transform change set 133
    workspaces 130
      edit 131
      search 131
      view 131
  Scheduler 223
    add calculation 224
    add data transformations 229
    add external tools 225, 226
      configure 225
    add imports 226
    add model optimization 229
    add period locking 230
    add plan calculation 224
    add publish 227
    add star schema population 228
    add table clearing 229
    add tailored report calculation 224
    add task generation 228
    add task run 228

Index 343
<table>
<thead>
<tr>
<th>scheduler</th>
<th>(continued)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>add web enable/disable</td>
<td>230</td>
<td></td>
</tr>
<tr>
<td>add workflow payees</td>
<td>230</td>
<td></td>
</tr>
<tr>
<td>email publications</td>
<td>228</td>
<td></td>
</tr>
<tr>
<td>error</td>
<td>233</td>
<td></td>
</tr>
<tr>
<td>IBM Cognos Sales Performance Management on Cloud</td>
<td></td>
<td></td>
</tr>
<tr>
<td>synchronization</td>
<td>226</td>
<td></td>
</tr>
<tr>
<td>Presenter report calculation</td>
<td>225</td>
<td></td>
</tr>
<tr>
<td>processes</td>
<td>224</td>
<td></td>
</tr>
<tr>
<td>properties</td>
<td>223</td>
<td></td>
</tr>
<tr>
<td>publisher</td>
<td>226</td>
<td></td>
</tr>
<tr>
<td>purge history</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>run item</td>
<td>233</td>
<td></td>
</tr>
<tr>
<td>saved publications</td>
<td>227</td>
<td></td>
</tr>
<tr>
<td>schedule an item</td>
<td>232</td>
<td></td>
</tr>
<tr>
<td>Scheduler log</td>
<td>234</td>
<td></td>
</tr>
<tr>
<td>search</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td>276, 277</td>
<td></td>
</tr>
<tr>
<td>time conflicts</td>
<td>232</td>
<td></td>
</tr>
<tr>
<td>timing</td>
<td>232</td>
<td></td>
</tr>
<tr>
<td>unassign idle inquiries</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>unschedule item</td>
<td>232</td>
<td></td>
</tr>
<tr>
<td>Scheduler log</td>
<td>246</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td>255</td>
<td></td>
</tr>
<tr>
<td>add documents</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>add role</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>administration</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>administrative options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>Audit</td>
<td>277</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>278</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>277</td>
<td></td>
</tr>
<tr>
<td>Calculate</td>
<td>279</td>
<td></td>
</tr>
<tr>
<td>calendars</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>lock</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>compensation plans</td>
<td>272</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>272</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>272</td>
<td></td>
</tr>
<tr>
<td>component</td>
<td></td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>265</td>
<td></td>
</tr>
<tr>
<td>components</td>
<td>264</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>265</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>265</td>
<td></td>
</tr>
<tr>
<td>Composer</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>264</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>264</td>
<td></td>
</tr>
<tr>
<td>copy role</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>data stores</td>
<td>271</td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>272</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>271</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>271</td>
<td></td>
</tr>
<tr>
<td>delete role</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>enable custom headers</td>
<td>284</td>
<td></td>
</tr>
<tr>
<td>import data</td>
<td>268</td>
<td></td>
</tr>
<tr>
<td>advanced settings</td>
<td>268</td>
<td></td>
</tr>
<tr>
<td>import</td>
<td>268</td>
<td></td>
</tr>
<tr>
<td>input forms</td>
<td>269</td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>269</td>
<td></td>
</tr>
<tr>
<td>add rows</td>
<td>270</td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>269</td>
<td></td>
</tr>
<tr>
<td>delete rows</td>
<td>270</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>269</td>
<td></td>
</tr>
<tr>
<td>edit data</td>
<td>270</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td>(continued)</td>
<td></td>
</tr>
<tr>
<td>input forms</td>
<td>(continued)</td>
<td></td>
</tr>
<tr>
<td>view history</td>
<td>271</td>
<td></td>
</tr>
<tr>
<td>manage roles</td>
<td>255</td>
<td></td>
</tr>
<tr>
<td>migration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>execute</td>
<td>284</td>
<td></td>
</tr>
<tr>
<td>model optimization</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>payee groups</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>Payee Ledger</td>
<td>278</td>
<td></td>
</tr>
<tr>
<td>permissions</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>Portal Access</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>276</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>276</td>
<td></td>
</tr>
<tr>
<td>Presenter</td>
<td>274</td>
<td></td>
</tr>
<tr>
<td>Audit log as source</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>process lists</td>
<td>262</td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>rename roles</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>role permissions</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>saved imports</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>run</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>saved publications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>281</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>281</td>
<td></td>
</tr>
<tr>
<td>run</td>
<td>281</td>
<td></td>
</tr>
<tr>
<td>saved transformations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>281</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>281</td>
<td></td>
</tr>
<tr>
<td>scenarios</td>
<td></td>
<td></td>
</tr>
<tr>
<td>promote</td>
<td>274</td>
<td></td>
</tr>
<tr>
<td>Scenarios</td>
<td>273</td>
<td></td>
</tr>
<tr>
<td>add scenario</td>
<td>273</td>
<td></td>
</tr>
<tr>
<td>create workspaces</td>
<td>273</td>
<td></td>
</tr>
<tr>
<td>modify scenario</td>
<td>273</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>273</td>
<td></td>
</tr>
<tr>
<td>Scheduler</td>
<td>276, 277</td>
<td></td>
</tr>
<tr>
<td>star schemas</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>enable purge history</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>enable web data edit</td>
<td>267</td>
<td></td>
</tr>
<tr>
<td>tables</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>add Views</td>
<td>267</td>
<td></td>
</tr>
<tr>
<td>delete</td>
<td>267</td>
<td></td>
</tr>
<tr>
<td>edit structure</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>view structure</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>Task Manager</td>
<td>277</td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td>282</td>
<td></td>
</tr>
<tr>
<td>web forms</td>
<td>274</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>274</td>
<td></td>
</tr>
<tr>
<td>Workflow Manager</td>
<td>278</td>
<td></td>
</tr>
<tr>
<td>create workflows</td>
<td>278</td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>279</td>
<td></td>
</tr>
<tr>
<td>start workflows</td>
<td>279</td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>278</td>
<td></td>
</tr>
<tr>
<td>view workflows</td>
<td>279</td>
<td></td>
</tr>
</tbody>
</table>
sign off
  emails 296
sort calculation 88
star schema
import to Excel 311
star schemas 311
create 311
statistics monitoring program 297
Summary Ledger 249
caps and guarantees 249
generate report 249

T
table history 49
disable 49, 301
enable 301
purge 50
tables 33
add 37, 38
add data 41
clear 48
column types 38
columns 33
copy 44
custom tables 36
data 33
Data table 39
data tables 36
delete 43
delete rows 43
dependency viewer 47
copy text 47
description 43
edit data 41, 42
edit table structure 42
filter 42
find and replace 49
hierarchy tables 34
  Accounts table 35
  Payee table 35
  Time table 36
navigation 48
pick lists 39
primary keys 38
publish 44
  Microsoft Dynamic CRM 45
  Microsoft Excel 45
  PDF 45
  Salesforce.com 46
text file 46
security 266
structural tables 36
system tables 34
  currency table 34
  group member table 34
  salutation table 34
title table 34
view as hierarchy 40, 41
view data 41
View table 37
edit 43
view table structure 42
View tables
add 40
web data edit 50
tabs (continued)
  move 5
tailored report
  view results 123
tailored reports 117, 121
  add 121
  alert generation 122
  copy 123
  edit locked reports 122
  payee groups 122
Task log 246
Task Manager 209, 235
  activate alerts 239
  administer tasks 238
  defer tasks 238
  disable alerts 239
  email 238
  enable alerts 239
  generate task list 237
  groups 235
  rules 236
  security 277
  tasks 235
testing the connection 298
themes 313
time shift calculation 89
toolbars
  show/hide text 7
tools 303
calendars 303
Tools
  security 282

U
Unicode 3
user preferences 314
user-defined calculation 87
users 285
users and permissions report 285

W
web access 209
web client 202
  configure Request Assistance link 293
  disable account 285
  force password reset 294
inquiries 219
  submit 219
security 293
sign off 216
web data edit 50
  approve 52
  define accessible information 50
  direct edit 51
  edit data 51
  row restrictions 51
web forms 137
  add 137
  admin forms 141
  attach web form filters 139
  cell span 141
  copy 142
  custom filter 138
  format 141

Index 345
web forms (continued)
JavaScript 143
link to Presenter report 143
link to web form 143
link to web page 144
linking 143
Portal Access filters 138
preferences 142
row forms 140
required flags 140
security 274
set field width 140
simple filter 138
sources 139
validation rules 139
web form filters 137
web form options 142
web resources 141
web forms publish
publish 144
web messages 298
create 298
delete 299
edit 299
notify web users 299
view 299
web tab groups 207
web tabs 205
access 207
create 206
delete 207
edit 206
move 206
remove from group 207
Workflow Manager 191, 201
add new payees 194
Base URL 198
clear 202
connections 200
Workflow Manager (continued)
errors 200
resolve 201
view 200
export 202
filter 202
nodes 196
action node 198
alert node 197
connect 199
cut, copy, paste 199
edit 199
process node 199
pending actions 201
process nodes
skip 202
reports 200
security 278
set web client URL 294
Start node 197
swim lanes 194
add 195
columns 196
delete 196
form initiator 195
web client 202
actioning workflows 203
completed workflows 204
initiate workflows 203
workflow events 201
workflows 191
add 192
default parameters 193
delete 193
edit 193
organize 194
search 194
start 193